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Introduction

The Android OS is currently the most popular operating system in the world. The Android OS runs on
everything from smartwatches to HD smartphones to touchscreen tablets to ebook readers to game
consoles to smartglasses to ultra-high definition interactive television sets!

There are even more types of consumer electronics devices—such as those found in automotive,
home appliance, security, robotics, photography, industrial and home automation markets—that are
adopting the open source Android OS as their platform as time goes on. This book will show you
how to develop applications for these new device type verticals as they emerge into the market.

Since there are literally billions of Android consumer electronics devices owned by billions of people
all over the world, it stands to reason that developing great Android applications for all these people
might be an extremely lucrative undertaking, assuming that you have the right concept and design.

This book will help you go a long way toward learning how to develop Android applications that will
run across all types of Android-compatible consumer electronics devices, and across all popular
versions of the Android OS, most recently the 32-bit Android 4 OS and the new 64-bit Android 5 OS.

Developing an Android application that works well across all of these types of consumer electronics
devices requires a very specific work process, which | cover in this book.

| wrote Android Apps for Absolute Beginners, Third Edition from scratch, targeting those readers
who are absolute beginners to Android yet are technically savvy, but who are not familiar with
computer programming concepts and techniques.

Since 32-bit Android is currently using Version 4.4.4, this book will be more advanced than Android
Apps for Absolute Beginners, First Edition, when Android OS Version 1.5 was released by Google for
smartphones, or Android Apps for Absolute Beginners, Second Edition, when Android OS Version
3.0 was released for tablets. Since then, five revisions of the 32-bit Android OS Version 4.x have
been released, including 4.0, 4.1, 4.2, 4.3, and 4.4, targeting all new iTV set and game console
products.

xxvii
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Since the 64-bit Android 5.0 OS was announced during the writing of this book, and is currently in
beta, | will also include an advanced chapter at the end of this book called “The Future of Android:
The 64-bit Android 5.0 OS.” This comprehensive Android 5.0 chapter will cover what you can
expect when 64-bit Android 5.0 smartphone devices are released during 2014, as well as when
64-bit Android 5.0 game consoles, tablets and iTV sets are released during 2015 and into 2016.

The first edition of this book was a mere 300 pages, as Android 1.5 was the first version to appear
on Android hardware devices (smartphones), and a second edition of this book was 33% longer, at
400 pages. I've expanded this version of the book to include nearly 700 pages of information, the
size of the first two editions combined. This third edition even contains chapters that cover how to
develop for Android wearable devices, such as the popular Neptune Pine smartwatch, as well as
covering the new Android Wear SDK using the new Android Studio and IntelliJ IDEA. This book also
covers how to develop for rapidly emerging Android appliances using the new Android TV SDK.

| designed this book to be a more comprehensive overview of the Android application development
work process than most beginning Android application development books, because, at this point,
there is really no way to “sugar coat” the Android application development process. To become the
leading Android application developer that you seek to become, you will have to understand, as well
as master, XML mark-up, user interface design, Java programming, and new media content creation.
Once you have done this, hopefully by the end of this book, you will be able to create the vanguard
user experiences required to create those popular, best-selling Android applications.

Android apps are currently developed for 32-bit Android 4 with Eclipse ADT Integrated Development
Environment (IDE) or for 64-bit Android 5 using IntelliJ IDEA. Android applications are not developed
via IDE alone, but also in conjunction with several other genres of new media content development
software packages. For this reason, this book covers a wide variety of popular open source software
packages, including GIMP 2.8, Planetside Terragen 3.1, Sorenson Squeeze Pro 9, VirtualDub 1.9,
and Audacity 2. These professional new media content production tools should be utilized in
conjunction with developing your Android 5 applications, and this book will show you exactly how
to accomplish this, as well as how to download, install, update, configure, and actually use each of
these programs.

This comprehensive Android 4/5 application development work process will allow you to experience
exactly how the use of all of these multimedia content development software packages needs to fit
into your overall Android application development work process. This 100% comprehensive “soup to
nuts” multimedia-centric Android app development approach sets this 32-bit Android 4.x and 64-bit
Android 5 book title distinctly apart from all of the other Android application development titles that
are currently on the market. This book covers the Android development process at a broader level.

Chapter 1 starts by covering downloading and installing the current Java SE 6 and Android 4.4 SDK
as well as the Eclipse IDE and the Android ADT bundle, along with several popular open source
content development applications. In Chapter 2, you will configure your Android 4 application
development workstation, and in Chapter 3, you will create a basic Android 4.4.4 application. You
will be adding more and more functionality to that basic Android application during the remainder of
the book, as well as converting it into an Android 5 app during the final chapter of the book covering
Android 5.

In Chapter 4, you learn all about the XML markup language, and in Chapter 5, you learn all about the
Java SE programming language. Thus, the first third of this Android book is foundational material,
which explains how the Android OS works together as a whole. In Chapters 6 through 8, you learn
about the fundamentals of user interface design in Android, and how to make Ul designs interactive.
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In Chapters 9 and 10 you will learn about graphics design and 2D animation in Android, and how to
use new media content production software in conjunction with Android development software and
IDEs. In Chapters 11 and 12, you will learn how to implement digital audio new media assets as well
as how to stream digital video new media assets from your remote video servers.

In the final four chapters of this book, you will learn about some of the more advanced development
topics that normally would not be included in an Absolute Beginner title, but | included them so that
all of the important topics regarding Android application development are in this one, single, unified
book. These included advanced topics including threads, processes and databases, developing
apps for smartwatches and iTV sets, and everything you would want to know about the new 64-bit
Android 5 OS, including how to set it up, how to develop Android 5.0 applications, and all of its new
features.

In Chapter 13, you will learn all about threads, Services and background processing for Android
using the Service class, and in Chapter 14 you’ll learn about RDBMS database theory and SQLite
databases in Android, as well as how to use the Android Content Provider classes to access built-in
databases.

In the last two chapters in this book, you’ll dive into the future of Android application development,
by developing applications for Android wearables and Android appliances, and learning all about
Android 5.0. Chapter 15 covers how to develop Android applications for wearable devices and the
Wear SDK, and Chapter 16 covers how to develop Android applications for Android appliances such
as the iTV set using the Android TV SDK and the new Android 5.0 OS and Android Studio Bundle
based on the IntelliJ IDEA and Java 7 on top of an all new 64-bit Linux Kernel and the new ART
Android RunTime.

This book attempts to be the most comprehensive Absolute Beginners book for Android application
development out there, by covering most, if not all of, the major Android classes that will need to be
used to create leading-edge 32-bit Android 4.x and 64-bit Android 5.x software applications.

Some of these classes include the View, ViewGroup, Activity, Menu, Menultem, OptionsMenu,
and ActionBar classes, used for GUI and screen designs, the FrameLayout, LinearLayout,
RelativeLayout, GridLayout, TableLayout, and SlidingPaneLayout classes, which are used

for user interface designs, the ImageButton, ImageView, NinePatch, NinePatchDrawable,
BitmapDrawable, Animation, AnimationDrawable, and AnimationSet classes, which are used for
graphics design and animation, the SoundPool, VideoView, MediaPlayer, Uri and MediaController
classes, which are used in digital audio and digital video applications, and finally, the Service,
Thread, Context, ContentProvider, and ContentResolver classes, used for database access and
more complex background processing tasks.

If you are looking for the most comprehensive, up-to-date overview of the latest 32-bit and 64-bit
Android OSes, including Eclipse ADT (Android Developer Tools) IDE on top of Java SE 6, and IntelliJ
(Android Studio) IDEA on top of Java SE 7, this is the book that covers the entire gamut.

This Android title covers everything regarding the XML markup langauge and the new media
content development work processes which spans across both 32-bit as well as 64-bit Android
development, as well as detailed knowledge about how to optimally use Android app technologies
with the leading open source new media content design and development tools.
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If you are looking for the latest Android title that covers everything about Android from the first
version that Google released (1.5) up to the current version (5.0) and how to assilimate these app
development technologies into your current content production workflows, this Android Apps for
Absolute Beginners, Third Edition book will be of significant interest to you.

It is the intention of this book to take you from being an “Absolute Beginner” in Android application
development, to having a comprehensive, solid, intermediate knowledge of both 32-bit Android 4.4
and 64-bit Android 5.0 application development.

You should be advised that this book contains a significant amount of technical knowledge and work
processes that may take more than one read-through to assimilate into an application development
knowledge base (your current Android knowledge “quiver of arrows” so to speak). This vast journey
through 32-bit Android 4.x and 64-bit Android 5 will be well worth your time, however; rest assured.



Chapter

Setting Up Your Android App
Development System

These days, you see Android devices of every size and shape everywhere you look. They can be
worn on your person, used in an appliance, are a part of your car, or provide you entertainment in
your living room taking the form of an iTV set, a tablet, eBook reader, or an Android game console.

In this chapter, we will explore some basic facts about the Android operating system (OS), to give
you a high-level overview of the history of Android, the benefits of learning Android application
development, and which open source programming languages and OSs Android is based upon.

We will also need to get all of the tedious searching and downloads out of the way regarding to how
to go about obtaining all of the various software packages, SDKs, and components, which together
form a comprehensive Android production workstation.

Even though this is an “Absolute Beginners” Android title, | want to teach you how to put together a
pro Android development workstation, so that you are all ready to get into the various Pro Android
series of books from Apress (after you finish mastering this book, of course).

So that everyone experiences this book equally, this chapter will outline all the steps to obtain a
completely decked out Android development workstation.

The History of the Android 0S: Impressive Growth

Android OS was originally created by Andy Rubin as an OS for mobile phones; this happened
around the dawn of this 21st century.

In 2005, Google acquired Android Inc., and made Andy Rubin the Director of Mobile Platforms for
Google. Many think this acquisition of the Android OS by Google was largely in response to the
appearance of Apple’s iPhone around that same time. However, there were enough other large
players, such as RIM Blackberry, Nokia Symbian, and Microsoft Windows Mobile, that it was
deemed to be a savvy business decision for Google to purchase Android engineering talent and
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Android OS intellectual property, allowing Google to insert their company into this emerging market,
which was known as Internet 2.0.

Internet 2.0, or the Mobile Internet, allows users of consumer electronic products to access content
via widely varied data networks, using portable consumer electronic devices. These currently include
tablets, smartphones, phablets (phone-tablet hybrid), game consoles, smartwatches, smartglasses,
personal robots, and eBook eReaders.

These days, Android OS-based devices can also include those not-so-portable consumer
electronics devices, such as iTVs, home media centers, automobile dashboards and stereos,
and digital signage system set-top boxes.

This ever-growing Android phenomenon puts new media content such as games, 3D animation,
interactive television, digital video, digital audio, eBooks, and high-definition imagery into our lives at
every turn.

Android is one of those popular, open source vehicles (the other one being HTML5) that digital artists
will increasingly leverage in order to be able to develop new media creations that users have never
before experienced.

Over the past decade, Android has matured and evolved, to become a stable, exceptionally reliable,
embedded open source OS. An Android OS that started out with its initial Version 1.0 just a few
years ago, once acquired by Google, has released stable OS versions at 1.5, 1.6, 2.0, 2.1, 2.2, 2.3,
3.0, 3.1,3.2,3.3, 4.0, 4.1, 4.2, 4.3, and, recently, the much-heralded KitKat Android version 4.4,
currently at Version 4.4.4. As of the writing of this book, Android 5.0 is in beta at version 0.8.0, so
that should show up in 64-bit Android devices in 2015 and 2016.

If you want to see the latest statistics regarding each of these Android OS revisions, directly from the
Android developer web site, visit this URL:

http://developer.android.com/about/dashboards/index.html

Table 1-1 shown this progression of all the popular versions of Android OS that have been installed
on the popular consumer electronics manufacturer products over the past decades. | wanted to
collect all of this Android OS information together into one single infographic for you so that you
could get a “bird’s eye” view of the current historic progression of the Android OS. As you can see,
there are certain Android market share “sweet spots.”

Table 1-1. Android Versions, Internal Codenames, API Levels and Market Share

VERSION CODENAME API LEVEL MARKET SHARE
1.5 Cupcake 3 0.1%

1.6 Donut 4 0.1%

2.1 Eclair 7 0.2%

2.2 Froyo 8 0.2%

2.3.7 Gingerbread 10 14.9%

3.2 Honeycomb 13 0.2%

(continued)
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Table 1-1. (continued)

VERSION CODENAME API LEVEL MARKET SHARE
4.04 Ice Cream Sandwich 15 12.3%

41.2 Jelly Bean 16 29.0%

422 Jelly Bean Plus 17 19.1%

4.3.1 Jelly Bean Plus 18 10.3%

4.4.4 Kit Kat 19 13.6%

5.0 L 20 0.0%

In case you are wondering what an embedded OS is, it is like having an entire personal computer on
a motherboard, which is small enough to fit into a handheld consumer electronics device, and which
is powerful enough to run applications (which are commonly known simply as apps).

Just like today’s personal computers and laptops, the Internet 2.0 devices such as smartphones,
tablets, eReaders, smartwatches, and iTVs now feature quad-cores (4 CPUs) and even octa-core

(8 CPUs) computer processing power, as well as one or two gigabytes of system memory. This is
approaching the power of a modern day PC, such as the workstation you are going to set up during
the next chapter of this book, which you can get for $300 at WalMart. The mini-tower PCs feature
quad-core 64-bit processors along with 4GB or 6GB of system memory, and a 500GB hard disk
drive with Windows 8.1.

The Android OS contains the power of a complete computer OS. It is based on the Linux Kernel
open source platform, and Oracle (formerly Sun Microsystems) Java 6 Standard Edition, one of the
world’s most popular programming languages. Android 5, coming out in products next year, will use
a 64-bit Linux Kernel, and Java 7.

Note The term open source refers to software that has often been developed collaboratively by an

open community of individuals, and is freely available for commercial use. Open source software comes
with all of the source code, so that it can be further modified if necessary. The Android OS is open source,
though Google develops it internally before releasing the source code. From that point on, it is freely available
for commercial use by app software developers.

It’s not uncommon for an Android device to have a 1.2GHz processor and 1GB of fast, computer-
grade DDR3 memory. This rivals desktop computers of just a few years ago, and netbooks that are
still currently available. You will continue to see this convergence of Internet 2.0 (mobile device) OSs
with desktop OSs, such as we are seeing with Windows 8.1 and Google Chrome OS currently, as
time goes on.

Once it became evident that Java, the Android OS, and open source software platforms were
vanguard forces to be reckoned with, a bunch of the popular consumer electronics manufacturers,
including Philips, Sony, HTC, Samsung, LG Electronics, and T-Mobile, formed, and joined the
Open Handset Alliance (OHA). This was all done in order to put the momentum behind Google’s
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open source Android platform, and it worked! Today, hundreds of leading branded consumer
electronics manufacturers leverage Android as an OS on their consumer electronic devices. In fact,
Android OS is used more than any other OS that has ever existed on the face of the earth.

This development of the OHA is a significant benefit to Android developers. Android allows
developers to create their applications using a single IDE, or integrated development environment,
and now this support by the OHA can enable developers to deliver their content across dozens

of major branded manufacturers’ hardware products as well as across several different types of
consumer electronic devices, including smartphones, iTV sets, e-book e-readers, smartwatches,
smartglasses, home media centers, settop boxes, and touchscreen tablets.

The Android OS affords its developers a plethora of powerful content delivery tools and platform
support and device playback possibilities, to say the least! But then again, you must have realized
this yourselves, as you are reading this book right now, so you can get in on all that power!

In summary, Android is a seasoned OS that has become one of the biggest players in computing
today, and with Google behind it. Android uses freely available open source technologies such as
Linux and Java, and open standards such as XML, CSS, MPEG, JPEG, PNG, MP3, WebM, WebP,
OpenGL, WebKit, and HTMLS5. Android incorporates all of these open source resources so that it can
provide the free new media content and application delivery platform to Android developers, and an
OS platform to consumer electronics manufacturers. Can you spell OPPORTUNITY? | sure can: it’s
spelled ANDROID!

Advantage Android: How Can Android Benefit Me?

There are simply too many benefits for the Android OS development platform to ignore your Android
applications development workflow, and environment, for even one minute longer. We are going to
get you all of the latest apps and OS SDKs and components during this chapter so you'll have a
valuable PC!

First of all, Android is based on open source technology, which was at its inception not as refined as
paid technologies from Apple and Microsoft.

However, over the past several decades, open source software technology has become equally as
sophisticated as conventional software technologies. You will soon see this with your professional
level new media content software that you will be acquiring (for free) during the remainder of this
chapter.

This is clearly evident with Internet 2.0, as the majority of the consumer electronics manufacturers
have chosen Linux and Java over the Windows, iOS, and Macintosh OSs.

For this key reason, Android developers can develop applications not only for their smartphones, but
also for new and emerging consumer electronics device ecosystems that include never-before-seen
products such as glasses and smartwatches and 4K UHD iTVs that are network-compatible and
available to connect to an Android Marketplace. The Android Marketplace was recently re-branded
by Google as Google Play due to a lawsuit brought by Apple.

This translates to more sales on more devices in more areas of a potential customer’s life and thus
offers more incentive to develop for Android over closed technologies such as Windows and iOS
and over less popular and less prolific PC OSs.
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In addition to being free for commercial use, the Android OS has one of the largest, wealthiest, and
most innovative companies in modern-day computing behind it: Google. Add in an OHA and you
have more than a trillion dollars of megabrand companies behind you, supporting your development
efforts. It certainly seems too good to be true, but it's a fact; if you're an Android developer (which
you are about to be, in about a dozen and a half chapters), then you now have a supreme hardware
and software sales and support team behind you.

Finally, and most importantly, it’s much easier to get your Android applications published than those
for other platforms that are similar to Android (I won’t mention any names here, to protect the
not-so-innocent).

We'’ve all heard those horror stories regarding major development companies waiting months, and
sometimes years, for their apps to be approved for the app marketplace. These problems are nearly
non-existent on the open source Android platform. Publishing an app on the Google Play Android
Marketplace is as easy as paying $50, uploading your Android .apk file, and specifying whether you
are offering a free or a paid download.

The Scope of This Book

This book is an introduction to developing applications for Android. It is intended for absolute
beginners; that is, people who have never created an application on the Android platform for a
consumer electronic device. | do not assume that you know what Java is, or how XML works, or
what styles or themes are, or what a codec, an alpha channel, color dithering, or an anti-aliasing
algorithm is.

All'l know is that by the end of this book, you’re going to appear as if you are speaking a foreign
language when you start talking about new media Android application development in front of
friends, family, and clientele, which ultimately will get you hired, and hopefully well paid!

What is Covered in This Book

This book covers the basic and essential elements of Android application development, including
but not limited to the following areas:

The open source tools required to develop for this platform

Where to get this free software development environment, as well as
professional new media content creation tools

How to properly install and configure the necessary tools for application
development as well as new media creation

Which third-party tools are useful to use in conjunction with the Android
development tools (ADT)

Which OSs and platforms currently support development for the Android
using these tools
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The concepts and programming constructs for Java and XML, and their
practical applications in creating Android applications

How Android goes about setting up an Android application
How it defines the application user interface components
How it addresses and writes graphics to a display screen
How it can communicate with other Android applications
How it interfaces with data, resources, networks, and the Internet

How it alerts users to events that may be taking place, inside of and outside
of your Android application

How Android applications are published using the app Manifest

How Android applications are ultimately sold, downloaded, and updated
automatically through Google Play Android Marketplace

Realize that Android OS has more than 44 Java packages, which contain functionality that allows
you to do just about anything imaginable, from putting a Ul button on the display screen, to
synthesizing speech, or accessing advanced smartphone features such as the high-resolution
camera, Bluetooth, GPS, Gyro, Compass, or Accelerometer.

Note A package in Java is a collection of programming utilities or functions that all have related

(and interconnected) functionality. For example, the java.io package contains utilities that deal with input
and output (10) to your program, such as reading the contents of a file, or saving data to a file. Later chapters
describe how to organize your own Android Java code, into your own custom packages.

What does the plethora of Android Java code mean for an Absolute Beginner?

It means that even the most advanced pro Android books can’t all cover the plethora of amazing
things that this Android OS platform can accomplish!

In fact, most Android books will specialize in a specific area of an Android API. An APl is an
application programming interface, or a collection of programming code routines that allow software
development. We will be learning about APIs in Chapter 5. There is plenty of complexity in each API,
which ultimately, from the developer’s viewpoint, translates into incredible creative power. What is
the price of this power, you might ask. Your time spent in mastering each API is the only price you’ll
pay, as the Android OS is otherwise free for commercial use.

What is Not Covered in This Book

So, what isn’t covered in this book? What cool, powerful capabilities do you have to look forward to
in the next level book on Android programming?

On the hardware side, we will not be looking at how to control the camera, access GPS data from
the smartphone, and access the accelerometer, or the gyroscope, which allow the user to turn
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the smartphone around and have the application react to the smartphone position. We will not be
delving into advanced touchscreen concepts such as gestures, or accessing other device hardware,
such as the microphone, Bluetooth, or wireless connections.

On the software side, we will not be diving into creating your own Android MySQLite Database
Structure, or Android’s real-time 3D rendering system (called OpenGL ES 3.1), although we will take
a closer look at these areas so that you know how to utilize them, and how they fit into the overall
Android OS infrastructure.

We will not be exploring speech synthesis and speech recognition, nor the universal language
support that allows developers to create applications that display characters correctly in dozens of
international languages and foreign character sets.

We will not be getting into advanced programming such as game development, artificial intelligence,
image compositing pipelines, blending modes, and physics simulations. All of these topics are better
suited to books that focus on these complex and detailed topical areas, such as the Apress Pro
Android Graphics and Pro Android Ul titles.

Assembling Your Android Development Workstation

In this section, | will outline the broad overview of what’s needed to put together a complete Android
development workstation that you can utilize throughout this book to create cool Android apps.

The first thing that you'll do is get the entire Java software development kit (SDK), which Oracle
calls JavaSE 6 JDK (Java Development Kit). Android OS uses Java Standard Edition (SE) Version 6
update 45, as of Android 4.4.

Note Java Version 7 also exists, and is in parallel release with Java6, at Java7 u45. In the second quarter
of 2014, there will be a Java Version 8 released, which will include powerful JavaFX APIs that turn Java
programming language into a powerful new media engine. Thus, the future of open source development
(Android OS, Java8, XML, HTML5) is here! In fact, Android 5.0, which should be available in 64-bit consumer
electronics products in 2015 and 2016, uses Java 7 and a 64-bit version of the Linux Kernel!

The second thing that we will download and install is the Android Developer Tools (ADT), which we
will get from Google’s developer.android.com web site.

ADT Bundle 4.4 consists of the Eclipse 4.4 IDE (integrated development environment), along
with the ADT 4.4 plug-ins, which bridges the Android SDK that is also part of the ADT Bundle
download, with the Eclipse 4.4 IDE. This makes the Eclipse Java IDE into an Eclipse Android ADT
IDE, essentially, although it could still be used for straight JavaSE 6 application development as
well. An IDE is an integrated development environment, like a word processor tuned for writing
programming code.

After your core Android development environment is downloaded, you’ll then download and install
external new media asset development tools, which you will utilize in conjunction with Android for
things such as Ul wireframing (Pencil), digital image editing (GIMP2), digital audio editing (Audacity),
digital video editing (Lightworks), 3D modeling and animation (Blender3D), and even running your
Android development business (Apache Open Office 4.1).
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All of these software development tools, which you will be downloading and installing, will come
close to matching all of the primary feature sets of the expensive paid software packages, such as
those from Microsoft (Office and Visual Studio), Apple (Logic, Avid, FinalCut Pro X), Autodesk
(Maya or 3D Studio Max), and Adobe (Photoshop CS6 and After Effects).

Each of these paid software packages would cost a couple thousand dollars each to purchase and
maintain, so plan on paying ten thousand (your local currency unit here) to put together a similar paid
software workstation to develop for the iOS or the Windows consumer electronics device platforms.

Open source software is free to download, install, and even upgrade, and is continually adding
features, and becoming more and more professional, each and every day. You’ll be completely
amazed at how professional open source software packages have become over the last decade or
two; if you have not experienced this already, you are about to, and in a very major way.

Android Development Workstation: Hardware Foundation

Since during the chapter you will put together what will be the foundation for your Android
applications development system for the duration of this book, let’s take a moment to discuss the
Android development workstation’s hardware configuration, as that’s an important factor for your
performance (speed of development), which is as important as the software itself.

This section will therefore cover a plethora of important systems hardware considerations that you
should consider when assembling your workstation.

| recommend using at a bare minimum an Intel i7 quad-core processor, or an AMD 64-bit
hexa-core processor, with at least 8GB of DDR3 1600 memory. I’'m using the octa-core AMD 8350
with 16GB of DDR3 2000. Intel also has a six-core i7 processor. This would be an equivalent of
having 12 AMD cores, as each Intel core can host two threads; similarly, the i7 quad-core looks like
8 AMD cores to the OS thread-scheduling algorithm.

AMD has a 16-core processor as well, which is usually deployed inside of server architectures, but
this CPU can be used in a client-side Android development workstation, which would greatly speed
video compression or 3D rendering for your Android applications development.

There are also high-speed DDR3 1866 and DDR3 2000 clockspeed memory module components
available. A high number signifies faster memory access speed. To calculate the actual megahertz
speed at which memory is cycling, divide the number by 4 (1333=333Mhz, 1600=400Mhz,
1866=466Mhz, 2000=500Mhz clock rate). Memory access speed is the key workstation performance
factor because your processor is usually “bottlenecked” by the speed at which the processor cores
can access the data (in memory) that it needs to process.

With all this high-speed processing and memory access going on inside your workstation while it

is operating, it is also important to keep everything cool so that you do not experience “thermal
problems.” | recommend using a wide full-tower enclosure, with 120mm or 200mm cooling fans
(one or two at least), as well as a captive liquid induction cooling fan on the CPU. This type of CPU
cooler has cooling tubes filled with water that touch the CPU and draw away heat, turning the water
into steam, which rises up the tubes to the cooling fan, which cools this steam, condensing it back
into water, which runs back down the pipe to cool the CPU. It’s important to note that the cooler
your system runs, the longer it lasts, and the faster it runs, which is important for Android application
development.
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If you really want the maximum performance, especially while emulating Android Virtual Devices
(AVDs), which are used for app prototyping or testing, which you will learn about in the next chapter,
using Eclipse, you’ll want to make sure that your Android development workstation has a solid state
disk (8SD) hard drive as its primary (C:\ “boot” drive) disk drive, from which your applications and
OS software will launch.

You can always use more affordable hard disk drive (HDD) hardware for your D:\ (secondary) hard
disk drive, for your data storage, which does not need the speed of operation as it is just used for
long-term storage.

For my OS, I’'m using a 64-bit Windows 8.1 OS, which is quite memory-efficient. Linux 64-bit OS is
also extremely memory efficient. It’s important to note that Windows 8.1 comes on most quad-core
workstations in retail stores such as WalMart and Staples, and with an OS price of several hundred
dollars if purchased separately, you could look at the hardware as being essentially free!

Android Development Workstation: Software Foundation

To create a well-rounded Android applications development workstation, you will be installing all of
the primary genres of open source software covered later in this chapter, after you install JavaSE
6u45, Eclipse, and the ADT environment, which are also all the open source programming packages
you’ll need. Thus, we’ll be putting together a 100% open source workstation for you (with the
exception of your Windows 8 OS).

For those readers who have just purchased their new Android workstations, and who are going to
put their Android development software suite together completely from scratch, I'll go through an
entire work process during the rest of this chapter.

We will start with Java SE 6u45 as it is the foundation for Eclipse ADT as well as Android, and then
we’ll acquire the Eclipse ADT Bundle. After that, we’ll search for and download your new media
content development software, as well as user interface design software and a complete business
software suite called Apache Open Office 4.1, originally created by Sun Microsystems, and acquired
and made open source by Oracle, who owns the Java SE platform.

Java SE 6: Download and Install a Foundation for Android

Before you run a JavaSE installation, you should remove any older versions of JavaSE using

your Windows Control Panel, via the Add or Remove Programs (XP) or Programs and Features
(Windows 7 and 8.1) utility. To remove an older version of the Java JDK or Java Runtime
Environment (JRE) select them and right-click on the selected entry and use the “Uninstall/Remove”
option to un-install.

This will be necessary especially if your workstation is not brand new, so that only your latest Java
SE 6u45 and JRE 6u45 are the sole Java versions that are currently installed on your new Android
development workstation.

To install a new JDK:

1. The first thing that you will want to do is to visit Oracle’s Java Archive web
site, and download and install the latest Java 6 JDK environment, which at
the time of writing this book was Java SE 6u45, as shown in Figure 1-1.



10 CHAPTER 1: Setting Up Your Android App Development System

B java 6 se jdk download ar. % E Java Archive Downloads - % |
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Figure 1-1. Oracle TechNetwork web site JavaSE6 Archive; scroll to the middle to find the JavaSE 6u45 JDK download

The URL is in the address bar of Figure 1-1, or you can simply Google Java SE 6 JDK Archive
Download, which will also give you the latest link to this web page, which | will also put here, in case
you want to cut and paste it:

http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase6-419409.html

You can pull the scrollbar on the right side of the web page down the page, until you see the Java
SE Development Kit 6u45 Download button, which you can see on the very bottom of Figure 1-1.
The first link in the long list of version links is the latest revision of the Java SE JDK Development Kit
and since you want to get the latest bug-free version, this is the one you want.

Make sure that you use this Java SE Development Kit 6u45 download link, and do not use a JRE
download link. The JRE is part of the JDK6u45, so you do not have to worry about getting the Java
Runtime separately. In case you’re wondering, you will indeed use the JRE to launch and run your
Eclipse IDE, and you will use the JDK inside of Eclipse to provide the Java core class foundation for
the Android OS Java-based API.


http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-javase6-419409.html
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Note The JRE is the executable (platform) that runs your Java software once it has been compiled into an
application, and thus a JRE will be needed to run Eclipse, because Eclipse is 100% written using Java SE.

Make sure not to download a JDK 7u45 or the JDK 7u45 Bundle, which includes NetBeans 7.4
from the normal (non-archived) download page, because Android 4.4 uses JavaSE 6u45 and the
Eclipse 4.4 IDE, not the NetBeans 7.4 IDE for its ADT plug-ins, so be very careful regarding this
foundational install step.

| actually use a completely different workstation for Android development, which has Java SE 6u45
and Eclipse 4.4, and have another HTML5 development workstation that has Java SE 8u5 and
NetBeans 8.0 (only) installed on it. These will be covered in my upcoming Beginner Java 8 Games
Development title from Apress.

2. Once you click on the Java SE Development Kit 6u45 link, you will be taken
to the Java SE Development Kit 6u45 Download section of this page, shown
in Figure 1-2, where you will be able to select the OS you are using.

- ©
Eﬁ java b se jdk download arc X E Java Archive Downloads - x
= C [ www.oracle.com/technetwork/java/java ess/dow Is/java-archive-downloads-javase6-419409.html#jdk-6u45-oth-JPF =
”~
Java SE Development Kit 6u4s
You must accept the Oracle Binary Code License Agreement for Java SE to download this
software.
Thank you for accepting the Oracle Binary Code License Agreement for Java SE; you may now
download this software.
Product/ File Description File Size | Download
Linux x86 6546 MB % jdk-6ud5-linux-i586-rpm.bin
Linux x85 6847 MB  # jdK.6udS-linux-iSB6.bin
Linux x54 550MB ¥ jdk-6u45-linux-x64-rpm.bin
Linux x64 68.75MB # jdk-6ud5.linux-x64.bin
Solaris x86 6838MEB ¥ jdk.6ud5.solaris.i586.sh
Solaris x86 (SVR4 package) 120 MB * jdk-GudS.solaris-i586.tar.7
Solaris x64 85MB # jdk-6u45.solaris-x64.sh
Solaris x64 (SVR4 package) 1223MB  # jdk-6udS5-solaris-x64.tar.Z
Solaris SPARC 7341MB  # jdk.6ud5.solaris-sparc.sh
Solaris SPARC (SVR4 package) 12474 MB ¥ jdk-6u45-solaris-sparc.tar.Z
Solaris SPARC 64-bit 1219MB ¥ jdk-6ud5.solaris-sparcvd.sh
Solaris SPARC 64-bil (SVR4 package) 15.49 MB # jdk-Gu45-solaris-sparcvd.tarZ
Windows x86 6935MB ¥ jdk.6ud5.windows-i586.exe
Windows x64 59.96 M8 ¥ jdk.6u45-windows-x6d.exe
Linux Intel Itanium 5339ME ¥ jdk-6ud5-linux-iab4.rpm.bin
Linux Intel ltanium 56 MB # jdk-Gud5-linux-ia64.bin
Windows Intel ltanium 51.72MB ¥ jdk-6ud5.windows-iabd.exe
| top v
| download.oracle.com/otn/java/jdk/6ud5-b06/jdk-6ud5-windows-x64.exe >

Figure 1-2. Java SE u45 download links after Accept License Agreement Radio Button on the left enables them

3. lam using what is described in these links as “Windows x64,” which
is the 64-bit version of Windows, for my Windows 7 and Windows 8.1
workstations. Once you click on an Accept License Agreement radio button
on the top-left of this download links table, the links will become bolded and
you will be able to click on the link for the OS version that you need to use.
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If you’re on Windows and your OS is 64-bit, you would use the Windows x64 link; otherwise, you
would use the Windows x86 link. To find out what level of bit-depth your Windows OS is running at,
open the Start menu, right-click on the Computer option, and select the Properties menu option.
This will tell you all about your computer’s hardware, including if it is using a 32-bit or 64-bit CPU and
OS. Optimally, your workstation should match the bit-depth of the CPU with the bit-depth of the OS.

4. Once the installation executable has downloaded, open it, and install the
latest Java SE 6u45 JDK on your system by double-clicking on the EXE file.

Remember that the reason that we did not download the JRE is because it is part of this JDK
installation.

Once Java 6u45 (or later) JDK is installed on your workstation, you can then download and install
the Android ADT Bundle from the developer.android.com web site. You can also use that same
Add or Remove Programs utility in your Control Panel that you just used to remove older Java
versions to confirm the success of the new Java installation, and to remove any older versions of any
Android development environments that might be currently installed on this Android development
workstation that we’re going to be assembling from scratch during the remainder of this chapter.
Let’s get back to work!

Android ADT Bundle: Find and Download Android’s IDE

Now we need to visit the developer.android.com web site, and download and install the Android
development environment ADT Bundle ZIP file from the /sdk/ folder of the site, at the following URL:

https://developer.android.com/sdk/index.html

1. Click on the Get the SDK button found on the bottom left of the Android
developer web site’s home page.

2. This will take you to the SDK section of the web site, which says “Get the
Android SDK” at the top as shown in Figure 1-3, along with my Google
search term: Android SDK (see top left browser tab), which is another way to
find the Android developer SDK page!


https://developer.android.com/sdk/index.html
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C 8 https;//developer.android.com/sdk/index.html

ii5 Developers ~  Design Develop Distribute
Training API Guides Reference Tools Google Services
Developer Tools Get the Android SDK

The Android SDK provides you the AP libraries and
developer tools necessary to build, test, and debug
apps for Android.

If you're a new Android developer, we recommend you
download the ADT Bundle to quickly start developing
apps. Itincludes the essential Android SDK
components and a version of the Eclipse IDE with
built-in ADT (Android Developer Tools) to streamline
your Android app development.

With a single download, the ADT Bundle includes
everything you need to begin developing apps:
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* Android SDK Tools

+ Android Platform-tools

+ Thelatest Android platform

+ Thelatest Android system image for the emulator
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ADT Bundle for Windows
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Figure 1-3. The https://developer.android.com/sdk web site page and the Download the SDK - ADT Bundle button

5. Once you are on the Get the Android SDK page, click on the big blue
Download the SDK button on the middle-right to download an ADT Bundle
for Windows, as shown in Figure 1-3. This will take you to the actual
download page.

The actual SDK ADT Bundle download page, shown in Figure 1-4, contains a section at the top for
the end user licensing agreement (EULA) specific to the Android Software Development Kit, as
well as selections for either the 32-bit or the 64-bit IDE Android software bundle download.


https://developer.android.com/sdk
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Figure 1-4. Android Developer site Download the SDK page where you click on the Download the SDK ADT Bundle button

6. Review the “Terms and Conditions” section of this web page carefully,
along with your legal department, if necessary, and then click the check box
next to the statement at the bottom that reads: | have read and agree with
the above terms and conditions, as you can see in Figure 1-4. Once you
have done this, the rest of your download options will become active (not
ghosted) and you will be ready to specify which version of the Android ADT
Bundle for Windows that you need.

| recommend using the 64-bit IDE on 64-bit Windows OSs and the 32-bit IDE on 32-bit Windows
OSs. Hopefully, you will have a 64-bit OS that can access 4GB memory or even more (8GB or
16GB of memory). If you forgot how to find out at which bit-depth your OS is running, right-click on
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My Computer” on the OS Start menu, and select the Properties menu option. This will reveal a
multi-tab dialog containing all of your OS specifications.

7. Once this check box has been activated (checked), you should now be able
to select either the 32-bit or the 64-bit version of this ADT Bundle, which is
essentially an Eclipse ADT 4.4 ZIP format software installation package that
contains an Eclipse IDE with the Android ADT plug-ins pre-configured.

If you downloaded the Java 6u45 JDK for Windows x64 or Linux x64, you would select the 64-bit
version; conversely, if you selected Java 6u45 for an x86 OS, you would select the 32-bit version of
this SDK ADT bundle of software.

8. Once this selection has been made, the actual Download the SDK ADT
Bundle blue button will be activated and you may click on it to begin a
download.

Once this download is complete, we’ll unZIP the files in a development directory that will set up the
Android OS and development environment (IDE) for use on your Android development workstation,
which you will be creating during this chapter and then configuring for use during the next chapter.

PAST INSTALLATION

Before this Android ADT “Bundle” became available in Version 4, setting up this Android IDE was a complicated and
involved process, taking some 50 or more steps, including installing Java SDK, then Android SDKs, then Android Plug-Ins,
then configuring the Plug-Ins to “see” the Android SDK.

If you are familiar with the first or second edition of this Android Apps for Absolute Beginners title, you are already
familiar with what used to be required to get a working Android development environment installed on your development
workstation.

This new bundling approach accomplishes all of the Android SDK and plug-in configurations by including the Eclipse IDE,
along with all of the Android SDK and plug-in components, in one single pre-configured “bundle.”

This allows all the configuration work to be done in advance by the people at Google who work on the Android team,
instead of by developers at home.

Install the Android ADT Bundle: Extract Android ADT IDE

1. The first thing that you will need to do once your download is complete is to
find the file that you just downloaded. It should be in your OS Downloads
folder, or in my case, | specified my Software folder for the download, since
I use a USB key to hold my open source software files.

If you don’t know where your browser put your file when you downloaded it, you can also right-click
on your downloaded file, located in the browser’s download progress window, and select the

View in Folder option. A download progress tab is generally located at the bottom “status bar” area
for your browser, or accessible via a download menu option, or an icon in the upper right of the
browser (usually three black bars/stripes indicating a menu).
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Once you locate either the adt-bundle-windows-x86.zip, which you would use for 32-bit Windows
XP, 32-bit Vista, 32-bit Windows 7, or 32-bit Windows 8, or the adt-bundle-windows-x86_64.zip,
which you would use for your 64-bit Windows Vista, 64-bit Windows 7, or 64-bit Windows 8, you will

then extract the contents of this ZIP file format into a folder on your hard drive.

9.

The ZIP file should be located in your Downloads folder, unless you have
specified a different folder during the download process. Once you find

the ZIP file, right-click on it, and select the Extract All... option from the
context-sensitive menu, as is shown in Figure 1-5.

Compressed Folder Tools
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Open with...

Send to
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Copy

Create shortcut
Delete

Rename

Properties

Compressed (zipp... 491,930 KB

Figure 1-5. Right-click on adt-bundle-windows-x86_64-20131030.zip file and select the Extract All... menu option

10.

In the Select a Destination and Extract Files dialog shown in Figure 1-6,

place your cursor before the adt-bundle-windows part of the file name and then
backspace over the Downloads folder, or in my case a Software folder. We're
doing this because we don’t want to locate a development environment in
our software downloads folder, but rather under the root of our primary hard
disk drive that is usually designated as C:\ and thus, the resulting install path
is C:\adt-bundle-windows-x86 or C:\adt-bundle-windows-x86_64, shown
in Figure 1-7. Once your install folder is specified, click Extract.
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1. Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted te this folder:

oftware\adt-bundle-windows-xE6_E4-20131030 Browse...

(] Show extracted files when complete

Extract Cancel

Figure 1-6. Edit the Target Installation Extraction Folder to place the subfolder into the C:\Android\ HDD folder
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Name: com.android.ide.eclipse.adt_22.3.0.v201310242005-387826
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78% complete = n
Copying 10,693 items from adt-bundle-window... to adt-bundle-window...

78% complete " x

Speed: 53.7 MB/s

_— “
MName: system

Time remaining: About 10 seconds
Items remaining: 1,383 (289 MB)

@ Fewer details

Figure 1-7. Detailed progress bar showing installation in Windows 8.1 using More Details option at 3% and 78%

Once you click the Extract button, you will get a progress dialog, as seen in Figure 1-7, showing the
archived files being extracted into 1GB of data, spanning some 10,693 items, into dozens of folders

and sub-folders.

Once everything is extracted, which may take a little while depending upon the data access
(and write) speed of your hard disk drive and the computer processor speed, we’ll be ready to create

a shortcut for Eclipse.

11. Once this extraction process is complete, open your OS file management
utility; for Windows 8.1, this is called Windows Explorer, and is shown in use
in Figure 1-8, with the Android 4.4 ADT Bundle showing as extracted next
to the older Android 4.2.2 installation | used for my Pro Android Graphic and
Pro Android Ul book titles that | wrote back in 2013.
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Figure 1-8. An adt-bundle-windows-x86_64-20131030 folder (Android 4.4) next to the Android 4.2 folder

It is important to note, as seen in Figure 1-8, that you can install more than one Eclipse ADT. Shown
are Android 4.2.2 and Android 4.4 versions, so if | need to, | can launch a previous version of Eclipse
ADT by using that eclipse.exe application to launch that (subdirectory) OS configuration.

12. Next, you need to locate your latest adt-bundle-windows-x86_64 folder, as
shown in Figure 1-9, on your C:\Android\ hard disk drive path in the left side
of the File Explorer, inside of your hard disk drive navigation pane.
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Figure 1-9. Open the latest adt-bundle folder and the eclipse subfolder and find the eclipse Application and Icon
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13. Find your eclipse folder (it will be located under your adt-bundle-windows
folder) and then click on it. This will show the contents (files and sub-folders)
for this particular folder, in your file management pane, on the right-hand
side of the File Explorer.

14. Find the eclipse.exe program executable file; it will have a purple sphere
icon, as shown in Figure 1-9. Right-click on this eclipse executable file, and
select the Pin to Taskbar option from the context-sensitive menu, which is
always accessible via a right-click.

Once you select the Pin to Taskbar option, a single-click Eclipse software launch icon will be
installed on the OS Taskbar, so that you can quickly and easily launch the Eclipse ADT software
anytime you want to develop Android applications. Figure 1-10 shows your Eclipse quick launch
application icon, along with some of the other applications that you will be installing later on in the
chapter, and some useful OS system utilities that developers should have easy access to via these
quick launch icons.

11:34 AM

@ &7 S B0

Figure 1-10. Taskbar with Quick Launch Icons for Eclipse, Pencil, Audacity, Blender, GIMP, Notepad, Calculator and Character Map

It is important to note that we did not need to install shortcuts for Java 6u45, as the JDK that
we installed exists underneath the other application development tools. Java is a development
environment infrastructure and is not directly accessed or run like Eclipse ADT or the other new
media software development tools that we’ll be installing next.

We’ll be creating launch icon shortcuts for these tools as well on our OS Taskbar so that we can
quickly and easily launch them at a moment’s notice!

Let’s install your digital image compositing and editing software package next. The current version
of the GIMP (Graphic Image Manipulation Program) is 2.8.10 and it provides most of the primary
features of Adobe Photoshop. GIMP 3.0 is expected out any day now, so if you are lucky, you will be
installing the powerful new GIMP 3.0 for your content development workstation!

Digital Image Compositing Software: the GIMP

We will be using GIMP in the book to manipulate digital image assets that will be used for application
icons and user interface elements as well as frame based animation. GIMP is a truly amazing piece
of software.

As you can see in Figure 1-11, you can either enter “GIMP” into the Google search bar as is shown
in the left browser tab, or you can type in the following URL for the web site:
http://www.gimp.oxrg/

When the GIMP home page appears, you will see an orange Download
button and a yellow Downloads link on the top-right of the page. You will
click on either one of these to access the GIMP 2.8.10 /downloads/ page.


http://www.gimp.org/
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B} GIMP - Google Search % | 4 GIMP - The GNU Image I =

C [1 wwwgimp.org &N o=

| Downloads

GIMP is the GNU Image Manipulation Program. It is a freely distributed piece of software for such tasks as
', image composition and . It works on many operating systems, in many
languages. (| J

This is the official GIMP web site. It contains information about downloading, installing, using,

and enhancing it. This site also serves as a distribution point for the latest releases. We try to

provide as much information about the GIMP community and related projects as possible.
find what you need here. Grab a properly chilled beverage and enjoy.

imp.org/dewnloads/

Figure 1-11. Go to the gimp.org web site and click on the orange Download button or on the Downloads link

Note Until recently, GIMP was hosted on SourceForge, but the company made the decision to self-host
on their HTTP servers, due to some activity regarding advertiser opt-ins that the creators of the GIMP
didn’t support.

As you can see in Figure 1-12, you can download GIMP via the GIMP 2.8.10 HTTP server, using this
downloads page.
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B GIMP - Google Search % | 4@ GIMP - Downloads x ."-\

‘ «

C' | [ www.gimp.org/downloads;

The Windows installer packages by Jernej Simondi¢ are now distributed from the GIMP

( )and its . The ads on the previously used site have
tricked too many users into downloading wrong apps or installers that have been tampered
with, so we decided to cut that out.

The installer contains both 32 bit and 64 bit versions of GIMP, and will the appropriate one.

4] GIMP 2.8.10 via or FTP — Installer for Windows XP 5P3 or later W

Figure 1-12. Click an HTTP link to download GIMP 2.8.10 from an HTTP server or FTP to download from an FTP

15.

Once the download is complete, launch the installer EXE, which is actually
visible in Figure 1-5, and should be named gimp-2.8.10-setup.exe, unless a
later version has become available (version 3.0 is expected out in 2014).

3D Modeling, Rendering, and Animation: Blender 3D

3D modeling, rendering, and animation software is a valuable tool for a number of things that are
included in Android, from application icons to digital imagery to frame-based animation to OpenGL
real-time 3D rendering.

Next, let’s go get one of the most popular open source software packages in the world, the Blender
3D modeling, 3D rendering, and 3D animation software package, which can be found on the Blender
web site, at the following URL:

http://www.blendex.oxg/

As you can see in Figure 1-13, there is also a blue Download Blender 2.69
button on the Blender.org home page, which will also take you to a Blender
download page, where you can select a 32-bit or 64-bit version of Blender

for Windows. Blender is also available for Linux, Mac, Unix, and Solaris.


http://www.blender.org/
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[ Elender 30 - GeogleSear: % | £ blender.ceg - Home of th, %

C [ wwwhlenderorg ! = |

’@bh’-‘mef Features Download  Support  Getlmoled  About  Store

Figure 1-13. The Blender.org home page, where you can click on the blue Download Blender 2.69 button

This site will auto-detect the OS version that you are currently running, and since | am running
Windows 8, you will see in Figure 1-14 that Blender for Windows is shown in the dark blue primary
software download area.

- olEl

] Blender 30 - Google Sear: ¥ [ 25 Download - blender.on *®
9! 9

€ & @[3 wwwhlenderorg/download

External Renderers  Previous Versions  Requirements

BLENDER
CONFERENCE

i Free & Open Source Software,

MacOSX GNU/Linux Source Code  Daily Builds

28 Blender 2.69 for Windows

Compatible with Windows 8 | 7 | Vista | X

() installer

& ?:nf.-z‘.l:II;J-mun.m . 3 " =

Figure 1-14. The Blender.org/download/ page and auto-detect of the Windows 0S, and 64-bit and 32-bit options
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Since | have new media content production workstations running Windows XP (32-bit), Windows
Vista (32-bit), Windows 7 (64-bit), and recently Windows 8.1 (64-bit), | have downloaded both of
these versions of Blender, as you can see if you look back at the screen shot in Figure 1-5.

16. Click on the version (the OS bit-level) that matches your OS configuration
(32-bit or 64-bit) and then download the appropriate version of Blender 3D
for your type of OS and your OS and hardware bit level.

17. Once your download is completed, launch the installer EXE, which should
be named blender-2.69-windows32.exe or blender-2.69-windows64.exe,
unless the later revision has become available (version 2.7 is expected out
in 2014).

Open source allows designers to put together fully loaded media production workstations for all
of their employees, as long as they can afford the cost of the hexa-core or octa-core workstation
hardware itself, which can range from $650 to $850 each, depending on features and quantity
purchased.

What this means is that putting together an Android development company is now affordable,

at least from the Android content production workstation perspective, thanks to now mature and
professional open source software packages such as the ones we’re downloading and installing in
this chapter.

18. Once your installation is complete, right-click on the icon, or executable file
and select the Pin to Taskbar option to create the quick launch icon shortcut
for the Blender 3D software.

Ul Design and Wireframing Software: Pencil Project

Next, you will download and install a user interface (Ul) wireframing and prototyping tool called

23

Pencil, which is currently at revision 2.0.5. You can use this software to prototype Ul designs for your

Android apps.
Do a Google search for Pencil, or go directly to the following URL, as is shown in Figure 1-15:

http://pencil.evolus.vn


http://pencil.evolus.vn/
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B Pencil - Google Search % | {@ Home - Pencil Project x \

C' [3 pencilevolusvn &l =

@ PENCIL PROJECT Foatros

' Pencil is built for the purpose of providing a free and

open-source GUI profotyping tool that people can easily
install and use to create mockups in popular deSKIOD
platforms.

The latest stable version of Pencil is EXIE) with

Download for Windows For other platforms?

| 1 e s
| evoluspencil.gocglecode.com/files/Pencil-2.0.5.win32installer.zxe v

Figure 1-15. The pencil.evolus.vn home page, where you can click on the orange Download for Windows button

When the Pencil home page appears, click on the orange download button
and download the 22MB executable file, which should be named something
like Pencil-2.0.5.win32.installer.exe (also shown in Figure 1-5).

19. Once the download is complete, launch the installer EXE, and when it is
finished, right-click on the icon or executable file and select the Pin to
Taskbar option to create the quick launch icon shortcut for the software.

Next, we will install your digital audio and engineering software package.

Digital Audio Editing and Engineering: Audacity

The Audacity project is hosted on sourceforge.net, an open source software development web
site, which you might find extremely interesting to search for software that interests you (if you didn’t
know about the site already, that is)!

Note We will be using Audacity later on in the book, to add sound effects to your Android Ul element
objects, such as your Buttons and ImageButton objects.

To reach the Audacity project, go to the audacity.sourceforge.net URL and
you will see a Download Audacity 2.0.5 link, shown in Figure 1-16.
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BAUdaclt}f-GoogleSEalch x J QAudacity: Free Audio Edit: x

C' [ audacity.sourceforge.net

D Audacity

Y

Search

Search Audacity sites and other selected sites.

J Home I [ About | | Download | | Help | | contact Us | | Get Involved | | Donate |

Audacity® is free, open source, cross-platform software for recording and editing sounds.

Audacity is available for Windows®, Mac®, GNU/Linux® and other operating systems
Check our feature list, wiki, and forum for more information.

Download Audacity 2.0.5

for Windows
2000/XP/Vista/Windows 7/Windows 8

Other Audacity Downloads for Windows

All Audacity Downloads

October 21, 2013: Audacity 2.0.5 Released

Audacity 2.0.5 replaces all previous versions. It fixes crashes or hangs that were reported in Audacity 2.0.4 on some

machines, and contains many other bug fixes and stability improvements

-

Figure 1-16. The audacity.sourceforge.net home page and Download Audacity 2.0.5 link for Windows 0S version

Notice that the 32-bit Audacity supports decades-ancient OSs such as Windows 2000, well over
a decade old, and Windows XP, now almost a decade old. | am hoping that you are using either
a Windows 7 or a Windows 8 OS for your Android development workstations, as these two OSs,
especially Windows 8, are almost as memory-efficient now as Linux is.

20. Once your Audacity installer file has been downloaded, you can launch it,
and proceed to install this feature-filled digital audio editing software. The
first thing that it will ask you is what language you want to run the software

in. | selected the default, English.

21. Then | clicked the Next button and read the information given and then |
clicked the Next button again, accepted a default installation location, and
created the desktop icon, using an option in the next dialog.

22. Finally, | clicked on the Install button, and got the Installing progress bar
dialog, as well as more information regarding the open source Audacity
project, and a final dialog where | could click on the Finish button to exit the

installer software.
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Now that Audacity 2.0.5 is installed, you can launch the audio production software and make sure
that it’s working on your system.

If you like, you can follow the same work process that we did with Eclipse and place a quick launch
shortcut icon on your Taskbar by right-clicking on the Audacity 2.0 icon and selecting Pin to Taskbar.
You can reposition launch icons by dragging them into any position you prefer on the Taskbar.

23. Launch Audacity via your quick launch icon, or by double-clicking the icon
on your desktop or in your Windows Explorer utility. You should see a new
blank project screen, as shown in Figure 1-17, open up on your desktop.

a Audacity - o IEN
File Edit View Transport Tracks Generate Effect Analyze Help
T < L] L|
—r |
" H ) I =10 |
Pl ok {) w| 36 -24 -2 0 )‘9., 36 -24 12 0
) O ﬁ OIE| - | B | @ W H| o | o> & 2|8 ,) /:i)‘
L@ * 5 mve v | 4) Speakers (High Definition Audo v | ¥ v v
-1.0 d“] 1.0 2.0 3.0 4.0 5.0 6.0 7.0
N
v
< >
Project Rate (Hz): Selection Start: @ End () Length Audio Position:

44100 v SnapTo[ ][00 h 00 m00.000 s~ [00h00m00.,000s~ [00h00m00.000 s~

Figure 1-17. Launching the Audacity 2.0.5 for Windows software to make sure that it will run on your system

Next, let’s go and download the leading open source digital video software package, EditShare
Lightworks 11.5, which is available for Windows, Linux, and Macintosh, in both 32-bit and 64-bit
versions.

Professional Digital Video Editing: EditShare Lightworks

EditShare Lightworks used to be an expensive digital video editing and special effects software, and
to this day, it competes “head-to-head” with leading digital video editing packages (FinalCut Pro

X and After Effects). Digital video editing software is useful for Android development, as the video
formats it supports are also integrated into the Android OS.

You can find out more about this leading digital video editing FX software package on the EditShare
web site at: www.editshare.com, or the Lightworks web site at: www. 1wks.com, where you can also
sign up to get a copy of the software and then download it. The home page is shown in Figure 1-18.


http://www.editshare.com/
http://www.lwks.com/
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LIGHTWIORKS Signin  Register

THE EDITOR LEARNING FORUM | SUPPORT [vell Kelisiay SHOP " éw now
| | |uFoRUM | | -

29/01/2014: Lightworks 11.5 release now available for Windows and Linux - More info

LET’S GET SERIOUS

Lightworks 11.5 delivers more power,
more features and greater control...
Everything you need to make your

movie look great!

LEARN MORE

The professional editor for everyone

Some of the finest films of the past 20 years have been edited with Lightworks. We're proud of its heritage and
we want to share it with you. | | more about Lightworks and discover why Oscar-winning editors around the
world use it every day.

! GET LIGHTWORKS FOR GET LIGHTWORKS FOR £, GET LIGHTWORKS FOR

o y Microsoft Windows ( » Linux (rpm / deb) ) Apple OS X (coming soon)
Figure 1-18. Go to the Iwks.com web site, sign-in or register, and then click on the Downloads link at the top

When EditShare made Lightworks open source, it became the second free open source software
(the first was Blender 3D) to be able to compete “feature-for-feature” with commercial software
packages in its new media production genre (digital video editing, compositing, special effects, and
compression).

Once you register on the Lightworks web site, you will be able to create a
video editor profile for your company and log in to be able to download a
copy of Lightworks 11.5 for your content development workstation that you
are putting together in this chapter. Since Lightworks is such a valuable piece
of software, you need to register to get it, which is fine with me, given that
this software used to have a four-figure price tag.

24. Once you are signed-up as a proud Lightworks 11.5 user, you will click on
the Downloads button, located at the top-right of the site menu, and you will
see all of the different versions and documentation for the software.
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As you can see in Figure 1-19, you will have to again ascertain if you have a 64-bit OS or an older
32-bit OS, so that you can download the version of this video editing software that matches with
your bit level capabilities of the workstation that you just purchased to do Android development.
I’m hoping (for your sake) that it is a quad-core, hexa-core or octa-core with 64-bit modern-day
specifications.

LIGHTWORKS

J THE EDITOR | LEARNING | FORUM ] SUPPORT |

29/01/2014: Lightworks 11.5 release now available for Windows and Linux - More info

Downloads

&Y windows Documentation

{J';“ Lightworks For Windows

Latest release: 11.5

Release date: 29 Jan 2014
Downloads: 55476 Download 64-bit

the chanaeloq

For the full power of Lightworks - Upg

Recommended Specification:

0S:  Windows 7 Professional (32 b or 64 bit)
Chipset Intel i7 chipset or faster, fast AMD chipset
Wemory.  3GB RAM or higher
Screen: Two high-resolution displays (1920 x1080) or above
Graphics card: PCl Express graphics card (NVIDIA or ATI) with 1GB or higher and support for DirectX 8
Storage: Separate media and system drives (these can be internal or external as long as the the interface is suitably fast: eSATA Firewire 500).

Sound Windows compatible sound card and an audic monitoring system

QOptional

Optiongl  Lightv ayboard
System drive: 200MB Disk space for Lightworks instalaticn

Internet Internet connection for activating Lightworks (first time only)

Figure 1-19. The EditShare Lightworks 11.5 download page

25. Click on the Download 64-bit button to initiate the download of the 64-bit
OS version installation software, or the Download 32-bit button to get the
32-bit version of the video software installation executable (EXE) file.
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26. Once you’ve downloaded an installer, install it using the default settings and
create a quick launch icon for it. Run Lightworks to assure it’s set up properly
on your system, as you have done with your other new software.

Congratulations, you’ve assembled a professional-grade Android Application and New Media
Content Development Workstation! You can now use your newest software development weapon
to create Android Ul designs, and develop user experiences as yet unseen. | hope you are excited,
because | am!

Even though you’ve installed all of this amazing software and set up quick launch shortcuts for your
future ease (speed) of development usage, you’ll still need to configure Eclipse ADT for use and set
up AVD Android Virtual Device emulators, which we’ll be covering in the next chapter of the book.

Just to be thorough, let’s install a business productivity software suite! We will do this just in case
you need to assemble quotes, spreadsheets, and contracts for all of your future Android OS
software development projects.

A Complete Business Software Suite: Apache OpenOffice

To make 100% sure that your Android development workstation has everything installed that you will
need for your Android development business, let’s finish off this run of professional software installation
with yet another package originally from Oracle, the makers of Java, called Open Office 4.1.

Do a Google search for OpenOffice or go to the waw.openoffice.org web site, as shown in Figure 1-20.

Y |

B} Open Office - Google Sear % | &) Apache OpenOffice - The x

c www.openoffice.org =
~

search |

e OpeﬂOfﬁce The Free and Open Productivity Suite

75 million downloads of Apache OpenOffice!

home Product | Download | Support | Blog @ Extend | Develop | Focus Areas | Mative Language

£ | want to learn more about OpenOffice Recent Blog Posts

“L‘g What is Apache OpenOffice? And why should  use it? 13 November.

. | want to download OpenOffice

Download Apache OpenOffice for free, or find out about other ways of getting it

Figure 1-20. The OpenOffice 4.0 downloads button on the OpenOffice home page
Click on the | want to download OpenOffice link, to go to the OpenOffice 4.1
download page.

27. Once you are on the /download/ page, shown in Figure 1-21, click the green
area to download the most recent version of the office suite for your OS.


http://www.openoffice.org/

30 CHAPTER 1: Setting Up Your Android App Development System

) Open Office - Google Sea: x | &3 Apache OpenDffice Dowr x

— c www.openoffice.org/download dl—

search

L")
0
D

eOpenOfﬁce' The Free and Qpen Productviy Suie

75 million downloads of Apache OpenOffice!

home » download Product Download Support Blog Extend Develop Focus Areas Native Language

Additional Information
Download Apache OpenOffice 4.0.1 ~|

Click here for the most recent version for 4
Windows (EXE) and English (US) (~137 MByte)

Signatures and hashes: KEYS , ASC , MD5 , SHA256 ., How to verify? | Release Notes |
Get all platforms, lanquages, |

rg.mimror/files/4.0.1/binanes/en-US/Apache_OpenOffice_4.0.1_Win_x86_install_en-US.exe/download Cyrrent Release Schedule o

ceforge.net/projects/openofficeo

Figure 1-21. The www.openoffice.orq/download/ page, where you can download OpenOffice 4.0.1 for Windows

In my case, this was Windows 8.1, which the site auto-detected for me. This download is almost
140MB, and includes more than half a dozen productivity software packages, including a word
processor, spreadsheet software, presentation software, drawing software, an equation editor, and a
database engine.

28. Once you have downloaded the OpenOffice 4.1 EXE installer, install it using
the default settings, and then create the quick launch icon for it on your
Taskbar. You should run OpenOffice 4.1 to assure it’s set up properly on your
system, as you have done before with your other new software acquisitions.

You have now set up a complete Android development and production business workstation, and
can accomplish any task that may be required of you by a client! You can draw up contracts, edit
digital video or digital audio, do 3D modeling, rendering, and animation, prototype Ul designs, create
digital image compositing pipelines, and of course, create Android applications!

Other Open Source Software

There are lots of other open source software packages that are available if you want to download
and install them. Popular open source repositories include SourceForge.Net, GitHub, and Code.
Google.Com if you want to go pan for open source gold.

Some of these other open source packages in the 3D software genre include: SketchUp
(architectural rendering), TerraGen 3.1 (virtual world creation), Microsoft TrueSpace (3D), Wings 3D,
Bishop 3D, POV Ray 3.7 (3D Rendering), and DAZ Studio 4.6 (Character Modeling).


http://www.openoffice.org/download/
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There are also some very affordable 3D software packages, which you should take a look at as well,
including NeverCenter SILO 2.2 (Quad 3D Modeling), Moment of Inspiration 3D 3.0 (NURBs 3D
Modeling), TerraGen Pro and Bryce 7 (3D world generation), Hexagon 2.5 (Polygon 3D Modeling),
and Auto-Des-Sys Bonzai (3D Modeling, all 3D modeling paradigms are supported).

In audio composition, production, and engineering areas, impressive packages include: Rosegarden
(Music Composition, MIDI, Scoring) and Qtractor (Sound Design). The list of amazing open source
software just goes on and on!

Summary

In this first chapter, you learned about Android, and acquired the software you’ll need to be able to
create a comprehensive Android application development workstation, which we will be configuring
in the next chapter.

From Java SE 6, to Eclipse, to new media content production software, to Ul prototyping to business
productivity tools, you downloaded and then installed the most impressive open source software
packages that can be found anywhere on this planet.

We did this to create a foundation for the Android application development work process that we
will be undertaking throughout this book, and rather than install these software packages as we go
along, | made the decision to get all of our readers set up with this amazing software right off the bat!

| did this in case you wanted to explore some of the many features of these powerful, exciting new
media content production software packages before you actually use them during this book. | think
that’s only fair.

The best thing about the process was that we accomplished it by using open source, 100% free
for commercial usage and professional-level application software packages, which is pretty darned
amazing, if you think about it.

We started by downloading and installing Oracle’s Java SE 6u45 JDK or Java Development Kit,
which is the Java 6 Programming Language’s SDK. This Java JDK is required to use Eclipse, as well
as to develop application software for the Android OS for consumer electronic devices.

We then visited the Android Developer web site and downloaded and installed the ADT Bundle,
which built an IDE and Android Developer Tools plug-ins on top of our Java SE 6u45 JDK
programming software development environment.

Next, we downloaded and installed GIMP 2.8.10, your powerful digital image editing package, which
is available for Windows, Linux, and Macintosh OSs.

Next, we downloaded and installed Blender 2.69 a professional 3D modeling, rendering, and
animation tool, available for Windows, Linux, and Mac OSs.

Next, we downloaded and installed Pencil 2.0.5, the popular Ul wireframing and prototyping tool,
which is available for Windows, Linux, and Mac OSs.

Next, we downloaded and installed Audacity 2.0.5, the open source, digital audio content editing
tool, available for the Windows, Linux, and Mac OSs.
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Next, we downloaded and installed Lightworks 11.5, a digital video editing and special effects
package that was recently released as open source and is currently available as of 2014 for the
Windows, Linux, and Macintosh OSs.

Finally, we installed Apache Open Office 4.1, just to make sure that you have a completely
well-rounded open source Android development workstation at your disposal. Remember, your
Android development business will require that you use a business productivity software package as
well, so we cover all of the bases by finishing up with this Oracle business software suite.

In the next chapter, you will learn exactly how to set-up an Android workstation and how to create an
AVD emulator for the Google Nexus Android device. We will also learn more about Android as well
as review what will be covered during the course of this book.



Chapter

Configuring Your Android App
Development System

Now that you have an Android development workstation assembled, with those valuable (but

free), professional-level, open source packages installed on it, it is time to configure the Eclipse
Android 4.4 Development Tools (ADT) integrated development environment (IDE) for what you will

be doing over the course of this book. Eclipse now works “out of the box” thanks to the ADT bundle,
a vast improvement over having to “wire” the Android SDK to Eclipse using plug-ins.

There are still a number of things that | want to teach you about in this chapter, however, regarding
how to keep the Eclipse ADT up-to-date and create and install Android Virtual Device (AVD)
emulators. Additionally, you’ll get a tour of what is installed as a part of the “default” or initial

ADT installation and how to install other Application Programming Interfaces (APIs), and other
non-standard capabilities, such as Google Cloud Services of one type or another, for instance.

Note You will be learning specifically about what an APl is as well as about packages, classes, methods,
and interfaces in Chapter 5, when we cover Java programming concepts and terminology in detail.

You’ve already configured your open source, new media content production software by installing
the latest updates and creating a quick launch icon on your Taskbar, which was relatively easy.
After we go over how to update, configure, and fine-tune Eclipse, I’'m going to give you an overview
of what you will be learning during the remainder of this book, so you have an overview of what
you’ll be learning in Chapters 3 through 17, and how it will all fit together. I'll make sure that the
content gets more advanced with each subsequent chapter of the book; by the end, you will be
well-versed in Android!

33
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Updating Eclipse ADT: Check For Updates!

This is a simple work process, which is actually similar across many advanced software packages,

so you may have seen what we are about to do before. There is a “Check for Updates” work process
for making sure that you have the latest version of your operating system (OS), production, or
development software. In fact, if you go into your Windows 8.1 Control Panel, you will see a Windows
Updates icon at the very bottom that performs this exact same function. You can configure this to be
automatic or you can run it manually, as we are about to do here, with your Eclipse ADT IDE.

Since we’re focusing on Android’s IDE in this chapter, we’ll be doing this inside of Eclipse, so you
can make sure that you are running the very latest version of your ADT IDE, including all of its many
components. You'll always want to run the Check for Updates utility right after you install your
Eclipse ADT software, and at least weekly thereafter.

This is the reason we are covering this here first, as this is a continuation of all of the installation
work that you did in Chapter 1. If you have not done this already, out of sheer curiosity, launch
Eclipse ADT using a single mouse-click on the Eclipse (purple sphere) quick launch icon, which you
created in the previous chapter. Each time that you launch Eclipse ADT, you will be presented with
the Select a workspace option, inside a Workspace Launcher dialog, right after you see your
Android Developer Tools launch progress screen. Both of these are shown in Figure 2-1.

w Workspace Launcher | x |

Select a workspace

ADT stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

~ Browse...

ANDROID

DEVELOPER
TOOLS

[ Use this as the default and do not ask again

oK Cancel

Figure 2-1. The Android Developer Tools launch progress (left) and Workspace Launcher dialog (right) on launch

You will probably accept the default workspace folder location for your Android project, although
you don’t have to, if you have another folder that you would prefer to use for your Android project.

| use the ADT suggested workspace folder, which is located under my operating system supplied
C:\Users folder, and under my system-name sub-folder, which on my AMD octa-core workstation is
named Default.Default-PC, a default (how can you tell?) folder name created by Windows 8, that |,
to this day, remain too lazy to change! | should have named the book Lazy Android Development.

After you select (and thus set) the Workspace location, Eclipse will then open up with an introductory
Welcome! screen, actually a tab, as shown in Figure 2-2. Click the close tab icon (or X) for now, it is
located in the right side of the tab, and let’s proceed to open a blank (empty) instance of the Eclipse
ADT IDE.
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Build Your First App If you're new te Androeid, follow this class to learn the fundamental Android APls for creating a user interface that
responds to input.

Design Your App  Before you begin developing your app, be sure you understand the design patterns that Android users expect
from your app.

Test Your App The Andreid Framewoerk provides tools that help you test every aspect of your app to be sure it behaves as
expected under various conditions.

5TM of 75M i
Figure 2-2. ADT’s Welcome! Initial start-up screen, with shortcuts to tutorials and New Android Application button

The Eclipse IDE will open up the first time that you start it with no project open, and thus will not
show any project data at all, just the blank IDE, as shown in Figure 2-3. Once we start creating
projects, which we will be doing in the next chapter, these projects will “persist” inside of Eclipse,
so that every time you launch the Eclipse ADT, you will see your current Android project exactly as
you left it the last time you exited the Eclipse ADT IDE.

() Java - ADT - 0
File Edit MNavigate Search Project Refactor Run Windew | Help

- BE P~ diH-0- Q- @) Andreid IDE ..| - Quick Access s 3:1 Java
(@ Help Contents
&7 Search

¥ Package Explorer &3 e = | 8% Qutling %

An outline is not available.
Dynamic Help

Key Assist... Ctrl+Shift+L
Tips and Tricks...

Cheat Sheets...

Check for Updates v =
Install New Software...

u]

|2! Problems 32
0 itemns
S About ADT = TR %
SERTof 70M il

Figure 2-3. The Eclipse Java - ADT IDE on initial launch, showing no project data, and showing Help » Check for Updates

Let’s go ahead and perform the Check for Updates work process now. To do this, click the Help
menu, as shown in Figure 2-3, and then select the Check for Updates menu option. Once this
Check for Updates utility has been launched, Eclipse will reach out over the Internet to the server
at Google that hosts the ADT software repository, and will then proceed to check your currently
installed Eclipse ADT component versions against the latest versions that “live” on this Android
Eclipse ADT IDE software repository. We will be getting into what exactly a software repository is
and how it works in the next section when we access it using the Android SDK Manager software
repository tool.
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It is important to note that you will need to have your workstations connected to the Internet via
high-speed Internet access connection for this Check for Updates utility to be able to reach the
software repository. If you want to do a lot of “heavy” updates to the Android IDE, which entail a
lot of software (data) being transferred over the Internet connection, you will need to have a fast
connection speed.

Once you click on this Check for Updates menu command, a progress bar will appear, which will tell
you what packages Eclipse ADT IDE is looking at, or comparing your current IDE against. If you are
on a fast Internet connection and a fast workstation, you may have to be a speed reader in order to
read fast enough as these blaze by! The dialog is shown in Figure 2-4, fetching the content.jar file.

w Contacting Software Sites = = n

0 Checking for updates...
[—

Fetching content.jar (765.07kB of 2.06MB at 1...load.eclipse.org/releases/juno/201303010900/

[] Always run in background

Run in Background Cancel Details >>

Figure 2-4. Contacting Software Sites dialog checking for updates

Hopefully, you will eventually receive the “No updates were found” message, which will appear at
the end of this “installed IDE packages to repository available packages” comparison work process,
as shown in Figure 2-5.

W Information ﬂ

0 No updates were found.

OK

Figure 2-5. Information dialog showing that No updates were found

If for some reason new versions of any of the Android software components are available, you will be
advised, and then asked to accept the licensing agreements so that you can install the new software.

After the updating process is accomplished, you can then proceed to take a gander at exactly what
APl components have been installed as part of the “ADT Bundle” Eclipse IDE that you installed in the
previous chapter as well as in this chapter (if any updates were found, that is).

You’re going to look at your Android API installation using the Android SDK Manager Tool next,
so that you become more familiar with that tool and with your currently installed ADT utilities and
Android SDK components such as APIs and documentation and emulation utilities.



GHAPTER 2: Configuring Your Android App Development System 37

Configuring Eclipse: Android SDK Manager Repository

Now that you’ve ascertained that you have the very latest Eclipse ADT IDE software possible
installed on your Android development workstation, we can take a look at exactly what is installed,
as well as options for other APIs, and things like documentation, which you can download to your
Eclipse ADT environment from the Android Repository. You can do this conveniently from inside the
Eclipse IDE.

A software repository is a specialized server hierarchy (folder structure across one or more
servers) that is maintained by the software provider. In this case, that would be Google, and their
Eclipse ADT IDE, which is customized specifically to (for) their Android OS software development
kit (SDK) environment and everything that is compatible with it, such as plug-ins, documentation,
emulators, hardware drivers, and similar things that would be used to enhance and support the
Android OS.

This software repository is different from the download environments that you normally encounter,
in as much that you cannot access it externally, using an FTP or HTTPR, as you did with GIMP
2.8.10 or Blender 3D, for instance, in the previous chapter. Instead, the software repository will be
accessed “internally” from within the IDE (or the OS environment, via its update utility) that you are
working in.

Those of you who use a Linux OS are already familiar with this repository concept, as this exact
same repository access functionality is an integral part of all the popular Linux OS distributions,

or “distros.” This repository methodology is how a Linux OS is upgraded, and how it adds in new
OS features and bug-fixes, which is one of the key reasons Linux is perceived as a more complex
operating system to work with. Windows also uses a software repository, but does not refer to it as
such; instead it “sugar coats” the repository model by hiding it behind the Windows Update “front-
end” Control Panel utility.

You are going to observe, and utilize, the software repository access work process here, using your
Eclipse ADT IDE through its Android SDK Manager utility, which functions in the same fashion as an
OS repository, but with a detailed front-end dialog that we are going to take a look at next.

Go to the Window menu, seen at the top of Eclipse, and select the Android SDK Manager menu
option, as shown in Figure 2-6. This will open an Android SDK Management Tool that allows you to
view the current Android development environment, as you should do after any new install, as well as
to add features and functions to it, and to update any component that has a new version available.
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Figure 2-6. Use the Window » Android SDK Manager menu sequence to open up the Android SDK Manager utility dialog

As you can see in Figure 2-7, the Eclipse ADT Bundle 4.4 installed exactly what you need to develop

Android 4.4.4 applications, and nothing else. This is exactly what you’ll want the ADT Bundle installer
to do, and the ADT Bundle did it perfectly. As you can see in Figure 2-7, you have Android 4.4 Level
19 SDK Tools (left dialog, at top), and the Android Support Library (right dialog, in the middle), which
provides backward-compatibility support for Android versions that came before OS version 4.4.4.
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Figure 2-7. Android SDK Manager dialog (top on left, bottom on right) with default Google USB Driver selection



CHAPTER 2: Configuring Your Android App Development System 39

You may also notice on the right in Figure 2-7 that there is a default check mark that Eclipse has
selected for you next to the Google USB Driver. This driver needs to be updated to a newer version,
and to alert you to this, the Android SDK Manager has placed a check mark next to this software
utility, in this case, a USB hardware driver. | am going to leave this check mark selected so that you
can see the work process for “pulling” an Android component upgrade over to your Eclipse ADT
configuration from the Google Android software repository.

You will also use this Android SDK Manager dialog to install any of the extras shown in Figure 2-7,
including the latest Android SDK documentation, specialized emulators, earlier Android OS (called
API or Level) versions, as well as external Google Cloud function libraries.

Let’s do this now, and place your checkmarks in any of the other unchecked boxes next to functions
you might need for your Android application. For instance, if you were going to create a messaging
application, you would select the Google Cloud Messaging for Android Library option, in addition to
the Google USB Driver, which is shown selected in Figure 2-7 on the right side of the screen.

Once you’ve selected the features you need, beyond the selections that the Android SDK will make
for you automatically that it knows that you will need, then click on the Install (nhumber selected)
packages button.

It is important to note that you should not install any features or Android API libraries that you do
not currently need for your currently open Android development project, as these downloads can
be quite massive, and these APIs also get updated quite frequently. For this reason, you should
download only those features, emulators, system images, and API libraries that you intend to use in
the application development environment for the current project.

Later, you can add in older Android version API libraries, but only if and when you will need to utilize
them to develop for targeted devices that only run these older versions of Android and need custom
development. An example of this is the original Kindle Fire, which runs Android 2.3.7 API Level 10.
The Android Support Library may not provide as “tight” a backward-compatibility result as simply
using the API Level 10 API to create applications specifically for the Amazon Kindle Fire product line.

Once you click on the Install 1 package button, you’ll be given the Choose Packages to Install
dialog, which is shown in Figure 2-8, and which allows you to accept the license terms and conditions
so that the Android software repository can (is willing to) install the latest USB driver revision (in this
case, it is version 8, but will probably be a later version by the time this book is published).
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Choose Packages to Install - o IEl
Packages Package Description & License
4 + Android SDK License Package Description ~
+" Google USB Driver, revision 8 Google USB Driver, revision 8
' ' By Google Inc.

USB Driver for Windows, revision 8
Install path: extras\google\usb_driver

Archive Description

Archive for Windows

Size: 8.3 MiB

SHAT1: 2b2f9109829842865a70f0bd8412843fb54462fc

License
Terms and Conditions

This is the Android Software Development Kit License Agreement.

1. Introduction v
(® Accept () Reject Copy to clipboard | Print () Accept License
[ Install Cancel

Figure 2-8. The Choose Packages to Install dialog and the Accept License Agreement

Once you click the Accept radio button or the Accept License radio button, click the Install button,
and you’ll get a progress bar at the bottom of the SDK Manager dialog, as shown in Figure 2-9.

[CJ g3 Intel x86 Emulator Accelerator (HAXM) 3 Not installed v
< >
Show: [¥]Updates/New [v]Installed [ | Obsolete Select New or Updates
Sort by: (®) API level () Repository Deselect All D
— O

Downloading Google USB Driver, revision 8 (15%, 142 KiB/s, 50 seconds left)

Figure 2-9. A download progress dialog bar located at the bottom of the dialog

Along with this progress bar, there is also information regarding what is currently being downloaded,
as well as the percentage completed, what download speed is currently being achieved, and finally,
the estimate for the remaining time that is left to completion, as shown in Figure 2-9.

Once your downloads are completed, the bottom of the Android SDK Manager dialog will then show
that the Google USB Driver is now installed, along with any of the other Google API libraries that you
have selected, the green progress bar will disappear, and you’ll receive a Done loading packages
message, all of which are shown in Figure 2-10.
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Done loading packages.

Figure 2-10. The Google USB Driver as installed after progress bar disappears

The next thing that we need to address in optimizing your Eclipse ADT IDE for Android development
during the course of this book is creating and installing an AVD. AVDs will be used during the
Android software development process to accelerate the development process. The reason an AVD
accelerates development is because you don’t have to go through the time-consuming process of
transferring your application over the USB cable to the Android device every time you want to test!

You can create an AVD to serve as a software emulator for each of the Android hardware products
or “devices” that you will be developing for, and need to test your application on. You can also
create AVDs for device hardware that you don’t own, which makes development and testing more
affordable for everyone. Let’s learn how to create an AVD and set it up for use in the next section of
this chapter.

Android Virtual Devices: Creating the AVD

Eclipse ADT provides developers with a unique hardware emulation capability that speeds up your
application development cycle of design, code, and test. This is done by allowing you to test your
application using an AVD, which is a software emulator for any given Android hardware device (AHD).

If you are developing for the real-world market, you will eventually need to test your applications
on all the real-world AHDs that you wish your application to run on. The AHD application testing
process, as you might imagine, can quickly become an expensive and time-consuming proposition.

The reason that you don’t want to test across these AHDs every time you want to test an upgrade
to your app design or code is because that would involve connecting each of these AHDs that you
want your application to support to your development workstation via USB, and then uploading a
compiled APK (Android Package) to the AHD, and then test it using that hardware. You will learn all
about the APK format in Chapter 5 when we cover the Java programming language in detail.

An AVD installed in Eclipse shortens this lengthy external device testing process to zero seconds! An
AVD does this by allowing you to right-click on your Android app project folder in Eclipse, at any time
during your development work process, and selecting the Eclipse Run As » Android Application

menu command sequence, which is accessed with a right-click on your Android project’s root folder.

This work process will automatically compile and transfer your Android application into your
currently active Android Virtual Device emulator, which we will be setting up in the next section of
this chapter.
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This will automatically launch both the AVD emulator as well as your Android application running

on that AVD emulator on your workstation’s desktop, so that you can test your app’s XML markup
logic, Ul design, new media assets, and your Java programming logic. You will be learning all about
XML in Chapter 4, Java in Chapter 5, Ul in Chapters 6, 7 and 8, and new media assets in Chapters 9
through 12. The rest of the book (Chapters 13 through 17) will cover more advanced topics, relating
to databases, background processing, and developing for Android 5, smartwatches and appliances.

In the next section, we will take a detailed look at how to create an AVD emulator definition using the
Android Virtual Device Manager. This is located on the Window menu, just below the SDK Manager.

Creating AVDs: Android Virtual Device Manager

In addition to the Android SDK Manager, the other important menu command, which is also located
under the Window menu in Eclipse, will access the Android Virtual Device Manager and its collection
of dialogs. Access this using the Window » Android Virtual Device Manager menu sequence.

This menu sequence, shown in Figure 2-11, will open up a dialog from which you can access several
other related dialogs, all of which will be important for you to master as you learn the proper work
flow for creating an AVD emulator completely from scratch.
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Show View

Customize Perspective...
Save Perspective As...
Reset Perspective...
Close Perspective
Close All Perspectives
[* Proble Navigaticn L T = [/
0 items F4  Android SDK Manager
Descriptiv H: Android Virtual Device Manager esource Path Location Type
| Run Andreid Lint L

Preferences 66M of 176M (i}

Figure 2-11. Use the Window > Android Virtual Device Manager to launch a collection of dialogs for AVD creation

Once you select this menu sequence, the Android Virtual Device Manager, which can be seen in
Figure 2-12, will open. As you can see, there is a New button to create the new AVD definition, and
once this is done, buttons will be enabled to Edit (Editing), Delete (Removing), Repair (Fixing), as
well as Detail (specifications) and Start (launching) the selected AVD. Using the Refresh button will
update the list if any new AVD definitions have been added since the list was last refreshed.
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4 Android Virtual Device Manager - Db n
Android Virtual Devices | Device Definitions

List of existing Android Virtual Devices located at C:\Users\Default.Default-PC\.android\avd

AVD Name Target Name Platform API Level CPU/ABI | New...

No AVD available

Refresh

+" Avalid Android Virtual Device. A repairable Android Virtual Device.
¢ An Android Virtual Device that failed to load. Click 'Details’ to see the error.

Figure 2-12. The Android Virtual Device Manager dialog before an AVD has been defined

In addition to the seven buttons on the right, there is a second tab at the top of this dialog that will
access some preloaded device definitions that come with Eclipse ADT. We will take a look at these
next, when we actually create an AVD for our use during this book.

There are two ways to create an AVD in Eclipse ADT, one is to select a “pre-configured” AVD device
definition, and the other is to create your AVD “from scratch.” We will do both in this chapter, so that
you have a complete and thorough overview of exactly what functionality this AVD Manager offers.

Pre-configured (pre-defined) Android device definitions are accessed using the Device Definitions
tab, shown as the right-hand tab at the top of Figure 2-12, which when clicked will display the
currently defined device definitions. If you define your own AHD, which we will be doing soon, it
will also be listed here along with the pre-defined AHD definitions that are provided with Eclipse by
default. After | show you how to create a Nexus One AVD emulator using one of these existing AHD
definitions, I'll then show you how to define your own custom AHD emulation specification from
scratch, by using the New Device button, shown at the top-right of Figure 2-13.
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Android Virtual Device Manager

Android Virtual Devices  Device Definitions

List of known device definitions. This can later be used to create Andreid Virtual Devices.
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Nexus 5 by Google
Screen: 4.0", 480 x 800, Normal hdpi
RAM: 343 MiB

Nexus One by Google
Screen: 3.7", 480 x 800, Normal hdpi
RAM: 512 MiB

Nexus 7 by Google
Screen: 7.3", 800 x 1280, Large tvdpi
RAM: 1024 MiB

Nexus 4 by Google
Screen: 4.7°, 768 = 1280, Normal xhdpi
RAM: 1907 MiB

Nexus 10 by Geoogle
Screen: 10.1", 2560 x 1600, X-Large xhdpi
RAM: 1507 MiB

Galaxy Nexus by Google
Screen: 4.7°, 720 = 1280, Normal xhdpi
RAM: 1024 MiB

H] A user-created device definition. [I A generic device definition.

Figure 2-13. The default definitions in the Device Definitions tab, as well as the New Device... button

Creating an AVD from a Pre-configured Device Definition

# | | New Device...

~ Refresh

Six of the pre-configured AHDs are shown in Figure 2-13. It will come as no surprise that many of the
device definitions are Google’s actual Nexus smartphone or tablet hardware products of one model or
another. If you scroll down underneath those (not shown in the figure), you’ll see more generic tablet
and smartphone hardware device definitions that you can use to emulate general types of devices.

1. Let’s click on the Nexus One shown highlighted in Figure 2-13 and enable the

Create AVD button shown on the right.

2. Click the Create AVD button with this Nexus One AHD selected, and you will

get the Create new Android Virtual Device (AVD) dialog shown in Figure 2-14.
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W Create new Android Virtual Device (AVD) “

AVD Name: AVD_for_Nexus_One_by_Google
Device: Nexus One (3.7°, 480 x 800: hdpi) v
Target: Android 4.4.2 - API Level 19 v
CPU/ABI: ARM (armeabi-v7a)
Keyboard: [#] Hardware keyboard present
Skin: [¥] Display a skin with hardware controls
Front Camera: None
Back Camera: None v
Memory Options: | pap (512 VM Hezp: | 32
Internal Storage: 200 MiB v
SD Card:

(®) Size: MIiB +

() File:

Emulation Options: [#] Snapshot []Use Host GPU

Override the existing AVD with the same name

oK Cancel

Figure 2-14. Create AVD dialog with Nexus One settings

3. The AVD Name and Device fields will be filled out for you by Eclipse, so first
select the latest OS version as your Target using the drop-down selector Ul
element. This was Android 4.4.2 at the time of writing this book, which is
API Level 19, and is shown selected in Figure 2-14. The current Android 4.4
revision is at 4.4.4 at the time this book’s publication.

4. Leave the Keyboard and the Skin options selected, since you have a
keyboard and want an emulator skin on your AVD. A “skin” is a customized
Ul design that mimics the real AHD.

5. In the Memory Options areas, leave the default 512 MB of RAM and 32 MB
VM (Virtual Memory) Heap and use an Internal Storage value of 200 MB.
Since we are not using an SD Card, we can leave that blank. Finally, select
the Snapshot Emulation Option and then click the OK Button.
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Once you click the OK button, the Create AVD dialog will vanish, and you will see your new AVD in
the Android Virtual Device Manager dialog, as shown in Figure 2-15. As you can see, the Android
Virtual Device Manager dialog shows you quite a lot of information about each AVD that you might
create, including the AVD name (in this case, AVD_for_Nexus_One-By_Google), as well as the Target
Android OS version that device is operating under (in this case, the latest Android 4.4.2 API Level 19).

) Android Virtual Device Manager - oIEN
Android Virtual Devices | Device Definitions

List of existing Andreid Virtual Devices located at C:\Users\Default.Default-PC\.android\avd

AVD MName Target Name Platform AP| Level CPU/ABI New...

+" AVD_for_Nexus_One_by_Google Android 4.4.2 442 19 ARM (armeabi-v7a) Edit

Delete...

Details...

Start...

Refresh

" Avalid Android Virtual Device. A repairable Android Virtual Device.

¢ An Andreid Virtual Device that failed to load. Click 'Details’ to see the error.

Figure 2-15. The newly created AVD_for_Nexus_0One_by_Google AVD emulator with its primary specifications

There is also a column on the right that shows which CPU architecture (such as the Intel Atom,
ARM, Cortex, AMD, nVidia, and similar) this AVD definition is emulating. This is because each CPU
has a different way of processing instructions and data, as well as having different operating features
and performance specifications. Discussion of this is too advanced for an Absolute Beginners title,
but a device specification option (column) such as this allows developers to specify which CPU
hardware that they are developing their application for, and allows them to emulate this using an
AVD definition.

Even though in this book we will be using AVD emulators for more mainstream smartphone and
tablet products such as the Nexus products from Google, in order to show you how to use the New
Device button under the Device Definitions tab, we will need to also take a look at how to define one
of these AHD definitions from scratch. We will do this so that we cover absolutely everything that
this Android Virtual Device Manager is capable of, and to take a look at how to create an AVD for
something really cool such as the Neptune Pine SmartWatch product.

Creating an AVD from Scratch: Pine SmartWatch

The first thing you will need to do in order to create an AHD definition for a Neptune Pine
SmartWatch product would be to find out precisely what its technical specifications are. Fortunately,
Neptune’s Pine web site is very complete, and if you Google “Neptune Pine specifications,” as you
can see that | did in in the first tab in each screen shot in Figure 2-16, you can learn all about the
Neptune Pine. The URL for the Pine Tech-Specs page is as follows:

http://www.neptunepine/tech-specs.html


http://www.neptunepine/tech-specs.html
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Figure 2-16. Go to the NeptunePine.com web site, and its tech-specs.html page, to get SmartWatch product specifications

This Neptune Pine Technical Specifications Page is one of the most complete and thorough Android
device technical specifications pages that I've ever encountered, and a very big thanks (and kudos)
to Neptune for this from all of us Android apps developers! As you can see, this Neptune Pine
product is nothing short of incredible, with just about every end-user feature that you would want

to see in the Android device, especially one that is self-contained and worn on your wrist! Come-in,
Dick Tracy!

6. Open your Android Virtual Device Manager, using the menu sequence shown
in Figure 2-11, and then click on your Device Definitions tab, in order to
access the New Device button, as shown at the top right in Figure 2-13.

7. Name the device Neptune Pine SmartWatch, as you can see in Figure 2-17,
on the left side of the Create New Device dialog. Next, you would enter the
Screen Size (in) specification, which is 2.4 inches, and the Resolution (px),
which is 320 x 240.
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© Create New Device n
Name: Neptune Pine SmartWatch Size: small v
Screen Size (in): | 2.4 Screen Ratio: | notlong v
Resolution (px): | 320 x 240 Density: mdpi v

= Buttons: Software v
oo [v] Accelerometer [v] Gyroscope
[Japs [] Proximity Sensor
Portrait:
c []Enabled | Navigation
ameras [¥] Front [] Rear Landscape:
Device States: [] Enabled v| Navigation
Input: [IKeyboard
@®NoNav (O)DPad (O Trackball | Enabled | Navigation
| Enabled + Na
RAM: 512 MiB v

| Override the existing device with the same name

Create Device | Cancel

Figure 2-17. Create New Device dialog showing the Neptune Pine SmartWatch specifications

8.

10.

11.

Next, you need to specify which Sensors the Neptune Pine has; the Pine
has a Gyroscope and Accelerometer, as Figure 2-16 shows, so let’s check
these two checkboxes in the Sensors section on the left side of the dialog
shown in Figure 2-17.

Next, you will specify what Cameras the Neptune Pine supports, and as
you can see in Figure 2-16, on the right side of their web site under Camera,
the Neptune Pine has both a front-facing as well as a rear-facing camera, so
check both the Front and Rear check boxes. Even Dick Tracy himself would
be proud to own this SmartWatch with these types of advanced features!

Since there are no Input devices included with the Neptune Pine (unless of
course your user adds one, using the advanced Bluetooth 4.0 capability that
the Neptune Pine features), you can leave your default

No Nav radio button selected.

As you can see in Figure 2-16, under the Memory section of the Neptune
Pine web site, the Neptune Pine SmartWatch product supports 512MB of
memory, so enter 512 in the RAM section, and leave the drop-down selector
set to MiB, which stands for MegaBytes! Why MiB? The only reason | can
think of is that this drop-down uses GiB for GigaBytes, which would be a
more accurate abbreviation!
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12.

13.

14.

15.

Once you have created this Neptune Pine SmartWatch device definition, you will see it listed at the
top of your Device Definitions tab in the Android Virtual Device Manager, on top of the Nexus S by

The Size should automatically be set to small, and the Density to MDPI, so
all you need to do is to set your Screen Ratio to notlong, since a Pine uses
a 4:3 aspect ratio rather than a widescreen (long) 16:9 aspect ratio. We'll be
learning about size, density, and aspect ratio in the graphics chapter.

Since the Pine has three hardware buttons, as shown on their product image
in Figure 2-16, set your Buttons drop-down menu to reflect the presence of
these hardware buttons.

Finally, in the Device States section of the dialog, uncheck the Portrait
Enabled check box, since the Pine SmartWatch is intended to be used in the
landscape mode, and leave the Landscape Enabled check box checked.

Once you have everything properly set up and configured, click your Create
Device button, and you will have then created your new Neptune Pine
SmartWatch hardware device.

Google, along with its primary specifications, as shown in Figure 2-18.
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Android Virtual Device Manager = = n

Android Virtual Devices | Device Definitions

List of known device definitions. This can later be used to create Android Virtual Devices.

Device

=]

=]

A | | New Device...
Neptune Pine SmartWatch

Screen: 2.4",320 x 240, Small mdpi —

RAM: 512 MiB Delete...

Nexus S by Google

Screen: 4.0°, 480 = 800, Normal hdpi

RAM:  343MiB Create AVD...

Nexus One by Google

Screen: 3.7", 480 x 800, Normal hdpi
RAM: 512 MiB
Used by: AVD_for_Mexus_One_by_Google

Nexus 7 bv Gooale v Refresh

E A user-created device definition. B A generic device definition.

Figure 2-18. The Neptune Pine SmartWatch device in the Device Definitions tab of the Android Virtual Device Manager

As you can see, on the right side of the dialog, there are a number of other buttons that allow you
to perform other AHD and AVD tasks. You have already used the Create AVD button to create your

Nexus One AVD emulator, so let’s look at the other two.

The Edit button allows you to highlight an AHD definition on the left side of the Android Virtual

Device Manager screen, and then click the Edit button, which will take you back into the dialog that
was used to create the Hardware Device specification data, which was shown in Figure 2-17. If you

like, you can try this with the Neptune Pine SmartWatch device definition and see what | mean!
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The Delete button allows you to highlight an AHD definition on the left side of the screen and
remove it from the Device Definition list shown in Figure 2-18. Be careful when using this, as you
can’t get the device definition back!

It is also interesting to note that the Create AVD button on the right middle of this dialog accesses
the same exact functional dialog that the New button, shown in Figure 2-15, does under the Android
Virtual Devices tab. This is convenient; | just wish they had used the same button label in both tabs!

You can use either of these buttons to open up the Create new Android Virtual Device (AVD) dialog,
which is shown in Figure 2-14, as well as Figure 2-19, and which you will be filling out next so

that you can complete the creation of the Neptune Pine SmartWatch AVD emulator, which you will
be using in Chapter 16 covering the Android application development work process for creating
wearables apps, in this case for the popular Neptune Pine SmartWatch product.

W Create new Android Virtual Device (AVD) “

AVD Name: AVD _for_Meptune_Pine_SmartWatch
Device: MNeptune Pine SmartWatch (320 = 240: mdpi) v
Target: Android 4.4.2 - AP Level 19 v
CPU/ABI: ARM (armeabi-v7a
Keyboard: [ Hardware keyboard present
Skin: [ Display a skin with hardware controls
Front Camera: None v
Back Camera: None v
Memory Options: | papg [ 512 VM Heap: | 16
Internal Storage: 200 MiB v
SD Card:

(@) Size: | 4 GiB v

() File:
Emulation Options: [V Snapshot []Use Host GPU

Owverride the existing AVD with the same name
OK . Cancel

Figure 2-19. Creating the Neptune Pine SmartWatch AVD
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16. Enter Neptune_Pine_SmartWatch into the Name field in the Create AVD
dialog as shown at the top of Figure 2-19.

17. In the Device field, drop down the selector Ul element and select the
Neptune Pine Smart Watch (320 x 240: MDPI) device definition, which you
just created.

18. In the Target field, leave the default Android 4.4.2 - API Level 19, since that is
what the Eclipse IDE is running at currently and since you have the (backward)
compatibility library installed. The Neptune Pine currently runs an Android 4.1
OS, which on an API level, at least for the APIs we will be using to develop
apps for this product, there have been no major changes from 4.1.2 t0 4.2.2
to 4.3.1 to just recently 4.4.4. We’'ll be discussing API levels in Chapter 4
covering the Java programming language.

Note The 4.x API revisions have implemented faster touchscreen refresh and graphics screen refresh
rate increases for game developers. Also added were OpenGL ES 3.0 upgrades, speed, and efficiency
improvements to the existing APl methods, and an addition of cloud-related services, such as off-device
printing and data storage on Google’s various cloud services. In other words, all of the recent versions

of Android, from 4.1 through 4.4 (released during 2013), have implemented what I'd term “user-facing”
improvements, rather than developer-facing APl updates. As you will see in Chapter 4, this means that none

of those Java programming language elements of Android OS that developers use have changed much at all.

Android 5.0, announced in the summer of 2014, will use Java 7 and a 64-bit Linux kernel when it becomes
available in hardware devices in 2015 and 2016.

19. Let’s get back to configuring an AVD definition for the Neptune Pine
SmartWatch just to show you the complete work process from AHD creation
through AVD definition and creation. Uncheck both of the Hardware keyboard
present and the Display a skin with hardware controls check boxes.

20. For the Front Camera and Back Camera, you can select any of these three
options that suit your workstation set up. If you have a webcam installed,
you can use that to simulate the Neptune camera hardware on the Pine
SmartWatch, you can simulate the cameras with the emulator itself, or you
can simply select None for now, as | have done here.

Note Remember, you can use the Edit button at any time to change the settings you have set for the
AVD emulator, so if you get a webcam or add camera features to your app, you can always change these
drop-down selections at any time in the future, which is quite convenient.

51
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21. |l used a 512 setting for the Internal Storage field, and selected the MiB from
the drop-down selector to specify megabytes, rather than gigabytes, which is
designated as GiB.

22. For the SD Card, | specified 4GB to make the emulator run more efficiently,

even though the product supports a 16GB or 32GB MicroSD Card, which to
the emulator would be the same as an SD Card.

23. Finally, for the Emulation Options, check the Snapshot option to speed
subsequent AVD reloads for your testing cycle. This keeps a “snapshot” of
the AVD environment in your system memory, so that each time you access
the AVD emulator to test your application, it does not have to be reloaded.
You can see the final result in Figure 2-20.

(3 Android Virtual Device Manager = = “

Android Virtual Devices | Device Definitions

List of existing Android Virtual Devices located at C:\Users\Default.Default-PC\.android\avd

AVD Name Target Name Platform AP Level CPU/ABI New...
[+ AVD_for_Neptune_Pine_SmartWatch Android 4.4.2 442 19 ARM (armeabi-v7a) | e
+" AVD_for_Nexus_One_by_Google Android 4.4.2 44.2 19 ARM (armeabi-v7a)
Delete...
Details...
Start...

Refresh

+" Awvalid Android Virtual Device. A repairable Android Virtual Device.
2 An Android Virtual Device that failed to load. Click 'Details’ to see the error.

Figure 2-20. A Neptune_Pine_SmartWatch custom AVD once it has been created using the Device Definitions tab

Note If you are creating interactive 3D OpenGL ES 3.1 applications, which use the OpenGL rendering
engine that is part of the Android OS, you will alternatively want to choose the Use Host GPU option instead,
to take advantage of your workstation GPU (Graphics Processing Unit) hardware. It is important to note that
you cannot select both of these emulation options at the same time, so unless you are using OpenGL 3D
technology in your application, select the Snapshot option.

Now that you have created AVD emulators for both a smartphone and a smartwatch, and are familiar
with the work process involved, you can create your very own AHD definitions, which you can then
use to create the final AVD definition. You are now ready for anything in the area of emulation that |
can throw at you in the remaining chapters of this book, which cover how to develop applications for
the Android operating system running on Android devices.
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We’ll be performing this same work process as needed in any chapters in this book that cover
non-standard Android devices that are not listed (included) in the Eclipse ADT at this time (on the
Device Definition tab) or that require us to add tablet or iTV set product definitions to our list

of emulators.

What Will Be Covered in this Book

Since we downloaded, installed, and configured your Eclipse ADT and its Java foundation, as well as
a plethora of professional-level, open source content production and business productivity software
in the first two chapters, let’s take a look at what will be covered in the rest of the book. | am doing
this so that you have a comprehensive overview of what Android encompasses, and what you’ll need
to learn, in order to go from an Absolute Beginner to an intermediate level Android app developer.

I will progress from (relatively) simple concepts to more complex topics as the book progresses.
However, don’t expect any of this subject matter to be easy to master or even comprehend during
the first go-round, because Android application software development is an extremely high-level
endeavor. As you probably are well aware, Android software developer is a complete profession, as
well as a high-paid career, and as such, will take you several years to completely master all of its
complexities.

Introduction to Android Application Development Platform

In Chapter 3, you will learn the unique “lingo” for Android application design; that is, what the
various components of an Android application are called, because Android uses its own terminology
(or lingo) to describe things like messages and databases and background processing and app
screen design. It is important to note that this “lingo,” which is based on Android class names, will
not change from version to version, which is why everything that you will learn about during this
book will apply equally well to both Android 4.x and 5.x versions.

As you’ll learn in Chapter 3, an Android application is “stratified.” This involves how an app’s
function is spelled out via Java code, while its design is controlled with XML markup, and its
privileges with an Android “Manifest,” in a way that that is truly unique, modular, and powerful.

You will get an overview of all the basic knowledge of Android application development in Chapter 3,
as well as learn how to create an application shell, which | call an application “bootstrap,” in that
chapter.

Android’s modularity adds a great deal of extensibility, or development flexibility, to Android
applications, but also makes it more difficult to learn initially. We will get a bird’s eye overview of how
all of these modules work together, to create your Android OS application development environment,
and how everything comes together to create your application.

It’s important to get this high-level view first, before we dive into each of the lower-level component
areas of Android application development, as you will need this perspective to understand
everything else in the book.
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How Android Simplifies Design: Designing Apps Using XML

In Chapter 4, we will take a look at how Android uses the XML markup language to define the basic
component design for your application, especially its visual (graphics) design and its Ul component
design. | look at XML as giving developers a maximum return on investment, as XML makes it
possible for absolute beginners to develop robust and functional applications right out of the gate!
That’s what the book is all about, after all; getting up-to-speed on Android as rapidly as possible!

Writing XML “markup” is not technically programming, but rather consists of using tags, similar to
the HTMLS5 tags that web developers use to format their online documents. These tags can also
contain configuration parameters to fine-tune them for your exact application design usage.

XML is used in Android to define everything from Ul designs, to constants, to styles or themes to
data access, and even programming constructs like Java Object definitions, which we explore in
Chapter 5.

XML markup tags are far easier for beginners to comprehend than complex programming languages
such as Java. This is why I’'m covering it first, right out of the gate, after the chapter after where we
discuss how Android is structured and stratified. Because it’s easier, we’ll use XML throughout this
book whenever possible, as Google recommends that developers do this.

Android Application Framework: Java Programming Primer

By the time you reach Chapter 5, you’ll have built a rock-solid integrated Android application
software development environment, and have acquired a basic understanding of all of the
components that make up an application development project (XML markup, Java code, text, Ul
layout, Ul widgets, images, audio, video, animation, and so on), and you will have learned how to
upgrade a new (an empty, or a “bootstrap”) Android application.

I will outline how Java programming logic or code and XML, along with any new media resources,
are compiled, compressed, and bundled into Android’s signature APK file type, and how the various
Android application components “talk” to each other inside your apps. The majority of Chapter 5,
however, will be dedicated to giving you a Java Programming “primer” in case you are unfamiliar
with Java SE.

We will look at the various concepts in Java, ranging from the entire API to your own custom
software “package” and the classes, methods, interfaces, variables, and constants that it may
contain, which will be based on what your application programming logic is trying to accomplish.

We’'ll look at the concepts of Object Oriented Programming (OOP) so that you can understand how
to visualize what we will be doing in the rest of the book. We will also put all this Java programming
knowledge to good use and write our first Android class, called Galaxy.java, in Chapter 5.

Screen Real Estate: View and Activity Classes

Chapter 6 provides an overview of Android’s Activity class and View class. These contain and

define your “user experience,” or UX, on the screen. I'll explain and demonstrate how an Activity
works. We will take a look at the new Android application you created in Chapter 3, and turn your
Java code from Chapter 5 into functional Android code. We will enhance the Java code inside of
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your application’s Primary (Main) Activity class. You’ll have learned about classes in the previous
Chapter 5, so as | mentioned, we will always build on your previous knowledge base as we
progress through this book.

We will also take a look at the Android View, which is the foundation for everything that displays

on the Android display screen and inside of these Activities that you will create as an Android
applications developer. Like the Activity, the View is another very high-level Android component, and
we will take a close look at how the View is used to create Ul elements and layouts (designs) that
ultimately make your application easy to use, functional, and even fun!

You will learn how Android’s Views are used to create the Ul “widgets” in Android, which are the Ul
design elements that you will utilize to create your functional user interface design for your Android
app inside of Android’s Ul layout containers, which are based on the ViewGroup class.

You will learn about the different screen resolution, density, orientation, and aspect ratio (width)
issues in Android, which you will need to understand so that you can make your applications span
across various Android hardware devices such as smartwatches, tablets, and iTV sets.

Chapter 6 explains how your Ul is contained within the Android device display screen. Android
device display screens are the way most users interact with their Android applications. In Android,
your Ul is written to the display using a mixture of Java (Activity class) and XML markup. This
defines View and ViewGroup widgets and layouts, which controls the custom hierarchy of View and
ViewGroup objects, which you’ve designed using nested ViewGroup layout containers (or using a
single layout container).

These ViewGroup layout containers ultimately hold all the other graphics (Chapter 9) and Ul content

for your application in its proper place, and thus ViewGroup classes provide a foundation for Android
application design. You'll want to learn these display screen (Chapter 6) and Ul layout design (Chapter 8)
concepts thoroughly, as they are core concepts to implementing everything else that Android can do.
After all, without a proper Ul, your user cannot access software functionality in the first place!

You'll revisit XML markup again in this chapter, as you will in almost every chapter in this book, and
learn how XML allows you to define complex screen layouts and Ul designs without writing a single
line of Java code. You will learn about the different types of layout containers, and how each can be
useful in different Ul design scenarios, and you will continue to code a really cool Activity for your
application, which is written almost completely using XML markup.

Interactivity: Using Android Intent and Event Handling

In Chapter 7, we’ll start building interactive applications using Android’s Intent class to make
our application menu system functional. We will also make the Ul screens for your application
interactive, as you’ll learn how to implement Android Event Handler and Event Listener capabilities.

We'll take a look at how to use Android’s Intent class, and Event Handling capabilities, to launch
new Activity subclasses and to make your Ul design functional. Although this is fairly advanced
material, we need to cover it fairly early on in the book, so that we can make sure all of the remaining
chapters, which cover how to integrate new media and data external to your application with your Ul
design, can be made to function (be interactive).
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The Android Intent and IntentFilter classes are used to communicate within an Android application,
between components such as Activities and Services, as well as outside of your Android application.
This External communication is usually with other Android applications, which are not part of your
Android application, but which your application will need to communicate with, to synchronize with,
or to exchange data with. Android is a very complex subject, so expect each chapter to become
more complex!

Ul Design: Adding User Controls to Your Apps

In Chapter 8, we will get into the plethora of facilities that Android provides to developers to design
Ul layouts containing Ul elements (called “widgets” in Android), so that your app’s users can
“interface” with your application. That’s why it’s a “user interface!”

This design process is called Ul Design, and you have already downloaded and installed the Pencil
2.0.5 Ul design tool on your workstation in the previous chapter, so you can prototype Ul designs!

In Chapter 8, we will focus on looking at Android’s flexible Ul design classes, which are based on
Android’s ViewGroup class. Ul layouts can be “nested” within each other, or simply utilized on their
own, in order to create any Ul design, no matter how complex, that your application might require to
“bridge” your application’s functionality over to its users.

We will take a look at some of the most often used Ul design classes in Android, commonly called
“layout containers,” and how these will allow developers to create Ul designs quickly and efficiently.

Graphics Design: Add Visuals to Your Apps

In Chapter 9, we will start to get into adding new media elements to your Android applications by
looking at static (fixed) graphics. These are implemented using digital images, and we will take a look
at the basics of digital imaging as well as at the digital image formats that are supported by Android.

We will start building highly visual Ul designs that incorporate graphic design elements, again by
using the XML foundation that you will have learned during the previous chapters. As we are building
one chapter upon another, this will continue to build on your newfound knowledge of Android
Activity classes, XML markup, Android screen design, View widgets, and ViewGroup layout classes.

Because Android smartwatches, smartphones, tablets, and iTV sets feature Organic Light-Emitting
Diode (OLED) wide video graphics array (WVGA, or 800x480) and high-definition television (HDTV, or
1920x1080) screens in the current market “line-up” of Android products, Android display screens are
impressive enough these days to allow some amazing user experiences to be created using graphic
design elements.

Since this is an area where Android development starts to get interesting, | decided to incorporate
how to leverage new media assets in your Android applications, so that your work can stand far
apart from the crowd. Android has a plethora of support for new media assets. Just because this is
an Absolute Beginner title doesn’t mean we should shy away from complexity!

We will look at several different image formats that are supported in Android and how they differ from
each other. We will look at their strengths and weaknesses, and which are the preferred ones to use
for your Android applications development. We’ll look at why Android prefers certain image formats
over others.
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We will look at the class foundation for graphics in Android by learning about the Drawable class
and its many subclasses such as BitmapDrawable and ShapeDrawable. You will also learn about
foundational concepts in the area of graphics design and image compositing.

You'll learn how to create graphics assets, as well as how to create several different versions

of those image assets that will scale well across different screen densities. You will learn about
Android’s scalable graphic classes, such as the NinePatchDrawable class, and learn about the
9-Patch tool that comes with the Android SDK. This is a chapter that will transform how your
Android applications look, and the knowledge gained in this chapter will allow you to greatly increase
an app’s professionalism.

Animation: Adding Motion Graphics to Your Apps

In Chapter 10, we will build on those static (still) graphic capabilities we learned about during
Chapter 9 by adding the fourth dimension of time, as motion, to these graphic assets, to create
animation assets.

We will take a look at the Android Animation class, which you can use to create procedural, also
known as vector or tween, animation, as well as the AnimationDrawable class, which is used to
create frame animation (also known as bitmap animation or raster animation).

You will learn what the differences between procedural vector animation and bitmap frame
animation are, and how to utilize the two completely different animation approaches together, in
hybrid animation, to create a more impressive visual result than would be achieved by using them
separately.

You’ll implement animation assets using XML, so you will get even more practice designing and
implementing new media assets using XML markup.

Digital Video: Captive or Streaming Video for an Application

In Chapter 11, we will look at the digital video type of new media asset, which is very different from
the animation new media asset, because it is self-contained and uses a single file format. We will
take a look at the concepts of URLs and URIs, which are used to define a path, or address, to your
digital video asset.

We will also take a look at the Android VideoView widget class, which is a user interface element
specifically designed and provided by Android for playing digital video formats. We will look at how
this class works hand in hand with the Android MediaPlayer and Android MediaController classes.

We will take a look at the foundational concepts involved with digital video, and how they expand on
what we learned about digital images, since digital video is simply a series of digital images. We will
also take a close look at popular digital video formats, which are implemented as something called
digital video codecs, currently supported in Android.

We will look at the two primary digital video formats that are supported in Android, MPEG-4 and
WebM, how they differ from each other, their strengths and weaknesses, which are the preferred
ones to use for your Android applications development, and which digital video formats you should
use for various types of captive versus streaming implementations. You will create a digital video
asset using Terragen, VideoDub, and Squeeze Pro and implement it in an Android application using
Java code and XML markup.
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Digital Audio: Adding Audio Media to Your Apps

In Chapter 12, we will look at the digital audio type of new media asset, which is the most well-
supported type of new media in the Android OS, as far as file formats (codecs) are concerned.

You will build on your knowledge of the MediaPlayer classes that you gained in Chapter 11, as
playing back audio files is quite similar to playing back video files, without the moving imagery, of
course. We will also take a look at the more advanced Android SoundPool class, which is more
suited to adding sound effects to an application as well as sequencing and mixing audio with an
application, as well as the SparselntArray class.

As an added bonus, in Appendix A we will look at the foundational concepts behind digital audio,
as well as the plethora of different digital audio file formats (also known as codecs) that are
supported in Android.

We will look at how the codec usage scenarios will differ significantly from each other. We will
discuss different audio codec strengths and weaknesses, and which are the preferred ones to use
for a given Android application, and discuss why you will want to use certain digital audio formats
over the others that are available.

Services: Adding Background Processing to Apps

In Chapter 13, we’ll take a look at the Android Service class. Services in Android are used to provide
background processing, which is used when you want something done in the background (such as
playing music) while your user works on something else using your app’s Activity and its Ul design.

To really give you a good feel as to what the Service class is doing, we will also have to cover some
fairly complex OS concepts such as Processes, Threads, and Scheduling. Threads can be a very
advanced area within any OS, and Android is no different, as Android is based on an open source
Linux OS Kernel, as well as on open source Java, XML, CSS, HTML5, WebKit, and OpenGL.

We will look at the Android Service-related classes, as well as how to use Intent objects to
create and control Services, which are launched and then operate in the background at the same
time that your user is interfacing with your Ul design (the Ul layout and its Ul widgets) in your
Activity class. An Android app may never need to utilize the Service class, but it’s part of our
comprehensive coverage.

Content Providers: Accessing Stored Data Inside of Your App

In Chapter 14, we will look at the Android concept of Content Providers, which are “data stores” for
the Android OS. These provide data to your application, and include things such as files on your SD
card or an internal database.

The Android OS includes a popular open source database called MySQLite, which is the “Lite”
or very basic version of the popular open source MySQL DBMS (DataBase Management System)
relational database engine.

We will look at all of the different ways to provide data to an Android application, and we will take a
closer look at the theory behind databases. We will revisit those concepts of the URL and the URI,
which you will have utilized in Chapter 11 on digital video new media assets as well as in Chapter 12
on digital audio new media assets.
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Android Wearables: Creating a Smartwatch Application

In Chapter 15, we will look at a rapidly emerging area of Android wearable devices. The most
popular and widespread type of wearable Android devices currently are smartwatches, so we will
develop an Android application for the popular Neptune Pine Android SmartWatch.

This is another area of Android development that can be more complicated than some of the other
areas that have been covered, and for this reason, | saved this for the last part of the book. | am also
writing an entire book on this area called Pro Android Wearables in case you want to go more deeply
into this popular area of Android application development.

The reason | am using the Neptune Pine SmartWatch for the development in this chapter is because
it is a full Android device and does not require the special Android Wear SDK, so you can use your
existing IDE setup and develop apps for the Neptune Pine as you have been doing throughout the
book. This will allow us to simply go the next level, as you will have been doing from chapter to
chapter.

Android Appliances: Creating an Android Appliance App

In Chapter 16, we will take a look into the future of Android application development, which lies in
the areas of Android Appliances, which include cloud computers, iTV sets, 4K iTVs, game consoles,
robots, drones, home security products, kitchen appliances, automobile dashboards, car stereos,
and similar emerging consumer electronics products.

Android Appliances are anything that are not common Android devices such as smartphones,
tablets, phablets, or notebooks, and that are not Android wearables. | am also writing a

Pro Android Appliances title that will cover this emerging area if you wish to get into Android
appliance development at a more advanced level.

Most of these Android appliances will use Bluetooth technology to talk to another “primary”

Android device (usually this is your smartphone), and thus, we will take a look at these concepts
and techniques regarding developing for the future of Android devices in this chapter. This will give
readers a comprehensive view of exactly what the app development skills that were mastered within
this book can do for their app development bottom line!

The Future of Android: 64-bit Android 5.0

Just as this book title was going to press, Google announced Android 5.0 at the Google 10
conference, and so | decided to add a “Future of Android” chapter to this book, going over how
Android 5.0 will be different, including a new 64-bit Linux OS Kernel, ART run-time, and Java 7
support. This chapter will serve to upgrade this book title to being an Android 5.0 title, and one of
the first Android 5.0 Absolute Beginners titles at that, so it will be worth my extra effort to add in this
comprehensive chapter on Android 5.0.

It is important to note that Java 6 code is compatible with Java 7, and that Android classes which
we cover in this book will also work under future versions of Android, a concept called “backwards
compatibility.” This concept is especially important to Google and Android as they don’t want to
“pbreak” their developers code, meaning the concepts and techniques you learn in this book will
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apply to Android 4.x and 5.x OS versions alike. For this reason you do not have to worry about the
content in this book becoming obsolete, especially because | cover the entire new media content
development work process, and not just Android programming alone.

Summary

In this second chapter, you made sure that your Eclipse ADTs installation that you downloaded
and put together in Chapter 1 is fully updated, and properly configured for the Android application
development that you will be undertaking throughout the rest of this book.

Next, you learned about hardware product emulators, called Android Virtual Devices, also known as
AVDs, and you learned why these AVDs are important to understand and how to implement them, so
that you can utilize AVDs to accelerate your Android application development work process.

You created a Google Nexus One AVD by using Eclipse ADT’s predefined AHD definition for this
smartphone device and by doing this you learned all about a (second) Device Definitions tab within
the Android Virtual Device Manager dialog.

Then you got a little bit more advanced and created your own AHD device definition for the Neptune
Pine SmartWatch, so that you could create an AVD emulator for the Neptune Pine SmartWatch from
scratch. You accomplished this by going to the NeptunePine.com web site and finding the product
info page, which contains all of the product specifications, and created your own AHD definition
using the New Device button and dialog.

Finally, we took a few pages to go over what you will be learning about in the rest of this book,

so that you have a high-level overview of what | will cover as well as how many truly powerful
development capabilities the Android OS currently encompasses. As | mentioned, | am going to
attempt, within one single book title, to take my readers from an Absolute Beginner status to a solid
intermediate status.

In Chapter 3, you will start developing your first Android application, while at the same time learning
about the “lingo” of Android, and getting a high-level overview of how the Android ecosystem all fits
together, to allow developers to efficiently create Android applications.



Chapter

An Introduction to the Android
Application Development Platform

In this chapter, we will take a look at how the Android development environment and platform works,
and how it is stratified within your Eclipse ADT Integrated Development Environment (IDE). To do this
properly, we will create the foundation for your Android application development for this book during
this chapter, and in doing so show you how to create a brand new Android application from scratch.

You create the foundation for your Android 4.4 application using Eclipse, and its New Android
Application series of dialogs. As you will see later on in the chapter, Eclipse can help an Android
developer to create an empty application, which | refer to as being an Android application
“bootstrap.” | call it this because it gives you the foundation of an Android application that you
can build upon, including a Java Activity class, your Android Manifest file, your application icon, a
menuing system, and a user interface (Ul) layout container.

We will take a closer look at all of the basic Android app components during this chapter, by looking
at the Android application resource folder structure, which the New Android Application series of
dialogs will also automatically create for you, inside of the Eclipse Package Explorer pane.

We will do a detailed examination of this folder structure, which will tell you how the Android OS
wants to see things structured and organized. We will also take a detailed look at other resource
folders that are not auto-created in the default Android application project folder structure, but that
you can optionally create yourself (and will, during the course of this book) to hold things such as
animation, video, audio, and much more.

As you progress in your knowledge of Android, you will enhance the application foundation that you
will put into place in this chapter into something that is truly impressive, and learn every corner of the
Android OS as well as the Eclipse Android Development Tools (ADT) IDE in the process.
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How the Android Platform is Structured: Java, XML, and
New Media on Top of Linux

An Android development platform is a multi-layered collection of software components that includes
an OS (Linux) with a massive number (thousands) of high-level function libraries (Java code) that
exist “on top of” that OS “kernel.” These Java libraries simplify your task of communicating with
Android’s Linux OS kernel, which is inherently complex, as you might well imagine.

On top of this more complex Java code libraries layer, you have a higher-level layer of XML mark-up.
XML mark-up allows you to more easily define your application’s Java object structures, as well as
any constants that will be used in your Java program logic. I’ll cover these Java concepts of libraries
and packages, as well as what Java objects, constants, classes, and methods are, in Chapter 5.

Finally, your XML mark-up references your even higher-level application Ul design, styles, theme,
and new media assets, which | will be covering in Chapters 6 through 12. These design-oriented
assets allow you to control how your Android app looks, sounds, and functions, and define your user
experience. | show this hierarchy visually, in Figure 3-1.

APPLICATION MEDIA ASSETS

XML OBJECT DEFINITIONS

JAVA CODE LIBRARIES
LINUX OS KERNEL

Figure 3-1. Android OS hierarchy, from Linux Kernel, to Java Libraries, to XML Definitions, to New Media Assets

Details Regarding Android’s Platform Structure

The foundation on which Android is built is the carefully coded, and painstakingly tested, Linux.
Linux and its core services manage the physical hardware for the smartphone, tablet, eBook reader,
smartwatch or iTV set, and give Android applications complete access to the features of each
consumer electronics device, including the GPS, touchscreen, memory, data storage, camera, gyro,
compass, accelerometer, Bluetooth, wi-fi, NFC, USB port, and more.

Linux doesn’t do it all alone, however! Android has a wide array of Java API libraries, which
provide higher-level customized functions and services for things like SQLite database
management, 2D imaging, 3D rendering, digital audio playback, digital video streaming, animation,
Bluetooth, and more.
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The higher-level Java functional libraries are the ones that Android app developers use to create
their applications. This is so that developers do not have to “talk” directly to the low-level operating
system functions. This is done so that application development becomes an order of magnitude
easier! You will be learning about all of the major Java functional libraries that are used to develop
Android applications over the course of this book, starting with this chapter.

The Android platform also includes a large number of “end-user” applications, which Android
device users have come to expect on their Android device. Examples of these include a phone
management utility, an e-mail client, various social media platform clients, a contact manager, a web
browser, an alarm clock, a calendar, Google Maps, Google Search, media player, basic games, and
so forth.

Finally, Android supports all of those popular open source rich media formats that you will want to
use in your applications, including the powerful ON2 VP8 video codec, now in Android 4. ON2 was
acquired by Google, and VP8 was released as an open source video codec called WebM, which you
can find in Android as well as browsers such as Firefox and Chrome.

Both the WebM and the MPEG4 H.264 AVC digital video codec’s “Quality to File Size Ratio,” and
therefore their playback performance, are pretty darn impressive for open source video codecs. For
more information regarding the new media formats that are supported in Android, you can visit:

http://developer.android.com/guide/appendix/media-formats.html

The next section of this chapter introduces a Java Dalvik Virtual Machine (VM), which optimizes your
Java code for low-power embedded (portable) consumer electronics devices. Later in this chapter,

| show you how to create your first Android application, and we will take a look at how Eclipse ADT
wants you to organize assets via a highly structured application project hierarchy.

Note In this book, you will build apps using a combination of XML and Java, which sit in layers on top of the
operating system, as shown in Figure 3-1. However, you could, if you wished, access the operating system
and its services directly, using a lower-level language such as C or C++, by utilizing the Android Native
Development Kit (NDK), rather than the higher-level Software Development Kit (Android SDK), which we
will be using for this book. You might consider this “under-the-hood” approach for an application that needs
the utmost speed, such as a game or a real-time heart-monitoring program, but this NDK is beyond the scope
of this book.

Now let’s take a look at the runtime, or compiled version, of your Android application, and how it
uses Java bytecode with the Dalvik VM to optimize the performance of your Android app!

Compiled App: Runtime Executable Java Bytecode

Everything in Android’s development environment, as well as all the included applications, is created
by using a combination of Java code and XML markup. This is compiled by Eclipse ADT, into a
Java “bytecode” version of your app that will be run using a runtime utility that is included with the
Android OS. Eclipse (using Android’s SDK) creates this inside of the DEX file format (similar to an
EXE file).
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This DEX format essentially amounts to being a compact, low-level executable file format that
the Android operating system, and therefore Android devices that run Android OS, will be able
to understand and run. A DEX is not specifically encrypted, but if you look at the contents of one
of these compiled files, it would not be decipherable! So the flow of code to bytecode to binary
(executable) data would be as follows:

XML (.XML) » Java (.JAVA) » ByteCode (.DEX) » App (.APK) » Runtime (DVM) » Screen

The Android runtime environments (before Android 4.4, DVM was the only runtime; in 4.4, you can
choose between DVM and ART, and Android 5.0 and later use only ART), which we’re going to look
at in detail in the next section of this chapter, provide your apps with a core set of operating system
libraries. An app can access these via Java code and XML markup. These runtimes give your apps
access to hardware device features, as well as the low-level Android operating system functions, so
that you don’t have to do all of that low-level programming yourself!

You simply include the appropriate components from the libraries you need in your program, using
something in Java called an import statement. After you do this, your app’s code can employ that
built-in Java library’s capabilities. You will learn how to put a number of these powerful Java libraries to
work later on in this chapter, and in all the chapters, for that matter, during the remainder of the book.

Android Runtimes: Dalvik VM

To execute Java code at runtime, Android OS has always used a runtime engine called the Dalvik VM
(or DVM). The DVM was created specifically for use with Android OS, and is an optimization
mechanism and technology that allows an application’s Java code, XML mark-up, and new media
asset resources to be aggressively optimized so that it can be utilized within a low-power, mobile,
single-processor, and similar embedded environment.

An embedded environment is one in which a low-power computer (one that can run using a
battery) is actually “embedded” inside of a consumer electronics product. This is commonplace in
smartphones, smartwatches, smartglasses, tablets, eBook readers, iTV sets, and iDVD players, to
name a few.

| have also seen “smart” household appliances, such as refrigerators, ovens, and door locks that
feature embedded devices that utilize Android coming out this year. Thus, Android app development
is no longer limited to Internet 2.0 (wearable, portable, or mobile) devices anymore.

Note |am writing a title on how to develop Android applications for these Android appliances that is called:
Pro Android Appliances, which will be released sometime during 2015, as well as a new title on how to
develop Android applications for wearable devices, called Pro Android Wearables, so stay tuned!

The good news for Android app developers is that this DVM isn’t something that the developer
needs to worry about for their application development. | describe it here only to give you a sense of
what’s going on under the hood with Android to provide you with a comprehensive overview.
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When the user first launches an Android application by clicking the launch icon, the DVM at that
time creates a runtime binary version of your application, by using your application’s DEX file. This is
called just-in-time (JIT) software execution. The runtime binary (zeroes and ones) will be compatible
with the specific type of CPU that is being used in that particular Android device.

Android then creates a process (more on these in Chapter 13) that will then allocate memory and
CPU processing resources (processor time slices) for your application, so that it has the resources
it needs to perform its various functions. Each time an application is launched, and a process
spawned, an instance of the DVM is created for that process and an allocation of that Android
device memory space is designated or reserved for your application.

An instance is a reference to where the DVM is stored in system memory. Instancing can save

loads of memory, and in fact it is used in 3D software in the modeling process to reduce the
amount of actual data that is required to generate a 3D model that features a repetition of identical
components. The reason the DVM is instanced instead of copied into memory each time is that only
one version of the DVM in memory is needed and can be used and referenced by all applications.
Each app does not need to have its own copy of the DVM in memory as that would be very
inefficient, and the DVM is all about efficiency!

The DVM implements your Java language instructions, along with your application Ul design
guidelines (in the form of Java objects) that you defined using XML markup, combines these with
external new media assets (images, audio, video, 3D,and so forth), and translates this infrastructure
into optimized, low-level, binary code. These low-level instructions get placed into the Android
hardware device memory, and are submitted to the OS process or “thread” manager, which then
takes these low-level instructions out of memory and runs them through the device CPU (processor)
for real-time processing, thereby “running” your Android application for your end-user.

So, what is the advantage of this DVM? The use of a DVM will allow more applications to run within
a somewhat limited memory space (1GB to 2GB) and with the slower (1GHz to 2GHz) processor
speed found in today’s consumer electronic devices. The DVM also protects all of the other launched
(active in memory) processes from interfering with each other. In this way, a crash of one application
will not bring down the entire Android operating system. This is a major advantage, because other
developers’ Android apps cannot cause your app to crash, or heaven forbid vice-versa.

The other major advantage of the DVM runtime environment is that you don’t have to create a
different version of your app for every CPU brand and manufacturer in the marketplace. As we all
know, Intel, AMD, and nVidia are competing in this mobile space, as are the ARM processor and
the Cortex processor, among others. By having one version of Java bytecode in your DEX file and
a runtime inside of the Android OS that turns this into binary machine language that is compatible
with the CPU architecture in any given Android device, our Android development work process is
simplified by an order of magnitude (or more, if more than ten different CPUs exist).

Android Runtimes: The Android RunTime VM

As of Android OS version 4.4, there is a brand new runtime called Android RunTime (ART). | will give
you an overview of ART in this section just so that you know about the very latest “under-the-hood”
developments in the Android OS. This is one of the cool things that you will learn in this book that will
allow you to “show off” your Android development knowledge to those that you wish to impress.
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It is important to note that DVM is still the default (preferred) runtime for the Android OS, and

that ART is included in Android 4.4 and later devices, but it is not initially activated for use as the
primary runtime scheduling utility. This is because ART is new and unproven, whereas the DVM has
withstood the test of time and works adequately, especially given faster CPUs and more memory.
Startiing with Android 5.0, ART will be the default (primary) runtime used for the Android OS.

ART is also a VM and is a runtime utility for the OS just like the DVM is. The main difference is that
whereas DVM uses a JIT model, ART uses an “Ahead of Time” (AOT) model. In the AOT model, the
machine language binary gets created when a user installs the Android app, rather than each time
the user executes (launches or runs) the app. The “pros” of this approach is of course a faster launch
time, which all users love, and the “cons” of this approach is the slower download and install time,
as this now includes the creation of this machine language binary runtime file. Another con would be
the storage space necessary to store this machine language binary, once it is created.

The thought here on the part of Android OS developers is that although during application installation
more processor power and memory will be used (and hence more battery power) to create this binary
machine language runtime module for each installed application, once the user is done installing all of
the apps that they will be using on their Android devices, less battery power, memory, and processing
overhead will be used during the actual day-to-day usage of the Android device.

The next thing that | want to show you is how to create a new Android 4.4 application project. The
reason | am doing this next is so that you have something concrete to look at, once | start talking
about how an Android application goes together, as far as how Java, XML, and your project assets
are used, and where things need to be stored, and how assets are organized within the Android
application project. Organization and structure becomes more and more important, the more
complex your app becomes!

Creating Your First Android Application

By now, you are probably quite eager to fire up Eclipse again, and to create your first Android 4.4.4
application. We need to do this so that you can observe how everything works together when it
comes to creating your own custom Android application.

A time-honored tradition across every programming language is for new users to create a Hello World
application. Let’s create our own Absolute Beginner Hello World Android application, right here and
now. Just so that we do things as “out-of-the-box” as possible, we should call this application “Hello
Universe,” so that we can expand (no pun intended) on it as we move through this book. We will add
all sorts of impressive features that you might find across the universe, were you ever to visit one.

First, we will launch Eclipse, and create the application. Then we will take a look at all of the files that
Eclipse creates for us, as well as the Java and XML code that Eclipse generates to get your app up
and running. We will then examine in detail the resource folder hierarchy for the project structure and
see how Android (Eclipse ADT) wants us to structure our Android project assets (resources).

Finally, we will use the GIMP digital image editing and compositing application to create your custom
application icon. As you probably know, the Android application icon is displayed on Android
devices in the application launch icons area on one of the primary OS screens. After we create a
custom app icon, we’ll use the Nexus One Android Virtual Device (AVD) that we created in Chapter 2
via the Run As Android Application work process, which allows us to test and admire the new Hello
Universe app we are about to create.
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Using Eclipse ADT to Create a New Android App

The first step is to launch Eclipse 4.4 for ADT. From there, in the empty IDE you looked at in
Chapter 2, you will create your new Android project. This application infrastructure will “house”
your application’s Java programming logic, XML markup, and new media assets.
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1. To launch Eclipse, find and click the Eclipse shortcut quick launch icon,
located on your workstation’s Taskbar.
2. You will see the start-up ADT branding and loading progress bar dialog, and
then you will get a Workspace Launcher dialog, where you can set where
the workspace folder is located. | always use the default suggested location,
which is under the Windows Users folder. If you want to see a screen shot of
these aforementioned screens, see Figure 2-1, from Chapter 2.
3. Once you start up your new, empty Eclipse ADT IDE, use the File menu to
access a New sub-menu, and then find and select the Android Application
Project option (sub-sub-menu), as is shown in Figure 3-2. Once you select
this option, you will see the first in a series of five dialogs. These dialogs
will step you through the process of creating a new Android application
project infrastructure.
(#) Java - ADT - oIEN
File | Edit Refactor Source Navigate Search Project Run Window Help
New Alt+Shift+N » | (55 Java Project v vion ™|
Open File... &= Android Application Project 5 | |8 Java
Close Ctrl+W LA myect= [ O-
o= Outline &2 = 0
Close All Ctrl+Shift+W | fff Package
Save Ctrl+S © Class An outline is not available,
Save A & Interface
Save All Ctrl+Shiftes | & | Enum
Revert (@ Annotation
&Y Source Folder
457 Java Working Set
21 ¢S  Folder
2] Refresh F5 File
Convert Line Delimiters To » Z  Untitled Text File
Print... Ctrl+P a  Android XML File
Switch Workspace » [ JUnit Test Case Y = 0
S [3 Bxample.. 14M of 179M
g2y Import... Y Other.. Ctrl+N

Figure 3-2. Using a File » New » Android Application Project menu sequence in ADT
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4. The first dialog in the New Android Application Project series, seen in
Figure 3-3, allows you to define a name for your Android application
(seen in the app title bar and icon), and your project folder name. Type
“HelloUniverse” into the first field in the dialog, labeled Application Name.
When you do so, you will notice that Eclipse ADT “copy-types” this same
name into the second Project Name field below it.

© New Android Application - o IEE

New Android Application

Creates a new Android Application

Application Name:©| HelloUniverse
Project Name:® HelloUniverse

Package Name: 0 absolute.beginners.hellouniverse

Minimum Required SDK: @ API & Android 2.2 (Froyo) v
Target SDK:©| API 19: Android 4.4.2 v

Compile With:® APl 19: Android 4.4.2 v

Theme:©| Holo Light with Dark Action Bar v

Choose the lowest version of Android that your application will support. Lower APl levels target more
devices, but means fewer features are available. By targeting API 8 and later, you reach approximately 95% of
the market.

@)
i/

m

Next > Finisk Cancel

Figure 3-3. Name your application and select minimum and target SDK

The Application Name will be used inside of your app, and will be both shown in the title bar for your
application, as well as under your application’s launch icon, on the Android OS desktop.

The Project Name is not used inside your application, but instead is the name that is used by Eclipse
for the top folder in its Android application project folder hierarchy. If you want to look ahead, you
can see this on the left side (at the top of the hierarchy) of Figure 3-8.
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5. You will also define your application’s package name, absolute.beginners.
hellouniverse, using this dialog. The parts of a package name are separated
using periods, and a package name generally uses lowercase characters.
Since this is the Absolute Beginners book, and the HelloUniverse app, | used
absolute.beginners.hellouniverse for the package name. You’ll learn more
about Java packages in the next chapter, when we get into the structure of the
Java programming language and its various components in far greater detail.

The next four drop-down selectors in the middle of this dialog allow you to specify which API
versions of Android OS you want your application to support (run on), and what you want your
application to look like, which is controlled using something called a “theme” in Android, which we
will be looking at in Chapter 5.

6. The first of these drop-down selectors allows you to specify the Minimum
Required SDK, which will determine how far back (in version numbers) your
Android application support will go! | accepted the default Android 2.2 value,
as there are still a lot of Android 2.2 smartphones and Kindle Fire uses 2.3,
so 2.2 and later covers the vast majority of the Android devices out there.

Note If you wanted to see the exact percentage of the device market that each 0S version has at any given
time, you can use the Android developer web site “dashboard” feature, which tracks what percentage of each
0S version is being used by manufacturers on their Android devices. If you want to see these percentages
now, you can visit the following URL on the Android developer web site, where these statistics are

kept up-to-date: http://developer.android.com/about/dashboards/index.html

7. The second of these drop-down selectors allows you to select the Target SDK,
which is essentially the opposite of the Minimum SDK, as it sets the other end
of your app’s range of version support. This is usually set to reflect the latest
version of the OS that has been released, as that will be the most feature-filled
and have the fewest “bugs” or code that does not work optimally. We will set
our Target SDK to Android 4.4.2 API Level 19, since that is currently the latest
version and is what we have installed in Eclipse and for our AVD emulator.

If you are using Android 4.4.4, this will say APl 19: Android 4.4.4 in the drop
down menu.

8. The third of these drop-down selectors allows you to determine which API
(OS version) Eclipse uses to compile your application DEX file with, and as
you might imagine, this should match your Target SDK. This is because we
are allowing the Android Compatibility Library (which we saw in Chapter
2 in the Android SDK Manager) to provide the “backwards OS version
compatibility support” for the code we are writing, allowing us to develop
for the latest OS revision without having to create a plethora of OS version-
specific DEX files.
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Note If you looked at the dashboard on the developer site, you saw that Android 4.x has about an 88%
device share, and 2.3.x has the other 13% (Kindle Fire is the primary reason for this), so developing for
Android 4 0S is becoming more and more the primary target of Android developers. This makes development
considerations that you will be learning about during this book an order of magnitude easier than they were
when developers had to develop to span Android 1.x to 2.x to 3.x to 4.x to 5.0. Android 5.0 currently is in beta,
and is not in any hardware devices, so that 0S version currently has a 0% market share.

9. The final drop-down selector allows you to choose the Android OS theme
(look and feel) you will use for your app. We will cover themes and styles
in the Ul chapter, but suffice it to say you can choose a light (gray) or dark
(grey and black) app look and feel, using the “Holo Light” or “Holo Dark”
themes included with Eclipse. You can also develop your own themes once
you become more advanced in Android development. | simply accepted the
default setting of Holo Light with a Holo Dark Action Bar, which keeps your
application dark up by the black status bar at the top and uses a Light Gray
color for the body (everything else) of your application.

10. Now that these specifications are set, click the Next button, and proceed
to the second dialog in this series, the Configure Project dialog, shown in
Figure 3-4.



CHAPTER 3: An Introduction to the Android Application Development Platform I

(@) New Android Application - o IEH

New Android Application
Configure Project i )

[#] Create custom launcher icon
[#] Create activity

[ Mark this project as a library

Create Project in Workspace

C:\Users\Default.Default-PC\workspace\HelloUniverse

Working sets

[ Add project to working sets

\?J < Back _ Next > Finish Cancel

Figure 3-4. The Configure Project dialog, showing the default selected options

11. This dialog is much simpler and allows developers to select what the Eclipse
ADT will create for the new Android application project. You will select the
default settings for this dialog, which will create a custom launcher icon for
your application, which you will learn how to modify and upgrade a bit later,
and create an Activity class to hold your Ul design and Java code. Finally,
a Create Project in Workspace option will create the Android project for
you in your Workspace folder, in the location that you specified when you
started Eclipse ADT earlier in the chapter. This location is greyed-out as it is
a combination of your workspace folder path and that the project name you
specified in the first dialog.

We won’t be using multiple libraries for this Android project (mark this project as a library option), nor
will we be using working sets, an advanced feature that allows development of multiple versions of
an app at the same exact time (too advanced for Absolute Beginners, I’'m afraid; however, you can
research it on the developer site).

12. Once you click on the Next button, you will progress to the third dialog in this
series, which is the Configure Launcher Icon dialog shown in Figure 3-5.
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© New Android Application - o IEH
Configure Launcher Icon g
Configure the attributes of the icon set \
F & [l Cipae | [T EISh
oreground: | Image | Clipart || Text mdpi:
Image File: | launcher_icon Browse... |qu
hdpi:
Trim Surrounding Blank Space
Additional Padding: I - u
< > 0%
xhdpi:

Foreground Scaling: .Crop: Center

Shape .None. Square | Circle Iau
Background Color:

/?'\‘ F I
\{) < Back Next > _ Finish Cancel

Figure 3-5. The Configure Launcher Icon dialog, showing the default selected options

13. This dialog allows you to configure your Android application icon using an
Image, Clipart, or Text, select a custom image file, automatically trim blank
space around your icon, add additional padding, crop or center the icon,
and determine the shape of your icon and the background color used. Since
we are going to learn how to do all of this “from scratch” using XML and
GIMP, as well as related concepts such as alpha channel support, which
allows transparent areas around your icon, | am simply going to accept these
default settings. We’ll use the green Android robot for now as a placeholder
until I can show you how your you can access your application icon content
and settings from inside of your Android project.

14.  Once you click the Next button you will be taken to the fourth dialog in the
series, which is the Create Activity dialog, which is shown in Figure 3-6. This
dialog will allow you to specify what kind of Ul design your Activity class will
have installed in it, which will determine what Java code and XML mark-up
Eclipse writes for you.
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© New Android Application - o IEH

Create Activity p .
Select whether to create an activity, and if so, what kind of activity.

[#] Create Activity

Fullscreen Activity (W ~n
Master/Detail Flow

Blank Activity

Creates a new blank activity, with an action bar and optional navigational elements such as tabs or horizontal swipe.

\Z) < Back Next > Finish Cancel

Figure 3-6. The Create Activily dialog, showing the default Blank Activity selected option

15. Since you’re going to learn how to create your own custom Android Activity
class, as well as your own custom Ul design from scratch, | am going to

select the first Blank Activity option, after making sure that the Create
Activity checkbox is selected.

| am selecting this option so that you can see what the “minimum application bootstrap code” that
Eclipse ADT will write for you will include, so that you learn how to code an Android application

from the lowest possible level, and with the most control over Java code and XML markup that you
yourself put into place.

16. Once you click on the Next button, you will be ready to fill out the final dialog
in the New Android Application Project series of dialogs, where you will
specify names for your Java code (Activity class), XML markup (Ul design)
and a Ul navigation type. Let’s do that now so that we can take a look at
what Eclipse ADT creates for you using this series of dialogs, as that is really
where you will start to learn how an Android app is structured!
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17.  After you click Next you will get the Blank Activity dialog, shown in
Figure 3-7, where you will see the naming conventions for the “main”
(the app’s Home screen) Android Activity Name and Ul Layout Name.
| am going to accept the suggested names, and set the Navigation Type to
None so that we can create our own navigation!

() New Android Application - o IEE

Blank Activity v
Creates a new blank activity, with an action bar and optional navigational elements such as tabs or horizontal swipe. \

Activity Name® MainActivity
Layout Name® activity_main

Navigation Type® None v

4 The type of navigation to use for the activity

'C?:' < Back MNext > Finish | Cancel

Figure 3-7. The Blank Activity dialog with Activity Name, Ul Layout Name, and Navigation Type

You will see later (throughout the book) why | am accepting these suggested names and will be
following these naming conventions that they embody. For now, just accept that your main application
“home screen” is called “Main” and its Activity Ul definition is referenced as activity_main.xml. We
will soon see where this XML Ul definition file is kept, and we will even take a look at its contents, and
learn what it does, using XML markup.

18. Once you click the Finish button in the final dialog, the dialog will disappear,
and you will see a formerly blank Eclipse ADT IDE filled with a complete,
working Android application project, as shown in Figure 3-8.



CHAPTER 3: An Introduction to the Android Application Development Platform 75

Lt ] Java - HelloUniverse/src/absolute/beginners/hellouniverse/MainActivity.java - ADT =5 n
File Edit Refactor Source MNavigate Search Project Run  Window Help
i BE MR B -0 ARG Fr® P OOy ] Quick Access | 8| Py
[2 Package Explorer 22 |51 ¥ = 0O [4] MainActivityjava &3 = = 5 Outline 13 =
4 125 HelloUniverse package absolute.beginners.hellouniverse; A =18 W W e W
4 [ src import android.os.Bundle; &

) absolute.beginners.hellouniverse

4 1 absolute beginners hellouniverse import Aar d.app.Act © MainActivity
LAfibdsane ety o i = e ~ onCreate(Bundle)

s gen [Generat =g public class MainActivity extends Activity { ® .. onCresteOptionsMenu(Meny)

B4 Android 4.4.2 gUverride

= Android Private Libraries - protected vold onCreace (Bundle savedInstanceState) {

assets reate (savedInstanceState);

: - bin tView(R.layout.activity main);

= libs

4 j:‘ = public boolean onCreateOptionsMenu | menu) {

d) AndroidManifestml getMenuInflater().inflate (R.men

ic_launcher-web.png retarn tros:
[2) proguard-project.t 3
[B project.properties } -
< >
= > [2 Problems &3 capm
absolute.begi hell MainActivity java - HelloUniverse/src 105M of 297TM i)

Figure 3-8. The bootstrap Android application MainActivity.java Java code for Activity, Bundle, and Menu

Eclipse has created a HelloUniverse project folder and sub-folder hierarchy (structure) as well as
opened up your Java Activity class in a currently active (selected) tab and your XML Ul definition

in a currently inactive (ghosted or deselected tab), as you can see in Figure 3-8. There is also a
“bird’s-eye view” of your Java code hierarchy in an Outline pane on the right. The Package Explorer
pane on the left is used to navigate the project infrastructure, as you are about to do next, so that
you can learn about what assets go where in an Android application project!

We will be getting into what the Java code in the Eclipse central Editing pane does in the next
chapter, so for now, let’s focus on the Package Explorer pane and learn how to use that to navigate
our Android project structure. As we do this, we will take a look at the various sub-folders and
what components of our Android application need to be stored in certain sub-folders. One of the
things you need to do to become an Android developer is to learn how Android projects need to be
organized. It’s really too bad there is not “forced organization” in more areas of our lives, because
as you will soon see, Android is organized in such a way that it forces your app development to be
surgically precise!

Navigating Around an Android Project

To close an open folder, such as the /HelloUniverse/src/absolute.beginners.hellouniverse/ folder,
containing your MainActivity.java file, shown highlighted in Figure 3-8, click on the downward-right
pointing arrow at its left, called a collapse arrow, and it will close the folder, and will then display a
right pointing arrow, called an expand arrow, instead of a downward-right arrow.

Conversely, to open up any folder, click the right pointing arrow, and it will reveal what is inside or
underneath this folder, which will always be either another folder structure and/or a file or series
of files. Let’s do this to open your Android project’s resource folder, named /res, which is shown
opened up in Figure 3-9.
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Figure 3-9. The bootstrap Android application activity_main XML mark-up, and project folder hierarchy

As you can see, there are a number of different types of folders present, which start with specific
names, such as drawable (image, animation, text, or shape assets), layout (Ul design XML
definition assets), menu (menu design XML definitions) and values (value constants that define text,
dimensions, styles, and themes).

You can also add other types of Android application project asset folders to this project folder
hierarchy, which we will be doing over the course of this book, when we add assets such as digital
video and animation to our HelloUniverse Android application project. Since these folders need to
have specific names, which indicate the type of assets as well as their functionality to the Android
OS, | will outline what these different asset folder types (indicated by the asset folder names) and
naming conventions are within the next section of this chapter. | will provide them here in a tabular
format in Table 3-1, just so that you have an overview of where everything goes in your Android
project folder hierarchy first.
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Table 3-1. Android Project Directory (Folder) Hierarchy, Showing the Key Sub-folders We Will Be Using in this Book

Project Sub-Folder Name: What application assets this sub-folder will contain:
/src Java source files (your Java programming logic)

/res Project resources (your XML markup definitions)
/res/drawable Digital image and digital illustration assets
/res/anim 2D animation assets (procedural or tween animation)
/res/raw Digital video and digital audio assets

/res/values Data values which remain fixed, called “Constants”
/res/layout Ul design layout definitions

/res/menu Application menu structure design definitions

Android Resources: Asset Project Folders

If you want to add custom animation, custom themes, digital video, and digital audio to an Android
project, you will have to add new folders to your project folder hierarchy. You will be learning how to
do this during the course of this book, as you learn about how to create and add in these types of
assets to your Android application.

For now, however, | just want to give you an overview of the different folder types and names that
are possible to have in your Android application projects. This is so that you have a high-level view
of what is possible in Android development as well as the types of Android assets you are going to
learn how to incorporate during this book.

Your external new media assets (that is, those primarily created outside of Android, using software
like GIMP and Blender 3D) are kept in the resources folder, shown in Figure 3-9 opened up to show
all the sub-folders, and referenced as HelloUniverse/res. Other resource assets that are external
to your Java code and XML markup such as constants, styles, themes, and user interface layout
definitions, are also kept in this folder. Externalizing resources allows your Android development
process to be more modular by nature, and to be more organized.

There are many different resource types in Android, and they either have their own sub-folders, under
the /res/ project folder, or their own files, under the /res/values/ folder. We will go over the majority
of these in detail in the next eight sections of this chapter. Primary types of resources include:

drawable resources (graphic)

layout resources (user interface design)
menu resources (menu navigation)

values resources (constant definitions)

raw resources (video and audio files)

xml resources (configurations and definitions)
string resources (text values)

color resources (custom colors)



78 CHAPTER 3: An Introduction to the Android Application Development Platform

dimension resources (dimensions and units of value)
bool resources (boolean true or false values)

integer resources (numeric constants)

array resources (collections of data values)

You can also provide something called alternative resources in the application project folder
hierarchy. These alternate resource folders provide support for a wide array of device types or
physical hardware specifications by grouping new media assets, user interface designs, and style
and theme definitions into specifically named alternate resource folders. The /res/values-sw600dp/
folder in Figure 3-9 is an example of an alternate resource folder, and holds assets that are specific
to your application design for 600-pixel or greater screen dimensions. We’ll be covering alternate
resources as they relate to Ul layout design a bit later on in this book.

At runtime, which we learned all about in the first part of this chapter, Android OS uses an
appropriate resource, based on the device’s hardware specifications. As an example, if you want to
provide different Ul design layouts that morph, or change based on the physical screen size, shape,
or orientation (portrait or landscape), you can define different Ul layout designs using different layout
folder names, such as /res/layout-land for a landscape-specific Ul layout design, or /res/layout-port
for a portrait-specific Ul layout design. We will be looking at all of this in greater detail in a future
chapter on Ul design principles and techniques.

As another example, you could define different string (a collection or array of text characters) values,
which would be evaluated at runtime based on the language setting on the end-user’s Android
device. As you can see, there is a reason for the way Android organizes resources, and one of the
major reasons is so that developers can create alternate resources (alternate resource folders) that
can be accessed at runtime based on Android device characteristics. As this book progresses, | will
show you how to reference and access these external resources from within your Java code and
XML mark-up. We will get into how to set up alternate resource folders in the chapters covering user
interface design, themes, and styles. Let’s look at drawables next!

Android Drawable: Assets that Draw to a Screen

A “drawable” in Android is aptly named, as it is anything that can be drawn to the display screen. As
you can see in Figure 3-9, Eclipse ADT created five /res/drawable subfolders, named drawable-Idpi,
drawable-mdpi, drawable-hdpi, drawable-xhdpi and drawable-xxhdpi for your use. It is
important to note that as of Android 4.2, there’s also an xxxhdpi resolution density that has been
added to Android to accommodate the new Ultra High Definition (UHD) (or Ultra High Density, in
this case) displays, such as those found on 4K TVs, which have a 4096 by 2160 resolution, or the
screen on the new Samsung Galaxy S5, which has a 2560 by 1440 pixel resolution screen. From
smartwatch (Idpi) to 4K TV (xxxhdpi), Android has a density constant to fit any device!

You will be learning all about pixels and resolutions in Chapter 9, covering graphic design, but to
give you an overview here of what these different DPI levels are for Android’s screen resolution
density constants, | have put all of the density constant data together here, in Table 3-2, for those of
you who are already “pixel savvy.”
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Table 3-2. Android Device DPI: Seven Levels of Pixel Density Constants Specifically Supported in Android

Android Device ~ Screen Size  Pixel Pixel Minimum Launcher Action Bar Notify Icon
DPI Constants Constant Density  Multiplier ~ Screen Size Icon Size Icon Size  Size
Currently in the in DPI Index in Pixels

Android 0S

LDPI small 120 0.75 426x320 36x36 24x24 18x18
(Low Density)

MDPI (Medium) normal 160 1.0 470x320 48x48 32x32 24x24
TVDPI HDTV 213 1.33 640x360 64x64 48x48 32x32
(HD 1280x720)

HDPI large 240 1.5 640x480 72x72 48x48 36x36
(High Density)

XHDPI xlarge 320 2.0 960x720 96x96 64x64 48x48
(Extra High)

XXHDPI xxlarge 480 3.0 1280x960 144x144  96x96 72x72
(Super High)

XXXHDPI xxxlarge 640 4.0 1920x1080 192x192  128x128 96x96
(Ultra High)

As you can see in Figure 3-9, | opened the first drawable-hdpi folder for you to show the ic_launcher
graphic file, which the Configure Launcher Icon dialog shown in Figure 3-5 created for you in four
different resolution density versions. If you are wondering what the pixel dimensions are for these
ic_launcher files in the drawable subfolders that have arrows next to them (which indicates that there
are files in the folders), take a look at the sixth column in Table 3-2. So the ic_launcher graphic |
exposed in the drawable-hdpi folder is 72 by 72 pixels.

There are about a dozen different types of drawable objects in Android, each of which has

their very own class. Some of the more important drawable types include: BitmapDrawable,
ShapeDrawable, NinePatchDrawable, AnimationDrawable, LayerDrawable, TransitionDrawable, and
StateListDrawable, to name a few. | will try and implement as many different types of drawables as |
can during this book, so you will be well-rounded (no pun intended) when it comes to using graphics
(drawables) in Android application design and development. If you wanted to dive into these graphics
classes at a pro level, check out the Pro Android Graphics title, by Wallace Jackson (Apress, 2013).

There are several types of drawable assets that will need to be placed in the drawable folders
for these assets to be visible to, and accessible to, the Android application. The primary one is
Bitmaps, which we will be covering in Chapter 9, as well as media assets that are based upon
(created with) Bitmaps, such as Frame Animation. Any assets that reference Bitmaps or Frame
Animation in an XML definition file format would also be kept in this folder, as would any XML
definitions creating Shapes (2D vector graphics).
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Note Vector graphics are defined using math instead of pixels; if you’re familiar with Adobe lllustrator (.Al files)
or Scalable Vector Graphics (SVG files) then you are probably familiar with the distinction between pixel-based
graphics (Photoshop and GIMP) and vector-based graphics (lllustrator and InkScape). | may have dropped the
ball in Chapter 1, as | didn’t have you download and install a vector graphics program! Google InkScape and go
download this and install it, if vector graphics is an area that interests you (or just to get free software)!

Android Layout: Assets that Lay Out a Ul Design

A “layout” in Android is also aptly named, as it is a definition of how your user interface elements
and drawable assets are going to be “laid out” relative to each other on the Android device display
screen. Once we get you up-to-speed on Java, in Chapter 5, you will be learning more about Ul
layout design during the rest of this book!

Chances are, if you want your Android app to have a custom design for each type of device (iTV,
smartphone, tablet, smartwatch, and so forth), you are going to have a number of custom /res/layout
folders, not just a /res/layout-land and /res/layout-port folder, as | gave as an example earlier. You
probably will have complex alternate resource folders as well, such as /res/layout-sw800dp-land
for tablets and /res/layout-sw240dp-port for smartwatches.

The /res/layout/ folder, and any custom layout alternate resource folders that you create, will
generally contain Ul layout definition XML files. As you will see in Chapters 6 through 8, and over
the rest of the book, Ul layouts in Android are defined using XML layout definitions. These are
hand-crafted by using XML markup, and stored in filenamehere.xml files in the /res/layout folder or
one of the alternate layout resource folders that you create.

Since we are going to look at the XML for the Ul layout that Eclipse created for us earlier in the
chapter, and because we have a couple of chapters coming up specifically covering Ul layout
design, | am going to leave the /res/layout/ folder coverage at that, and move on to look at some of
the other resource folder types next. If you are interested in the concept of alternate layout design
folders, you can find in-depth coverage on the Android developer web site at the following URL:

http://developer.android.com/guide/topics/resources/providing-resources.html

Android Menu: Assets that Define Menu Options

A “menu” in Android is exactly what it says it is, and what you would expect it to be: a menu, or a list
full of options, for your end-users to select from in order to navigate around your Android application
infrastructure.

There are several different types of menus in Android, including pop-up menus, context-sensitive
menus, and options menus. We will get more into menu design as we progress through this book,
adding menu items to your application’s menuing system. We will start this process during the next
chapter when we customize the default menu XML markup and Java code that Eclipse ADT’s New
Android Application Project series of dialogs created for you.

Technically, the Android menu that your application uses, via a hardware MENU button on the
Android device, or via those three vertical dots on the Action Bar at the top of an Android device
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(if there is no hardware MENU button) is called the Options Menu. The Status Bar is always at the
very top of every Android device, and holds the battery power indicator, network mode (3G, 4G, 4G
LTE, and so forth) indicator, signal strength indicator, and similar hardware operation indicators.

The Action Bar is located just underneath the Android Status Bar, which is the top-most OS bar
containing your signal meter and the like. In addition to the options menu, accessed by those

three vertical dots on the right end of the Action Bar, the Action Bar contains your application icon,
application title, and if you code it correctly, either icons or text tabs that can access areas of your app.

The /res/menu/ folder contains XML definitions of the menu structures that you create for your
application, as you may have imagined. Notice in Figure 3-9 that Eclipse ADT created a default menu
XML definition for you, in a file called main.xml. Notice the file naming convention here; the main.xml
menu XML definition, and the MainActivity.java and activity_main.xml layout XML definition all
match up, so you know they are related!

Android Values: Assets Defining App Constants

A “value” in the Android project folder hierarchy is what is known in Java programming as a
“constant.” Values in Java code are different than Java constants, as they are meant to change,
whereas constants are meant to stay the same (that’s why they’re called constants). We will be
getting into this distinction as far as Java goes soon, in Chapter 5, when we look at the Java
programming language specifically. You will, of course, be required to understand exactly how Java
works before we get much further into the book, as things will get more and more complicated with
each chapter.

Android values (constants) are a bit more flexible than Java constants are, as Java constants
define fixed (known as immutable) data values that cannot be changed, whereas Java values can
be changed at runtime. The Android values we are talking about in this section also cannot be
changed (they are actually constants, but are called values). So make sure not to get confused by
semantics here. Of course, once your Java code places these initial constant values into memory,
the application code (logic) may change them!

Let’s examine the /res/values folder from the current application bootstrap project in more detail.
This is where you (or Eclipse, in the case of the New Android Application Project series of dialogs)
will place any predefined application values. These exist inside of (underneath) the /res/values/
folder in the form of XML files. These XML files contain constant definitions that define constant
names (x or y, for instance) and their data values.

The value constants that are defined inside of these XML files will later be referenced inside of your
Java code, or via your XML markup. For example, these values might be strings (a collection of text
characters), styles (how you want a Ul design to be formatted throughout your app), dimensions
(numeric size specifications), or other constants that need to be “hard-coded” values that your Java
code or XML markup uses in your program logic or Ul design that you do not want to change.

The logic behind having a /res/values/ folder involves holding all of your constant values for your
application in one place. This is a similar concept to the repository we used in Chapter 2 to update
Eclipse ADT, only the /res/values is a resource repository for value constants which are used in your
Android application. The /res/values/ folder is therefore your application constants repository data
(folder) structure, and its usage allows you to make your application constant changes in one single
location. In this way, if you need to adjust your constant values during application development or
testing, you can do this using XML files.
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Figure 3-9 shows three examples of the types of constant value files that you can place into this
values folder:

dimens.xml: An XML file that defines dimension values, such as standard
heights or font sizes for your Ul. You can then use these values across your app,
to ensure it is consistent.

strings.xml: An XML file that defines text strings that are used in your
application. For example, you can place any screen titles, or the app nhame, here
and reference these in your code. If you need to change or refine these items in
the future, you simply do it in this one central location, rather than in your Java
code or XML markup.

styles.xml: An XML file that defines Ul design styles you can use across your
application. These styling constants will be applied to the Ul elements that
reference the style constant definitions, allowing you to separate the look and
feel of your app from the physical layout and Ul functionality. This makes your
app easier to refine, change, and enhance over time.

Some of the other types of value constant XML definition files you could create and place in your
Android project’s /res/values/ folder might include:

arrays.xml: An XML file that defines a series of data value constants that
are intended to be utilized together (known as an array) in your application.
For example, this could be a list of icon files, a list of graphic layers, or a list of
options to display to the user.

integers.xml: An XML file that defines constant numeric integer constant
values that will be used in your Java programming logic in your application.

bool.xml: An XML file that defines Boolean constant values (true or false) that
will be used for the default (initial) setting for the states (like switches) in an
application. Examples of these would include states such as on or off, yes or no,
visible or hidden, and so on.

colors.xml: An XML file that will define the color constant values to be used in
the app. These allow you to standardize the Ul. For example, you could define
your app’s background color as a constant. Then, if you decide to tweak it later,
you need to do the tweak in only one place and the change is implemented
across your entire application. We will cover color theory and hexadecimal color
values in more detail in Chapter 9, which covers graphic design.

Notice that Android uses certain file naming conventions for the different types of XML files in the
/res/values/ folder, adding another level of complexity. It is important to note that you can also
create your own customized XML files and file names in this folder, so you are not limited to the
constant types that are discussed here. Next, let’s cover the folder names that Eclipse ADT did not
automatically create for you, and that you can optionally utilize to contain other asset types such as
animation, digital video, digital audio, and XML data.
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Android Anim: Assets Defining Tween Animation

Besides frame animation, also known as bitmap animation or raster animation, Android OS also
supports vector animation, which it terms tween animation. This type of animation is what is
known in the industry as procedural animation, and is created using Java code or XML markup
parameter definitions rather than by “flipbooking” through a collection of images (frames) to create
an illusion of motion.

Whereas Bitmap Animation in Android uses the BitmapAnimation class, Tween Animation in Android
uses the Animation class, and thus the proper folder to contain resources or assets related to
procedural animation is not the /res/drawable/ folder, but instead the /res/anim/ folder, which you
will have to create in order to utilize this type of animation in Android. Fortunately we will be covering
this in Chapter 10, so you’ll create this folder then.

Android Animator: Asset for Property Animation

There is a third type of animation in Android, called property animation, used to animate
“properties” or “parameters” for any of your Ul widgets or even your entire Ul design. You can

use this to obtain impressive special effects that entice your end-users. Property Animation XML
definition files are held in the /res/animator/ folder, and reference the Ul elements that you want to
animate as well as To and From values.

Android Raw: Pre-Optimized Video & Audio Files

The /res/raw/ folder in Android OS holds your application’s “raw data.” Raw data in Android is not
optimized (touched) in any way by the Android OS, it is simply played back (usually streamed) from
this folder “as-is.”

This is the folder that you want to contain your new media assets for which you have taken the time
to optimize the data footprint (file size) to quality ratio. This would be done outside of Android using
software packages such as Audacity or Lightworks, both of which you downloaded and installed
during Chapter 1.

We will be looking at how to create and leverage this /res/raw/ folder a bit later on in this book,
during Chapters 11 and 12, where | will cover the Android MediaPlayer and MediaController classes,
as well as how to create and play back digital audio and digital video new media asset resources
using this particular resource folder.

Android XML: Arbitrary XML and Configurations

The last resource folder that you should know about is the /res/xml/ folder, which is used to contain
XML files that specify configuration parameters that are external to (outside of) the scope of your
Android application, possibly relating to certain device hardware or similar. This folder can also
contain custom XML files that have nothing to do with the Android application creation process, but
that are “parsed” (read in) by your Android application using the Resources.getXML() method call.
We will cover Java method calls in Chapter 5.
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Creating a Custom App Launch Icon

One of the first things that any Android application developer wants to learn how to do is to create
their own custom Android application launch icon for the Android OS desktop. This is because this
icon represents the branding for the application, so let’s learn about how to do this here, using the
open source GIMP digital image editing and compositing software.

Creating a Launch Icon for Each Screen Density

The final thing that we are going to do in this chapter is give our application what Android OS terms
a launcher icon. This is your application icon that will show up on your users’ Android devices.
Your users will use this to identify and then launch your Android application. This process is not as
easy as you might imagine, so | am going to show you how to create custom launcher icons for
every resolution density display screen type. We will do this using the GIMP 2.8.10 software that you
installed on your workstations back in Chapter 1.

We will leverage what you have learned so far about defining alternate drawable resources by
creating a custom icon in four different versions targeting medium (using the mdpi or MDPI
constant), high (hdpi or HDPI), extra high (xhdpi or XHDPI), and super high (xxhdpi or XXHDPI)
density resolution screens. It is important to note here that you can write constant values in Android
OS either using all lowercase or all uppercase characters.

We will be modifying (updating or replacing) the appropriate launcher_ic.png files into their correct
alternate drawable density resolution folders. These folders were provided by the New Android
Application Project series of dialogs we encountered in the first part of this chapter.

By using these alternate drawable resource folders, we can assure that Android will automatically
find and use the correct launcher icon image asset resource for mainstream types of Android device
screen size and density:

/res/drawable-mdpi for normal size, Medium Density in Dots Per Inch
(MDPI) displays

/res/drawable-hdpi for large size, High Density in Dots Per Inch (HDPI)
display screens

/res/drawable-xhdpi for extra large size, Extra High Density Dot Per Inch
(XHDPI) screens

/res/drawable-xxhdpi for super large, Extra Extra High Density Dot Per
Inch (XXHDPI)
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Not surprisingly, you do this by giving your icon an exact name and file format, and putting it into
an exact directory. When Android finds an icon file there, it automatically puts it into play as your
application’s icon. These files must follow these rules (defaults) precisely:

Be placed in the correct /res/drawable-dpi folder, which holds all of the drawable
resources for that screen density resolution

Be named launcher_ic.png (we will learn how to change this in the next chapter
on XML)

Be a PNG file with an alpha channel (transparency), so that the icon overlays on
any system background wallpaper seamlessly

In this section, I’ll use my 3D company logo and an Android green hue, but you can use any image
that you like. Also, | will use GIMP 2.8 for this image editing example, since all readers will have it
installed, but you can use any image-editing program you prefer, such as Photoshop CS6 or Corel
Painter. So let’s fire up the GIMP software package that we installed in Chapter 1 and create a PNG
file with transparency. We will be getting into transparency (alpha channels) in detail in the graphic
design chapter later on in the book.

Creating Transparency: Edit the Image in GIMP

The first thing we need to do is to put the logo onto a transparency layer, and remove the white color
from the current graphic design. Here are the steps to remove the white background from the Mind
Taffy Design logo:

19. Use the GIMP File » Open menu sequence to open the
MindTaffyLogoAndroidGreen.gif logo file. The graphic image is currently 200
by 200 pixels, and is actually the first frame of an Animated GIF file that is
utilized on my WallaceJackson.com web site

20. Select the “Select By Color” tool (fifth in the toolbar) and set the tolerance at
15 (bottom-middle tool tab for Select by Color tool settings) and the Select
By to Composite. Make sure the Anti-Aliasing option is checked as well and
then click the white area to select it, as shown in Figure 3-10.
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Figure 3-10. Logo open in GIMP including a Layers tab (left), Select by Color icon (middle), and settings

21. Right-click in the white area in the layers tab (upper-left, under the blue
in Figure 3-10) that is directly underneath the selected layer showing the
MindTaffyLogoAndroidGreen.gif image that you opened in Step 1, and select
the “New Layer” option to open the New Layer Dialog shown in Figure 3-11.
Name the layer “Transparency,” accept the size defaults, and click OK.
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Figure 3-11. Create a New Layer dialog

22.

Choose the Select Menu, and then the Invert menu option, shown in

Figure 3-12. This will “invert” the selected white areas, deselecting them and
instead selecting the logo itself. This cool technique will allow you to easily
grab only the logo, since before only the white (non-logo) areas were selected,
and therefore after the Invert operation only the logo pixels (non-white-area)
are selected. The moral of this story? It’s easier for the selection tool to

select the (simple) contiguous white areas in the image than the complex
shading gradients in the logo, so the proper work process is to actually work
“backward,” or in reverse!
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Figure 3-12. Use a Select » Invert menu sequence to invert the selection so it selects the logo instead of white areas

23.

Next, select the GIMP Edit menu, and then the Copy menu option shown

in Figure 3-13. This will copy the currently selected logo image data to the
clipboard. This is because the GIMP copy operation looks to see if there is

a selection, and understands that if there is, that your intention is to copy
the pixels inside of that selection area. It is important to notice the yellow
pop-ups in many of these GIMP screenshots. These will appear in GIMP
when you have your mouse over an icon, menu option, or tool setting, and
they will tell you precisely what that GIMP Ul element will do! | have included
these pale yellow pop-ups in my GIMP screenshots during in chapter in
order to make it easier for you to follow along with the work process we are

learning about.
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Figure 3-13. Use the Edit » Copy menu sequence to copy the selected logo pixels to the system clipboard

24.

25.

Click on your Transparency layer on the left, which will select it (the layer will
turn blue), if it is not selected already. You need to select this layer in order
to paste the selected and copied logo above it. This is because the paste
operation puts data above a currently selected layer, and not below it. If you
left the original graphic layer selected, and then pasted, your transparency
would be above your logo data, and not underneath it!

Next, hit the Ctrl+V keystroke combination, to paste the pixel data from the
clipboard, or you can access the Edit menu and the Paste menu option,

if you prefer a more visual work process. To see your logo on top of the
transparency, you will need to click on the Eye Icon (turns a layer visibility on
or off) next to the original MindTaffyLogoAndroidGreen.gif layer at the bottom
of the layer stack. Once you do this, all that will be showing in your primary
GIMP preview area on the right is the Transparency layer that you created
earlier and the floating selection (the logo-only pixels that were copied from
the clipboard memory) that you just pasted into the floating selection layer.
The results of this work process are shown in Figure 3-14.
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Figure 3-14. A floating selection layer over a Transparency layer; deselecting the original layer visibility

Note If you save out the file with GIMP configured in this fashion, what you see in the primary display area
will be saved into the new target file that you specify, which we will be doing after we scale this graphic
image to match the launcher icon size “rules” that | outlined in Table 3-2 earlier in this chapter. Once we do
this scaling, you will be ready to save out your new app launch icons.

26. Now that we have the launcher icon image in the transparent format we’ll
need in order to “composite” it (that is, to blend it seamlessly) with any
Android desktop out there, we will use the Image menu and its Scale Image
menu option, shown in Figure 3-15, to turn this 200 by 200 pixel source
image into the Android-specified (required) target icon image sizes. If you
remember from Table 3-2, the launcher icon sizes include 144, 96, 72, 48,
and 36 pixels and you will need to use these icon sizes in your alternate
drawable resources folders that Eclipse ADT created for you earlier in the
chapter.
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Figure 3-15. Use the Image » Scale Image menu sequence to scale the 200-pixel graphic to be a 144-pixel icon

You have successfully finished the transparent Android launcher icon work process, in only eight
steps. This is the basic work process necessary to extract your icon graphic elements and place
them onto a transparent background.

Next, we will take a look at the work process to create all of the required resolution density assets
(MDPI, HDPI, XHDPI, and XXHDPI; LDPI and XXXHDPI are not currently required) that you will need
to have in place in order to properly support the wide range of Android consumer electronics devices
in the marketplace, ranging from smartwatches to smartphones to eBook readers to tablets to
laptops to iTV sets to 4K iTVs and probably beyond!

Creating Resolution Density App Launch Icons

To create the launcher icons needed for your Android application, we will use the GIMP Image
Scaling Algorithm to “downsample” the 200 pixels in the current “source” image to the 144-,
96-, 72-, and 48-pixel resolution “destination” images that we need for the alternate resource folders.

Use the Image » Scale Image menu sequence to do this in GIMP, as shown in Figure 3-15.
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This menu sequence accesses the GIMP Scale Image dialog, shown in Figure 3-16, that allows us
to specify what image size to which we wish to scale our Image down. In this first case, this is a
144-pixel image, which we need for our /drawable-xxhdpi/ resource folder location.
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Figure 3-16. The Scale Image dialog with the settings for XXHDPI on the left, and for XHDPI on the right

As you can see, you will need to choose an Interpolation Algorithm. In GIMP, the “Cubic” (known
as Bi-Cubic in Photoshop) interpolation algorithm will yield the highest quality level, so you will
always want to use this particular algorithm. This is why GIMP 2.8 has this set as its default
selection. GIMP 3.0 will be adding powerful new scaling algorithms, so make sure to get it when it
becomes available!

Once you set your scaling parameters, click the “Scale” button to commit the scaling operation, and
scale your 200-pixel source image into a 144-pixel extra extra high density Android device icon!

The technical term for scaling an image down in size is called “downsampling.” In this particular
case, we are downsampling an “indexed” or 8-bit color image, which is why you see the “GIMP
Lightbulb” notification at the bottom of the Scale Image dialog shown in Figure 3-16.

This notification tells us that our image (and thus its layers) is using 8-bit indexed color depth, and
that the Cubic interpolation will only affect RGB color channels (which we learn about in the graphic
design chapter) and layer masks (transparency or alpha channel data, which our current image
composite does indeed use). So we still need to specify Cubic since we are using a layer mask

(an area of transparency) in our floating layer!

We will learn more about digital image concepts and terminology in an upcoming chapter on graphic
design, where we will be creating “truecolor” PNG image assets and a truecolor application launcher
icon, so that you will have experience working with 8-bit color, 24-bit color, and 32-bit color imagery
in the Android OS.
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Next, we will want to save this new 144-pixel image data into the launcher_ic.png file in our drawable
resource folder to replace the standard green Android robot “placeholder” image that we had Eclipse

ADT generate for us earlier in the chapter.

27. In GIMP, use the File » Export or the File » Export As menu sequences.
The Export option in GIMP allows image data to be “saved out” using image
formats other than GIMP’s own XCF format, which is what you will get in
GIMP if you use the File » Save or File » Save As menu sequences. Since
Android uses PNG format (among others) but does not (yet) support the
XCF format, we will be using the File » Export As menu sequence shown in

Figure 3-17.
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Figure 3-17. Use the File » Export As menu sequence to export your downsampled icon to your project folder

Also notice that our transparent logo icon graphic has been scaled down from 200 pixels (shown on
the right-hand side of the screenshot). The Cubic interpolation algorithm has done a great job, as the

logo still looks really clean!
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28. In the File Export dialog, use the Places Navigation Pane (located on the
left side of the dialog), and find your workspace folder, the HelloUniverse
project folder, and the alternate drawable resources drawable-xxhdpi target
folder, as shown in Figure 3-18, in the dialog that is numbered one, at the

top, next to Save in folder.
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Figure 3-18. An Export Image dialog, the file overwrite warning dialog, and Export Image as PNG dialog

29. Once you have the correct path diagrammed at the top of the GIMP Export
Image dialog, as you can see in Figure 3-18, (mine was C:\Users\Default.
Default-PC\workspace\HelloUniverse\res\drawable-xxhdpi), click the
ic_launcher.png file that will be showing in the central area of the dialog.
This is the launcher icon that was auto-created for you previously, during the
New Android Application Project series of dialogs. Once you click the
ic_launcher.png file to select that file for replacement with the new icon
asset you have just created, it will turn blue and you will see an image
preview of what is inside of the file on the right-hand side of the dialog.

30. When you click ic_launcher, that filename will be placed automatically in the
top Name field, and the Save in Folder field will still show the proper path for
saving (overwriting) this file to your drawable-xxhdpi folder on your C: drive!
Once everything is configured correctly, click on the “Export” button to save
out (to overwrite) your custom XXHDPI icon, which will replace the generic
green Android robot that ADT auto-created earlier.
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Once you click on Export, you will get two dialogs shown on the right side of Figure 3-18, the first
confirming that you want to replace (overwrite) the existing ic_launcher.png launcher icon, and the
second requesting File Export Image as PNG settings. These settings pertain to features supported
by the PNG image file format.

To create the other three resolution icons, rather than going through the entire work process outlined
previously from scratch, let’s take a clever shortcut that involves the Edit menu and the Undo menu
option, which is shown in Figure 3-19. This work process will save you almost a dozen iterative steps
of production work!
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Figure 3-19. Use the Edit » Undo Scale Image menu sequence to revert to your original 200-pixel image

All you need to do is utilize this Edit » Undo Scale Image menu sequence, redo the last couple of
steps (the image cubic scaling and the File Export dialog), and then do the same work process 3
more times to scale your original 200-pixel transparent image to 96, 72, and 48 pixels. Once you do
the rescaling, you will then do the File » Export and save (overwrite) your new launcher icon into the
XHDPI, HDPI, and the MDPI alternate drawable resource folders under your HelloUniverse Android
project master folder. This will replace the first ic_launcher.png file (Android robot) in each folder with
the required resolution density equivalent of your new logo launcher icon. We will be replacing this
later with a space-related truecolor (24-bit) HelloUniverse icon.
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It is important to make sure that you scale down, or downsample, from the 200-pixel image each
time you scale. So do a 200 pixels scale down to 96 pixels, a 200 pixels scale down to 72 pixels,
and a 200 pixels scale down to 48 pixels. The reason for this is because the resulting quality will be
significantly higher this way than if you utilized a work process where you scale from 200 to 144, and
then 144 to 96, and then 96 to 72, and then 72 to 48.

This is because the more data you give the original Image Scaling Algorithm, the better job it will do;
the algorithm will have more source image data to work with to create a good downsample quality.

Theoretically, to get the absolute highest-quality result, you would want to design your source
image assets for your launcher icons to be 864 pixels! This is the resolution that Google actually
recommends in their graphic design guidelines, because each of the Android launcher icon
resolutions is an even downsample mathematically of that number. If you want to create an icon for
the Sony SmartWatch or SmartWatch 2, you will also want to create a 36-pixel LDPI
launcher_ic.png file, and put that into the /res/drawable-Idpi asset folder.

Saving Your GIMP Composite: Native .XCF Format

The next logical thing to do before you spend a lot of time creating all of these resolution density
icons is to save your work using GIMP’s native .XCF file format. This file format will not only save
your image data, but it will also save the structure of your image compositing “stack” or “pipeline”
shown on the left side of GIMP in Figures 3-10 and 3-14 (and which is obscured by menus in all of
the other GIMP screenshots, unfortunately).

Use the File » Save As menu sequence shown in Figure 3-20 and save your GIMP project file on
your hard disk drive in your content production assets folder. Mine is called C:\Clients, and it has
sub-folders for each client.
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Figure 3-20. Use a File » Save As menu sequence to save a native GIMP file with your image composite layers

Now that you have saved all of your hard image compositing work, it is time to go back and utilize
what you have learned during this chapter to create all four (or five, if you are developing for LDPI
devices such as smartwatches or flip-phones) ic_launcher.png assets.

In case you are wondering why all of these are called ic_launcher.png, ic_launcher is what is going

to be referenced in your Java code and XML markup, and so that is the name you will need to use.
What prevents these files from overwriting each other’s different pixel resolution versions is the fact
that they are kept separate from each other in different folder structures.

Then, at runtime, which we learned about earlier in the chapter (it seems so long ago, doesn’t
it?), Android will evaluate what hardware device it is running on as well as the physical hardware
specifications of that hardware and decide for you what the optimal new media asset that you
provided would be best served for that device!

Repeat the Work Process for the Lower Density Assets

Now, let’s repeat the work process that you did to create your XXHDPI icon for the XHDPI, HDPI, and
MDPI launcher icons. If you are developing for smartwatches, you can also create an icon to use for

the 36-pixel LDPI density resolution specification. All of these resolution density folders have already
been created for you by the Eclipse New Android Application series of dialogs earlier in this chapter,

so hey, why not use them, and get in some much needed practice!
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Figure 3-21 shown the Scale Image dialog in GIMP, with the parameters needed for the HDPI and
MDPI icons.
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Figure 3-21. Showing the Scale Image dialog with the settings for an HDPI icon on the left, and MDPI on the right

Congratulations, you’ve just created a custom application icon for your HelloUniverse app, using
GIMP 2.8.10!

Summary

In this third chapter, you learned about how the Android platform is structured, and about how it
deals with the application at runtime, when one of your end users launches it on one of their many
Android hardware devices. You learned that as of Android 4.4, the Android OS now has two different
runtime environments, the Just In Time (JIT) Dalvik Virtual Machine (DVM) and the Ahead Of Time
(AOT) Android RunTime (ART) virtual machine (VM). You looked at the pros and cons of JIT and AOT
compilation as well.

Next, you learned how to create an Android 4.4 application bootstrap and Android project folder
foundation by using the New Android Application Project series of dialogs in Eclipse ADT. Then, we
took a look at the folders that comprise your Android application, most of which (besides your Java
source files /src/ folder) are application resource folders. We looked at the various types of resource
folders you can have in your Android app.
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Finally, we learned how to create a custom Android application icon, which is always a top request
from any new Android app developer. You learned how to use GIMP 2.8.10 to create a launcher icon
with a transparent background, and how to save it in all the required screen density resolutions. In
the next chapter, you will learn all about the XML markup language by taking an in-depth look at the
Android application that you created during this chapter, including the XML files in the /res/values/
folder as well as the /res/layout/ folder and the AndroidManifest.xml file from your HelloUniverse

project root folder.



Chapter

Introduction to XML.: Defining
an Android App, Its Design,
and Constants

In this chapter, we will take a look at how the XML markup language allows application developers,
and more importantly, application designers, to define their Android application’s user interface (Ul)
designs, styling, themes, constants, permissions, icons, activities, services, and how they function
within the Google Play e-storefront, all without having any knowledge of Java programming. Of
course, | am going to teach you Java programming in this book, starting with the next chapter, but
you could hire people to do just design and all they would have to know is how to use the XML
language we are going to learn about during this chapter. It is important to note that these same XML
concepts that you will be learning in this chapter apply to both the 32-bit Android 4.4 OS as well as
to the new 64-bit Android 5.0 OS, which you will learn how to develop apps for in Chapter 16.

In the previous chapter, you created the foundation for your HelloUniverse Android application using
Eclipse Android Development Tools (ADT) New Android Application series of dialogs. As part of this
new application creation process, more than a half-dozen XML definition files were created. We are
going to review all of these XML files during this chapter. We will do this so that you can learn the
basics of XML markup, and also to show you how user interface design, menu systems, text values,
styles and themes (global application styles), screen layout dimensions, and even your application
configuration, using the Android Manifest, can all be easily implemented using only XML markup.

We will again take a closer look at all of the basic Android application components during this
chapter, but this time, instead of doing this by looking at the Android application resource folder
structure, we will do this by looking at the AndroidManifest.xml file. We will be learning about

this Android Manifest XML definition file and its functions, structure, and its role in defining and
controlling how your application will work within the Android OS, as well as within the Google Play
e-storefront.
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It is important to note that this AndroidManifest.xml application characteristics definition file works
in exactly the same way, whether you are developing for 32-bit Android 4.x OS devices, or for 64-bit
Android 5.x OS devices.

As you progress in your knowledge of Android, in this chapter this will be your knowledge of XML,
you will continue to enhance the application foundation that you put into place in the previous
chapter into something that is truly impressive, learning every corner of the Android OS as well as
the Eclipse ADT Integrated Development Environment (IDE) in the process.

Extensible Markup Language: XML Overview

XML stands for eXtensible Markup Language. Extensible means that you can use it for whatever
you like (think customizable); you could create your own XML set of tags for any purpose that you
wish. It is a markup language because it uses simple “tags” to define what you wish to do. Most
of you will be familiar with another markup language called HTML, or Hypertext Markup Language,
which is used for creating HTML5 web sites and more recently for HTML5 application design.

Markup languages differ from programming languages in that they use tags, parameters (also
called attributes) within these tags, and nesting structures to accomplish tasks that a higher-level
programming language such as Java will implement using more complex programming structures,
such as arrays, loops, and methods. We will be getting into Java and these types of constructs in the
next chapter. You are really learning two programming languages, one that uses code, and the other
that uses markup, over the duration of this book.

The reason for this approach, that is, using XML for everything that could possibly be construed as
being design-oriented, is that using XML frees the members of your application development team
who are designing the application’s purpose, features, user interface, user experience, style and
theme, graphics, and the like, from having to learn, or even understand, how the Java programming
language works.

As you will soon see, when you compare this chapter to the next one on Java, XML markup is an
order of magnitude easier to learn and leverage than Java programming structures and concepts
are. For this reason, during this book, | am going to implement everything that | possibly can
using XML markup, so that | can get you to an intermediate level of Android 4.x and Android 5.x
application development in less than 700 dense pages of learning!

Although I'd like to take all the credit for this book being able to take you so very far from Absolute
Beginner to Android Developer, the primary reason that this is possible is because Google Android
OS developers allowed most of the advanced “front-facing” features, which allow you to ratchet up
the wow-factor of your applications, to be designed and implemented entirely using XML, using only
a line or two of Java programming logic!

Some examples of advanced Android design-related features that you can implement primarily using
XML markup “definitions” include: multi-state graphics, skinned Ul elements (custom graphic design
Uls), frame or bitmap animation, vector or tween (procedural) animation, user interface layout design
animation (Ul parameter animation), options menus, pop-up menus and context-sensitive menus,
dialogs, alerts, styles, themes, and more.

You can also implement less advanced design features using XML, including string (text) values
for your app, integer (numeric) values, state or status (boolean) values such as on or off, visible or
hidden, true or false, and screen spacing (dimension) values for your Ul designs. Arrays, which are
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collections of data used in your app (sort of like a simple database) can also be created and
loaded with their data values using XML files. All of this holds true for XML in 32-bit Android 4 and
64-bit Android 5.

XML markup is contained in simple text format files using an xml file extension. You can create
XML files in a text editor, such as Windows Notepad; however, most programmers usually use a
software editing tool with programming and markup design features, such as Eclipse, IntelliJ, or
NetBeans. These XML files can then be read or “parsed” by the Android OS or your application Java
code, and turned into Java object structures using the XML “definition” in each file.

XML Naming Schema: Tag & Parameter Repository

XML is comprised of “tags” and their “parameters.” Parameters are part of the tags, and are used
to configure and fine-tune what each of these tags accomplishes, as well as to reference any new
media assets, or text fonts, or color values, or styles, or themes, or other XML definitions, and similar
assets that might be required to “skin” or define how that application element appears to your users
on their display screen.

The XML tags and parameters that you can use in a particular framework, such as in Android
development, are specified using an XML “naming schema.” This definition of the XML tags and
parameters is stored in a centralized repository, similar to the one Eclipse accessed in Chapter 2,
when you did a Check for Updates function. That repository hosted the latest Android SDK version
and codebase, whereas the Android XML repository is located at a different URL location (a different
folder) on Google’s Android servers.

The reason that XML needs to have a naming schema is because this language is inherently
designed to be “extensible.” This means there is no “standard” version of XML; each version is
customized for some required implementation (end use) by whatever person or organization needs
to use it. In this case, Android’s XML has been specifically customized for, and implemented for, the
development of Android applications.

As an example, Android OS developers created the XML tag named <RelativeLayout> for designing
Relative Layout designs that ultimately use the Android RelativeLayout Java class and define
RelativeLayout objects. You’ll learn all about what classes and objects are in the next chapter
regarding the Java programming language.

The XML naming schema is referenced inside of each of your XML definition files, at the very top, so
that the XML markup inside of that file can reference its XML naming schema (the customized XML
specification) in order to make sure that all of the tags and parameters used in the XML definition are
up-to-date and “valid.”

This ability to reference the current XML tags and parameters definition (naming schema) is possible
due to the ability to check the XML in the file against the “master definition” represented by the
schema at the remote repository location, although Eclipse ADT does not do this in “real-time”
currently, so you do not need an active Internet connection to be able to develop your XML markup.
This process of making sure that your XML tags and their attributes or parameters are correct (in
conformance with the XML definition) is called XML validation, and it uses an XML naming schema
parameter to accomplish this XML validation.

In any custom extensible markup language, such as the one that has been created by Google for
Android, this naming schema URL reference needs to be contained in the first (outermost) “parent”
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tag. This parent tag will usually contain other “child” tags, which are “nested” inside of (underneath)
the parent tag. XML is so familial that way! The nesting of child tags, as well as tag parameters,

are more easily seen if the XML programmer uses indenting to show which tags are inside of other
higher-level (parent) tags, as you can see in Figure 4-1.
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Figure 4-1. The contents of the activity_main.xml file in the /res/layout folder in the Eclipse editing pane

Let’s take a look at the Relative Layout Ul design in the activity_main.xml file, which Eclipse ADT
created for you as a Ul layout foundation to start building your Ul design upon for the HelloUniverse
Android application.

As you can see in Figure 4-1, the first line of the parent <RelativeLayout> Ul layout container tag
has an xmins:android=http://schemas.android.com/apk/res/android parameter. This parameter
defines the XML naming schema repository for Android OS as being in the schemas virtual server,
on the android.com Internet address, in the /apk/ folder, in a /res/ sub-folder, and finally in an
/android/ sub-sub-folder.

In this case, the <RelativeLayout> container is the parent tag, and the xmins:android is one of the
parameters that configures this tag. This parameter will allow this parent Ul layout tag to reference
the XML naming scheme repository, and defines the prefix “android” as a short cut to reference

this repository. Note that just because it “references” the proper XML definition repository does not
mean that it is connecting in real-time to check this repository, as | pointed out earlier (it is used as a
unique identifier). As you can see inside of the <RelativeLayout> tag, there are a significant number
of parameters, a half-dozen of which start with android: and what this android: reference equates to
is defined by that first xmIns:android parameter.

Essentially, what is happening here is that the xmIns:android parameter is defining a “shortcut” for
all the other parameters that start with android: to be able to check themselves against the XML
naming schema repository.


http://schemas.android.com/apk/res/android
http://android.com/

CHAPTER 4: Introduction to XML: Defining an Android App, Its Design, and Constants 105

Thus, thanks to the xmins:android URL definition parameter, the android:width=“match_parent”
parameter is actually short-hand for a http://schemas.android.com/apk/res/android:width="match_parent"
parameter.

The same logic applies to the second xmins:tools parameter and the tools:context=“.MainActivity”
parameter at the end of the <RelativeLayout> parent tag, also shown in Figure 4-1. These XML
constructs (tags and parameters) are more complex, lower-level operating-system-related definitions
such as the one here that sets the Context object for the RelativeLayout Ul definition to the
MainActivity Activity class, which Eclipse ADT created for you in Chapter 2 using the New Android
Application Project series of dialogs.

As you can see here, Android OS really has two XML naming schemas (language definitions), in two
different software repositories. The Android Package (apk) naming schema was designed for high-
level (design-oriented usage) XML, and is at schemas.android.com/apk. It is also the one you will

be using 95% of the time in your Android application development, and the one | will be covering
throughout this book.

The Android Tools (tools) naming schema was designed to provide low-level (OS-related usage)
XML, and is at schemas.android.com/tools. You can use it to do things such as declare a Context
object using XML. You will learn more about Context objects in the next chapter when | cover Java
programming concepts and structures as well as throughout the book as we use Context objects.

XML Syntax: Containers, Brackets, and Nesting

There are two ways to code (or to mark up, to be more precise) any XML tag, and which markup
approach you use depends upon whether that tag is going to have any children (nested tags) or not.
Attributes, also known as parameters, are inside each tag, and configure the tag and what it will do,
but should not be considered “children” of the tag. Attributes that specify values or references will
use quotation marks to do this, such as the android:text="“data value” parameter shown shortly.

If an XML tag is a parent tag (this is, it has “nested” or child tags inside of it), it is said to be a
“container,” just like the XML file itself is the container for the entire XML construct, which in
Android is generally a definition of one type or another, as you will see throughout this chapter, as
well as throughout the rest of this book.

Fortunately, our HelloUniverse bootstrap Ul layout design, shown in Figure 4-1, shows both of these
types of bracketing treatments, so | can simply describe the usage here and you can observe it in
the screen shot (or in Eclipse ADT, if you have it running and on your computer workstation screen,
which | am hoping you do).

Since the <TextView> Ul element, which defines a Text Ul element on the screen, as you may have
guessed, has no children, and has parameters configuring its width, height, and text content, this tag
is opened using the <TextView portion of the tag and is closed using the /> character sequence.

So, with parameters inside of this tag, it would look something like this:

<TextView android:layout_width="0S constant" android:layout_height="0S constant" android:text="data
value" />

The XML for this child tag, which is shown in Figure 4-1, uses indentation, for easy parameter
views, as well as actual Android constants, which you’ll learn about in the next chapter covering
Java, as well as Java String references to a text data value, which you’ll learn about soon in the
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chapters covering Java programming and Ul layout design. For now, we are just going to look at the
“syntax” of XML—that is, how it needs to be constructed or coded (written on the screen). We will
look at how it all works together in the next section of this chapter.

Since the <RelativeLayout> tag does have a child <TextView> tag nested inside of it, it uses a
different bracket configuration. At a high-level view, it will look like this:

<Relativelayout> <TextView /> </Relativelayout>

Once you put parameters inside of the parent and child tags, and indent everything, so that you
know what level each of these tags and its parameters are supposed to be at, it will look exactly
like what you see in Figure 4-1, which | will replicate here. We will be going over what all of this XML
markup is doing during this chapter.

<Relativelayout
xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"”
android:layout_height="match_parent"
android:paddingBottom="@dimen/activity vertical margin"
android:paddingleft="@dimen/activity horizontal margin"
android:paddingRight="@dimen/activity horizontal margin"
android:paddingTop="@dimen/activity vertical margin"
tools:context=".MainActivity" >
<TextView
android:layout_width="wrap_content"”
android:layout_height="wrap content"
android:text="@string/hello world" />
</Relativelayout>

In summary, any tag that is used as a parent tag will have an opening tag <RelativeLayout> and

a closing tag </RelativeLayout> with the tag name in both the opening and the closing tag. The
closing tag will have a slash in front of the tag name to signify to the XML “parsing engine” (the code
that is interpreting the XML markup and turning it into something else; in this case, Java objects) that
this is a closing tag.

Alternatively, a child tag that has no children of its own will have the closing slash at the end of the
opening tag, like this: <TextView android:parameters/> which allows a much more compact way
of writing a child tag. You might think of this as an implicit closing tag, so a tag with no child tags
nested inside of it will not have an explicit (backslash in front of tag name inside of < > chevron
bracketing) closing tag like the </RelativeLayout> Ul layout container has. Since a layout container is
inherently a container and will always have child tags, it will always have an explicit closing tag at the
bottom of the XML definition file.

It’s important to note that tag nesting can be more than one level deep, so you can have the
following structure:

<Relativelayout>
<LinearlLayout>
<ImageView>
<TextView>
</Linearlayout>
</Relativelayout>
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As you can see, the closing tags must be in the reverse order from the opening tag order, so that the
XML tag structure exhibits proper nesting within its level hierarchy.

XML Referencing: Chain XML Constructs Together

XML files can also “reference” other XML files, so that you can create a “chain” where your XML
definitions can be more “modular.” XML file referencing is somewhat akin to XML tag nesting, but it
spans across files. Referencing in Android uses the @ symbol, which is specific to Android XML file
referencing.

If you were wondering what the @dimen/ and @string/ “prefixes” were in the activity_main.xml Ul
layout XML markup shown in Figure 4-1, these are references to XML tags and parameters in the
dimens.xml and strings.xml XML definition files.

Android uses the @ character to signify that another XML file is being referenced, as you will see
over the rest of the chapter, as we look at how to use XML markup to define values, dimensions,
menus, styles, themes, and your Android Manifest, which controls everything about your application
and how it works.

The @ character allows XML files to reference other XML files, allowing developers to create their
own logical XML structures. This allows XML markup to be modular and allows developers to
organize and optimize their XML definitions using multiple files. Without this referencing capability,
XML markup would end up being all lumped together in one or two massive files. Referencing allows
this XML “structure” to be created, such as the XML structure for your HelloUniverse application,
which the Eclipse ADT put into place for you with the New Android Application Project series of
dialogs.

We’ll be looking at your application’s current XML structure, and all of the files within it, as well

as how these XML files reference each other. We will also be looking at how to change the tag
parameter values within these XML files in order to customize your Android application during the
remainder of this chapter.

Once we’'re all finished looking at each of the XML files that are currently in your bootstrap project,
I’ll include a visual of how all of these go together to for the foundational XML structure for your
Android application that you will be building upon during the rest of this book. If you want to cheat,
and look ahead in this chapter, you can go ahead and take a quick peak, the visual is Figure 4-17.

Let’s take a closer look at the strings.xml file in the /res/values folder first, as this is one of the most
often used XML files in Android application development. Open the /res/values folder by clicking
the right-facing arrow next to it. Right-click on the strings.xml file and select the Open option from
the context-sensitive menu.

As you can see in Figure 4-2, the strings.xml file does not need to reference the XML repository URL,
as it just contains resource definitions, using the parent <resources> tag and, in this case, child
<string> tags, defining each string value, and giving the value a (variable) name. We will get into
variables in the next chapter on Java. The reason this file does not require an xmins:android XML
naming schema definition at the top of the XML definition is because the attributes or parameters
used inside of the tags in this file do not preface themselves with something else. Notice in Figure 4-2
you are using name="“app_name” and not android:name=“app_name” and realize that if you

were using android:name="app_name” that you would then need an xmins:android naming schema
definition in place before you used this parameter name convention.
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Figure 4-2. The strings.xml file located in the /res/values folder and with three <string> constants defined

The three <string> tags currently defined in this strings.xml file are named app_name,
action_settings, and hello_world, and define the text strings for the application icon and title bar,
currently HelloUniverse, as well as a menu item labeled Settings and the “Hello world!” message
that your app writes to the display screen.

The way a <string> tag defines a string (text) variable is that the name parameter is used in the first
part of the string value XML definition to define the string variable name, and the actual text value for
a string goes inside of the <string>text</string>, as you can see in Figure 4-2. The app_name string
XML definition would thus be:

<string name="app_name">HelloUniverse</string>

Next, we will edit our application name, by editing this XML <string> constant definition in this
strings.xml file, so that there is a space between the Hello and Universe. Your AndroidManifest.xml
file uses this app_name constant (as you will see in a later section of this chapter) to determine what
the application icon name (under the icon graphic) and the title of the app in the title bar will be.
Making this simple edit will make your app look more professional, and will be easier to read for your
end users. Let’s do this next, and then we can get into more complicated XML definitions after that.

XML Constants: Editing Constants Using XML

Click your text insertion cursor between the Hello and Universe in the first <string> tag’s data value
and hit the spacebar to add a space character, as is shown in Figure 4-3. This simple edit will
change all of the instances of HelloUniverse in your application to be Hello Universe. After we look
at the dimensions, styles, and OS themes defined by XML, we will run the Android application in
the Nexus One Android Virtual Device (AVD) emulator and you can see this for yourself. For now,
however, you will just have to trust me and the app modifications we are making.
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Figure 4-3. The edited constant values in the strings.xml file located in the /res/values folder

Next, we will take a look at the dimens.xml XML definition file, which is used to hold the dimension
constants and their data values used to define the dimensions, using pixel values to define layout
spacing, for an Android application’s Ul design (or for more than one design, if you have defined
multiple Activity classes).

XML Dimensions: Editing Dimensions Using XML

Let’s take a look at the dimens.xml file in the /res/values folder and see what global application
margin spacing has been set up for your Android application by the Eclipse ADT New Android
Application Project series of dialogs. Right-click on the dimens.xml file and select the Open option
from the menu, or alternatively, left-click on the file name and use the F3 function key at the top of
your keyboard; either work process will work.

As you can see in Figure 4-4, there are two <dimen> child tags defined inside of a parent
<resources> tag, just like you saw in the strings.xml file, but instead of <string> the child tag is
<dimen>. These also use the name= parameter to name the dimension constants and set a data
value of 16 dp, or density pixels, in exactly the same way that the text string values were set. Here
is an example of the XML tag and parameter format used:

<dimen name="activity_horizontal_margin">16dp</dimen>
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Figure 4-4. The dimens.xml file located in the /res/values folder and with two <dimen> constants defined

It is important to note that the tags for <string> and <dimen> are singular, as are the @string/ and
@dimen/ referencing prefixes used to reference them, but the XML files that hold these definitions
are plural.

In case you are wondering, the reason for this is that the assumption by the Android OS is that you are
going to define more than one <dimen> or <string> and so the file names the Eclipse ADT IDE created
for you to use are called strings.xml, dimens.xml, and styles.xml. The same logic applies to the <style>
tag and @style/ prefix, as you are about to see in the next section where we cover styles and themes.

If you want to put a little more space between your Ul design and content and the edges of your
Android device hardware, you could edit these values and use something like 20dp or 24dp. Later,
when we learn the AVD work process, you can edit these values and play around with the results of
how close to or far away from the edge of the display screen you want your app content to be. | will
be covering dp, also known as device-independent pixels (DIP) in later more advanced chapters on
Ul design and graphic design.

Next, we are going to take a look at the third and final XML definition file that Eclipse ADT created
for you in the /res/values folder, the styles.xml file. If you are wondering why this values folder is not
named value, or why the layout and menu folders are not named layouts and menus, | unfortunately
don’t have the answer to that one for you!

XML Styles: Editing Styles or Themes Using XML

Whereas text strings and density pixel dimensions are fairly straightforward, Android styles and

OS themes, which are actually a collection of style definitions, are a bit more involved and farther
reaching, and hence are more complicated. If you are familiar with web sites and apps created
using HTML5 and CSS3, you are familiar with the concept of “styling” using a style definition that is
separate from your code and content. Styles and Themes in Android 5 are called “Materials,” and
will be covered in Chapter 16.

What a style does is allow you to define in one central location how the design of your application

is going to look as far as colors, spacing, and font characteristics (text typeface and size) are
concerned. This allows you to extract the “styling” of your design from the actual content within that
design, and from the programming logic behind how the design functions.
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We are not going to completely cover styles and themes in this chapter, as that more advanced
subject matter is better suited for the Ul design chapters, but | am going to show you how the styles.
xml files fit into your overall app structure and how to change the OS primary theme, so you can
make your application “light” (white and light gray) or “dark” (black and dark gray).

Let’s right-click on the styles.xml file in the /res/values folder, and select the Open option from the
context-sensitive menu, or left-click and hit the F3 key, and then we can take a look at the styles.xml
file in the central editing pane of Eclipse, as is shown in Figure 4-5.
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Figure 4-5. The default styles.xml file, located in the /res/values folder, with two <style> containers defined

As you can see, there are two <style> containers defined in the file, and both of these child tags
are empty, although they are set up using the tag opening and closing syntax, which shows that
they will eventually contain child tags (style definitions) of their own, which is why | am calling them
“containers.”

Another interesting thing in this XML definition file is that a second <style> tag named AppTheme
references the first <style> tag named AppBaseTheme. This is done using a parent=“AppBaseTheme”
parameter, which makes the AppBaseTheme style the parent of the AppTheme style. As you can see,
the android:Theme.Light OS theme is the parent of the AppBaseTheme, and since the AppTheme
style is referenced as the theme for the app in the AndroidManifest.xml file, which we will be looking

at a bit later in the chapter, the “chaining” that | talked about earlier between XML definitions would go
something like this:

Android Manifest App's Theme > AppTheme > AppBaseTheme > android:Theme.Light theme definition

If you follow this chain of referencing through, you will see that for Android OS versions earlier than
Version 3, your application is set to utilize the Android Theme.Light OS theme. If you wanted
pre-version 3.0 Android devices to use a dark (black and dark grey) OS theme, you would change
this to android:Theme.Dark.
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As you decide what you want your application styles to be, you can add definitions in this
/res/values/styles.xml file to affect Android versions 1.5, 1.6, 2.0, 2.1, 2.2, and 2.3. Styles for
Android OS versions 3.0, 3.1, or 3.2 will go in the styles.xml file in an alternate definition folder
called /res/values-vi1, as you can see in Figure 4-6.
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Figure 4-6. The second styles.xml file, in the /res/values-v11 alternate folder with <style> definition container

As you can see, there is a second styles.xml file in this alternate values folder! This will be accessed
by Android OS if the device your application is running on is running Android OS version 3.0, 3.1,

or 3.2. You will need to get used to this paradigm in Android OS where files with the same exact
name also exist, with different content, in different (alternate resource) folder names. This can take
some getting used to, but the logic behind it is that Android OS is allowed to select from different
resources based on OS versions and hardware versions that your end users are utilizing. The reason
the names have to be the same is that they are referencing the same asset in your Java code and
XML markup. Once you understand what is going on and why, it will make complete sense to you and
you will have that “Ah-Ha! moment” where (and when) you no longer question this strange practice.

You encountered this same file name with different asset contents for the first time in the previous
chapter when you created the same ic_launcher.png file name with different image resolution
versions of your icon graphic, in different /res/drawable-dpi alternate pixel density resource folders.

As you can see in Figure 4-6, Android OS incorporated a new theme in Version 3.0 and later called
Holo, which also comes in Light and Dark versions. The reason for this “chaining” of <styles> will
now become apparent to you, as the only link in the chain that needs to be changed to incorporate
this change for V3 devices is the AppBaseTheme style, which gets changed to reference the parent
style of android:Theme.Holo.Light. If you wanted Android 3.0, 3.1, and 3.2 OS devices to use a dark
theme, you would change this to Theme.Holo.

So for Android Version 3.0, 3.1, and 3.2, the <style> XML definition chain still goes from the Android
Manifest style assignment to the AppTheme style, and this first XML style definition link in the chain
is located in your AndroidManifest.xml file as you will see a bit later on in the chapter. The style “link”
from the AppTheme style to AppBaseTheme parent style still remains in place as well, as defined in
the /res/values/styles.xml “root” style definition. However, for devices running version 3.0, 3.1, or 3.2,
the AppBaseTheme style is defined differently due to the styles.xml file that is located in the
/res/values-v11 alternate folder. This same alternate style folders approach holds true for Android
5.x OS as well.
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When the Android OS ascertains that your application is running on a hardware device that is running
version 3.0, 3.1, or 3.2 of the Android OS, it will insert the API Level 11 folder /res/values-v11 XML style
definition(s), shown in Figure 4-6. Since this style definition (or definitions if you add any child styles
in the empty container, as it is intended for you to do) features a parent of android:Theme.Holo.Light,
the HOLO Light OS theme will be inserted into this XML definition chain, and this theme will be the
one that will be utilized for the Android application whenever it is running on Android 3.0, 3.1, and
3.2 devices.

Figure 4-7 shows the /res/values-v14 alternate folder, with a third styles.xml definition, which
covers Android 4.0 and later OS versions, which would include 4.0.4, 4.1.2, 4.2.2, 4.3.1, and 4.4.4.
The same logic applies here, and to implement the new HOLO Light Theme with a Dark Action Bar,
all you need to do is change the AppbaseTheme style definition to point to the parent OS style of
android:Theme.Holo.Light.DarkActionBar and the new XML style reference chain that will be
utilized for Android 4.x devices will be as follows:

AndroidManifest Theme > AppTheme > AppBaseTheme > android:Theme.Holo.Light.DarkActionBar
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Figure 4-7. The third styles.xml file, located in the /res/values-v14 alternate folder with <style> container defined

If you want to change your OS theme for Android 4 and later devices to be a dark theme, which we
will do in the next section after we learn how to launch and use the Nexus One AVD emulator, you
would change this to be Theme.Holo, as the default Holo theme is Holo Dark. If you want to add a
custom style, called a “material” in Android 5, it would go in a /res/values-v20 alternate folder.

Now that we have taken a look at the three XML definition files in the /res/values folder and alternate
values folders, let’s take a break from XML for a bit and run your HelloUniverse app using the Nexus
One AVD. After that, we will change your OS theme to Holo to see what a Holo Dark OS theme looks
like, and then we will take a look at XML definitions in the /res/menu folder. Finally, we’ll look at the
XML that is used to define your app itself inside of the AndroidManifest.xml file in the “root”
/HelloUniverse project folder.
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Running Your HelloUniverse App: Using Your AVD

The easiest way to “run” your Android application is to right-click on the HelloUniverse project folder,
which will give you a context-sensitive menu containing all of the things that you can do in Eclipse
relative to your HelloUniverse Android project.

As you can see in Figure 4-8, there is a “Run As” option two-thirds of the way down the menu, and it
has a sub-menu with two important options. The first sub-menu contains the “Android Application”
option. This runs your Android application in the currently active (selected) AVD emulator. If you

have defined more than one AVD emulator, which we in fact did back in Chapter 2 when we defined
the Neptune Pine smartwatch emulator to show you how to “scratch define” an unsupported AVD
emulator, you can select which one you want to use using the Run Configurations sub-menu option.
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Figure 4-8. Right-click on the HelloUniverse project folder and select the Run As » Android Application menu sequence

This is the reason that the other important sub-menu is the Run Configurations option, which
opens the Run Configurations dialog that shows you all of the AVD emulators you have defined, and
allows you to select which one you want to use and to set it to be your default or active AVD for your
Eclipse ADT IDE.



CHAPTER 4: Introduction to XML: Defining an Android App, Its Design, and Constants 115

If you use the Run As » Android Application menu sequence, and the Nexus One AVD does
not appear (for instance, if the Neptune Pine AVD pops-up), simply use this Run As » Run
Configurations menu sequence first. The Neptune One emulator is shown in Figure 4-10, in case
you are wondering what it should look like.

Once you have launched the Run Configurations dialog, shown in Figure 4-9, click the middle
Target tab, and then select the Nexus One as your default emulator. To do this, place a check mark
next to AVD_Nexus_One_by_Google, which will deselect any other selected AVD emulator (in

this case, that would be the Neptune Pine smartwatch). Once this is done, you can click the Apply
button, which will set the Nexus One as your new default AVD emulator, so that it is now the AVD
that will appear every time you use the Run As » Android Application work process.
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Figure 4-9. Use the Run Configurations dialog to select Nexus One AVD and click the Apply button to set it as your AVD
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Figure 4-10. Viewing the HoloLight theme with Dark ActionBar in AVD

If you do indeed need to switch between AVD emulators, after you have applied the Nexus One
AVD emulator to Eclipse ADT by using the Apply button, you can then use the Close button in
the bottom-right corner of the dialog, and then you can go back and use the Run As » Android
Application work process to launch the ADT.

It is important to note that you can also use the Run button (underneath the Apply button) and
launch the Nexus One right there from within the Run Configurations dialog. This is a great
convenience, especially if you switch between AVD emulators frequently, as many developers do,
in order to see what their application design looks like on various Android devices.

Once you get the Nexus One AVD emulator running, you will see your Hello Universe Android
application running in it, as seen in Figure 4-10. You can see the custom application launcher icon
that you created in Chapter 3 in the left side of the title bar, which is called the Action Bar in Android
and is controlled by the Android ActionBar class. We will learn about Java classes in Chapter 5 and
the Action Bar in Chapter 7.
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You can see the text string modifications you made in the strings.xml file, back in Figure 4-3, in the
ActionBar title, which is now attractively spaced, relative to your application icon. Your app_name
text string now says Hello Universe, rather than HelloUniverse, and your hello_world text string,
which is referenced in your Ul design by the TextView Ul widget in the activity_main.xml file shown
in Figure 4-1, now gives a more logical greeting for the application relative to the application name.
You can also see the Holo Light OS theme with the Dark ActionBar in this screenshot; this was
defined in the styles.xml file in the /res/values-v14 alternate folder.

The first time that you use the AVD emulator in Eclipse, you will get an Auto Monitor Logcat dialog,
which will ask you if you would like ADT to automatically monitor logcat output error messaging for
your current application. This is a good idea to have available for your application “debugging” or
error eradication work process, so select the “Yes” option and accept the default “error” level of
notification set via the drop-down menu shown at the right side of the dialog in Figure 4-11. | clicked
on the drop-down menu before | took the screenshot, so that you could see the various levels of
error notification that the Android OS can give to you.

© L]

Auto Monitor Logcat
Would you like ADT to automatically monitor logcat
output for messages from applications in the workspace?
() No, do not menitor logcat output.

(®) Yes, monitor logcat and display logcat view if there aremessages with priority higher than: | error v

verbose
debug
info

warn

Figure 4-11. Setting the ADT Logcat to Auto Monitor error messages

If you look at the error and debugging related tabs at the bottom of Eclipse in one of the screenshots
in this chapter before you select this Logcat monitoring option, such as Figure 4-7 being the most
recent that shows this, you will see that there is no Logcat tab available. After you select this option,
there will be a Logcat tab in Eclipse ADT, as you can see in Figure 4-12 when we begin to edit OS
themes to change your application style.
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Figure 4-12. Changing your application 0S theme to the Holo (Dark) theme in the /res/values-v14/styles.xml

In fact, Eclipse ADT also added a Console tab, as well as a LogCat tab, so now you have five
different error investigation tabs at your disposal at the bottom of Eclipse, rather than just three! It is
also interesting to note between Figure 4-11 and 4-12 that Eclipse ADT spells logcat three different
(capitalization) ways: Logcat in the dialog title, logcat in the dialog text area, and LogCat in the tab
used in the Eclipse ADT IDE. | prefer LogCat, as it stands for Error Log Catalog (for errors) and so

I will used that capitalization during the rest of this book.

Next, let’s play around with the styles.xml XML style (OS theme in this case) definition, to see
how you can easily edit XML parameters in order to elicit some fairly drastic changes to how an
application looks and feels!

Changing the App’s Theme using XML: HOLO Dark

Since our current application is running under Android 4.4.4, as we specified in the Target SDK of
API Level 19, in the first of the New Android Application Project series of dialogs back in Chapter

3 (Figure 3-3), we would need to edit the styles.xml file, which is in the /res/values-v14 alternate
resources folder to see this change inside of the Nexus One AVD, which is running as an Android 4.x
device emulator.

Let’s remove the Holo Light designation, and the Dark ActionBar, by setting the parent= parameter
to simply refer to the android:Theme.Holo constant setting, as the default Holo OS theme is Dark
as its default setting. This is shown in Figure 4-12, and simply involves back-spacing over the
.Light.DarkActionBar position of the OS theme constant shown back in Figure 4-7. Once you run
your AVD emulator again, which we are going to do next, you will see the change to the application’s
look and feel.

To test your new OS theme in the Nexus One AVD, use your Run As » Android Application work
process to launch the emulator, and check out your new “darker” application look and feel, which is
shown in Figure 4-13.
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Figure 4-13. Viewing the Holo Dark theme in the Nexus One AVD
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As you can see a “dark” theme uses Black as a background color instead of White, and uses White
text instead of Black text. The same changes are applied to the ActionBar, which uses a Cyan-colored

separator bar instead of no separator bar (see Figure 4-10). Next, we’re going to try the Holo Light
OS theme, so you can see some of the different looks you can get for your application, simply by

changing one XML style tag parent= parameter!
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Changing the App’s Theme using XML: HOLO Light

Now let’s take a look at the Android 4.x Holo Light theme, which is quite simple to do, thanks to
Android using XML to define application resources, constants, and settings in such as organized and
easy-to-code way. Add the .Light extension to the android:Theme.Holo constant in the <style> tag
in the app’s /res/values-v14/styles.xml XML style definition file, shown in Figure 4-14, so that this
parameter now reads parent="android:Theme.Holo.Light" and then you will be ready to again use
your newfound Run As » Android Application work process to preview the results!

(4] Java - HelloUniverse/res/values-v14/stylesxml - ADT - 0 “
File Edit Refsctor Scurce Mavigate Search Project Run Window Help
rd@ AR Mg rQrQriti Gri®™y [ OO~ | Quick Access [ | | & ava
|2 Package Explorer 52 518 ¥ = O i "splesomi 22 = O EE Qutiine i

~ {resgurces> - An outline is not available.

mil

| stylesamil
= values-swilddp

7] Resources || 7 stylesaml
d) AndroidManifestaml v D LogCat 2
stylesuml = HelloUniverse/res/values-v14 185M of 270M [l : Andreid SDK Content Loader

Figure 4-14. Editing the /res/values-v14/styles.xml AppBaseTheme style's parent theme to be Theme.Holo.Light

As you can see in Figure 4-15, the Android Holo Light OS theme uses a White background in
conjunction with Black text, along with a LightGray ActionBar and MediumGray ActionBar
separator, which looks quite nice!
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Figure 4-15. Viewing the Android 4.x Holo Light theme in the Nexus One AVD, and showing the Options Menu

If you are wondering why | have been capitalizing color names during this chapter, such as White,
Black, Cyan, LightGray, and MediumGray, it is because these are Android Color Constants, and
| wanted you to get used to them in the format that you will be utilizing them in within your
application design and development process.

Now let’s take a look at how XML menu definitions are handled within the Android application
development work process. To access the Options Menu, provided by the Android OptionsMenu
class, click on the three dots on the right-hand side of the ActionBar to access this menu structure,
which we will be adding to as we progress through the book. | have added a screen shot on the right
side of Figure 4-15, to show this menu access visually.

XML Menus: Designing Menus for Android Apps

Let’s take a look at the Options Menu bootstrap which the Eclipse ADT New Android Application
Project series of dialogs created for you in the /res/menu folder named main.xml, after the Main
Activity class. Android uses lowercase letters and numbers for file names, as a standard or
“convention.” You can also use an underscore character, as you have seen already, in the
ic_launcher.png and activity_main.xml file names. Right-click on the main.xml file, and select the
Open option to open this main.xml in the Eclipse IDE, as shown in Figure 4-16.
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Figure 4-16. The /res/menu/main.xml file, with child <item> tag and parameters inside of parent <menu> tag

As you can see in Figure 4-16, an XML menu definition uses a <menu> parent tag to define an
Android Menu (class-based) object, and inside of that Menu object, Android uses <item> child
tags to define Menultem (class-based) objects. Inside of the <item> child tags are parameters that
set the Menultem object’s configuration data fields, for things such as a Menultem object name
(android:id), Menultem order (android:orderinCategory), Menultem ActionBar display mode,
(android:showAsAction) and the Menultem label (android:title).

As you can see, another convention in Android, as well as in Java, is that data field or parameter
names will use “CamelCase,” which uses internal capitalized letters, but start the variable (also
known as data fields, properties, or parameters) names with a lowercase letter. This helps in
readability, as you can see. An exception to this is Java Class names, which start with an uppercase
letter. We will get into all of that in detail in the next chapter.

Now it’s time to look at the most complicated XML file within the Android application, and the most
important one as well: the AndroidManifest.xml file, located in your /HelloUniverse “root” (top-most)
project folder. This Android Manifest XML file is used in the same exact way in 32-bit Android 4 and
64-bit Android 5.

This XML application definition file is the first XML file that the Android OS (runtime) looks at when
your app is launched by your user on their Android hardware device. It defines everything about your
application so that the Android OS knows exactly what it is dealing with.

The Android Manifest, as it is termed, specifies how many Activities, Services, and Providers are

to be used in the application, as well as defining more complex constructs, such as Intent Filters,

if they are needed by the application. You will be learning about all of these areas of the Android OS
during the course of this book.

The Android Manifest also defines more simple and basic things such as API support, versioning,
an app icon, name, and OS theme. These may be simpler to conceptualize, but they are no less
important to the overall app.
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XML Manifest: Configuring the Android Manifest

Let’s open the Android Manifest in Eclipse’s central editing pane by right-clicking the AndroidManifest.
xml file and selecting the Open menu option (or left-clicking this file and using the F3 function key).
As you can see in Figure 4-17, the AndroidManifest XML markup is already nested several levels
deep, and starts with the parent <manifest> tag, as would be expected, and contains two child tags.
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Figure 4-17. Viewing the HelloUniverse Manifest in the Eclipse central edit pane using the AndroidManifest.xml bottom tab

The child tags describe the <application> as well as what SDK versions are being used for your
application, via the <uses-sdk> child tag, which as you can see includes two parameters, for
your android:minSdkVersion and android:targetSdkVersion, which you set back in Chapter 3
(Figure 3-3) at API Level 8 and 19, respectively.

The <application> XML construct or structure is more complicated, as expected, and references the
icon that you created back in Chapter 3 as well as the app_name string constant and AppTheme
style constant. There is also an android:allowBackup switch (Boolean) that is set to “on,” which is
indicated by a “true” value.

Nested under your <application> child tag is the <activity> child tag, so in a sense, the <manifest> tag
has grandchildren, although Android does not use the terminology grandchild tag or great-grandchild
tag. The <activity> tag has an android:name parameter that references your MainActivity.java file

in your package, which is named absolute.beginner.hellouniverse, so the complete path to the
MainActivity.java Activity class would be absolute.beginner.hellouniverse.MainActivity and would be
referenced using the following parameter:

android:name="absolute.beginner.hellouniverse.MainActivity"
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There is also an android:label parameter inside the <activity> child tag that is also set to
@string/app_name, making this the same exact parameter as was used inside of the <application>
tag, which is both a parent tag (to the <activity> tag) as well as a child tag (to the <manifest> tag).

You are probably wondering what the usage difference is between these two parameters. The
app_name text string in the <application> tag is applied underneath the app launcher icon, as that is
what labels the application.

The app_name text string in the <activity> tag is applied in the ActionBar, as that Activity (screen)
title, and if you have more than one Activity (Ul or screen area) in your app, this Activity title could be
used to tell your users where they are in the app, or you can keep it as the app name for branding
purposes. It’s entirely your call.

This is a great example of how you can use a single XML constant value (in this case, it is a text
string value) in more than one area of your application, and for more than one purpose. This is
exactly why Android has set this modular asset and resource referencing up in this way, as when
leveraged optimally by a developer, it will allow a more efficient and effective optimization of
application resources by encouraging more modular and logical resource definition and usage. As
you can see in Figure 4-17, there is a third level of nesting underneath the <activity> tag where an
<intent-filter> child tag is defined, which launches the application from the main (icon) screen of the
Android device. We will be getting into Intents and the IntentFilter class later on, in Chapter 7, when
we cover event handling and processing Intent objects.

To describe what the <intent-filter> is doing here for you, so you don’t have to wonder for several
chapters, the <action> child tag (we are now at five levels of nesting) defines an Android Action
Constant of MAIN, which refers to the Android MAIN screen, and the <category> child tag defines
the category or “type” of action that should be taken (in this case, using the Android Category
Constant of LAUNCHER, which tells the Android OS to launch the application). Essentially this is
what tells the Android OS to launch your application when the user uses your app icon within their
OS. Next, let’s take a look at all this XML construction in a single view!

XML Application Structure: A Bird’s Eye View

Before we learn how to edit these XML files visually inside of Eclipse ADT, which we are going to
learn about in the next section of this chapter using the Eclipse Graphical Layout Editor (GLE), let’s
take a look at how all this XML that we’ve been looking at during this chapter fits together into the
larger XML structural picture.

I am only going to cover the GLE in detail in this book because it is an Absolute Beginners book.

| do not promote using the GLE in my Pro Android books, as an advanced developer should get used
to thinking in and writing XML and Java code directly, but you can use the GLE as a shortcut for
previewing some XML design work, including most Ul design tasks, so that you do not have to use the
more time-consuming AVD emulator as you are designing your Ul design-related XML markup. There
are some graphics features, such as blending modes and animation, that do not work in the GLE.

As you can see in Figure 4-17, as well as in the diagram in Figure 4-18, the AndroidManifest.xml file
is where everything starts from (XML or otherwise) in an Android application. This is very similar to an
index.html file, which will “bootstrap” or launch an HTML5 web site or an HTML5 application.
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AndroidManifest.xml

styles.xml ][ activity_main.xml ][ main.xml

| (in /res/values folder) (in /res/layout folder) (in /res/menu folder) |

f styles.xml ] [ styles.xml ][dimens.xml][ strings.xml
1 4

|/res/values-v11]|/res/values-v1 /res/values (in /res/values folder)

Figure 4-18. The HelloUniverse initial XML structure from the AndroidManifest.xml file on down the hierarchy

As you just saw in the previous section of this chapter, the styles.xml file is accessed using the
android:theme parameter, set equal to @styles/AppTheme, and the activity_main.xml and main.
xml files are accessed through a MainActivity.java reference, which is located inside of the <activity>
tag, using an android:name parameter.

These XML Ul and menu definitions are accessed through Java methods, which we will be looking at
in the next chapter. These methods serve to “inflate” these XML definitions into Java objects, and so
I include them in this graphic so that you can see how all of this XML markup affects and references

each other.

The AndroidManifest also directly accesses the strings.xml file in both the <application> and
<activity> tags, using the android:label=“@string/app_name” parameter, which we learned does
different things when used inside of different XML tags.

The activity_main.xml Ul design layout XML definition accesses the dimens.xml file to get the app’s
screen dimensions as well as the strings.xml file to get text string constant values to display the
Hello Universe message on the application’s primary Activity display screen.

The /res/values/styles.xml file references the styles.xml files located in your alternate resource
folders, named /res/values-v11 and /res/values-vi4, to set the OS theme preferences for your
application. This depends upon if the end-user is using Version 3.x, Version 4.x, or legacy (earlier)
versions of the Android OS, such as 1.6 or 2.3.

It is important to note that this diagram only includes XML to XML referencing, and not XML to new
media assets referencing, most of which would exist underneath the activity_main.xml Ul definition
in res/layout.

Next let’s take a look at the Eclipse ADT GLE, in case you have been wondering what that Graphical
Layout tab at the bottom of the Eclipse ADT central editing page does whenever you are working
on XML definition files that refer to Ul design layouts, such as the activity_main.xml file does. | am
including this in the XML chapter to give you an early preview of this feature as well as an overview
of what it does, and how it can help the Absolute Beginner to quickly develop Ul designs for their
Android applications.

Using the Eclipse Graphical Layout XML Editor

You may have noticed the Graphical Layout tab, located at the bottom-left of the Eclipse central
editing pane, when you were taking a look at the Ul design XML definition at the beginning of the
chapter in Figure 4-1.
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| am going to show you how to use this now, as well as later in the book, as you can sometimes use it to
preview Ul designs that you create using XML, and can actually use it to create these designs visually.
For the sake of learning XML and Android development in this book, | will be referencing this tab to create
previews of Ul designs using XML, so you don’t have to go through the more time-consuming Run As >
Android Application AVD work process, which we took a look at a bit earlier in this chapter.

You can switch back and forth between XML editing view and the GLE by clicking the bottom-mounted
tabs, which you can see in Figure 4-19, and are labeled with your XML file name for the XML editing

view and the GLE name for the Graphical Layout view. Whatever you have your cursor clicked on
(or inside of) in the XML editing view will be selected in the GLE when you switch over (in this case,

a TextView).
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Figure 4-19. The <TextView> tag and parameters in the Graphical Layout tab and its Properties Editors

As you can see in Figure 4-19, there is a Palette pane on the left, where you can select and drag and
drop Ul widgets onto your design, as well as an Outline pane containing your Ul design hierarchy

on the right, and even a handy Properties pane, where you can set the properties (also known as
parameters) for your Ul element tags.

If you want to add parameters to your TextView tag, you can do it in the Properties pane and then
switch back into XML editing mode to see the XML markup which Eclipse ADT has written for you.
This is a good way to learn about the XML parameters that are available to you for any given Ul
element tag, so be sure and play with this GLE feature when you have a chance!
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Using Eclipse’s Graphical Manifest XML Editors

Eclipse ADT also has the equivalent of the GLE to edit your Android Manifest, except that it takes
four tabs to cover all of the different types of Android Manifest editing visually. We will take a quick
look at two of the primary Manifest editing tabs, the Manifest and the Application editing tabs,
here; you can look at the others later on in the book, when we get into advanced topics covering
permissions and instrumentation hardware.

The Manifest Visual Editor, shown in Figure 4-20, shows the parameters inside of your <manifest>
tag in a visual environment. This includes your Java Package name, version code and version
naming, and shared user information and installation location. Most of these fields are not needed
for your Android application.
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Figure 4-20. View the <manifest> tag and parameters in the Manifest tab and Manifest General Attributes Editor

The Manifest Extras interface allows you to add “extras” such as External Libraries, Compatible
Screens definitions, Supported Input definitions, and other advanced features. This is accomplished
by adding tags similar to the <uses-sdk> tag, to define support for various areas of your application
hardware support features.

The next tab over is the Application tab, which shows visually the Application Attributes that you
can assign to your Android application (see Figure 4-21). Those of these that have a drop-down
menu next to them will show you every available setting for those parameters, which can again be
an incredible learning tool.
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Figure 4-21. View the <application> tag and parameters in the Application tab and Application Attributes Editor

For instance, if you want to see every permission you can ask the Android OS to give your
application, such as permission to use the camera, which is afforded by the android.permission.
CAMERA constant, you can spend some time perusing the drop-down menu next to the
Permission field, as it contains hundreds of Android OS permission constants.

All of the other drop-down menus in this section of the Manifest Application visual editor feature
either a “true” or “false” value selection, so to learn what these do, you’d want to consult the
developer.android.com web site.

Before we finish this XML chapter, | want to give you an overview of how XML and Java interface
together, which is accomplished using a process that the Android OS calls “inflation.” Inflation

is simply a fancy term for “turning XML-compatible data structures into Java-compatible data
structures,” which is of course necessary due to the fact that your application programming logic is
written using the Java programming language.

Let’s take a look at XML inflation next, and after that we will summarize in greater detail how Android
applications work on a more global level, by revisiting and refining the visual that | used back in
Figure 3-1 in Chapter 3. After we do this, you will be ready to get into the even more complicated

subject of the Java SE programming language and all of its various programming logic and data
storage constructs.


http://developer.android.com/
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XML Inflation: How XML Works with Java

Since we are going to get into Java objects, as well as classes and methods and the like, in the next
chapter, | am going to briefly touch upon how all of this parameter-rich XML markup gets turned into
Java-compatible data structures.

These XML definition structures that contain your parent and child tags as well as any parameters
need to get transformed from XML-compatible data structures into Java-compatible data structures.
This is accomplished by the Android OS using a process called “inflation,” which you invoke using
the .inflate() or findViewByld() method in your Java programming logic.

The Java-compatible data structures that are created from your XML definitions via this inflation
process are known as “objects,” and you will learn all about what Java objects are, and what they
are utilized for, in the next chapter, which covers the Java programming language.

Think of an empty Java object structure as a limp balloon, and your XML definition as the air that
will inflate it! What Android does, more accurately, is to take your XML definition and create a Java
object of the appropriate type using your definition; that is, by using the XML tags and parameters
you defined in your XML file.

For instance, for a <menu> XML definition, the Android “inflater” will create a Menu Java object by
using the Android Menu class constructor, and will then populate this Menu object with Menultem
sub-objects by using the Android Menultem class. You will learn what a Java constructor is in the
next chapter, so hold on tight!

These Menultem sub-objects, which are contained inside of a Menu “parent” object, will have

the configuration parameters for each of your Menu items (entries) set in exactly the way that you
defined them within your XML menu definition. This is accomplished by using data fields within the
Menultem object that define each menu item in your menu using parameters (Android calls them
“properties”), which you defined inside of each <item> tag in your XML menu definition.

Currently, this menu definition is contained in the main.xml file in the /res/menu folder of your
HelloUniverse Android application project hierarchy or folder structure. Before we finish the chapter,
let’s add a level of detail into our How Android Works graphic that adds in what we have learned
since we started Chapter 3.

XMLU's Role: Revisiting How Android Works

Now that you have learned a bit more about XML, let’s revise Figure 3-1 from Chapter 3 and add in
some of the things we have learned about XML. | also added the Dalvik Virtual Machine (VM) and the
Android RunTime VM to the diagram just to be sure that | had everything covered, going from one
layer to the next. The updated graphic is shown in Figure 4-22.
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APPLICATION MEDIA ASSETS

(2D ANIMATION X DIGITAL IMAGES X ILLUSTRATION N

XML OBJECT DEFINITIONS
—(OBJECT INFLATION)—{XML FILE PARSING)}——

JAVA CODE LIBRARIES
—(Dalvik Virtual Machine)———(Android RunTime (ART))—

LINUX OS KERNEL

Figure 4-22. Android 0S hierarchy from Linux Kernel, to Java Libraries, to XML Definitions, to New Media Assets

You can use XML markup to define a number of application new media assets, including 2D
animation, called Animation and AnimationDrawable objects in Android, as well as digital images,
or BitmapDrawable objects, and digital illustration, known as ShapeDrawable objects in Android.

XML object definitions get turned into Java objects using object inflation Java methods, and XML
files that are not object definitions can be utilized by your application as well using XML file parsing
methods such as the .XMLparse() method. The resulting Java objects and code is then run using
one of the two Android runtimes.

Summary

In this fourth chapter, you learned all about the XML markup language, as well as how the Android
platform utilizes XML markup to simplify the application development work process, so that non-
programmers can get involved.

You learned about how XML uses tags and parameters to define XML definition structures, as well
as how levels of nesting define what a parent and child XML tag is. You learned about the XML
naming schema, and how this is defined at the beginning of XML definition files.

Next you looked at some of the primary types of XML files that are utilized in an Android application,
by looking at the bootstrap XML files that were generated by the New Android Application Project
series of dialogs in the previous chapter. You examined, and in some cases edited, XML files defining
value constants, menu entries, application styles or OS themes, and the Android Manifest, which
defines your entire application.

You learned how to use the Run As » Android Application work process and Run Configurations
dialog, and got used to compiling and running your HelloUniverse Android app using the Nexus One
AVD emulator. You looked at all of the major Holo OS themes, and looked at the inter-relationships
between all of these XML files at a high-level to see how they all relate to each other to create your
Android application user experience.

Finally, you learned how to use the visual editors, including the GLE, in Eclipse.

In the next chapter, you will learn all about the Java SE programming language by taking an in-depth
look at the Android application that you created in Chapter 3, including the java files in the /src/
folder. You will also learn how to create Java objects, classes, methods, and interfaces from scratch
for your Android application.



Chapter

Introduction to Java:
Objects, Methods,
Classes, and Interfaces

The programming language used for developing your Android applications is Oracle’s Java SE,
which was created by Sun Microsystems and acquired by Oracle. As you learned in Chapter 1, Java
SE stands for Java Standard Edition, though many programmers shorten this to just “Java” to refer
to this programming language.

Java is what is called an object-oriented programming (OOP) language, which you are going

to learn all about during this chapter. It is important to note that all of these Java programming
concepts, components, and constructs that you will be learning during this “dava Primer” chapter
will apply equally well to both the 32-bit Android 4.4 OS as well as to the new 64-bit Android 5.0 OS
that will be released by the end of 2014.

OORP is based on the concept of developing modular, self-contained constructs that are called
“objects.” These OOP constructs contain their own attributes and characteristics. In this chapter,
you will learn a great deal about the OOP characteristics of Java, and the logic behind using a
modular programming approach and OOP techniques to build applications that are easy to share
and debug due to an OOP approach.

You will also learn about all of the other Java programming language constructs, such as packages
and classes, methods and interfaces, loops and arrays, variables and constants, and application
programming interfaces (APIs), which tie everything together into one coherent computing ecosystem,
such as the 19 Android Java Platform APIs, which were discussed in Chapter 2. Android’s 19 APIs are
actually progressive collections of all of these Java programming constructs. The 64-bit Android 5.0
OS is the 20th API, and will be covered in Chapter 16, “The Future of Android.”
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Together these Java constructs will allow you to create the application’s objects and then modify
them according to the programming logic that your application will utilize to create a user
experience for your end-users.

Finally, we will put much of this newfound knowledge to use, and will create our own HelloUniverse
planetary tracking system, so that you get some hands-on experience creating your own objects,
classes, methods, and the like. While we do this, we will also learn what the bootstrap Java code in
your existing application is doing.

The Three Versions, or Editions, of Java

There are two other “editions,” or versions of the Java programming language, in addition to the
Java SE. These are called Java EE, short for Java Enterprise Edition, and Java ME, for Java
Micro Edition, which was originally used for mobile application development, so a lot of people
incorrectly assume that Java ME stands for Java Mobile Edition. Many mobile phones now use the
Android OS, which uses the more powerful Java SE, instead of Java ME, due to the more powerful
hardware utilized in today’s HD smartphones.

Java EE was designed for use on potentially massive computer networks. These types of computing
networks are used to run large “enterprises” or corporations with thousands of active users, and
could be termed “server-side” computing.

Conversely, Java SE could be termed “client-side” computing, as the Java application, in the case
of this book, an Android application, runs on the user’s own personal computing device, which is
termed the “client” in the computer programming industry.

The reason an enterprise computing network is considered to be a “server-side” scenario is because
the “dumb terminals” used by workers are simply keyboards and display screens, whereas the
memory and processing resources are centered in the powerful computers serving the network.
Java EE was originally designed and optimized for this exact type of centralized computing scenario,
which is still utilized today in many large corporate MIS and IT departments.

It is important to note that Java EE can also be run on smaller installations, as long as they have
enough system memory and a couple of processing cores, and this is sometimes done in companies
that are developing applications for use on Java EE installations, so that they can work in and
simulate that type of environment for their testing. Java EE’s differentiating feature to Java SE is that
Java EE features a multi-user, scalable design, whereas Java SE is designed for use by a single user
on a single computer system, say a home PC or a laptop, or better yet, on an Android device such
as an iTV Set, eBook reader, tablet, smartphone, game console, or smartwatch.

Java ME was designed for low-power, embedded systems, to create highly portable computers
such as mobile phones. It has fewer features than Java SE, so that it can fit onto a phone without
using too much memory and resources to run it. Most mobile flip-phones run Java ME, but Android
phones run the more powerful Java SE. Android phones can run Java SE because they have at
least a half gigabyte or more of memory, and a 1GHz or faster CPU, so essentially today’s Android
devices are tiny Linux computers.
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The Foundation of 00P: The Java Object

The foundation of OOP is, no surprises here, the object itself, because everything in Java is an object.

Objects in OOP languages are similar to the objects that you see around you every day, except Java
objects are virtual, and are not tangible, since computers use zeroes and ones (binary) to represent
things. Just like tangible real-world objects, Java objects have characteristics, called states, and
things that they do, called behaviors.

One way to think about this distinction is that Java objects are nouns, or things that exist in
and of themselves, whereas their behaviors are like verbs, or things that these nouns can do.
As an example, let’s consider that very popular object in all of our lives: the automobile. Some
characteristics, or states, of the car might be as follows:

Color (candy apple red)
Direction (N, S, E, or W)
Speed (15 miles per hour)
Engine type (gas, diesel, hydrogen, propane, or electric)
Gear setting (1, 2, 3, 4, or 5)
Drivetrain type (2WD or 4WD)
The following are some things that you can do with a car, that is, the car’s behaviors:
Accelerate
Shift gears
Apply the brake
Turn the wheels
Turn on the stereo
Use the headlights
Use the turn signals

You get the idea. Now stop daydreaming about your new car, and let’s get back down to learning
about objects!

Figure 5-1 shows a simple “Anatomy of a Car Object” diagram of the Java object structure, using a
car as an example. It shows the characteristics, or attributes, of the car, that are central to defining
the car object, and the behaviors that the car object can perform. These attributes and behaviors
serve to define the car to the outside world, just like your application’s objects will for your Android
application.
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ANATOMY OF A CAR OBJECT

SHIFT GEARS APPLY BRAKE

ACCELERATE TURN WHEELS

Figure 5-1. Car object, showing the car attributes or characteristics (inner oval) and the car behavior (outer oval)

Objects can be as complicated as you wish them to be, and Java objects can nest or contain other
Java objects within their object structure, or object hierarchy. An object hierarchy is like a tree
structure, with a main trunk, and branches, and then sub-branches as you move up (or down) its
structure, and then leaves at the ends of these branches. A good example of a hierarchy that you
use every day would be your multi-level directory or folder structure that is on your computer’s hard
disk drive (refer to Figure 1-9 back in Chapter 1, for a visual example).

Directories or folders on your hard disk drive can contain other directories or folders, which can in
turn contain yet other directories and folders, allowing complex hierarchies of organization to be
created. We saw another really great example of this back in Chapter 3, shown in Figure 3-9, where
our Android HelloUniverse project folder was shown in the Eclipse Android Development Tools (ADT)
Project Explorer pane, showing the project sub-folder hierarchy, with its source folder, and resource
folder, and sub-folders for your layouts, menus, drawables, values, and the like.

You can do this same hierarchical construction using Java objects, which can contain sub-objects,
which can themselves contain further sub-objects, and so on and so forth as needed to create an
object hierarchy structure.

You'll see plenty of nested object hierarchies when you are working with Android, because nested
objects are very useful for “grouping” related objects that are used together, but that are often used
in more than one place, and for more than one type of usage. After all, the goal of modular code is to
foster effective code re-use!

In other words, some types of objects are similarly useful to other types of objects in an Android
app, so they are provided in a nested object hierarchy underneath the other object types. You will
see many examples of this during this book, as we will be covering all of the primary Java classes
(which as you will soon see are used to create objects) in Android in great detail during the course of
this book.

As an exercise, you should practice identifying different objects in the room around you, and then
break their definition or description down into states (variable characteristics and fixed or constant
characteristics) as well as behaviors (things that the objects can or will do). This is a good exercise
to perform, because this is how you will need to start thinking in order to become more successful
in your OOP endeavors using the Java programming language (and even using the XML markup
language, for that matter).
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It’s important to remember that you can use both Java program logic, as well as XML markup, to
define objects for Android applications, as you learned in the previous chapter when you learned
about object inflation. You have already defined a TextView user interface object, having several
characteristics, in Chapter 4 using XML markup (refer to Figure 4-1, to see the XML tag and
parameters defining the TextView user interface (Ul) object definition).

OOP Terminology: Variables, Methods, Constants

Next, let’s cover some of the technical terminology used in conjunction with Java objects. First,
objects have data fields to hold variable data, constants to hold fixed data, and methods to define
behaviors, as follows:

Data fields that hold a Java object’s states, or things that can change about an
object’s characteristics over time, are called “variables.” Using the car example,
the direction you’re driving in, the gear that you’re driving in, and the speed
you’re driving at, are all variables.

Data fields that hold an object’s attributes, or things that do not change
regarding an object’s characteristics over time, are called “constants.” Using
the car example, the candy apple red paint job on the car would be a constant,
as is the car’s engine type (unless you own an automotive paint and body shop,
or are an auto mechanic, that is).

Methods are programming logic, or program code routines, that operate on,
and change, the object’s internal data fields or states. Methods will also allow
other Java objects that are external to the object itself to communicate with
that object, as long as the method is declared to be “public.” We will be getting
into methods in greater detail a bit later on in the chapter, so | won’t get into too
deep a level of detail regarding how methods work here.

One of the key concepts of OOP is data encapsulation. In Java, data encapsulation is implemented
by only allowing a Java object’s variable data fields to be modified directly through that same Java
object’s internal (private) methods. This allows a Java object to be self-sufficient, or “encapsulated.”

Using the car example, in order to turn the car, you would use the .turnWheels() method, shown

in Figure 5-1 on the bottom-right of the diagram. This method would be comprised of Java
programming logic that would correctly position the wheels of the car, ultimately causing it to move
in the desired direction. You would not see the details of how the object’s wheels turned, because of
encapsulation. That detail is left to the private, internal functionality in the object.

Note Notice the empty parentheses | am using after my method names in the text. These are always
used when writing about a method, so that the reader knows that the author is referencing a Java method.
Additionally, since method calls are invoked using dot notation, | also preface the method names with a dot,
further reinforcing that this is a method call, so that you can visualize it. You will see this naming convention
used throughout the rest of this book.
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With data encapsulation, you can build and test each object that is part of a larger object construct
individually, without requiring data to be accessed from other objects, or modules, of your
application. External data access can translate into “bugs,” so encapsulation helps when developing
complicated, large-scale applications.

Without data encapsulation, developers on your team could simply access any part of your object data
and use it however they pleased. This could introduce bugs affecting the methods you have perfected

to manipulate your object and to provide your encapsulated solution. So data encapsulation promotes

the core concept in OOP of modularity. Once an object is created and tested, other objects can use it
without worrying about its integrity.

Data encapsulation. thus allows code re-use, so programmers can develop “libraries” of useful
objects that do not need to be rewritten, or retested, by other programmers. You can see how this
might save developers time and money, by structuring only the work that needs to be done, and
avoiding redundant work processes related to testing multiple code modules in conjunction with one
another. Data encapsulation will also allow developers to hide the data and the internal logic of a
Java object, if desired.

Finally, Java objects make debugging easier, because you can add or remove them modularly
during testing to ascertain where bugs are located within the overall code. In the car object example,
the attributes of our car are encapsulated inside of the car object, and can thus be changed only

via the methods that surround them in each diagram. For instance, one would use a .shiftGears|()
method to change the Gears=1 field variable to Gears=2.

Java Constructs: Create Your Own Objects

In the next several sections of this chapter, you will learn about the primary Java programming
“constructs,” or code structures, that developers can create to be able to define their own custom
Java objects. These custom objects will have their own attributes (constants), characteristics
(variables), behaviors (methods), accessibility (access control modifiers), procreation (constructors),
and rules of engagement (interfaces).

This is in large part accomplished using the top-level structure in Java, which is called a Java class.
For this reason, we will start learning about classes first, since all of the other structures in Java are
either created (nested) inside of the class or relate to its usage and implementation in some way.

The Java Class: Java Code Structure Container

In real life, there is seldom just one single type or kind of object. Usually, there is a large number of
different object types and variations. For instance, for a car object, there are many different manufacturers,
sizes, shapes, seating capacities, engine types, fuel types, transmission types, drive-train types,
and so on.

In Java SE, you write something called a “class” that defines what your object can do (its methods),
and what data fields it will possess. Once the class has been coded in Java, you can then create

an “instance” of an object that you wish to use, by referencing the class definition. In architectural
terms, the class is a kind of blueprint as to what the object will be structured like, including what
states it will contain (its variables), and what tasks it can perform (the methods that it has).
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Note Aninstance is a concrete object created from the blueprint of the class, with its own states or
unique data attributes. For example, you might have a (second) baby blue car instance that is traveling south
and is in third gear. (In the example, our first car instance is red, and is traveling north, in first gear.)

To illustrate this further, let’s construct a basic class for our car object example. To create a car class,
you use the Java keyword class, followed by your custom name for the new class you are writing,
and then curly brackets that will contain your Java code class definition, like so:

class Car {
// Java code definition for the car class will go in here. We will do this next!

}

The first thing that you usually put inside of a class (inside the curly {} brackets) is the data fields
(variables).

These variables will hold the states, or characteristics, of your Car object. In this case, you will have
six data fields, which will define the car’s current gear, current speed, current direction, fuel type,
color, and drive-train (two-wheel drive or four-wheel drive), as was specified in the basic diagram
shown earlier, in Figure 5-1.

To define a variable in Java, you must first declare its data type. An integer or int data type declares
a variable to be able to hold a whole (non-fractional) number. A String data type declares the
variable to hold a text value.

The next portion of the variable definition or “declaration” after the data type has been specified is
your custom variable name, which you will use to refer to that variable later on within your Java
programming logic. If you want to know technically what the Android OS is going to do with

these variable declarations, it is essentially going to set aside, or “allocate” an area in the system
hardware memory to hold this value for your application.

You can also (optionally) set a default, or starting, data value for your variable. This is done by using
the equal sign and a starting or default data value. The variable definition is ended once it reaches,
or is terminated with, a semicolon character. This is how the Android compiler in Eclipse, which

is reading or “parsing” your Java code, knows that each statement or “Java structure component
definition” is finished being defined.

Note Semicolons are used in programming languages to separate each code construct, or definition, from
the other code constructs within that same body of code (variable, method, interface, and so forth).
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So, with the six variables from our Anatomy of a Car Object diagram shown in Figure 5-1 in place,
your Car class definition will initially look something like this:

class Car {
int speed = 15;
int gear = 1;
int drivetrain = 4;
String direction = "N";
String color = "Red";
String fuel = "Gas";

}

Remember that since we specified a starting value using the equal sign for all of these variables, that
these variables will all contain this default or starting data value. These initial data values will be set
(in the system memory) as the Car class variable’s data values.

Notice how the example spaces out the curly braces ({}) on their own lines, as well as indenting
certain lines, similar to what you did with your XML markup. This is done as a Java programming
convention, so that you can visualize the organization of the code constructs that are contained
within your Java class structure inside of those curly braces more easily and more clearly, analogous
to a “bird’s eye view” of your Java code construct.

The Java Method: Java Code Function Definition

The next part of your Java class definition file will contain your methods. Java methods will define
how your Car object will function (that is, how it will “operate” on the variables that you defined at
the top of the class that hold the Car object’s current “state of operation®).

Method “calls” can invoke a variable (state) change, and methods can also “return” data values to
the entity that “calls” or “invokes” the method, such as data values that have been successfully
changed, or even the result of an equation. For instance, there could be a method to calculate
driving distance by multiplying speed by driving time, and this method would “return” this driving
distance data value to the Java code that invoked this method.

You will see a bit later on exactly how a Java method is invoked or called; this is usually
accomplished by using something in the Java programming language called dot notation. Next, let’s
take a closer look at how a Java method is declared and created inside of your Java class structure.

To declare a Java method that does not return any data values to the calling entity, and that only invokes
some sort of state change in the object, you would utilize the void Java keyword before the method’s name.

Note In this chapter especially, but also throughout the book, you will be learning about a plethora of Java
and Android "keywords." Keywords are reserved words that cannot be used in your own custom code
(because that would confuse the compiler, which needs to have everything that is defined be 100% unique,
and thus not ambiguous), because each keyword does something specific in Java or Android. As an Android
programmer you will need to learn all of the programming language keywords and what they mean (do) and
how to implement them properly, which we will be doing throughout the rest of this book.
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You can see a good example of using void in a method that “triggers” something. This type of
method would be used to trigger (invoke) a change in the object, and thus would not need to send
any specific data values back to its calling entity.

If your method or function returns a data value, then instead of using the void keyword, you would
use the data type of the data value that needs to be returned, say int or String. As an example,

a simple, whole number addition method might return a number data value after finishing its sum
calculation, so you would declare a data type using the int keyword.

After the data type keyword comes a name for the method (say, shiftGears). This is followed by
the type of data (in this case, an int) and variable name (newGear) in parentheses, which is called the
parameter list, and then finally the curly braces, which will contain the method’s Java code, just like
we used with the Java class:

void shiftGears (int newGear) { The Java code which defines the method's functionality will go in
here. }

The data variable’s data type and name, seen within the parameter list, contains the data parameter
that will be passed into the method, so the method now has this passed-in data variable to work
with inside of the Java code that is defined inside of the method programming logic (inside of its
curly braces).

Note The normal method-naming convention is to start a method name with a lowercase letter, and
then to use uppercase letters to begin words embedded within the method name, called GamelCase, like
this: methodNameExample(). Read more about naming conventions for Java at;
http://www.oracle.com/technetwork/java/codeconv-138413.html.

Some methods, such as those that trigger something, will be “called” without using any variables,
as follows:

turnCar0ff();

To call the .shiftGears() method, you would want to pass the desired gear over using the parameter
list as an integer data variable, so you would therefore utilize the following method call format:

shiftGears(4);

This passes over the integer value of 4 using the .shiftGears() method’s newGear variable, which sets
its value. This data value is then utilized in the interior of the .shiftGears() method logic (the part inside
the curly braces), where it is finally used to set the object’s gear (internal) field to the new gear shift value
of 4, or fourth gear. If you wanted to set up your .shiftGears() method so that it does not require any
integer data values, that is, if you wanted to set it up to be a method with no calling parameter, you will
need to create a .shiftGearUp() as well as a .shiftGearDown() method. The programming logic inside of
these methods would add (or subtract) a value of one from the current gear setting, instead of setting the
gear value to the passed in (desired) gear value. In Java coding, there’s always more than one way to skin
a car! Or is it, there’s always more than one way to shift a cat?


http://www.oracle.com/technetwork/java/codeconv-138413.html
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A common reason to use a method without any parameters is to invoke a state change in an object
that does not depend on any data being passed in. In the case of this particular gear shifting example,
this would also fix a potential problem of skipped gears, as you would simply code a . shiftGearUp()
method and a . shiftGearDown() method, which would upshift and downshift by one gear level

each time they were called, rather than change to a gear selected by the driver. If you have ever
shifted from first into fifth gear on your car, you know that it does not work very well, and can cause

a stall. This might be a smarter way to code this particular method, and then you would not need

to pass a parameter in order to shift gears on your Car object; you would just call .shiftGearUp() or
.shiftGearDown() whenever any gear shifting for the Car object was needed.

After the method declaration, the method’s programming logic procedures are contained inside
the curly braces. In this Car class and object definition example, we have four methods as defined
back in Figure 5-1:

The .shiftGears() method will set the Car object’s gear to the gear value that
was passed into the .shiftGears() method. You should allow an integer to be
passed into this method, to allow “user error,” just as you would when you are
driving your car in the real world.

void shiftGears (int newGear) {
gear = newGear;
}

The .accelerateSpeed() method takes your object’s speed state variable and
then adds your acceleration factor to the speed, which causes your object
to accelerate. This is done by taking your object’s current speed setting, or
state, and adding an acceleration factor to it, and then setting the result of this
addition operation back into the original speed variable, so that the object’s
speed state now contains the new (accelerated) speed value.

void accelerateSpeed (int acceleration) {
speed = speed + acceleration;
}

The .applyBrake() method takes the object’s speed state variable and
subtracts a braking factor from the current speed, which causes the object

to decelerate, or to brake. This is done by taking the object’s current speed
setting and subtracting a braking factor from it, and then setting the result of the
subtraction back to the original speed variable, so that the object’s speed state
now contains the updated (decelerated) braking value.

void applyBrake (int brakingFactor) {
speed = speed - brakingFactor;
}



CHAPTER 5: Introduction to Java: Objects, Methods, Classes, and Interfaces 141

The .turnWheel() method is straightforward, much like the .shiftGears()
method, except that it uses a string value of N, S, E, or W to control the direction
that the car turns. When .turniWheel("W") is used, the car will turn to the left,
when .turnWheel(“E”) is used, the car will turn to the right, given, of course, that
the Car object is currently heading to the north, which according to its default
direction setting, it is.

void turnWheel (String newDirection) {
direction = newDirection;
}

The methods that make the Car object function go inside the class and after the variable
declarations, as follows:

class Car {
int speed = 15;
int gear = 1;
int drivetrain = 4;
String direction = "N";
String color = "Red";
String fuel = "Gas";

void shiftGears (int newGear) {
gear = newGear;
}

void accelerateSpeed (int acceleration) {
speed = speed + acceleration;
}

void applyBrake (int brakingFactor) {
speed = speed - brakingFactor;
}

void turnWheel (String newDirection) {
direction = newDirection;
}

}

This Car class allows us to define a Car object, but only if we include a Car() constructor method,
covered in the next section of this chapter.

Constructor Methods: The Java Object Blueprint

If you want to be able to make an object with preset values out of your class definition, then you
need to include what is called a constructor method. This method needs to be named the same as
the class name, in this case it would be the Car() method, and should be the first method that is
defined inside of the class construct, after the variable definitions.
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A constructor method is used to construct an object and to configure it, so the first thing that we
will want to do is to make our variable declarations undefined, by removing the equal sign and
initial data values, as is shown in the following code. A Car() constructor method will set data
values, as part of the construction and configuration of the Car object, and thus the Java code for
the Car() constructor method could be written as follows, where we specify the car name in the
constructor’s parameters:

class Car {
String name;
int speed;
int gear;
int drivetrain;
String direction;
String color;
String fuel;

public Car (String carName) {
name = carName;
speed = 15;
gear = 1;
drivetrain = 4;
direction = "N"
color = "Red";
fuel = "Gas";

.
)

}

A Java constructor method differs from a regular Java method in a number of distinct ways. First of

all, it does not use any of the data return types, such as void and int, because it is used to create a

Java object, rather than to perform a function. It does not return nothing (void keyword) or a number
(int or float keywords), but rather returns an object! Indeed, that’s why it’s called a constructor in the
first place; because its function is solely to construct or create the new Java object; in this particular
case, that would be a Car object.

Note that every class that needs to create a Java object will feature a constructor with the same
name as the class itself, so a constructor is the one method type whose name can (and will, always)
start with a capital letter.

Another difference between a constructor and a method is that constructors must have a public
access control modifier, and cannot use any non-access-control modifiers, so be sure not to declare
your constructor as: static, final, abstract, or synchronized. We will be covering modifiers a bit
later on in this chapter, so stay tuned!

In case you may be wondering how you would modify the previous Car() constructor method
example if you wanted to not only name the new Car object using the constructor method, but also
wanted to define its speed, direction, and color using that same Car() constructor method call,
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you would do this by simply creating a longer parameter list for the constructor method call. This
revised Car() constructor method’s Java code structure would look something like the following:

class Car {
String name;
int speed;
int gear;
int drivetrain;
String direction;
String color;
String fuel;

public Car (String carName, int carSpeed, String carDirection, String carColor) {
name = carName;
speed = carSpeed;
gear = 1;
drivetrain = 4;
direction = carDirection;
color = carColor;
fuel = "Gas";

}

It is important to note that this Car() constructor method will not do anything at all until you use it to

instantiate an “instance” of the Car object. An instance is just what it sounds like it is; the Android OS
will allocate system memory space to hold each particular instance of any Java object created by its
class’s constructor method.

A constructor method must be called or invoked in conjunction with the Java “new” keyword, which
we will cover next. The new keyword creates a new object in a new area of system memory, so it’s
keyword appropriate!

Next, let’s look at how you would create new Car objects in your current MainActivity.java class
Java code.

Instantiating Objects: The Java “new” Keyword

To create an instance of an object, you instantiate it. Here’s what it would look like if you added
this code to the .onCreate() method of your current Android application. This shows the creation
of two Car objects, as well as how you would use these Car objects along with dot notation to call
the methods that would operate upon them. Refer to Figure 3-8 in Chapter 3 to see this bootstrap
.onCreate() method code for the Android app.

public void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity main);
// Tuo forward slashes allow you to insert comments into your code

// Create new Car Objects using the Car() constructor method
Car carOne = new Car("carWon", 20, "S", "Blue");
Car carTwo = new Car("carTwoon", 10, "N", "Green");
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//  Invoking three methods on CarOne Car Object by using dot notation
carOne.shiftGears(3);

carOne.accelerateSpeed(15);

carOne.turniWheel("E");

//  Invoking three methods on CarTwo Car Object by using dot notation
carTwo.shiftGears(2);
carTwo.applyBrake(10);
carTwo.turnWheel("W");

}

Upon launch or creation of our Android application, which is what the .onCreate() method is used
for, we now have instantiated and configured two Car objects. We have done this by using the Car()
class constructor along with the Java new keyword, which creates a new Car object for us, using
the following Java code format:

Car carOne = new Car("carName", carSpeed, "carDirection", "carColor");

The syntax for doing this is very similar to what we used to declare our variables:
Define the object type Car

Give a name to our Car object (carOne) that we can reference in our class and
method code

Set the carOne object equal to a new Car object definition using four “state”
value parameters (a String carName, an integer carSpeed, a String carDirection,
a String carColor)

It is also important to notice that | have put comments in the Java code by using two forward
slashes, which tells the Eclipse Java compiler to “ignore everything else on this line after these, as it
is a comment!”

To invoke our methods using our new Car objects requires the use of something called dot notation.
Once you have created and named a Java object, you can call methods off of it, by using the
following code construct:

objectName.methodName(parameter 1list variable);
So, to shift into third gear on the Car object named carOne, we would use this Java code statement:
carOne.shiftGears(3);

This “calls” or “invokes” the .shiftGears() method off of the carOne Car object, and “passes over” the
gear parameter, which contains an integer value of 3. This value is then placed into the newGear
variable, which is then utilized by the .shiftGears() method’s internal code.

So, as you can see in the final six lines of code in the public void onCreate() method, we set the
carOne Car object to third gear, using .shiftGears(3), accelerate it from 15 to 30 mph, by accelerating
by a value of 15, using .accelerateSpeed(15), and then turn east by using the .turnWheel() method
with a String value of "E" (the default direction is north, or "N").
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Car two (carTwo) we shift into second, using .shiftGears(2), then .applyBrake(10) to slow it down
from 15 to 5 mph, and finally turn the car west, by using a .turniheel("W") method call, all using
dot notation.

Dot notation “connects” the Java method call to the Java object, invoking that method on that Java
object. Once you understand it, you will see it is actually really cool how Java works!

We will be creating a custom class for your HelloUniverse Android app during the second half of this
chapter, and so you will be getting some excellent experience creating your own constructor method
very soon.

Extend an Object’s Structure: Java Inheritance

There is also support in Java for developing different types of custom objects, in this case it’s a Car
object, by using a technique called inheritance. Inheritance is where more specialized Car classes
(more uniquely defined Car objects) can be subclassed using the basic Car superclass. The
inheritance process is shown in Figure 5-2.

INHERITANCE OF A CAR OBJECT
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Figure 5-2. Inheritance of the Car Object superclass to create the SUV and the SPORT Car Object subclasses

Once a class is used for inheritance by “subclassing” it, it becomes a superclass. Ultimately, there
can be only one superclass at the very top of the chain, but there can be an unlimited number of
subclasses. All of the subclasses inherit the methods and fields from the superclass. The ultimate
example of this in Java SE is the java.lang.Object superclass (I call it the masterclass), which is
used to create all other classes in Java.

As an example of inheritance using our Car class, we could create the Suv subclass, using the Car
class as the “master” class. This is done using the Java “extends” keyword, which extends the
Car class definition, creating the Suv class definition. The Suv class will then define the attributes
(variables) and behaviors (methods), which then apply only to an SUV type of car, in addition to
extending all of those attributes (variables) and behaviors (methods) that apply to all types of

Car objects, which is the functionality that the extends keyword provides to the subclassing
(inheritance) operation.
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The Suv subclass might have additional .onStarCall and .turnTowLightOn() methods defined, in
addition to inheriting the usual Car object operational (basic car function) methods allowing the Car
object to shift gears, accelerate, apply the brakes, and turn the wheels.

Similarly, we might also generate a second subclass, called the Sport class, which would create
Sport objects. These might include an .activateOverdrive() method,to provide faster gearing, and
an .openTop() method,to put down the convertible roof.

To create a subclass using a superclass, you extend the subclass from the superclass, by using the
Java extends keyword inside of the class declaration. The Java class construct would thus look just
like this:

class Suv extends Car {
// Additional New Variable Data Fields, Constants, and Methods Will Go In Here.
}

This extends the Car class so that Suv objects have access to, essentially contain, all of the data
fields and methods that the Car object features. This allows the developer to have to focus only on
just the new or different data fields and methods that relate to the differentiation of the Suv object
from the regular or “master” Car object definition.

Since classes create objects, given that they have a constructor method, the same hierarchy could
be applied at the spawned object level. So logically, the Suv object will be more complex (more data
fields and functionality) than a Car object.

To refer to one of the superclass’s methods from within the subclass you are coding, you can use
the Java super keyword. For example, in the new Suv class,you may want to use the master Car
object’s .applyBrake() method, and then apply some additional functionality to the brake that is
specific to SUVs. You can call the Car object .applyBrake() method by using super.applyBrake()

in the Java code. The following Java code will add additional functionality to the Car object’s
.applyBrake() method, inside of the Suv object’s .applyBrake() method, by using the super keyword
to access the Car object’s .applyBrake() method, and then adds in additional logic:

class Suv extends Car {
void applyBrake (int brakingFactor) {
super.applyBrake(brakingFactor);
speed = speed - brakingFactor;

}

This code makes the Suv object’s brakes twice as powerful as the generic Car object’s brakes,
which is again something that would have to take place in “real life” for an SUV to be safe for

use. The reason this Java code doubles the SUV’s braking power is because the Suv object’s
.applyBrake() method first calls the Car object’s .applyBrake() method from the Car superclass using
the super.applyBrake(brakingFactor); line of Java code in the Suv subclass .applyBrake() method,
and then the line of Java code that comes next (again) decreases the speed variable, by applying the
brakingFactor a second time, making the brakes twice as powerful or effective!
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Be sure to use good programming practices and refer to documentation for your superclass’s fields
and methods within each subclass that uses the super keyword to reference these superclass
programming infrastructures in one way or another. The Java class documentation should let users
(developers) of your superclass know which of your superclass fields and methods are “public” and
are available for use, since these do not explicitly appear in the Java code for the subclass, as only
incremental code (methods and variables) appear in the subclass code.

The Interface: Defining a Class Usage Pattern

In many Java applications, as well as in the Android APIs, Java classes must conform to a certain
usage pattern.

There is a specialized Java construct called an interface that can be implemented so that
application developers will know exactly how to utilize the Java classes implementing an interface,
as well as the methods required for proper implementation of the class. Implementing an interface will
thus allow your class to become more “conformant” regarding those behaviors that your class offers
for use.

Interfaces in essence are forming a “programming contract” between your class and the rest of the
development world. By implementing a Java interface, the Java compiler can enforce this contract
at build time. If a class “claims” to implement a public interface, all of the methods that are “defined”
by that Java interface definition must appear in the source code for the class that implements that
interface before that class will successfully compile.

Interfaces are especially useful when working within a complex Java programming framework like
Android that is utilized by other developers who build applications on the Java classes that the
Google Android OS developer team members have written specifically for that purpose. A Java
interface can be used like a roadmap, showing developers how to best implement and utilize the
Java code structure that is provided by that Java class within another Java programming structure.
Basically, a Java interface guarantees that all methods in a given class will get implemented together,
as an inter-working, inter-dependent collective programming structure, guaranteeing that any
individual function needed to implement that functional collective does not get inadvertently left out.

This public interface that the class “presents” to other developers who are using the Java language
and Android platform makes using that class more predictable, and allows developers to safely

use that class in programming structures and objectives where a class of that particular end-usage
pattern is suitable for their implementation.

In other words, a public interface is an implementation roadmap that tells your application what
that class needs to do and how to implement it without your application needing to test that class’s
functional capabilities.

In Java terms, making a class conform to a usage pattern is done by implementing an interface.
The following is an ICar interface, which forces all cars to implement all of the methods that are
defined in this interface.

These methods must be implemented (exist) even if they are not utilized (that is, no code exists
inside the curly braces). This also guarantees that the rest of the Java application knows that each
Car object can perform all of these actions or behaviors, because implementing the ICar interface
defines this public interface for all of the Car objects that implement the ICar interface.
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The way that you would implement the ICar public interface for the methods in your Car class is as
follows:

public interface ICar {
void shiftGears (int newGear);
void accelerateSpeed (int acceleration);
void applyBrake (int brakingFactor);
void turnWheel (String newDirection);

}

So, the Car class that implements this ICar public interface must implement all of the declared
methods when implementing a Car class using this ICar interface.

To implement an interface, you need to use the Java implements keyword, as follows, and then
define all of the methods exactly as you did before, except that the methods must now be declared
using a public access control modifier, in addition to the void return data type. We will be covering
Java modifiers in a future section of this chapter, after we cover the Java package and the concepts
of APIs.

Here is how a Car class would implement this ICar interface using the Java implements keyword:

class Car implements ICar {
int speed = 15;
int gear = 1;
int drivetrain = 4;
String direction = "N";
String color = "Red";

String fuel = "Gas ";

public void shiftGears (int newGear) {
gear = newGear;
}

public void accelerateSpeed (int acceleration) {
speed = speed + acceleration;
}

public void applyBrake (int brakingFactor) {
speed = speed - brakingFactor;
}

public void turnWheel (String newDirection) {
direction = newDirection;
}

}

Notice we added the public keyword before the void keyword, which allows any other Java classes
to be able to call or invoke these methods, even if those classes are in a different package (packages
are discussed in the next section). After all, this is a public interface, and anyone (more accurately,
any class) should be able to access it.
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A Java interface cannot use any of the other Java access control modifier keywords, so it cannot be
declared as private or protected. We’'ll be learning about these access control modifiers in a future
section of this chapter.

It is important to note that only the methods declared in the interface absolutely need to be included.
The data fields that | have at the top of the class definition are optional and are in this example to
show its parallel to the Car class that we declared earlier without using an interface. There is not
much difference other than using the implements keyword, except that implementing an interface
tells the compiler to check and make sure that all of the necessary methods that make a Car class
complete (work properly) are included by the developer.

Logical Collection of Classes: Using a Package

As you know, each time you define a new project in Android, the Eclipse Integrated Development
Environment (IDE) will create a package to contain your own custom classes, which you will define
as you implement your application’s custom functionality. In your HelloUniverse Android application,
which you created back in Chapter 3, you named your package as absolute.beginner.hellouniverse.
If you remember, that first dialog in the New Android Application Project series of dialogs asks
you to specify this package name (refer to Figure 3-3 if you need to refresh your memory).

The Java package declaration is the first line of code in any Android application class, or in any
Java class in any application for that matter. The package declaration tells Java how to package
your application. Recall the first line of code in our Hello Universe application’s MainActivity.java
Activity class, as shown in Figure 3-8:

package absolute.beginner.hellouniverse;

After the package keyword and declaration come the import statements, which import existing
Java classes and packages into your declared package. So, a package is not only for your own
code that you write yourself, but also for all code that your application uses, even if it is open source
platform code, or even code that has been written by another programmer or company, or, in the
case of Android applications, Android API code, which serves up Android OS functionality that is
only available within the Android OS.

Basically, a package naming strategy is similar to the folder naming hierarchy on your computer.
A package is just a way of organizing or grouping Java code according to its functionality. As an
example, Android organizes its classes into many logical packages, which we will routinely import
and use throughout this book.

Each Android API Level (Level 19 for the 32-bit Android KitKat OS version 4.4, or Level 20 for the
64-bit Android 5 OS) contains a vast collection of functional packages that are utilized by developers
to access the Android OS feature set. We will take a closer look at APIs in the next section of this
chapter. In our Hello Universe application in the previous chapter, you needed the following import
statement in your MainActivity.java file to be able to utilize the Bundle class:

import android.os.Bundle;
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This is basically to address where the code for each import statement is located. Here is a
generalization of how an import statement follows a path to the class:

import platform.functionality.classname;

The Android Bundle class import statement tells us the following information about the Bundle
Java class:

android indicates that this is an Android OS development package.

os refers to the operating system utilities functionality inside of this android.os
package.

Bundle refers to the proper name of the class that we intend on using, or
sub-classing.

Thus, the Activity class, which is the superclass for any Android Activity that you create, is found
within the android.app package. This .app part says that this package logically contains classes that
are necessary for the creation of Android applications, and one of these is the Activity class, which
allows us to define Ul designs. The Bundle class, which allows us to bundle together application
variables into custom Bundle Objects, is kept in a different package for OS utilities as Bundle
Objects can be used in any area of Android, not just Activity.

The API

You might be wondering if the package is the highest level of organization in Java. The answer

is actually no, there is one even higher level, which is as you might imagine a collection of these
packages themselves! This level is sometimes called the platform or application programming
interface (API) level. An API for any given programming platform, like Android or Java, is a collection
of all of the packages for that given language.

Thus, there is a separate API for Java SE, Java EE, and Java ME, containing all the packages for
each specialized platform’s implementation, as well as an Android API, such as you are using in your
Hello Universe application currently. Android 4.4.4 KitKat API Level 19 is the 19th Android platform
to be released so far, and Android 5.0 “L” API Level 20 is the first 64-bit version of Android, and the
20th Android platform, and will be released sometime during the fourth quarter of 2014.

For this reason, if you want to develop applications using any given programming language, you
must go and get (and eventually learn) the API for that programming language in order to be able to
develop an application using its API, which is simply a collection of all of that language’s classes,
methods, and interfaces, which have been logically grouped in packages. You'll essentially be
learning about core classes used in API during the course of this book.

Modifiers: Data Type, Access, Inheritance

Java uses strategic keywords prefacing, or in front of, its major constructs, which include: variables,
methods, and classes. These are also used in front of more specialized Java constructs, such as
public interfaces or constructor methods, all of which we’ve been learning about in this chapter.
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Since we have already looked at data type keywords in the chapter already, at least the void
(signifying no data type used), String (text data type,) and int (Integer or whole number data), | will
go over all of the other data type keywords that are used in Java and Android here, and then we will
cover the more advanced access and non-access modifiers that are used in the Java programming
language.

It is important to note that even though using a data type keyword in front of your variable names
modifies the type of data that they are defined to contain, the more precise technical term in Java
for this data type keyword is a data type specifier keyword. These two terms are often used
interchangeably in Java; in the next section, the access control modifiers could indeed be looked at
as access control specifiers, as they are indeed specifying the level of access control by prefacing a
Java keyword in front of the Java programming construct.

Other types of data type specifier keywords used in Java (and thus in Android) include float or
floating point numbers, which have a fractional component represented by decimal notation, for
instance, 1.375, as well as boolean, which hold Boolean math “states” such as true and false. There
are other data types in Java for holding more complicated (longer) numeric representations, such as
the long and double data types, which have 64-bit accuracy and can accommodate extremely large
or extremely small numeric representations. There is also a data type that can hold one single 16-bit
Unicode character, called the char data type. The byte data type can hold one number from an 8-bit
range (256, from -128 to +127) of numeric data values, and finally the short data type can hold one
number from a 16-bit range (65,536, from -32,768 to +32,767) of numeric data values. Data types
are relatively easy to understand in comparison to access and non-access modifiers, which we will
cover next.

Java Access Modifiers: Four Levels of Access

Java has a number of modifiers that you can place before Java constructs to define what they
are and who can see them. There are two types of Java modifiers, access control modifiers and
non-access control modifiers.

In case you are wondering what | mean by access control, I'm talking about other Java
programming constructs outside of a given Java class or package being able to reference and
utilize Java assets inside of those packages.

You can apply access control modifiers to classes, methods, interfaces, constructors, and
variables, and include the public, private, and protected Java access modifier keywords. Not
using any access control keyword at all also defines a level of access control, so let’s cover all of
these concepts here in order from the most restrictive (closed) level of access control to the least
restrictive (open) level of access control.

Table 5-1 shows the four different levels of access control modifier in one place.
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Table 5-1. Access Control Modifier Keywords in the Java Programming Language and Their Functionality Definitions

Access Modifier Keyword:  Functionality Definition:

private Access is allowed only within that class

protected Access is allowed only to subclasses of that class and other classes in the package
public Access is allowed to all classes even outside your package

unspecified Access is allowed only to other classes within the package

As you might imagine, the private access modifier is the most restrictive, and if declared, only allows
access to private variables and private methods from inside of the containing class. It is important

to note that classes cannot be declared as private, unless they are inside of another class, in which
case they are a special case and are called “private inner classes.” Java interfaces, which we
learned earlier, are public interfaces, and also cannot be declared as private since they are inherently
public in their access control.

The next most restrictive access modifier keyword is the protected access modifier keyword,

which is utilized in Java classes that are intended to be used as superclasses, and that need to
allow access to their subclasses to protected variables, protected methods, as well as protected
constructors. Protected access could be viewed as being protected from access by any class
outside of the inheritance chain, keeping it in the family, if you will. Thus, other members of the same
package can also access protected class members.

Like the private access modifier, the protected access modifier cannot be applied to any class itself,
only to Java code elements inside of the class. Protected access cannot be applied to any Java
interface definition, as these are required to be declared using the public access control modifier
keyword. It also follows that methods and data fields (variables) within an interface definition also
cannot be declared using a protected access control modifier keyword, as they also must always
be declared using the public or the abstract access control modifier. If an access modifier is not
explicitly provided for a method inside of an interface, it will default to be declared as public.

The next most restrictive access modifier is actually using none of the access control modifiers at
all, which is the “norm” in Java, as we saw when we created our original Car class, using the data
type declarations of void, int, or String without any public, private, or protected modifier in front of
(before) them. Using no access control modifier allows visibility throughout your entire package,
essentially, inside of your entire application if you have the entire Android application in one package,
as we will be doing in this book.

The least restrictive access modifier, which removes all access restrictions, is the public access
control modifier. This allows Java code in other packages to access your variables, methods,
interfaces, and classes from outside of your package. It’s like you are opening the door to your code
and saying “come on in, folks!“

It is important not to confuse access control and non-access control modifiers with data type
declarations, which are used before variables to declare their data type, and which thus look a lot
like a modifier. In fact, modifiers and data type declarations are often utilized right next to each other,
like in the public void shiftGears() method.
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Java methods have their own rules regarding inheriting access control modifiers as classes that
contain them are later subclassed and enhanced to become more detailed and refined subclasses.
For instance, any method that has been declared using public access in a superclass must also be
declared using public access in all subclasses. Similarly, any method that has been declared using
protected access in a superclass must either be declared using protected access, or using public
access, in any subclass. It can never be declared using a private access control modifier. A method
declared without using an access control modifier is the only scenario where a method can be
declared using a private access control modifier in a subclass.

It is important to note that a method that has been declared using a private access control modifier
keyword is not inherited, because it is private relative to the class within which it is contained, and
no others, including any subclasses. As you can see, although access control modifiers seem fairly
simple and straightforward, you have to pay attention to what you are doing with them, especially
where inheritance (superclasses and subclasses) is going to be utilized in your Java programming
structure and package design.

Non-Access Modifiers: Static, Final & Abstract

There are also modifiers in Java that are not access control modifiers and not data type declarations.
These are called non-access modifiers, and these are the most complicated ones to understand and
implement in practical use. There are three modifiers that are frequently used in Java programming
that we will be covering in this section of the chapter: the static modifier, the final modifier, and the
abstract modifier.

There are also some more advanced modifiers such as synchronized or volatile, which are used to
manage the use of threads, a topic that is beyond the scope of an Absolute Beginners level Android
programming book.

The static Keyword

A static modifier keyword when used in conjunction with a variable will create a variable that

will exist independently of any object instances created using that class. Static variables will be
initialized only one time, at the start of the execution of the application, sometimes called the
“app launch.” The variables that use the static modifier keyword will be initialized first, before the
initialization of any instance variables.

Only one copy of a static variable will exist in system memory regardless of the number of instances
of the class that contains that variable are created. Thus, static in Java programming means a
variable that belongs to the class and not to the object instances created by that class.

Objects created by that class can share that variable with the class and with each other, so use of
static variables can optimize system memory. The opposite of static is “dynamic,” and thus, any
variable not declared as static would therefore be “dynamically” created (created at the time it is
needed, not ahead of time as when it is declared statically), and system memory would be allocated
for that variable in each object instance created by the class constructor method.
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To use a variable from the Car class example, if you wanted all Car objects to reference the fuel
variable, which is set in the code to “Gas” at the class level, and wanted that fuel variable to belong
only to the class, and not to any of the Car objects that will be created using that class, you would
declare the fuel variable as follows:

static String fuel = "Gas";

The static modifier keyword works in much the same way for methods that are declared as static,
thus a static modifier would be utilized to create methods that are intended to exist independently of
any object instances created using the class. This again “fixes” the method in place, so it is the only
“copy” of that method that will be used by your class and objects from that class.

A static method can be referenced using the class name and dot notation even without an object
instance of the class ever being created. For instance, if you declared the .applyBrake() method to
be static, you could reference it using the code statement Car.applyBrake() even without having
created a Car object using the new keyword.

Static methods cannot use any instance variables of any object instances created using the class
in which they are defined, until one of those object instances has been created. Static methods
should take all their data values from the incoming parameter list, and then compute something from
those parameters, with no reference to variables, which are inherently not “static” because they’re
variable!

It is possible to access your class variables and methods inside of a static method. Use the class
name followed by a period and then the name of the variable or method, so using your Car class
example, you could access your Car object’s speed variable using Car.speed, or its .shiftGears()
method, by using for instance a Car.shiftGears(4) method call, similar to what you would do off of a
Car object instance.

So to recode your .applyBrake(int brakingFactor) method as static and reference the class speed
variable, you would modify your method to look something like this:

public static void applyBrake (int brakingFactor) {
Car.speed = Car.speed - brakingFactor;
}

Notice that the access control modifier comes first, then the non-access modifier, and then finally
the return data type declaration comes last in the list. This is the modifier and declaration ordering
convention for the Java programming language. Next, let’s look at the final modifier, which
sometimes gets confused with the static modifier, as the final modifier also means that something
cannot be changed, and is thus “fixed” as welll Java can be confusing in a number of areas, and this
happens to be one of them!

The final Keyword

You can define a class using the final modifier keyword, and if a class is final, it cannot be subclassed.
This is usually implemented for reasons of Java security, so tested, mission-critical Java code
cannot be modified or changed. You will notice as we get deeper into the Android API and Java that
many standard Java library classes are declared using the final modifier keyword. As an example,
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the java.lang.System and java.lang.String classes are declared to be final so that their functionality
cannot be altered.

All methods in a final class are implicitly final. Any method that is declared using the final modifier
keyword cannot be overridden by subclasses. This is also for security reasons and is used to
prevent unexpected behavior from a subclass altering a method that might be crucial to the function
or consistency of a class’ functionality.

You can explicitly initialize a final variable only once. A reference variable that is declared as final can
never be reassigned to refer to a different object, if the variable references an object, rather than a
data value. If the final variable references an object, the data contained within that object can still be
changed, only the reference to the object is “fixed,” and is said to be final.

Thus, you can change the state of an object referenced by the final variable, but not the reference
to the object, which is what is “locked” or final. With variables, the final modifier is often utilized in
conjunction with the static modifier to make the class variable into what is considered a “constant”
or an immutable fixed variable for the duration of the class.

As an example, the <string> constant named app_name that you defined using XML in the
strings.xml file would have to be declared in your application’s Java code by using the following
single line of Java syntax:

public static final String app_name = "Hello Universe";

This shows how using XML to define constants is much simpler than using Java. Next, let’s take a
look at the abstract modifier keyword, which allows you to create classes that can be subclassed
but not instantiated.

The abstract Keyword

A class declared using an abstract modifier keyword can never be instantiated, so it follows that
a class logically cannot be declared using both an abstract modifier and a final modifier, because
if a class cannot be instantiated or extended, it will not be of much use in the scheme of the Java
programming language.

If a class is declared as abstract, then the sole purpose for that class is to be extended—that is,
subclassed. If a class contains any methods that have been declared using the abstract modifier,
then the class should also be declared using the abstract modifier. If a class contains abstract
methods and is not declared as abstract, a compiler error will be “thrown” when you use the Eclipse
Run As » Android Application work process, which invokes the Android Java code compiler. Every
time the compiler encounters an error, it “throws” it into the error log, which is now monitored in real-
time by your LogCat tab in Eclipse. It is important to note that if your application will not compile, it
also will not run!

An abstract class can, however, contain both abstract methods as well normal (non-abstract)
methods, so the rule is if you want to put an abstract method inside of a class, make that class
abstract as well, or you will get a compiler error. You cannot have abstract methods inside of a class
that is not also declared as abstract.
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Creating Your HelloUniverse Class: Galaxy

Now that we have gone over the main Java constructs and concepts, let’s get some real-world
experience with Java and code a Galaxy.java class for our Android HelloUniverse application.

We will use our Hello Universe app as an example of how to create a functional Java class from
scratch, and create a class that will define and manage our Galaxy objects, so that you can see
these concepts in action! This Galaxy.java class will also be something that we can utilize and build
upon as we progress throughout the book, so it is the perfect example.

Defining a Galaxy Class: Variables and Methods

First, let’s define some of the attributes or characteristics of our Hello Universe app’s Galaxy class
(and thus of the Galaxy objects that will be created using this Galaxy class’s constructor method) as
shown in Table 5-2.

Table 5-2. Galaxy Class Data Fields (Variables) Along with Their Data Type Specifier Values

Class Variable Name Data Type Specifier Used, and Information Held in the Variable
Galaxy Name String data type containing a text value, such as “Milky Way”
Galaxy SolarSystems An integer value representing the total number of solar systems
Galaxy Planets An integer value representing total number of habitable planets
Galaxy Colonies An long data value representing the total number of colonies
Galaxy Population A double value representing total number of sentient life forms
Galaxy Fleets An integer value representing a total number of starship fleets
Galaxy Starships An integer value representing the total number of starships

As you can see, our Galaxy object(s) will need to have a name, number of solar systems, number of
habitable planets, a number of habitable colonies, a population of life forms, a number of starship
fleets, and a number of starships that are in that Galaxy object. This Galaxy object will help keep

track of our “high-level” Galaxy information for each Galaxy object that we add to our Hello Universe
simulation.

Next, let’s define our Galaxy object behaviors, or functions, that can be attributed to our Galaxy
objects, such as “getting” and “setting” the number of colonies in the galaxy, the total life form
population, the total number of starship fleets, and the total number of starships in the galaxy, as
seen in Table 5-3.
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Table 5-3. Galaxy Class Method (Behavior) Names, Along with Their Functionality Specifications

Name of Method: Functionality of Method:

Galaxy(constructor) Constructor method, which creates each Galaxy object instance
setGalaxyColonies Method allowing the number of Galaxy colonies to be set
getGalaxyColonies Method that returns the current number of Galaxy colonies
setGalaxyPopulation Method allowing the total population of the Galaxy to be set
getGalaxyPopulation Method that returns the current total population of the Galaxy
setGalaxyFleets Method allowing a total number of fleets in a Galaxy to be set
getGalaxyFleets Method that returns the current number of fleets in the Galaxy
setGalaxyStarships Method allowing the number of starships in the Galaxy to be set
getGalaxyStarships Method that returns the current number of starships in a Galaxy

As you can see, these are behaviors or characteristics that each new Galaxy object can do, or can
change, about its current existence (states or characteristics), including your Galaxy() constructor
method, which can actually create and initialize a new Galaxy object, which will represent and track
all the variables specified in Table 5-2.

Coding the Galaxy Class: Variable Declarations

Let’s add to our Hello Universe application example from the previous chapters, and create a new
Galaxy class that generates Galaxy objects for our existing Hello Universe application. To declare
this new class, which we will call Galaxy, we will utilize the following Java class creation syntax:

public class Galaxy { instance variables, constructor, and methods will go in here, between these
curly brackets }

Just as is the convention with any other modern programming language, the first items that we will
want to declare at the top of our Java Galaxy class are our instance variables, which we are going to
use to hold the attributes or states of our Galaxy objects. In Java, this is done by using the following
generalized format:

<data type declaration» <¢instance variable name» = <set variable value;

So, for our Galaxy object state instance variables that we described in the previous section, we
would write the variable description lines of code as follows, shown inside of the public Galaxy class
definition code structure:

public class Galaxy {

String galaxyName;

int galaxySolarSystems;
int galaxyPlanets;

long galaxyColonies;
double galaxyLifeforms;
int galaxyFleets;

int galaxyStarships;
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We are not using any default values for these instance variables because that is something that we
are going to want to do in our constructor method parameter list and constructor Galaxy object
initialization code, which will create and initialize (set starting data values for) each Galaxy object
we create using a Java new keyword. Normally, you would declare only the data types and variable
names, and set the data values later, using your constructor method, which we will be looking at in
the next section. If you wanted to set the data values as part of the variable declaration, here is an
example of what that would look like with the galaxyName variable:

String galaxyName = "The Milky Way";

Coding Galaxy Objects: Constructor Method

Now let’s look at adding some functionality to the Galaxy class by adding in methods using Java
code that will start right after our variable definitions end. The first method we need to define is the
constructor method that has the same name as the class, so it will be called public Galaxy(parameter
list) and will create and initialize our Galaxy objects as we add them to our Universe.

The initialization code for the constructor method will live inside of the curly braces, which will
always define the beginning and end of each Java method that you create (code). This first Galaxy()
method is the very special type of method called the constructor, and this constructor method’s Java
code would be written as follows:

public Galaxy (String name, int solarSys, int planets) {
galaxyName = name;
galaxySolarSystems = solarSys;
galaxyPlanets = planets;
galaxyColonies = 0;
galaxyLifeforms = 0;
galaxyFleets = 0;
galaxyStarships = 0;
}

Inside of this Galaxy() constructor, we take three important parameters for our new galaxy’s name,
number of solar systems, and number of planets, and we then set them using the = operator
inside of the constructor method, where we will also be initializing the other Galaxy object instance
variables to zero.

Creating Galaxy Functions: Coding Your Methods

Next, let's code our other eight methods, which perform functions that check on (called “polling”

or “getting”) and modify (called “setting”“) the state of our Galaxy’s component attributes or
characteristics. This will provide a number of useful “galaxy building” capabilities to the users of your
Hello Universe application. We are going to use the .set() and .get() method naming format, which is
commonly used throughout Android, so that you see the convention for how things are done in Java
(and Android) at its most fundamental level.
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You might be wondering: “Why not code an .addGalaxyColonies() method?” The answer is that
then you would also have to code a .subtractGalaxyColonies() method call, for when any colonies
were destroyed by starship fleets! By having a .setGalaxyColonies() method, we can add and
subtract colonies in our gameplay code logic, and simply call a .setGalaxyColonies() method when
we are done to update the Galaxy object galaxyColonies data value in either direction, up or down.

The first .setGalaxyColonies() method is much simpler than our Galaxy() constructor method, and
it will allow us to set the number of colonies in our Galaxy object. The Java code for this method
would be written as follows:

void setGalaxyColonies (long numberColonies) {
galaxyColonies = numberColonies;

The void return data type that is declared before our .setGalaxyColonies() method name declares
what type of data value will be returned by this method. In this case, the method does not return any
data value at all, thus we’ll declare it as being of the void return data type (that is, devoid of any data
return type or return data value).

Also note that our method name begins with a lowercase letter, and uses uppercase letters for
words that are internal to the method name. Inside the .setGalaxyColonies() method body, we’ll
utilize an assignment operator that sets the galaxyColonies instance variable to the value in the
numberColonies long parameter.

In Java programming, assignment operators are how we set the values of instance variables, which
we declare at the head, or top, of our Java class.

We will do something very similar with the .setGalaxyPopulation() method, which will look like this,
once we code it in Eclipse ADT, which we will be doing a little bit later on in this chapter:

void setGalaxyPopulation (double numberLifeforms) {
galaxyLifeforms = numberLifeforms;
}

Next, let’s code our .setGalaxyFleets() method, which lets us set the number of starship fleets
in our Galaxy objects. This method will set the galaxyFleets count instance variable, using the
assignment operator, as shown in the following Java method construct:

void setGalaxyFleets (int numberFleets) {
galaxyFleets = numberFleets;

Finally, let’s code our .setGalaxyStarships() method, which lets us set the number of starships in
our galaxy. This method will set the galaxyStarships count variable, using the assignment operator,
as is shown in the following Java method construct:

void setGalaxyStarships (int numberStarships) {
galaxyStarships = numberStarships;
}
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The .get() methods do not involve any assignment operators, as they simply “return” the requested
data field value, which is essentially the current variable value in the Galaxy object. The .get()
methods use the return data type of the variable data type that is being returned. There are no
parameters passed in the method call, so the parenthesis are empty, because a call to one of the
.get() methods simply returns the requested value.

For instance, if you instantiate a Galaxy() object named theMilkyWay, to get the colonies would look
like this:

theMilkyWay.getGalaxyColonies();  (this would return the galaxyColonies variable value at that
moment in time)

The .get() methods for the Galaxy class and object would thus be coded in Java using the following
structures:

long getGalaxyColonies() {
return galaxyColonies;
}

double getGalaxyPopulation() {
return galaxylifeforms;
}

int getGalaxyFleets() {
return galaxyFleets;
}

int getGalaxyStarships() {
return galaxyStarships;
}

Now we are ready to open up the HelloUniverse project in Eclipse ADT and create our new Galaxy
Java class. We will write all of this code that we’ve developed until now into the Eclipse central
text editor pane, so we can use it later on in the book in our HelloUniverse application to create,
populate, and track our new Galaxy objects.

Creating a Java Class in Eclipse: Galaxy.java

Launch Eclipse ADT, if it is not already open on your Android development workstation, and close
(using the x icon) the XML tabs at the top of the central editing pane, which will clear them out of the
central editing area, making room for our Java Galaxy class programming coming up next.

1. Inthe Package Explorer pane on the left side of Eclipse ADT, open the
/src source code folder, the package sub-folder, and the MainActivity.
java sub-sub-folder so that you can see your MainActivity.java class,
as shown in Figure 5-3. Notice that the Package Explorer allows
you to open up your MainActivity class structure as well, so you can
also see the void onCreate(Bundle) method as well as the boolean
onCreateOptionsMenu(Menu) method. You can also see the LogCat error
message management tab that we added in the last chapter, which is shown
at the bottom of the Eclipse ADT IDE, along with the other problems, error,
and debugging-related tabs.
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Figure 5-3. Eclipse with central editing pane cleared for Java editing, and /src folder open showing files

2. To create a New Java Class, right-click on the /src folder, as shown in
Figure 5-4, and select the New » Class menu sequence, which will bring
up the New Java Class dialog, which allows you to enter all of the pertinent
information needed for Eclipse to create a “bootstrap” Galaxy.java class
infrastructure for you.
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Figure 5-4.

Right-click on the HelloUniverse/src folder, and then select the New » Class menu sequence
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3. Asyou can see in Figure 5-5, a New Java Class dialog allows you to click
the Browse button next to the Package field to open the Package Selection
dialog, where you can select the absolute.beginners.hellouniverse package,
and click the OK button. Then all you have to do is to Name the class
Galaxy, and then click the Finish button.

(@) New Java Class - o IEH @ Package Selection - o IEl

Java Class 3 Choose a folder:
Create a new Java class. Q
fH (default package)
Source folder: HelloUniverse/src Browse... B3 absolute
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IES .absolute.beginnels.hellouﬁ.i\re!sé]i
[[]Enclosing type:

Modifiers: ®@public (O default private

[ abstract []final static
Superclass: java.lang.Object Browse...
Interfaces: | Add...

Which method stubs would you like to create?
[ public static void main(String[] args)
[] Constructors from superclass
[ Inherited abstract methods
Do you want to add comments? (Configure templates and default value here)

[ Generate comments

= : _
I.g:: C 2 ncel

Figure 5-5. The New Java Class dialog and the Package Selection sub-dialog accessed using the Browse button

4. After you click Finish, Eclipse will create the Galaxy.java class Java
structure, which is shown in Figure 5-6.
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Figure 5-6. Bootstrap Galaxy.java public class definition that the Eclipse New Java Class dialog created

Coding Your Galaxy.java Class with Eclipse ADT

Now all you need to do is to type in your seven instance variable declarations at the top of the
class, and then a Galaxy() constructor method under that, and finally the four .set() and four .get()
methods, which | have paired together logically, as shown in Figure 5-7. If you type everything in
accurately and all of your data types match, you will get the same error-free result that | did, which
you can see in Figure 5-7. As you’ll see during the book, Eclipse uses red x icons for errors and
yellow ! icons for warnings, none of which are appearing in our Java editing pane shown here, so
our Java code is error (and warning) free. Let’s compile the app just to make sure!
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Figure 5-7. The Galaxy.java class with instance variables, constructor method, and set and get methods

Right-click on the HelloUniverse project folder and use the Run As » Android Application menu
sequence to run the Nexus One AVD and you will see the application launch and the Hello Universe
screen shown back in Figure 4-15 (no need to duplicate screenshots unnecessarily here) will pop-up
onto your screen. We are running the app here simply to make sure that the application compiles
and runs, and thus that there are no errors in the Galaxy.java code. In the next chapter, we will use
the Galaxy class to create Galaxy objects, which we will display in a user interface design.

Summary

In this fifth chapter, you learned all about the Java programming language, as well as how the
Android platform utilizes Java to facilitate the application development work process, so the
programmers can get involved too!
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You learned about the various versions of Java used for enterprise, client, and mobile application
development, and about OOP. You learned about the java.lang.Object that is the foundation of OOP
and about how Java objects can define attributes, characteristics, states, and behaviors that allow
Java programmers to mimic real-world objects in our “virtual” software development environment.

Then you learned about all the various components of Java programming structures, such as
methods, constants, variables, classes, public interfaces, and constructor methods. You learned
about the Java concept of inheritance, and how to use the new keyword to instantiate an instance of
a Java object using a constructor method call.

Then you looked at the higher-level Java organization constructs called packages and how the total
collection of packages in a programming language forms the API for the language.

Next, you looked at some of the data type specifiers and access control modifiers as well as the
more complex non-access modifiers, and after that you were finally ready to design your first Java
class, called Galaxy, to create Galaxy objects for your HelloUniverse Android application.

You designed the entire Galaxy class, including seven instance variables, one constructor method,
and eight methods to get and set various attributes of the Galaxy object. Once this design was
accomplished, you coded the variable declarations, constructor method, and the functional methods
for the class, and then you typed them into Eclipse and compiled and ran the application to make
sure everything was compiling and would run, meaning there were no code errors introduced.

In Chapter 6, you will start to learn about how Android handles the device display screen by using
the Android View class, and all about the foundation of user interface design as it relates to the
Android OS.



Chapter

Android Screen Design: Writing
to the Display Using Activity
and View

Now that you’ve been exposed to the Android operating system, and have seen how it works from
a high-level view, have learned about XML and Java, and how they are used in Android application
development, the next thing we need to take a closer look at is how Android “addresses” or writes
things to the device display screen.

In the new age of touchscreen devices, such as smartphones, tablets, eBook readers, iTVs, and
smartwatches, the display screen has become the center of not only the visual feedback for your
application but also for interacting with it. This chapter will cover those classes that allow your
Android app to write things to the device display screen, such as Activity classes, Ul elements, and
of course, the app’s primary subject matter content.

There are some very important Android superclasses, such as Activity, View, and ViewGroup,
which provide a foundation for the subclasses that you will use to get your application content and
Ul onto the display screen. The superclasses are not used directly in the application, but you need to
know about them nonetheless.

We will look at Activity subclasses, used for organizing your application’s functional screens, which
ultimately will provide the structure for your end user’s workflow, let’s call it the “use-flow,” for your
Android application.

We will look at View subclasses, used for creating your application’s Ul element components; these
are also known as “widgets” in Android jargon, as you will soon see. We will look at the ViewGroup
subclasses, used for creating your application’s Ul layout containers. Layout containers are used
to contain View subclassed Ul widgets, which make up the body of the Ul design, providing the Ul
layout with its functionality.

167
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Finally, we will put all of this newfound knowledge to use, and will create your first custom Hello
Universe Ul design, so that you get some hands-on experience in creating your own Ul designs. We
will create a Galaxy object using your code from the previous chapter, and populate an information
screen for that object.

How Activity, View, and ViewGroup Relate

Before we look at the Android Activity, View, and ViewGroup superclasses and the functional
subclasses (those classes that you will actually utilize to construct your apps) that are created with
them over the next couple of chapters, it is important to understand how they all relate to each other
within the context of your application.

The reason I’m not including the Menu superclass and its functional subclasses in this chapter

is because menus in Android are “handled” separately from Ul widgets (View) and Ul layouts
(ViewGroup), in as much as they pop up over the screen triggered by a hardware MENU button or
the ActionBar Overflow menu. For this reason we are going to cover Menu objects separately, in the
next chapter. The one similarity is that each Activity subclass also has its own Menu system, as you
can see in Figure 3-8, set up via the second method, called .onCreateOptionsMenu().

As you have learned already, the Android runtime environment resides on top of the Linux operating
system (OS) kernel, and forms what is essentially the Android OS, under which your application
executes (runs). Your application defines itself to the Android RunTime (ART, for Android 5.0 and
later) or to the Android Dalvik Virtual Machine (DVM, for Android 4.4 and earlier OS versions) using
the AndroidManifest.xml application definition XML file that we looked at in detail during Chapter 4.

For each functional display screen in your app, which will generally contain some sort of Ul design,
as well as related content, your application will define an Activity subclass. Your Hello Universe
application currently has one of these Activity subclasses already, as you saw in Chapter 3 in
Figure 3-8, with your MainActivity.java class, which as you now know from what you learned in
Chapter 5 on Java is actually an Activity subclass, due to the public class MainActivity extends
Activity declaration at the top of the class.

Each Activity subclass in your Android application will be required to have an .onCreate() method
defined, and this method will in turn be required to contain a setContentView() method call, whose
parameter list contains a reference to that Activity’s Ul layout XML definition. For the MainActivity.
java class, this reference is R.layout.activity_main, which is Android “shorthand” to reference the
/res/layout/activity_main.xml file, as you can see in Figure 3-8, which after our Java primer chapter
should be making a whole lot more sense to you!

Android’s shorthand resource “path” definition starts with an “R,” which stands for “resources,” and
uses period characters (instead of slash characters) to reference the “layout” folder, and then the
“activity_main.xml” XML file. Notice that Android references do not include any file extension, so
R.layout.activity_main equates to your full Android project folder path as follows:
/workspace/HelloUniverse/res/layout/activity_main.xml.

The parent tag in this Ul layout XML definition will generally reference a ViewGroup subclass,
such as the RelativeLayout class, which in the activity_main.xml file is represented by a
<RelativeLayout> parent tag. The ViewGroup superclass in Android is used to subclass (create)
custom layout container classes in Android, which we will be covering in detail in Chapters 7 and 8.
There are a large number of custom layout container classes in Android, because these Ul layout
classes provide the foundation of Ul design in Android.
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Inside of a ViewGroup Ul layout container parent tag are child tags representing Ul elements, which
are called “widgets” in Android. Ul widgets are based on Android’s View superclass. Each widget,
like that <TextView> child tag you used back in Chapters 3 and 4, references an Android TextView
widget class, which is subclassed from the View superclass. Inside each (View subclass) Ul widget
child tag, you can set parameters that reference the new media assets for your application, such
as drawables (images and bitmap animation), animation (procedural, tween, or vector animation),
audio, video, shapes, custom Ul elements, and the like.

Thus, getting your new media assets onto the Android device display screen involves putting
parameters in child widget tags inside of parent Ul layout tags referenced by Activity subclass
methods declared in your application’s AndroidManifest XML file. This is all passed over to the
Android RunTime engine, which then converts these into machine language, and then passes them
over to the Linux Kernel, whose job it is to interface the software with the hardware and thus to write
your application Ul design and content to the Android device display screen hardware with pixel-perfect
accuracy. Whew! The chain from Android Runtime to app resources looks like this:

Android RunTime > Android Manifest > Activity Subclass > ViewGroup Parent Tag > View Child Tag >
Resource Parameters

To make it even easier to visualize, | created a diagram shown in Figure 6-1 that shows layers

(and connections) between your application’s new media resources, the Ul widgets that hold them,
Ul layouts that hold the Ul widgets, and the Activity subclass that defines and controls your Ul layout
XML definition, by referencing it using the .setContentView() method call. It is important to note that
since you can set the background image, or animation, for the Ul layout container, a ViewGroup can
also reference new media resources; thus, the new media resource area of the diagram in Figure 6-1
makes contact with both the View and ViewGroup subclasses.

Android Run-Time Engine

Android Manifest XML File
App Activity Subclasses
Ul Layout ViewGroup Subclass
Ul Widget View Subclasses
App New Media Resources

Figure 6-1. The stratification of an Android application from new media resources up to an Android device screen

As you learned in the previous chapters, your Android Manifest serves to define for the ART
what Activity classes an application contains, as well as what your application is allowed to do,
and other information about your application’s version history, support, structure, permissions,
communications, intents, and the like.



170 CHAPTER 6: Android Screen Design: Writing to the Display Using Activity and View

Next, we will take a closer look at the relationship between the ViewGroup (layout container) and the
View (Ul widget) superclasses in Android, since the ViewGroup superclass is actually a subclass of
the View superclass. It is interesting to note that a superclass can also be a subclass! ViewGroup
inherits characteristics like margin settings, which as you will see, are supported in both layout
containers (ViewGroup subclasses) and Ul widgets (View subclasses), thanks to Java inheritance, as
well as to how Android has coded these superclass structures.

The ViewGroup Class: A Subclass of View

Even though the View widgets are nested inside of ViewGroup layout containers, the ViewGroup
superclass is actually underneath (subclassed from) the View superclass in the Java class hierarchy.
Starting with a Java Object master class, the inheritance hierarchy is structured as follows:

java.lang.Object
> android.view.View
> android.view.ViewGroup

The reason that the Android OS development team structured (coded) the View class hierarchy in
this fashion is because some of the View class attributes, for instance, top, bottom, left, and right
margin attributes (properties, or parameters), will also be available for use in a ViewGroup layout
container, as well as in all View Ul widgets.

Thus, the logical Java structure is to subclass ViewGroup from View, so that the ViewGroup
subclasses inherit all of the same attributes and methods that the View subclasses will also feature.
If you want to take a closer look at what this Android View superclass includes, you can see for
yourself, by visiting the following URL.:

http://developer.android.com/reference/android/view/View.html

If you look at the View class reference page on the Android developer web site, you will see that
the View class has 11 known direct subclasses, one of which is ViewGroup. Some of the other
common Ul widgets such as the TextView, which you have already used in your app, as well as
ImageView and AnalogClock, which we will eventually be using in your application Ul design, are
also subclassed directly from the View class.

Note A known direct subclass is a subclass that has been created from the class that is being
documented on that developer web site class reference page. “Known” means it has been officially added
to the Android API. If you subclass your own Android class, it would be called an unknown direct subclass,
because it is “unknown” to the Android API. A known indirect subclass would represent any subclass of a
known direct subclass. It is said to be indirect to the class being documented, because it is more than one
level away from, and therefore not a direct subclass of, the currently documented class.


http://developer.android.com/reference/android/view/View.html

CHAPTER 6: Android Screen Design: Writing to the Display Using Activity and View 17

There are 63 known indirect subclasses of the View class, which are essentially subclasses of the

11 known direct subclasses. These are Ul elements, known as widgets in Android, and you will be
learning about some of these during the course of this book. Since ViewGroup (Ul layout) subclasses
are just as important as the View (Ul widgets) subclasses that are contained inside them, the
ViewGroup class also has dozens of direct and indirect subclasses with unique Ul layout features or
options. However, the ViewGroup class doesn’t have quite as many subclasses as the View class
does. Since referencing the Android developer web site page for the class you’re using is always a
smart thing to do, I’ll provide these URLs. The ViewGroup class is located at this URL:

http://developer.android.com/reference/android/view/ViewGroup.html

If you take a look at this ViewGroup class reference page to see what the class is capable of, you will
see that the ViewGroup class has 12 known direct subclasses, one of which is the RelativeLayout
class that your XML Ul layout definition is currently using for the HelloUniverse app currently. There
are 30 known indirect subclasses providing more specialized Ul design layout containers, because
as subclasses get further down in the hierarchy they become more specialized. We’ll be looking at
several of the most popular ViewGroup subclasses in Chapters 7 and 8 covering Ul layout design.

When using ViewGroup subclasses, termed Ul layout containers in Android, and View subclasses,
termed Ul widgets in Android, the View widgets are contained inside of the ViewGroup layout
containers, which is why the class is named ViewGroup, as it groups your View objects together into
a Ul layout design, as shown in Figure 6-2. The ViewGroup layout design is then referenced inside of,
or contained in, your Activity.

( ACTIVITY SUBCLASS |

Ul Layout Container

[ ViewGroup ]

ViewGroup
Ul Layout Container

ViewGroup
Ul Layout Container

B @@

Figure 6-2. Activity subclass contains Ul design created with ViewGroup layout containers and View Ul widgets
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It is important to note that even though a ViewGroup subclass must be used as the “parent” object
in your XML Ul layout design, ViewGroup subclass objects can also be “nested” underneath this
parent ViewGroup object. We’ll actually be nesting ViewGroup subclasses using a LinearLayout
ViewGroup subclass later in the chapter. ViewGroup subclass objects can be both parent and child
objects, whereas View widgets are usually just child objects.

Hands-on experience is the best way to show you all of this Ul design theory, so let’s integrate a Ul
design with a Galaxy object created using the Galaxy() constructor you built in the previous chapter.
Let’s use the Galaxy class you created in Chapter 5 to create a Galaxy object and utilize the .set()
methods you created to establish its properties. Then we’ll develop a Ul design using the popular
LinearLayout ViewGroup subclass that displays galaxy information on your Activity screen. Finally,
we will “wire together” your Ul design and the Galaxy object, so that the Ul design displays the
variable data in the Galaxy object’s data fields.

Customizing Your Ul Design: Galaxy Screen

Next, let’s get right into learning how the Activity subclass, ViewGroup layout container, and View
widgets are used, within the context of your current Hello Universe Android application. To do this,
we’ll continue building upon your Java programming work that you did in Chapter 5, and continue
using your Galaxy class, to create a new Galaxy object in your MainActivity.java Activity subclass’s
.onCreate() method. Then, we’ll create the Ul design for this Galaxy Info Screen, which will display
your Galaxy object’s characteristics on the Hello Universe app screen.

During the next several sections of this chapter, we will make the following Hello Universe
application additions and Ul design modifications:

Review the Eclipse Project » Clean Project menu sequence, and learn the
work process to rebuild a project. This is in case you ever open up Eclipse
Android Development Tools (ADT) and find that your project is filled with errors
that should not be there (that is, were not there the last time that you closed

and exited Eclipse). This just happened to me, as | was writing the code for this
chapter, so | am going to include this topic here so you know how to deal with

it in case this ever happens to you. Opening up what you know is a “clean”
project and seeing it filled with “red ink,” or error highlighting everywhere, can be
extremely unnerving to any Android developer.

Review and enhance the .onCreate() method in your MainActivity.java class,
to create a new Galaxy object, so that you have some Galaxy data values to
display in the revised Ul design that we’ll be creating by using one of the most
commonly used ViewGroup subclasses (LinearLayout).

Edit and reconfigure the activity_main.xml Ul layout definition, to use a more
basic and memory efficient LinearLayout ViewGroup subclass to create a
Galaxy Information Screen. We will also be using the most commonly used
View subclass Ul widget, the TextView, and we will take a look at how to “nest”
LinearLayout ViewGroup objects, in order to create more complex Ul structures.
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Install and reference digital image new media assets, to add an actual galaxy
image to the background of your Galaxy Information Screen, to make it more
visual and more professional.

Further enhance your .onCreate() method, to create TextView objects so that
the Ul design can “set” its TextView objects to display the Galaxy object’s
attributes using the .set() method calls.

Eclipse Clean Project: Sanitizing Your Project

When | opened my Eclipse ADT and looked at the error-free code that | had left off in Chapter 5,

| was startled to see errors in my project that | knew should not be there. To research what these
were, | opened up the five error-related tabs, located at the bottom of the Integrated Development
Environment (IDE), by placing my cursor on the tan divider area, above the error tabs section. | then
clicked down (and held the mouse button in the down position) so that | could “drag” the divider
upwards, to expand the area that holds these five error tabs. | then clicked on the first tab called
“Problems,” and then | clicked the right-facing triangle, next to the Errors line item, which revealed
the two errors, “The project was not built since its build path” and “The type java.lang.Object cannot
be resolved,” which are shown at the bottom of Figure 6-3.
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Figure 6-3. Errors on opening Eclipse, caused by Eclipse’s inability to resolve a link to the java.lang.0Object (in Java SDK)

Since Eclipse (and ADT) are constantly evolving, these software development tools themselves
will also have “bugs” or errors in their code, just like your Android applications invariably will.

This makes the software development process even more complex, but then again, the software
development process is inherently complex anyway, so this is just something that you are going to
have to be aware of, and deal with, in your software development work process. This is why | am
putting what just happened to me, and how to deal with it if it happens to you, into this chapter, as
its very own section.



174 CHAPTER 6: Android Screen Design: Writing to the Display Using Activity and View

You can see an error in the Eclipse programming code, in Figure 6-3, in fact. Notice that the
Galaxy.java tab is clearly showing several errors in the code contained in it, but the Eclipse code
is not putting the red error X next to the Galaxy.java class in the Package Explorer pane, which it
should be, to show that this class has errors in it! This is an Eclipse bug!

As you can see under the Problems tab, these errors are stemming from Eclipse ADT’s inability to
reference, or “resolve,” the path to the java.lang.Object master class, which is part of the Java
SDK, also known as the JDK.

Let’s utilize this Eclipse error in referencing the JDK to reinforce what we learned in Chapter 5, just to
turn this negative experience into a positive one! As you can see in the editing pane in Figure 6-3,
the String and Galaxy objects that are subclassed from the Java Object are the ones that contain
the red underline, indicating an error. Since the galaxyName variable is a String object, it is also
marked as an error. Thus these are not our own Java coding errors, but errors that are being
generated by Eclipse’s inability to “see,” resolve, or reference, the Java Development Kit (JDK) and
its Object superclass.

The easiest way to fix this is to simply click the red X exit icon at the top-right corner of the
Eclipse IDE, or use a File » Exit menu sequence, to exit Eclipse. Then restart Eclipse, accept the
workspace, and wait for the IDE to load and reference the Java software development kit (SDK,
also known as JDK), and after a while, the red error highlighting will vanish. | have seen online that
developers have said that they had to exit and restart Eclipse several times before Eclipse saw the
JDK again.

If this does not restore the link between Eclipse ADT and the JDK, you might need to “rebuild” your
project. Use the Project » Clean menu sequence, which is shown in Figure 6-4, along with the
Clean dialog this menu sequence brings up, shown in the lower-right corner of the screenshot.
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Figure 6-4. Using the Project » Clean menu sequence with the Build Automatically option checked (underneath)
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Make sure that the Build Automatically option on the Project menu has a check mark to the left
of it, which it should, since this is the default setting in Eclipse. This auto-build option is directly
underneath the Clean submenu option.

Once the Clean dialog opens up, click on the radio button next to the “Clean projects selected
below” and then make sure that the check box next to the HelloUniverse project is checked, and
then click the OK button, which will then “clean” and finally “rebuild” your Hello Universe project.

If this does not get rid of the errors in the IDE, which it didn’t when | tried it, then exit Eclipse again,
and restart it again, accept the workspace location dialog, and then wait for a few minutes for
Eclipse to look for and to find the JDK on your hard drive. We know it’s there, because we would not
have made it past Chapter 2 of this book if it wasn’t!

This finally worked on my workstation, and | finally got the clean project that | should have gotten in
the first place, when | started working on all of this today. The clean IDE, shown in Figure 6-5 with
zero Java code errors, which | knew to be the case, and the “empty” Problems tab shown at the
bottom, shows me that Eclipse ADT has found, and is now referencing (I like to call it “wired up to”),
the java.lang.Object class inside the Java SDK.
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Figure 6-5. Once visibility to Java SDK (java.lang.Object) has been restored, all the incorrect error tags disappear

Next, let’s construct the new Galaxy Object, and name it milkyWay, using the Galaxy() method, so
that we can use the impressive code that you created in Chapter 5 for something useful in your Hello
Universe application.

Using the Galaxy Class: Creating a Galaxy Object

As you learned in Chapter 5, the way to construct an object is by calling the constructor method; in
this case, it is the Galaxy() method, in conjunction with the Java new keyword, utilizing the following
Java code structure:

Galaxy milkyWay = new Galaxy();
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As you can see in Figure 6-6, when you type this in Eclipse, the IDE will check your Galaxy.java
class method.
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Figure 6-6. Constructing a Galaxy object named milkyWay using a Java new keyword and a Galaxy() constructor method

| typed the constructor method call in this incomplete way to show you that your Galaxy.java class
is now a part of all of the Java language constructs that Eclipse checks all code against, and Eclipse
will now tell you that you are not calling your constructor method correctly, and an error underline
now highlights this new Galaxy() method call!

When you mouse-over the error highlight, you will get a light yellow coding tips popup, which will
tell you what Eclipse thinks is wrong with your Java code; in this case, “The constructor Galaxy()
is undefined” or more accurately, the constructor method call is not defined (configured) correctly.
Eclipse is even nice enough to suggest “quick fixes” and as you can see the first one shows your
constructor method call format of Galaxy(String, int, int), which tells you that you need to pass
some data values over inside of the method call parens (parameters area).

Let’s add a galaxy name, number of solar systems, and number of inhabited planets now, and
see if this removes the error. As you can see in Figure 6-7, | added the String “Milky Way,” 511
solar systems, and 97 habitable planets to the constructor method call, and this removed the red
error highlighting, but added some yellow warning highlighting. A warning means that the code
will compile and run, whereas the error means that the code will not even allow you to attempt to
compile (and run) your application until you fix that particular programming problem.
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Figure 6-7. Completing the Galaxy() constructor method call parameter list and mouse-over the warning to get tip

To access the Eclipse warning helper popup to see what Eclipse thinks is a problem with the
milkyWay object now that the constructor method call has been completed, mouse-over the
milkyWay object reference in your code.

The warning message at the top of the popup will tell you that “The value of the local variable
milkyWay is not used” because the milkyWay Galaxy object has not been used to do anything
(call any methods) as of yet.

It is also important to notice that Eclipse is calling milkyWay a variable, and not an object name,
telling us that milkyWay is actually a variable that’s referencing that particular Galaxy object,
created using the Java new keyword.

It is still OK for you to look at milkyWay as the name you use in your code to access this instance of
the Galaxy object. | just wanted to point out the finer detail in how the Java programming language
is viewing things here! The milkyWay variable, as Eclipse (Java) sees it, is a “pointer” or a memory
reference that accesses the Java object instance (that is, in this particular case, a Milky Way Galaxy
object definition and all its data values somewhere in system memory).

To remove this warning highlighting, make a method call, using dot notation, off of your new
milkyWay Galaxy object. Enter a return character at the end of the Galaxy object constructor line of
code, after the semi-colon, and create a new-line for your next line of code. Type in milkyWay and
hit the period key on your keyboard. This will open a different Eclipse helper popup, which contains
every method call that is compatible with this Galaxy object. As you can see in Figure 6-8, this
includes the four .set() methods that you coded in Chapter 5, which we are about to use here, to
set up the other properties of your milkyWay Galaxy object. We are doing this so when our Ul design
accesses this object, it has data values to display!
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Figure 6-8. Using a milkyWay object with dot notation to call the .set() methods, and get rid of the warning highlight

Double-click on the setGalaxyColonies(long numberColonies):void method, which will insert the
method into your code, and then enter 37,579,321 as the number of colonies for your new Galaxy

object. As you can see, in Figure 6-9, this “throws” a red error highlighting indicator underneath your
method call.
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Figure 6-9. Error message tip regarding using commas for the numeric parameter values in method call
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If you mouse-over the error, you will see that Eclipse is telling you that “The method
setGalaxyColonies(long) in the (object) type Galaxy is not applicable for the arguments (int, int,
int).” This lets you know Eclipse is evaluating those comma characters in your numeric designation
as value delimiters, not as numeric formatting, which you were using to try and indicate (signify) a
large (millions) numeric representation.

This means that Eclipse (and thus the compiler) will think you are passing three integer values
into the method call, rather than one large, accurately formatted number! The solution to this is,

of course, to not use commas in your numeric values in method call parameter lists, as parameter
values are separated, or “delimited,” using Programmer speak, by using the comma character. We
can always provide this numeric formatting once we pass a data value from the Galaxy object to
each TextView, which we will be doing much later on in the chapter using Java code.

Note that none of these three “quick fixes” in this particular pop-up will solve the problem, so you
will have to remove the commas yourself! Don’t be surprised if someday Eclipse ADT features a
higher level of artificial intelligence in their helper code analysis algorithm that will add in a fourth
quick fix option of “Remove comma delimiters to create the required long data value.” The reason |
am generating these errors and warnings in this section is so that | can show you all these Eclipse
helper popups and how to use them.

Once you remove these commas from your numeric data value, the error will vanish, and you

can use this same work process of typing in the Galaxy object variable name of milkyWay and a
period, and double-click on each of the remaining three method calls, to set the population at
1,967,387,132 (without commas, of course), set the number of fleets to 237, and set the number of
starships to 34,769, without using the comma, as is shown in Figure 6-10. Note that all of the Java
code is error-free and you have created and configured the milkyWay Galaxy object and all of its
data fields (its characteristics) for your MainActivity.java class, using only five compact lines of Java
program logic.
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Figure 6-10. Completed Galaxy object construction and configuration using Galaxy class method calls
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Next, we will create a Ul design to display our Galaxy object characteristics (data values) using a
LinearLayout class (ViewGroup subclass) as our layout container. Inside of the Ul, we will use View
subclass that we’ve been using so far in the book, the TextView class, to create an impressive
Galaxy Information Screen Ul design.

Using LinearLayout: Creating Linear Ul Designs

Since we’re going to cover the RelativeLayout class in greater detail in Chapter 7, | want to take

the opportunity to teach you about the LinearLayout class in this chapter, so that we can focus on
the advanced layout container classes in Chapter 8 regarding Ul layout classes. To see how easy

it can be to edit a layout container class reference using the parent tag in XML, change the word
“Relative” to “Linear” in the opening and closing tags in the current /res/layout/activity_main.xml
Ul definition file, shown in Figure 6-11.
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Figure 6-11. Changing a <RelativeLayout> parent tag to a <LinearLayout> parent tag and reposition parameters

To make room for some of the other child tags we will be adding, | also put the tools:context
parameter next to (but after, as the xmins:tools parameter defines the tools: prefix) the xmins:tools
parameter, and also placed the android:layout_width and android:layout_height parameters on
the same line as well, to make the mark-up more dense and save us some space. Next, we need
to change the Hello Universe! text at the top of the screen to be the new screen design’s title,

by editing the hello_world constant in the /values/strings.xml file to hold your new “Galaxy
Information Screen” data value, which we will be using for a title for the new information screen’s
Ul design.
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Adding <string> constants for Your Ul Labels

Once this has been edited, copy and paste this <string> constant definition tag seven times
underneath itself, and then create text string constants for galaxy_name, galaxy_solar,
galaxy_habit, galaxy_colony, galaxy_pop, galaxy_fleet, and galaxy_ships named constants,
as shown in Figure 6-12, using the following XML mark-up:

<string name="galaxy_name">Galaxy Name:</string>

<string name="galaxy solar">Galaxy Solar Systems:</string>
<string name="galaxy habit">Galaxy Habitable Planets:</string>
<string name="galaxy_colony">Galaxy Colonies:</string>

<string name="galaxy pop">Galaxy Population:</string>

<string name="galaxy fleet">Galaxy Starship Fleets:</string>
<string name="galaxy_ships">Galaxy Active Starships:</string>
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Figure 6-12. Change the hello_world <string> variable to a new screen title; create the eight galaxy info <string> tags

Using Parameters to Configure Your LinearLayout

Now that we have the galaxy information screen’s data value holder string constants defined,

we can configure the LinearLayout Ul layout container. As you can probably infer from the class
name, a LinearLayout class is used to create either rows of horizontal Ul elements, or columns of
vertical Ul elements, as we are doing here with vertically stacked TextView Ul elements (widgets).
Let’s tell the <LinearLayout> parent tag how to orient its child tag View Ul widgets by adding the
android:orientation parameter. To get the helper dialog containing all of the parameters that are
available for use with the LinearLayout class, type in the word “android” and then type a colon and
wait a second for the Eclipse child tag helper dialog to appear, as is shown in Figure 6-13.
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Figure 6-13. Use the android and colon work process to display a helper popup of parameters for LinearLayout

Find the android:orientation parameter near the bottom of the list and select it to see what it does,
which will be shown on the right, and then double-click it to insert it into the parent tag.

Once the android:orientation="" appears inside of your parent <LinearLayout> tag, type the
vertical constant inside of the quotation marks to complete the configuration of this parameter,
which is shown in Figure 6-14.
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Figure 6-14. Defining the <LinearLayout> parent tag android.orientation parameter with a vertical constant value
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Also, notice that | have deleted the android:padding parameters, since we are going to learn about
how to use the android:margin parameters to control the spacing of our Ul design on the Activity
screen, after we add in the child <TextView> tags that will make up the galaxy information label
portion of our Ul design. First, let’s use the Run As » Android Application work process, and look
at our Ul design, shown on the left in Figure 6-15.
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Figure 6-15. The Nexus One AVD with the changed title text, the added galaxy info labels, and margins

Let’s create the seven <TextView> child tags the easy way. Select the hello_world <TextView>
tag, and copy and paste it seven times underneath itself, as seen in Figure 6-16. Change the
android:text parameters to point to, or to reference, the <string> tag name variables that you
created in Figure 6-12 so that the TextView objects use the correct label data value. Leave the
android:layout_width and android:layout_height set to wrap_content.
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Figure 6-16. Reconfiguring the first <TextView> parameter, and then copying it seven times, to create text labels

Note These android:layout_width and android:layout_height are the only required parameters to have
in both a ViewGroup (a parent tag) as well as a View (child tag) XML class reference. The reason these are
required in ViewGroup is because they’re required in View class inheritance scenarios, so essentially, every Ul
element must define a layout_width and a layout_height constant, either wrap_content or match_parent,
which we’ll be looking at over the next few chapters.

Once you finish these edits, use the Run As » Android Application work process, and the Android
application should look like what is shown in the middle part of the screen shot shown in Figure 6-15.

As you can see, since we removed the android:padding parameters that pushed the Ul content
away from the sides of the display screen, the Ul design is now too close to (touching) the sides of
the display. We are going to use the android:layout_margin parameter to space the Ul design away
from the sides of the screen next.

Although we could put these android:layout_margin parameters inside each of your <TextView> child
tags in order to achieve this end-result, it would be far more efficient to use the grouping feature of
the LinearLayout (ViewGroup) to space the entire design out by using a single parameter placed in
the LinearLayout parent tag.
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Inside of the end of your <LinearLayout> tag, after the android:orientation parameter you
just added, type in android: again, display the parameter helper popup, and find the
android:layout_margin parameters, as is shown in 6-17.

This android:layout_margin parameter puts space around the entire Ul widget (if used inside of a
View child tag) or around the entire Ul layout container (if used inside of the ViewGroup parent tag),
as you will soon see. If you want to put space only on one side, or only above or below your Ul
widget (View) or layout container (ViewGroup), you can use one of the more specialized
layout_margin parameters, shown in the parameter helper popup in Figure 6-17. Double-click on
the android:layout_margin parameter to insert it in your <LinearLayout> parent tag, and add a 12dip,
or 12 density independent pixels, value inside of the quotation marks. We will be learning all about
this DIP (dip, or dp) constant, and how it relates to graphics, in Chapter 9, which will cover graphic
design in Android.
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Figure 6-17. Use an android: work process to access LinearLayout parameter helper showing margin parameters

Let’s see how this margin spacing around the perimeter of our design improves how it looks, and use
the Run As » Android Application work process. As you can see on the right side of Figure 6-15,
an entire Ul design is moved out using this single parameter, since we used it in the parent
ViewGroup to move the entire Ul design as a whole.

Since this is the Hello Universe application, and a Galaxy Information Screen, let’s put a galaxy
image from the NASA web site into the background of the Ul layout container, before we start
learning about how to refine and “tweak” our Ul design using XML parameters, which is both easy
and fun, at least compared to doing it in Javal

After you learn how to add this “image background plate” to your Ul layout design using the
android:background parameter in the parent <LinearLayout> tag, you will need to change your
<TextView> child tag parameters to use a white text color and add some <TextView> Ul elements
to hold the default data values, and eventually the Galaxy object data values. Later on, once the Ul
design looks reasonably professional, we will go back into your MainActivity class Java code and
create TextView objects and configure these with the Galaxy object data fields so that the actual
data from your Galaxy object is referenced in your Ul design.
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Using Digital Imagery: Adding a Galaxy Background

| have prepared a galaxyinfoscreen.png digital image file to use as the background image, which

is in the book assets’ ZIP file. Open the ZIP file, or better yet, extract it to your hard disk drive on
your workstation, right-click on the galaxyinfoscreen.png image, and select the Copy menu item.
Then find your /workspace folder on your hard disk drive, it should be in a C:/Users/ComputerName
folder. Right-click on the /res/drawable-xhdpi subfolder, and then select the Paste option, which
will paste the image into that folder, as shown in Figure 6-18.
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Figure 6-18. Copy the galaxyinfoscreen.png file into the drawable-xhdpi folder; right-click and Refresh the project

Once you copy this digital image file into your /res/drawable-xhdpi folder using this procedure, you
need to let Eclipse know that you have updated your project “outside” of Eclipse, so that Eclipse
can rescan your project folder hierarchy and “see” any new files. This is done using the “Refresh”
menu option. Access the Refresh utility by right-clicking on your HelloUniverse project folder in the
Eclipse Package Explorer pane to access the context-sensitive menu, as shown on the right side of
Figure 6-18.

Once you have copied the galaxyinfoscreen.png file into the drawable-xhdpi folder and used the
Refresh tool, the file will appear in your Package Explorer pane as seen highlighted on the bottom-
left of Figure 6-19. Now you are ready to add an android:background parameter to your parent
<LinearLayout> tag that will place this background image behind every Ul widget that you place
inside of this container, giving your Ul design a hip scenic background, and making your Ul design
more visually appealing.
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Figure 6-19. Insert an android:background="@drawable/galaxyinfoscreen” parameter into the parent LinearLayout

To add this parameter, you can type in android and the colon key, select the background
parameter, and double-click it, or you can just type the entire parameter in along with the proper
@drawable/ path reference to the file, using the following XML mark-up:

android:background="@drawable/galaxyinfoscreen"”

The reason we do not use @drawable-xhdpi/galaxyinfoscreen is because the Android OS will
choose which drawable resolution density asset to use for any given Android hardware device
screen specification. In the case where there is only one image asset available, such as this, it will
simply use that. We will be covering how to develop multiple graphic image assets in Chapter 9, but
for now, we’ll just use one extra high definition (XHD) image asset.

Now let’s use the Run As » Android Application menu sequence, which can be accessed by
right-clicking on the HelloUniverse project folder, or alternately via Eclipse’s Run menu (Run » Run
As » Android Application) and see how the galaxy image looks behind our current galaxy
information screen Ul design.

As you can see in the left-hand pane of Figure 6-20, the contrast between the dark gray Ul text
color and the galaxy space image makes the text quite difficult, if not impossible, to read, unless it
is in front of a very bright star, like the “e” character that you can see is the only easily discernable
character in the Ul design currently!
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Figure 6-20. Problems with dark text and parent layout_margin parameter (left); fixed (center) and refined (right)

Contrast is one of those graphics terms that we normally would save for Chapter 9 on graphic
design for Android, but let’s cover it here since we are encountering this problem now! Contrast

is how much difference between light and dark there is in an image, and with text or Ul widgets
especially, influences how visible they are to a user (that is, how much they “pop” out, in the case of
Ul widgets, or are easy to read, in the case of text).

Maximum contrast would be achieved by using a black text color on a white background color, or
a white text color on a black background color, while a minimum contrast scenario would involve a
medium gray text color on a medium gray background color. The minimum contrast scenario would
appear as though the medium gray background color was the only thing on the screen, as there is
zero contrast between the medium gray text and medium gray background.

Let’s fix this next by adding the android:textColor parameter to the <TextView> Ul widgets, so we
can crank the contrast back up near maximum, and make the Ul readable again for our
application users!

After we learn how to control the <TextView> Ul widget textColor parameter, we will create

the <TextView> Ul elements that will hold the data values for our milkyWay Galaxy Object.

If you want to peek at the result of the next two sections of this chapter, where you’ll learn about
android:textColor and nesting LinearLayout containers, you can also see this in Figure 6-20.
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Creating Ul Contrast: The TextView Color Parameter

Let’s add a space character after the android:text parameter in our first hello_world <TextView>
tag, and use the android: work process to bring up the parameter helper dialog. As you can see in
Figure 6-21, | actually typed in android:t which “refined” the parameters displayed in this dialog, to
only include those parameters that begin with the letter “t,” which, as you can see, gives me all of
the android:text related parameters!
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Figure 6-21. Change the <TextView> textColor parameter from gray to white using the pop-up helper

The second parameter is the one | am looking for, android:textColor. So, | selected that one, by
double-clicking on it, so that Eclipse will automatically insert it into my XML mark-up for the
hello_world <TextView> child tag, and all | have to do is to “configure” it, by using a color data value
that the Android OS understands.

The android:textColor parameter takes a “hexadecimal” or Base-16 color value, which we will be
looking at in greater detail in Chapter 9 on graphic design. For now, all you need to know is the
hexadecimal representation for the color white is #FFFFFF, and thus, that is the color data value
you will need to utilize inside of the quotation marks, once Eclipse has written the empty parameter
for you.

Once you have modified this first <TextView> child tag, as shown in Figure 6-22, you can copy just
this one parameter (make sure to copy the space character in front of the parameter along with it)
and simply paste it into the other seven <TextView> child tags in exactly the same location! Your
XML mark-up is getting pretty dense and is about to get even more complex, as we have to add in
seven more <TextView> tags, to hold data values!
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Figure 6-22. Add android:textColor="#FFFFFF” parameters to all eight <TextView> child tags in the LinearLayout

To confirm that you have solved your contrast problem, use the Run As » Android Application
menu sequence, and compile and run your Hello Universe application. What you should see
should look like the middle section of Figure 6-20, and your Galaxy Information Screen’s Galaxy
characteristics text labels should now be readable!

Nested LinearLayout Containers: Creating a More Complex Ul

To add in the <TextView> Ul elements that will be updated by your Java logic (in the next section) to
display the actual Galaxy object data values, we cannot simply add seven more <TextView> child
tags into the existing <LinearLayout> parent tag, as that would put the values underneath the text
labels, and not to the right of them.

The solution to this Ul layout problem using <LinearLayout> containers is to nest two vertical
LinearLayout child containers inside of a parent LinearLayout container configured as a horizontal
layout, which will place two rows of (matching) text next to each other horizontally, kind of like a
spreadsheet would. At a high-level tag overview, using pseudo markup, if you will, the basic XML
structure that you will be building soon would look something like this:

<Linearlayout android:orientation="horizontal" android:background="@drawable/galaxyinfoscreen" >
<LinearlLayout android:orientation="vertical" android:background="transparent background" >
<TextView>UI Labels</TextView>
</LinearlLayout>
<Linearlayout android:orientation="vertical" android:background="transparent background" >
<TextView>UI Data Fields</TextView>
</Linearlayout>
</Linearlayout>
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As you can see from my pseudo markup above, the parent <LinearLayout> is now configured to be
horizontal, and thus will arrange everything inside of it from side-to-side instead of top-down. The
parent tag still contains the digital image asset reference, as we want this image to fill the screen
behind our Ul design. There are now two child <LinearLayout> tags nested inside the horizontal
parent <LinearLayout> both of which are vertical, and both of which have defined a transparency
value for their background so that the parent background image will show through. If this is not
done, Eclipse “throws” a warning that the parent background has been rendered useless because it
is now covered up by the child layout containers. Inside of the vertical <LinearLayout> child tags are
the seven or so <TextView> grandchild tags (no, they are not really called that), which are child tags
of the child <LinearLayout> tags, hence the “nesting” terminology. Let’s hope Dr. Phil never learns
Android, or we may have to cover the psychology of Android parent-child familial relationships in a
future version of this book.

Eclipse Tricks and Treats for Using the XML Editing Pane

Another Eclipse shortcut to get a child tag helper dialog is to use a left-facing chevron < character,
to bring up the helper dialog, as is shown in Figure 6-23. Put your cursor at the end of the opening
<LinearLayout> tag and hit the return key, which will auto-indent your code for you, and type a “<”
character and wait for the pop-up to appear, with all of the child tags (widgets and layout containers)
that are compatible with the parent <LinearLayout> container.
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Figure 6-23. Use a left chevron < character inside the parent LinearLayout tag to invoke a child tag helper dialog
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As you can see in the child tag pop-up helper (segment) shown in Figure 6-23, there are three layout
containers: FrameLayout, which we cover in Chapter 11, GridLayout, which we cover in Chapter 8, and
the LinearLayout, which we are covering in this chapter. The other 11 classes shown are Ul widgets.

A slick way to calculate how many total class entries are shown in a helper dialog is to see how many
times the slider-bar height divides into the total height (in this case, about 5 times, or one-fifth slider-
bar height to total height ratio), and multiply that by the number of visible entries (in this case, 14),
giving you an estimate of 70 or more classes that are supported inside of a <LinearLayout> parent tag.

Double-click on the LinearLayout selection shown in Figure 6-23 and insert the empty
<LinearLayout> child tag into your activity_main.xml Ul layout definition, so that we can start to
configure these nested Ul layouts.

Reconfiguring Your LinearLayout Container

The first reconfiguration that we will want to do is to move the android:layout_margin="“12dip”
parameter from the parent <LinearLayout> tag over to the child <LinearLayout> tag that you just
added. This is to transfer the margin spacing for the <TextView> Ul elements that are underneath the
<LinearLayout> tag containing the text labels, which has now become a nested (child) LinearLayout.

The parent LinearLayout no longer needs any margin spacing, as it is now serving simply as a
horizontal layout “organizer” of child vertical LinearLayout containers, which will now be “carrying”
their own margin spacing configuration parameters. The movement of layout_margin from parent to
child tag is shown in Figure 6-24.
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Figure 6-24. Configure a parent LinearLayout as horizontal and a child LinearLayout as vertical and transparent
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Since the layout_width and layout_height parameters are required for every Ul tag, copy these from
the parent LinearLayout, and paste them into the child LinearLayout as well. We will get into what
the exact difference is between the match_parent versus wrap_content constants after we define
transparency for a child LinearLayout.

The next thing we need to do is to make your child LinearLayout container transparent, as far as its
background plate is concerned, so the digital image asset that is defined in the parent LinearLayout
container can show through. This is because the default (undefined) layout container background is
white (Holo Light Theme) or black (Holo Dark Theme).

It is important to note that Ul containers (and widgets) are stacked on top of each other from the
ground (floor) up, just like you would build a skyscraper. Thus, the parent LinearLayout is on the
bottom, the child LinearLayout containers are on top of that, and the grandchildren TextView widgets
are on top of those.

The hexadecimal value for transparency in Android is #00000000, and the way that color and
transparency are defined using hexadecimal values will be covered in detail in Chapter 9 covering
graphic design for Android.

The android:background parameter can accept a reference to an image asset, to an animation
XML definition, or to other Android drawables, such as a ShapeDrawable, for instance. The
android:background parameter can also accept hexadecimal color and transparency values. To
set the background to be 100% transparent (that is, not present at all), the android:background
parameter would be configured using the following XML mark-up:

android:background="#00000000"

Once these parameters have been put in place in the child <LinearLayout> tag, as shown in
Figure 6-24, use the Run As » Android Application menu sequence and you will see the result
shown in the middle of Figure 6-20.

Adding String Constants for Use in Your Ul Design

Before we add the second nested LinearLayout container to hold the TextView Ul widgets that will
hold the actual Galaxy object data values, we must first create the <string> text constants for the
default (pre-modified) values for the data value text Ul elements. We will use “My Galaxy” for the
default name and zeroes for the other default values, as shown on the right side of Figure 6-25.
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Figure 6-25. Create seven <string> objects to hold the seven data values (variables) for the Galaxy object

The easiest way to do this is to copy the galaxy_name through galaxy_ships string tag constants and
paste them underneath themselves. Remove galaxy_ from the front of the string constant name, and
add _data to the end of the string constant name, so galaxy_name would become name_data, as
shown in Figure 6-25.

Adding a Second Nested LinearLayout Container to the Ul Design

Now we can create the second <LinearLayout> nested container, right after the first <LinearLayout>
nested container. Since the parent <LinearLayout> container is arranging these horizontally, from
left to right, the second <LinearLayout> content (nested TextViews) will appear on the right side

of the Ul design, as shown in Figure 6-20. Again, the easiest way to write all of this mark-up is to
select the entire first nested child LinearLayout and all of its TextView children and copy and paste it
underneath itself.

One of the concepts of fast program development is to copy, paste, and edit whenever possible!
Delete the first hello_world TextView tag from the second nested <LinearLayout> and leave only
the seven <TextView> tags that are needed to hold Galaxy object attributes (variable data values),
as shown in Figure 6-26. Change the galaxy_ references to the _data references so the <string>
constants you just created occupy those TextView Ul elements. If you now use the Run As »
Android Application menu sequence and look at your Ul design, you will see only what you saw
after you added the first nested <LinearLayout> child tag, and you will not see the second nested
<LinearLayout> structure at all. Why? It looks like it’s time to discuss the Ul layout constants!
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Figure 6-26. Change child LinearLayout width and height constants to wrap_content; center hello_world TextView

The reason you can’t see the second <LinearLayout> is because you have all of your <LinearLayout>
structure android:layout_width and android:layout_height parameters set to use the match_parent

constant.

What this match_parent constant tells Android to do for both the width (X axis) and height

(Y axis) dimensions of the layout container is to expand the layout container to fill the Ul layout
container “above” it in the display hierarchy. For the first parent <LinearLayout>, this tells Android
to fill the device display screen, which is what we want, and you can see by the background
image filling the screen (once we removed the margins) that this is working as desired. The first
nested <LinearLayout> is therefore also filling the screen, leaving no room for the second nested
<LinearLayout> to display its contents, because it is also set to match_parent. The constant needs
to be changed to a constant that tells it not to fill the screen, which is where the wrap_content

constant comes in.
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The solution to this is to change the “match_parent” constant in both of the nested <LinearLayout>
containers to use the “wrap_content” constant instead. The wrap_content constant essentially
does the exact opposite of what the match_parent constant does; instead of expanding to fill, or fit,
the screen above it, it contracts instead and “shrink-wraps” the content below (contained inside of)
it. As you can see in Figure 6-26, both of the nested <LinearLayout> containers use wrap_content
constants in their parameter settings, and when you use the Run As » Android Application, you
get the result shown in the right-hand panel of the screenshot in Figure 6-20.

Next, let’s add a couple of final android:layout_margin-related “tweaks,” to fine-tune this Ul design.

The first thing we need to do is to space the data field TextView Ul elements down next to their
corresponding Galaxy attribute label TextView Ul elements, using an android:layout marginTop="33dip"
in the second nested <LinearLayout> tag parameter list. The next thing we need to do is add an
android:layout_marginlLeft="48dip" to the first hello_world <TextView> tag in the first nested
<LinearLayout> child tag to center the screen title.

Interfacing with Ul Elements: The ID Parameter

There is one last bit of XML markup editing that we will need to do to the seven TextView Ul elements
in the second nested LinearLayout container, so they can be “wired into,” or accessed by, the Java
TextView objects, which we are about to create in your MainActivity.java class. In order to be able to
transfer the Galaxy object variable data values into the data field TextView objects we have created
in our Ul design to hold and display these values, we need to create these TextView Ul elements as
TextView objects in your Java program logic.

The XML parameter you need to be able to reference a Ul element (widget) or Ul layout in your Java
code is the android:id parameter, which gives an ID to the XML Ul element definition, so that you
can instantiate it and subsequently reference and utilize it in your Java code. The XML markup for
this parameter is as follows:

android:id="@+id/name"

Create ID parameters for all seven of your TextViews as @+id/solar, @+id/habit, @+id/colony,
@-+id/pop, @+id/fleet and @+id/ships, which are going to display solar, habitable, colonies,
population, fleet, and ships data respectively, as shown in Figure 6-27.
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Figure 6-27. Adding the android:id parameter to the seven TextView Ul elements which will hold the data values

Before | show you how to “wire up” your Galaxy object to your Ul design in Java, so that your data
display TextView objects display your Galaxy object characteristics, | want to first show you how to
organize your Java code a little bit better, by creating your own custom methods in your MainActivity
class, to organize your Java code according to task. This is primarily so that your onCreate() method
does not turn into one huge Java code construct. Creating logical methods is called “modularizing”
your Java code, and makes it much more elegant, organized, and logical, as you will see during the
remainder of this chapter as you create three methods.

Creating Modular Code: createDefaultGalaxy()

Let’s make our Java code more modular by putting the Galaxy class-related code into its own
method, called createDefaultGalaxy(), so that all we have to call in our onCreate() method is a
single createDefaultGalaxy() method call. We will perform the same modularization in the creation
of the TextView Ul objects later on, by using a method we will name createUiTextViews(). We will
do the same thing for the transfer of the data field values from the Galaxy object to the TextView Ul
widget objects, via a method named transferDataValues().

This modularization happens to be easy to do, which is why | decided to include it early on in this
book. Since we just had the chapter covering Java, let’s get some practice writing modular Java
code right away, so you can build on what you learned in the previous chapter. First, create the
empty method by typing the following code:

private void createDefaultGalaxy() { ... }
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Then all you have to do is to cut and paste the five lines of Galaxy object code inside the curly
braces, like this:

private void createDefaultGalaxy() {
Galaxy milkyWay = new Galaxy("Milky Way", 511, 97);
milkyWay.setGalaxyColonies(37579231);
milkyWay.setGalaxyPopulation(1967387132);
milkyWay.setGalaxyFleets(237);
milkyWay.setGalaxyStarships(34769);

}

See, that was easy, as you can see in Figure 6-28. The createUiTextViews() method will be more
advanced, and the transferDataValues() method will be more advanced, and you’ll even learn how to
“nest” Java method calls!
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Figure 6-28. Creating a private void createDefaultGalaxy() method to modularize our Galaxy object-related code

Now we’re ready to declare TextView objects for use, naming them while we’re at it so we can
instantiate them.

Updating the Ul in Java: Using Ul Objects

In order to have our Java program logic access or utilize our Ul elements, we must instantiate (that
is, create objects for) each Ul widget or Ul layout container that we wish to modify or control using
Java program logic. There are two ways to do this, both of which we will take a look at in detalil
during the remainder of this chapter. To declare a TextView object for use and give it a name, simply
call the TextView class and give it a name, using the following Java code, which looks a lot like your
variable declarations, but it declares an object:

TextView nameData;



CHAPTER 6: Android Screen Design: Writing to the Display Using Activity and View

As you can see in Figure 6-29, the first time you use any class reference in your Java code that
has not been specifically “imported” for use in your code, you will get the wavy red underline

highlighting underneath it.
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Figure 6-29. Declaring a TextView object named nameData at the top of the MainActivity class to hold Ul values

If you place (termed “hovering” in computer speak) your mouse over the error highlight, you will get
the pop-up telling you the TextView cannot be resolved, because Eclipse does not know what it is
yet. The first of eight solutions to this problem happens to be the “correct” one, so click on Import
‘TextView’ (android.widget), which will instruct Eclipse to write this import statement for you.

As you can see in Figure 6-30, the Java import statement has been inserted (highlighted in light
blue in the IDE) after the three existing import statements, and before the class declaration. As you
will also notice, the error highlighting has vanished, and you are ready to copy and paste this first
nameData TextView Ul object declaration six more times underneath itself, which will create all seven
“updateable” TextView Ul widget objects, all of which are defined to “live” inside of your second
nested <LinearLayout> container.
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Figure 6-30. Collapse the createDefaultGalaxy() method to make room in the IDE; add seven TextView declarations

We will create all of the TextView object(s) instantiation code inside of a createUiTextViews()
method so that all our onCreate() method will contain is method calls to Java routines or structures
that create the Galaxy and TextView objects, and later on a call to wire them all together using a
transferDataValues() Java code structure.

A Ul Instantiation Method: createUiTextViews()

Now it’s time to create the second method that will be called in the onCreate() method. Let’s add a
new-line in the onCreate() method after the createDefaultGalaxy() method call and type in a
createTextViews() method call. As you can see in Figure 6-31, this is error highlighted; on mouse-over,
Eclipse offers to write the code for you!
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Figure 6-31. Create a createUiTextViews() method call in onCreate() and allow Eclipse to create the method for you

Inside of this “bootstrap” method structure that Eclipse will write for you, you will instantiate your
nameData TextView object, which you declared earlier at the top of the class. This is done using the
following Java code:

nameData = (TextView)findViewById(R.id.name);

If you type in the R.id part, and then hit the period key, Eclipse will display a helper pop-up
containing all of the Ul elements that have an ID attribute (parameter) assigned to them, as is shown
in Figure 6-32.
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Figure 6-32. Instantiate a nameData TextView; use the findViewByld() method and Eclipse helper pop-up to configure

Once this first line of code shows as being error-free, you can then copy it in its entirety and paste it,
six more times, underneath itself. Make sure to change the name variable and TextView ID reference
to be solar, habit, colony, pop, fleet, and ships, respectively, as can be seen in Figure 6-32.

Now you have the createUiTextViews() method coded, which instantiates all of your TextView
objects and also sets them to reference their XML definitions by using the findViewByld() method
in conjunction with the appropriate resource area and ID value. You are now ready to create the
transferDataValues() method, which will take the data values out of your seven variables in your
milkyWay Galaxy object, and transfer those values into your seven TextView Ul widgets, which you
designed to display those values in your Ul screen design.

Creating the transferDataValues() Method

By modularizing your Galaxy and TextView object(s) set up into logical methods, your onCreate()
method has a mere two lines of code, as you can see in Figure 6-33, instead of a dozen lines of
code. These method calls are logically named, so that anyone else who may need to read your code
will know precisely what you are doing!
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Figure 6-33. Duplicate the TextView Ul objects instantiation for the other six data fields for the Galaxy object

Once you code your transferDataValues() method, which we are about to get into next, your
onCreate() method will be quite compact, with only five key lines of code, and yet it will be doing
quite a lot of work, thanks to the three methods that you have coded during this chapter. Your
MainActivity.java class will have five important Java methods to use for your application functions
instead of just the two that Eclipse created for you earlier.

Let’s have Eclipse ADT write some more Java code for us, as it is always so much more fun
watching someone else (or something else, in this particular case) do all of the work whenever
possible!

Add a new-line under the createUiTextViews() method call in your onCreate() method, type in the
name of your third method, transferDataValues(), and hit the semi-colon character to complete
this Java (method call) statement, and watch the familiar wavy red error underline highlighting
appear, as you had expected.

Mouse-over the red error highlighting, and bring up the Eclipse error message helper pop-up, and
then select the create method ‘transferDataValues()’ option so that a method bootstrap code
structure will be written for you.

Inside of the method, we are going to call a .setText() method off of your nameData TextView
object to, as you might suspect from the logical method name, set the text value of this nameData
TextView object. Since we want to use the galaxyName variable’s data value to set the text with,
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we will reference this right inside of this .setText() method call, by using the following single line of
(somewhat elegant, in my opinion) Java logic:

nameData.setText(milkyWay.galaxyname);

What this does is to pass over the milkyWay Galaxy object galaxyName variable as a parameter,
referenced by milkyWay.galaxyName (ObjectName.VariableName), to the nameData TextView
object that is utilizing the .setText() method call to retrieve and set this text (String) data value. This
data value then replaces your default “Milky Way” placeholder text value, which you previously had
set in the XML Ul definition via an android:text parameter, so that you would have a text value to use
to visually refine your XML Ul design, prior to your Java coding.

As you can see in Figure 6-34, the milkyWay Galaxy object has error highlighting underneath it,
which you discover upon mouse-over has an error reason that says “milkyWay cannot be resolved
to a variable” (that is, Eclipse cannot “see” your milkyWay Galaxy object). The reason for this is that
the Galaxy object is currently constructed inside of the createDefaultGalaxy() method, highlighted in
light blue in Figure 6-34, so the object is considered to be “local” to that method. The same problem
would have existed if you had left this code inside of your onCreate() method as well. The solution

is to do what you did with the TextView object declarations, and cut the Galaxy constructor line of
code outside of the createDefaultGalaxy() method and paste it at the top of your class above

(or below) the TextView object declarations.
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Figure 6-34. Use a .setText() method call off the nameData TextView object configuring it with galaxyName data
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Doing this will allow every method in your class to now be able to “see” and reference your Galaxy
object. The other code that sets your Galaxy object’s attributes using dot notation to call your Galaxy
class methods can stay inside of the createDefaultGalaxy() method.

As you can see in Figure 6-35, once you place this Galaxy constructor line of code at the top of your
class, the error highlighting disappears, because the milkyWay Galaxy object is now visible to every
method in the class.
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Figure 6-35. Moving the Galaxy object declaration and instantiation outside of the createDefaultGalaxy() method

If you remember earlier, | said | would show you two different ways to instantiate an object in

Java, and now you have done this using one line of code (Galaxy object) in one location, or two
lines of code (TextView objects) in two different locations (inside of, as well as outside of, a method).
To clarify the difference, you could also split the Galaxy object instantiation using just the

Galaxy milkyWay; part, called the object “declaration,” at the top of the class and insert the
milkyWay = Galaxy("Milky Way", 511, 97); part in createDefaultGalaxy().

You can try this second (split) coding as an “exercise” for this chapter, if you like; it is a cool way

to make your object declaration(s) visible to your entire class, while actually instantiating the object
inside of whichever method you wish to do so. On the other hand, the long-form (object declaration
and instantiation all using one single line of code) uses less code, which is said to be more
“compact” code, in programming terminology.
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Testing and Debugging your Application

Now let’s take a moment to use the Run As » Android Application menu sequence, and we will
see if your Ul design now displays the “Milky Way” text data value, assigned using Java code, rather
than the “My Galaxy” text data value assigned using XML markup using the <string> constant.

As you can see in Figure 6-36, the code thus far in your transferDataValues() method is working as
expected, and the Ul screen now displays the Galaxy object galaxyName variable’s data value in the
nameData TextView next to the “Galaxy Name:” labeling TextView.

5554:AVD._for_Mexus One_by_Goagle

Gataxy.Information Screen
Galaxy Name:

Galaxy Colonies:
Galaxy Population:
Galaxy Starship Fl#ts: -
Galaxy Active ?ar_ships:

Unfortunately, Hello Universe
has stopped.

Figure 6-36. Testing the HelloUniverse application in the Nexus One AVD emulator, and showing an app crash

The next six data TextView Ul widgets need to display numeric values (integer, double, long, and so
forth) and so we can (and will) try to use the same code, and hope that Java will “cast” the numeric
values into text values for us.

The concept of “casting” in Java is a process where the Java programming environment (the
compiler) will auto-convert (cast) a data value from one format into another where it is logical and it
is able to do so. So we will try passing a numeric data value type into the .setText() method call in
the hope that the “type casting” (any actors out there?) will be done for us automatically. If not, then
you are about to get to utilize your LogCat tool!

Copy and paste the nameData.setText(milkyWay.galaxyName); line of code underneath itself
and change the nameData and galaxyName references to the solarData TextView reference and
galaxySolarSystems Galaxy object variable references, respectively.
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Next use the Run As » Android Application menu sequence and see if you can get the application
to run. As you can see on the right side of Figure 6-36, the Hello Universe application crashes (stops
running, as per the error message in the emulator).

The probable cause of this crash is most likely passing a numeric value to the .setText() method call,
which is expecting a String (text) value, and most likely Java is not “casting” the numeric value into
a text value for you, and so the application crashes. When your application crashes, you can use the
LogCat to investigate what happened. Let’s do that next.

Using the LogCat

Let’s use this as an opportunity to see how to use the LogCat error log catalog utility to see exactly
what is crashing your application. Pull up the separator between the main editing pane and the error
tabs at the bottom of the IDE, to give some room to the LogCat tab to display its results, as is shown
in Figure 6-37.
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Figure 6-37. Using the LogCat utility tab to diagnose where the fatal app error is located in the code (Line 21)
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| look for error messages that feature line numbers that | know are reasonable for the amount of
code that | have written, such as the line of code annotated as java:21, shown highlighted in light
blue in Figure 6-37.

Since | haven’t written thousands of lines of code, | know the other error messages referenced are
not in my code, although those errors are certainly caused by my code. What | want to see is what
line of my code is causing the error, so | look at Line:21, which is shown highlighted in the screen
shot, and references the latest line of code you just wrote, which attempts to pass an integer data
value to a method expecting a text data value.

What we need to do to correct this error is add to our Java programming statement’s structure in
such a way as to convert the numeric value into a text value “on its way in” to the method call. In
pseudo-code, this would be:

TextViewObject.setTextMethodCall( ConvertNumberToTextMethodCall(GalaxyObjectNumericDataValue) );

There is indeed a method in Java, in the String class that we have already used to create String
objects, called the .valueOf() method, which will turn a numeric value into a String text value, by
using the following format:

String stringVariableName = String.valueOf(numeric variable here);

In the construct we are using, we can nest this String.valueOf() method call inside of our existing
Java structure:

solarData.setText( String.valueOf(milkyWay.galaxySolarSystems) );

Java is pretty cool in the way that you can nest and chain (using dot notation) constructs together
to get dense code constructs; that is, to accomplish a lot of what | call programming “moves” using
a single line of code. We will take a look at Java code chain constructs later on in the book as we get
into more and more complex topics and code structures. This may be an Absolute Beginners book,
but Android topics in it are inherently advanced. My apologies if you thought Android programming
was ever going to be some sort of cakewalk! Once you have the solarData line of code working,
replicate it for the other five numeric data values, as shown in Figure 6-38.
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Figure 6-38. Using the String class’s .valueOf() method inside of the .setText() method, to convert integer values

Now again use the Run As » Android Application menu sequence, and see if your code will run,
and is doing what you wanted it to. As you can see in Figure 6-39, everything is working, and the
application runs and does not crash, but there seems to be an extra data variable listed on the right
side of the galaxy information screen.
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Figure 6-39. The TextView Ul objects displaying the Galaxy object data values; fine-tuning the margins

Upon closer examination, it looks like Android is using “exponential” numeric representation for the
population numeric data value. Instead of 1,967,387,132, or even 1967387132, Android is writing
1.967387132E9, part of which is wrapping to the next line.

To fix this, we will need to move the second nested (right side data values) LinearLayout container to
the left, so that this long value will not wrap.

Since there is no margin parameter defined inside your second nested LinearLayout, it must be
the android:layout_marginLeft parameter DIP value in the first (title) <TextView> that is pushing the
second nested LinearLayout to the right, so let’s reduce this by 20 DIP from a value of 48dip to a
value of 28dip.

As you can see in Figure 6-40, the android:layout_marginLeft parameter value has been reduced
to 28dip, fixing the problem with the Galaxy Information Screen <TextView> in the first nested
<LinearLayout> container, pushing the second nested <LinearLayout> container too far over to the
right, causing the wrapping.
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Figure 6-40. Reducing the hello_world screen title TextView from 48dip to 28dip, to pull second LinearLayout left

If you wanted to put this TextView above the nested <LinearLayouts>, you would need an even more
complicated nested <LinearLayout> structure, such as the following (pseudo) Ul layout container
structure:

<LinearlLayout android:orientation="vertical" android:background="@drawable/galaxyinfoscreen" >
<TextView>UI Screen Title</TextView>
<LinearLayout android:orientation="horizontal" android:background=" transparent background " >
<LinearLayout android:orientation="vertical" android:background="transparent
background" >
<TextView>UI Labels</TextView>
</LinearlLayout>
<LinearlLayout android:orientation="vertical" android:background="transparent
background" >
<TextView>UI Data Fields</TextView>
</LinearlLayout>
</LinearlLayout>
</Linearlayout>

This is why we are going to learn about the <RelativeLayout> layout container in the next chapter, as
it is always desirable to use a single Ul layout container rather than using four layout containers and
nesting as we’ve done here to achieve a fairly simple Ul design result.

Summary

In this chapter, you learned all about several of the most important Android superclasses that are
used to create Android applications and get them running on the device display screen. These
include the Activity class, the View class, and the ViewGroup class, and the subclasses of these
classes, which are actually used to create your Android applications, such as the LinearLayout
class. You already know you have to write all the Activity subclasses yourself, but as far as the View
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and ViewGroup subclasses are concerned, Android has generously written all of the subclasses for
you; all you have to do is to “include” them in your application code by using an import statement,
and of course you have to implement their features correctly.

You learned about the relationship between the Activity class, the View class, and the ViewGroup
class, and how these are used together to get your application Ul design and content onto the
device display screen. Then you used the Galaxy class you created in the previous chapter to create
a Galaxy object to use in this chapter, where we create a Galaxy Information Screen Ul design.

Then you learned about the LinearLayout class and how to create a Ul design using this simple Ul
layout container designed for designing row-oriented or column-oriented Ul layouts. You learned
about the Project » Clean work process in case you ever start up your application to a project filled
with errors that you did not create, and how to go about restarting the IDE and/or using the Clean
command to make sure ADT sees the Java SDK, or JDK, and the java.lang.Object class.

You learned how to reference digital image assets in your Ul layout containers, how to use
transparency, and how to nest LinearLayouts to create more complex Ul layout designs. You also
learned how to modularize your Java code by writing your own custom methods, as well as how to
call those methods from inside other methods. You learned a couple different ways to declare and
instantiate objects so that code inside all of your class methods could see them.

In Chapter 7, you will start to learn about how Android handles Events, uses Intent objects, and
Menu objects by using the Android Menu subclasses, and all about how to make Ul designs and
Menu systems interactive, by using Event Handlers and Intent objects.



Chapter

Making Apps Interactive: Intents,
Event Handling, and Menus

User interface design is built upon the foundation of the Activity superclass as well as the View and
ViewGroup superclasses, which you learned all about in the previous chapter. However, without any
interactivity in your Ul design, the usefulness of what you can do with your Android application is
somewhat limited!

For this reason, I’'m going to cover several fairly advanced concepts fairly early on in this book, such
as how the Menu and Menultem classes work in Android, as well as how Intent objects can be
utilized to switch over to your Activity subclasses. Using Intent objects, you can switch between
functional screens in your applications, each of which is defined using an Activity subclass that
references a Ul layout container (ViewGroup) subclass.

Besides covering Android’s menu-related classes, we will also cover the broader concepts of Intents
and Intent Filters, as they relate to Android. You first encountered Intent Filters in Chapter 4

(refer to Figure 4-17 near the bottom of the screen shot) when we looked over your bootstrap
AndroidManifest.xml file in detail.

In this chapter, we’ll implement an “Edit Galaxy Info” menu item in the HelloUniverse app, and
make the menu item call an EditGalaxy class, using an Intent object. We’ll learn more about the
RelativeLayout layout class, developing a new Ul design. This will allow users to update Galaxy
objects via Button and EditText widgets.

Adding interactivity to your user interface elements, or widgets, will require that you learn what Event
Handlers are, and how to implement Event Listeners, which are used to make the Ul elements (widgets)
interactive. Once the RelativeLayout Ul design is completed and referenced using the onCreate()

and setContentView() methods, we can instantiate your Button and EditText objects, and then attach
onClick() event handler Java structures to them, so that your user can use them interactively to update
the statistics for the Galaxy object. Since we are covering Menu, Menultem, Intent, RelativeLayout,
Button, EditText, and onClick() event-handling routines all in a single chapter, we had better get started
right away. Hang on tight, you’re in for an exciting journey through user interface land!

213



214 CHAPTER 7: Making Apps Interactive: Intents, Event Handling, and Menus

The Menu Class and Interface: Android Menus

An Android Menu interface was specifically created by the Android OS developers for creating
options menu and context menu structures in Android. Android’s Menu superclass has only two
subclasses: a ContextMenu class and a SubMenu class. These subclasses are used to provide
localized (context-sensitive) menu structures and sub-menu structures for both options menus and
context menus.

The options menu is more of a “global” menu structure, as it is accessed using a hardware
MENU key on your Android device, or, if the Android device does not feature a MENU key, using
the ActionBar “overflow” menu icon, which is those three vertical dots at the right-side of the
ActionBar, at the top of your Android device.

The Menu interface is used for creating Menu object structures, which hold your menu design, much
like a ViewGroup holds your Ul screen design. Just like a ViewGroup contains View sub-objects, the
Menu object contains Menultem objects, along with their configuration parameters, which you will
define using XML mark-up.

As you have already seen, these parameters can include the Menultem label or “title,” as well as the
order, ID, and various display characteristics, such as an icon, or whether the Menultem is active (not
dimmed or inactive) or is even visible, or whether it is checkable (can show a check mark next to it
when it has been selected).

The three different types of Menu objects, options menus, context menus, and sub menus all have
different characteristics. For instance, sub menus cannot have nested sub menus and cannot have
Menultem icons, and context menus also do not support Menultem icons or shortcuts. In case you
don’t know what “shortcuts” are regarding menus, they are letter (android:alphabeticShortcut) or
number (android:numericShortcut) definitions which the user can use as a shortcut for accessing
that Menultem more directly or more rapidly.

Options menus, which are the primary type of Menu object used in Android applications, and the
kind we are going to focus on in this chapter, have their own set of rules, such as icon menus
displayed within the ActionBar do not support Menultem check marks, and will only show the
Menultem condensed title, if provided using the android:titleCondensed parameter.

You can access the expanded options menu, which will only become available if six (or more)
Menultems are defined, via the ‘More’ item in the icon menu or ActionBar overflow menu. This
expanded options menu will not show Menultem icons, and Menultem check marks are not
recommended for use either.

The Menu object defined by the Menu class and Menu interface will contain Menultem objects
defined by the Menultem class, and as you will soon see when we create a working Menu and
Menultem in the Hello Universe application, both of these classes will have to be imported into your
MainActivity class. There is another menu-related class, the Menulnflater class, which is utilized to
turn or “inflate” your XML menu definition file into a Menu object in much the same way that your Ul
design is inflated.
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The class hierarchy for the Menulnflater class is structured as follows, and this class was created
“from scratch” from the Java Object master class specifically to inflate Menu objects using XML
definition files stored in the /res/menu folder:

java.lang.0Object
> android.view.MenuInflater

It is interesting to note that you do not need to use an import android.view.Menulnflater;
statement at the top of your MainActivity.java class because there is a method which is part

of the android.app.Activity package called getMenulnflater() which provides access to the
Menulnflater class’s .inflate() method by using something called Java method “chaining” using the
getMenulinflater().inflate() Java code construct. As you will see later on in the code which we will
be writing in this chapter, the dot or period character chains the two Java methods together.

Designing Menus in XML Using <menu> and <item>

Your Menu object design is implemented using two primary XML definition files, specifically the
strings.xml file, located in the /res/values folder, which contains the Menultem object’s label text
(String) constant, and the main.xml file, located in the /res/menu folder, which holds the Menu
object definition.

The first thing that you will need to do is to define your Menultem object’s “title,” which | prefer to
call its “label,” in the strings.xml file. Right-click on this file in the /res/values folder, and use the
Open command to open it for editing in Eclipse. Create a <string> child tag inside of the parent
<resources> tag, with the name edit_galaxy, and give it a text (String object) data value of “Edit
Galaxy Info” as is shown in Figure 7-1.
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Figure 7-1. Add a <string> constant named edit_galaxy with a text data value of Edit Galaxy Info for use in an options menu
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Now you are ready to edit your Menu object, which is defined inside of your main.xml XML menu
definition file, which is located in the /res/menu project folder. Right-click on this /res/menu/main.xml
file, and select the Open option to open this file in your Eclipse central editing pane.

Add a second Menultem object by adding another <item> child tag inside of the parent <menu> tag
which defines the Menu object. Just like Menultem objects are “children” of the Menu object, the
same hierarchy is reflected in your XML file definition, where your <item> tags are child tags of the
parent <menu> tag.

You can further define and configure Menultem objects using parameters within each <item> child
tag, such as the android:id parameter to define the ID that will be evaluated (later) in your Java code,
the android:title parameter, which will reference the edit_galaxy <string> constant which you just
created for your Menultem label, and other parameters defining Menultem order and whether or not
it shows up in the Android ActionBar.

As you can see in Figure 7-2, | placed the edit_galaxy Menultem object above the action_settings
Menultem object, as Android menu design convention dictates that Help and Settings menu items
should be last on the menu structure. This is similar to all software menu design guidelines, where
help and settings menus are listed last, at the bottom of the menu.
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Figure 7-2. Add an <item> child tag in the <menu> parent tag which references the edit_galaxy <string> constant

To see your new Menu object design, use the Run As » Android Application menu sequence and
launch the Nexus One AVD, and click on the hardware MENU button, or on the ActionBar overflow
menu (three vertical dots) to see that your menu now has two entries in it!

It is interesting to note that you can design and test Menu objects and Menultem objects using

this XML-based work process all day long and the Menu and Menultem objects will show up in the
AVD, which is a designer’s dream! It will take some Java coding to make these Menu and Menultem
objects actually interactive (that is, do something when they are clicked on), but it is interesting

that XML makes the application design possible using ZERO Java coding, which is the intent of
extracting some of the application design functionality over to be done using XML markup.
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When | used the Run As » Android Application menu sequence, the Nexus One AVD launched,
and the default Android (installed) OS application icons appeared, but the Hello Universe icon was
nowhere to be seen, and the application start-up screen (MainActivity.class or MainActivity.java) did
not show up, as it should have during a normal code-compile-AVD-test development cycle.

For this reason, | am going to add a section into this chapter here, much as | did in the previous
chapter when | opened up Eclipse and got a gaggle of nasty red error highlights that were not even
my fault! | will do this to show you what | do when the Eclipse AVD emulator “stalls,” and does

not complete its “lifecycle” and perform its necessary AVD emulation duties. Bad Emulator! Next,

| am going to show you how | get around this emulator breakdown scenario, and how | get the

AVD emulator to restart “from scratch,” so that it will load the application, and then auto-launch

the application in the way that it is supposed to launch the application for testing in the first place.
After that, we will continue on exploring the Menulnflater class, as if this AVD glitch had never even
occurred.

AVD Is Not Starting App: Using the Eclipse AVD Manager

To solve the “hung” AVD problem, | used Eclipse’s Run » Android Virtual Device Manager menu
sequence, and opened up the Android Virtual Device Manager dialog shown in Figure 7-3. |
selected a Nexus One AVD by clicking on it (it turns blue, as shown), and then clicked on the Start
button. A Launch Options dialog pops open, with two selected (checked) options; Launch from
snapshot and Save to snapshot. | then de-selected, or un-checked, these two options, as shown
on the right-hand side of Figure 7-3, and | clicked on the Launch button.
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Delete...
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+" Avalid Android Virtual Device. A repairable Android Virtual Device.

3¢ An Android Virtual Device that failed to load. Click ‘Details’ to see the error. Cancel

Figure 7-3. Use the AVD Manager’s Start button, then deselect the snapshot options, before using the Launch button

This work process will launch the AVD “from scratch,” and you will see the silver ANDROID logo
“loader animation” reloading the AVD into your system memory anew (afresh?), which should “reset”
or “restore” the connection between the AVD and the auto-loading of your project data into the
emulator for auto-starting and testing.
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My logic here in performing this work process is that somehow this “snapshot” of the app which
was being saved (between subsequent launches of the AVD) had become corrupt, or otherwise was
causing some sort of bug or error that was preventing the AVD emulator from continuing the part of
its launch which accesses the app project (and icon) from Eclipse.

Thus, to allow me to do an “end-run” around this particular problem, | utilize the AVD Manager’s
Start button, in order to allow me to access this Launch Options dialog, so that | can disable these
shapshot features. The Launch Options dialog allows me to be able to force a “fresh” AVD launch
into system memory of whichever AVD emulator | wish to test with.

If the Android OS (or AVD) developers fix this particular AVD issue, which you at some point in time
will most likely encounter in your Android app development work process, then this work process
will no longer become necessary to fix this quagmire. However, | thought it wise to advise you
regarding this work process, and my implementation logic behind it, in case you encounter this
problem, and it brings you to a grinding halt in the application development coding-testing cycle! If
you can’t get your application to launch in the emulator, you can’t test it as you develop it; thus, this
is an important topic.

Once the animated Android logo stops loading the AVD into memory, you will see the screen shown
on the left side of Figure 7-4. Click and drag the lock icon outward, until it circumscribes a circle,
and then release it. After you do this your application (and your new menu structure) will auto-launch
again, as is shown on the right side of Figure 7-4.
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SUN, MARCH 16

Figure 7-4. Drag to unlock the Nexus One; click the ActionBar options menu (three vertical dots) to open the menu
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Next let’s take a look at the onCreateOptionsMenu() method and see how it inflates your Menu
object using the Android Menulnflater class in conjunction with your /res/menu/main.xml XML
menu definition file.

Inflating the Menu: onCreateOptionsMenu()

Let’s take a look at the Java code collapsing and expansion (plus + and minus -) icons on the left
side of the IDE central editing pane. Click on the plus + sign, next to the import statements, to
expand that section. This will turn the + next to the import statements section into a minus sign, as
shown in Figure 7-5 at the top. This will allow you can see all of the import statements, including the
highlighted import android.view.Menu statement, which Eclipse just provided (coded) for you.
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Figure 7-5. The getMenuinflater() method chaining to a .inflate() method referencing the main.xml menu

Use the minus - sign next to each of your MainActivity class methods, except for the
onCreateOptionsMenu() method, for which you will click the plus + sign to open it up for
observation, so we can go over what it does. The result of this is shown in Figure 7-5 and you will
have four method names with plus + signs next to them! This is a handy way to “put away” your
Java method code blocks when you are not working on them, so that you can focus on the code
that you are currently writing, or in this case, the code in Figure 7-5 we are analyzing for learning
purposes.

The onCreateOptionsMenu(Menu menu) method uses a Menu object named menu, which it
passes over to the .inflate() method in the Menulinflater class along with the R.menu.main reference
to the XML menu definition. The .inflate() method call is referenced inside the Menulnflater class
using the Activity class getMenulnflater() method call, using a Java dot-chaining construct, like
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this: getMenulinflater().inflate(R.menu.main, menu). Once this .inflate() method has been called
successfully, the onCreateOptionsMenu() method will then return a true value, signifying the
completion of the Menu obiject inflation process.

Now that your Menu object is inflated using the bootstrap method that Eclipse created for you back
in Chapter 3, and which we just delved into the inner workings of how it stitches Android’s Menu
and Menulnflater classes together, we are going to finish implementing the Menu object and its
Menultem sub-objects via the following objectives:

Learn how to declare multiple TextView objects in a single Java declaration by
using commas.

Create a public boolean onOptionsltemSelected() method to evaluate the
Menultem objects.

Learn how to create a Java switch programming structure, using case
statements to evaluate each Menultem object.

Instantiate an Intent object named editintent using the Java new keyword, and
then utilize that Intent object in order to call the EditGalaxy.class, passing over
the current application Context object, by using the Java this keyword.

Create the EditGalaxy.java Activity subclass, by using the Eclipse New Java Class
dialog, and its related Superclass Selection sub-dialog to define an
android.app.Activity superclass.

Call a .startActivity() method from the Activity class and the android.app.Activity
package, passing over the editintent Intent object, which contains the current
application Context and the binary representation of the EditGalaxy.class
Activity subclass which you wish to start.

Create a New XML Ul Layout Definition, by using the Eclipse New XML File
menu sequence.

Create a RelativeLayout Ul design, which contains both Button and EditText
Ul widgets, using an XML Ul definition file, and then inflate that Ul design using
the setContentView() method call, inside of the onCreate() method, in the new
EditGalaxy.java Activity subclass.

The Menultem Class: onOptionsitemSelected()

In order to evaluate and process your Menultem objects inside of your Menu object structure, you
will need to create a public boolean onOptionsltemSelected() method, which will be the next step
in your options menu implementation work process.

First, in order to make some additional room in the Eclipse central editing pane, let’s turn your seven
TextView object declaration and naming lines of code into just two lines of code, giving us back five
lines of code. To do this, | will show you a consolidation trick by which you can declare the TextView
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object type and place more than one name after that declaration. This is done by using the comma
character as a delimiter between the name values, as is shown in Figure 7-6. You can code seven
TextView declarations and names using the following Java code:

TextView nameData, solarData, habitData, colonyData;
TextView popData, fleetData, shipsData;
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Figure 7-6. Add an onOptionsltemSelected() method and consolidate TextView object declarations with commas

You could also have done this using one single line of Java programming logic, by using the
following format:

TextView nameData, solarData, habitData, colonyData, popData, fleetData, shipsData;

Next, collapse your five methods, as shown in Figure 7-6, and add the onOptionsltemSelected()
method as follows:

public boolean onOptionsItemSelected() { ... }

Once you do this, you will get red error highlighting under this new method name, advising you that
you need a return statement. Click on the Add return statement option, which will add the return
false; Java statement for you. Later on, we will change this to return a true value; but for now, since
the method does not do anything, false, which means nothing has been processed, would be the
correct return value for the currently empty method.
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Since the onOptionsltemSelected() method evaluates Menultem objects, you will need to declare a
Menultem and name it item inside of the method parameter list area, because you will want to pass
(or take) in Menultem objects for evaluation, and inside of the method you are going to reference
these using the name item. This is done using the following method declaration construct, as is
shown in Figure 7-7:

public boolean onOptionsItemSelected( Menultem item ) { return false; }
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Figure 7-7. Add a Menultem object named item to the onOptionsltemSelected() method, then import the Menultem class

Mouse-over the wavy red error highlighting under the Menultem class reference and select the
Import ‘Menultem’ (android.view) option to have Eclipse write the Java import statement for you.

Now that the method infrastructure is in place, we need to write Java code inside of the method that
looks at the Menultem object (named item) which is passed into the method, and puts this Menultem
object through some sort of evaluation structure, to ascertain what to do if the Menultem conforms
to certain characteristics—in this case, its ID.

The Java Switch Statement: Choosing a Menultem

The Java programming structure to use in this scenario is called a “switch” structure, which will
allow the Java code to switch between different code scenarios, based on a “case”-by-case
evaluation structure, which you put into place. We are going to take a closer look at how to put
together this type of Java code evaluation structure in this section of the chapter.
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The first part of the evaluation structure starts with the switch keyword and something to evaluate
on a case-by-case basis—in this case, that would be the Menultem object named item. The switch
statement, which is shown in Figure 7-8, would be coded as follows:

switch( item.getItemId() ) { case by case statements go in here }
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Figure 7-8. Add a switch statement to the inside of the onOptionsltemSelected() method to evaluate Menultem

As you can see, we are again “nesting” Java constructs, with the Menultem object named item
calling the .getltemld() method by using dot notation inside of the switch() evaluation value
parameter area. What this is evaluating is fairly obvious, as it is looking at each Menultem object’s ID
value which comes into the method.

Inside of curly braces will go case statements, each of which will have an ID value and then a colon,
as follows:

case R.id.edit_galaxy: Java programming statements to process, these are exited by using a Java
break; statement

After all of the case statements, there is a return statement, which we will be changing to true
once we add case evaluation statements. As you can see in Figure 7-8, once you type in the case
keyword and the R.id. precursor, the Eclipse pop-up helper dialog will give you all of the ID values
you have defined in your XML definition files.

Double-click on the edit_galaxy : int option shown highlighted in blue in Figure 7-8 to insert this
particular ID for your edit_galaxy Menultem object, for evaluation in this first case statement. Next,
we will add Java statements inside of the case statement for the edit_galaxy Menultem which will
create, name, and load an Intent object, which will be used to launch an EditGalaxy.java Activity
subclass which will contain our RelativeLayout Ul container and an interactive Ul design allowing
users to edit and change the Galaxy object data field values.
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Using Intent Objects: The Android Intent Class

An Intent object is used within the Android OS as a messaging construct that you can dispatch to
request some sort of “action” from one of the other components within your Android application, or
even within someone else’s Android application, which is external to your own Android application.
There are three primary uses for Intent objects in Android; launching Activity subclasses, starting
Service subclasses, and sending messages around an Android application, or even to external
Android applications by using Broadcast Receiver classes and methods.

Here’s a basic diagram which shows how your Activity uses Intent objects:

Activity > Intent object containing start Activity Intent > Activity (launched) or:
Activity > Intent object containing start Service Intent > Service (launched)

As you know, the Activity subclasses each represent a single user interface screen within an app’s
functionality. You will start each new instance of an Activity subclass by passing an Intent object over
to the .startActivity() method, which we will be doing in the next step in the menu implementation
work process.

The Intent object passed into the .startActivity() method will contain data which prescribes which of
the app’s Activity subclass you want to start, and carries the Context object describing the current
context for your application. We will go over the concept of Context within this chapter as well, as it
is used often in Android programming.

You can also use an Intent object to start a Service subclass; we’ll be covering Services in

Chapter 13. A Service is an Android component which can perform operations in the background.
These operations usually do not need a user interface, and can be performed “asynchronously,” or
out of sync, with the user’s normal “flow of use” of your application and its purpose and objectives.
An example of this would be playing a background music track.

You can also start a Service subclass using an Intent object in order to perform a one-time operation
such as the downloading of a file, again by passing an Intent object over to a .startService() method
call. This Intent should describe the Service subclass to start, as well as any necessary data that is
needed for the Service to process.

You can also use an Intent object to deliver a broadcast across the Android OS, to anything running
under it. A broadcast in Android is a term for any message that an app running on the same
Android device as your app can receive. The Android operating system will deliver broadcasts for
system events, such as when the system boots up, or when the device is plugged in and starts
charging. You can deliver a broadcast message to other apps by passing Intent objects via a
.sendBroadcast(), a .sendOrderedBroadcast(), or a .sendStickyBroadcast() method call.

There are two types of Intent objects you can create and utilize within the Android OS: explicit Intent
objects and implicit Intent objects. Explicit Intent objects will specifically reference the Android
application component to start, by using a precise application component name and component
type. When you create an explicit Intent object to start an Activity subclass or Service subclass, the
Android operating system starts the component specified in that Intent object.

In the next section, you will start your EditGalaxy.class using this fully qualified compiled class
name. A fully qualified compiled class name would be referenced in your code as EditGalaxy.class,
which is different than the fully qualified code class name, which would be referenced as
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EditGalaxy.java. The difference is that your code is calling, or in the case of using an explicit Intent
object, launching, a .class compiled version of your Activity subclass from within your compiled
package (.APK or Android PacKage) infrastructure.

You will typically want to use an explicit Intent object to start a component within your own
application. This is because you inherently know the class name of your Activity subclass or Service
subclass which you want to launch, and so you can utilize, or “hard code,” that component name in
your Java code. For example, you would start your new Activity subclass in response to a Menultem
selection, as we are about to do in the next section, or you could also start a Service subclass, in
order to start processing in the background, as we are going to do in Chapter 13 when we cover
Services.

Implicit Intent objects do not name their target application component, but instead declare a general
“action” to perform. This implicit Intent approach allows any application component, even from
another Android app outside of your own Android app, to “handle” the Intent. The reason that
Android also has Intent Filters and the IntentFilter class is for the processing, action determination,
and handling of these implicit Intent objects.

For example, if you wanted to show your app’s user a location on a map, you could use an implicit
Intent object to ask, or “request,” that another mapping-capable Android application show your
application user that specific location on the map that your application is referencing. Implicit Intents
allow Android apps to work together!

When you create an implicit Intent object, the Android operating system will find the appropriate
application component (Activity, Service, Broadcast Receiver) to start up by comparing the contents
of your implicit Intent object to the <intent-filter> definitions declared in the AndroidManifest XML file
for other apps on the device.

If the implicit Intent object matches up with one of those IntentFilter definitions, the Android
operating system starts that component, and delivers your implicit Intent object to it. If multiple
IntentFilter definitions are found to be compatible on the same Android device, the Android operating
system will display a pop-up dialog, so the user can pick which app to use. It is important to note
that every user installs different apps, and thus different users’ Android devices will invariably exhibit
different combinations of installed Android applications, which will result in different popup dialog
selection choices.

An IntentFilter object is an Intent processing definition construct which is defined using your
Android application Manifest XML file. This <intent-filter> construct defines the structure for the type
of implicit Intent objects that your Android application’s components would like to be able to receive,
and to be able to process. This is quite powerful (and quite complex as well), as it allows developers
to create Android applications which do things (perform tasks) for other Android apps, which opens
up an entirely new genre of Android applications that Android developers can create.

As an example, by declaring an IntentFilter object for an Activity subclass, as you have already seen
done by Eclipse for your MainActivity class in your AndroidManifest.xml, you make it possible for
other applications, in this case it would be the Android OS application launching screen, to directly
start your MainActivity.class Activity subclass using a specific Intent object containing the MAIN
action and the LAUNCHER category.

If you do not declare any <intent-filter> XML definitions constructing an IntentFilter object for any
of your Activity subclasses, then these Activity subclasses will be “invisible” to outside Android
applications, and will only be able to be started using an explicit Intent object. A great example of



226 CHAPTER 7: Making Apps Interactive: Intents, Event Handling, and Menus

this is what we are doing in this chapter with your EditGalaxy Activity subclass, since we only want
your MainActivity class Menu object to be able to start this private component of your Hello Universe
application.

Finally, remember one important “rule” regarding the use of Intent objects in your Android
programming! To ensure that your Android application is completely secure, you will always want to
use an explicit Intent object when starting a Service object (Service subclass). This also means that
you would not want to declare <intent-filter> XML constructs that create IntentFilter objects for your
application’s Service subclasses, since these are only utilized with implicit Intent object processing,
and are not needed when using explicit Intent objects.

The reason for this “rule” is because by using an implicit Intent object to start a background
processing Service class, you risk creating a security hazard within the Android OS on your end
user’s device. This is because the developer cannot ascertain what Service subclass will respond to
an implicit Intent object, and the end user also cannot see which Service is starting on their Android
device. This opens up the ability for a destructive Service to be created, which could be triggered
by an implicit Intent object used to start a Service subclass. So don’t create Services using implicit
Intent objects!

Instantiate an Intent Object: An App’s Context

Let’s instantiate, name, and configure an explicit Intent object named editintent, which will start the
EditGalaxy Activity subclass, which we are going to create as the next step in this work process.
This is done by declaring the Intent object for use, then providing a name, and then “loading” the
newly named Intent object using the equal sign, while at the same time (in the same Java statement)
creating an Intent using the Java new keyword, and configuring this new Intent with the class name
which you will be starting.

All of this can be accomplished by using the following single line of Java programming logic:
Intent editIntent = new Intent( this, EditGalaxy.class );

So the Intent declares the object type, the editintent gives it a name, the equals = sign signifies
that we are about to instantiate it, the Java new keyword creates an instance of the Intent object,
and finally the parameter list passes over the Context object for our MainActivity Activity subclass,
using the Java this keyword, as well as the EditGalaxy.class Activity subclass that we want to

start or launch using the explicit Intent object created with this Java statement. As you can see in
Figure 7-9, we have some wavy red error underline highlighting in the code, which you will probably
guess is related to creating either import statements or code structures which do not yet exist, but
which are referenced within the Java code structure you are currently coding (you have seen both of
these error scenarios before).
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Figure 7-9. Declaring an Intent object named editintent and instantiating it using the new keyword and loading it

Let’s take care of the import statement for the Intent class first. Mouse-over the Intent error
highlighting, either one will provide the same pop-up helper dialog, and select the Import ‘Intent’
(android.content) option. Next, we will go over what the Java this keyword and a Context object
do for your Android application, and then we will continue our work process in the section after that,
and allow Eclipse to create our EditGalaxy.java class.

Explaining Context: The Android Context Class

The concept of Context in Java programming is simple in its definition, and yet complex in its
implementation. It is something that you will need to know what it is doing, and why it is needed, to
be able to accomplish certain things in Android. It is not something you need to manipulate directly,
at least not until you become an advanced Android developer.

The Context object, and the Java this keyword, which essentially passes over a Context object, is
exactly what it sounds like it is! Android Context objects contain detailed “contextual” information
regarding the application component which is calling over to the other application component to do
something. If someone asks you to do something for them, you usually ask them what the context
for the task is, so that you know what, and why, you are doing the task!

The reason for giving the receiving application component this “Context” (clever Java keyword pun
intended) is that Context objects will allow a called application component to “see” or ascertain what
the calling application component is doing, so that it can do the job (task) that it is being asked to do
more efficiently, effectively and with greater precision.

When this “Context” object, which is filled or “populated” with information regarding the calling
application component, is combined with the (inherent) “knowledge” of what the called application
component is doing, it results in “Context,” which, as we all know from real life, can be defined as
the clear, overall view of the entire process which we are currently involved with. A Context object
is similar to a Bundle object, in that it contains a lot of related information, all collected, or bundled
together, into one complex object and sub-object hierarchy.
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Note You have already used a Bundle object to save the current “state bundle” for your Activity subclass,
with the Bundle object named savedinstanceState in your onCreate() method call. The Bundle class allows
you to put together “bundles” or collections of variables and data, so it is not complex enough to merit its very
own section in the book. That said, if you are really into bundling things, you can take a detailed look at the
Android Bundle class on the Android developer web site, located at the following URL:

http://developer.android.com/reference/android/os/Bundle.html

The Context object thus contains information about what your application component is doing,
how it is set-up, what resources it uses, and all manner of information regarding that Android
application component, essentially. Whereas the Android Manifest XML definition is used to provide
some of this “global” information to the Android OS when it goes to launch your application,

the Context object provides all of this technical-, systems-, and resources-level info for each of
your application components, “local” information if you will, using the Context object while your
application is actually running.

As | mentioned previously, you only need to know how to use an application component’s Context
(and the this keyword) properly to be successful in the majority of your Android application
programming, design, and development endeavors, so | am not going to spend that much time
delving into the public abstract Context class in this book.

If you’d like to learn more about this Android Context class, you can visit the following Android
developer site URL:

http://developer.android.com/reference/android/content/Context.html

Now we can continue on in our work process for creating a working menu which launches a second
EditGalaxy Activity subclass, and create a RelativeLayout Ul design for that Activity, and make it
functional using Events!

Creating Your Second Activity: The EditGalaxy Class

Now that you know what the Java this keyword is, which is used here to pass over the Context
object for your MainActivity.class to the EditGalaxy.class, we can go ahead and mouse-over the
wavy red underline highlight under the reference to the EditGalaxy.class (which does not yet exist),
and select the Create class ‘EditGalaxy’ option, which will give Eclipse the go ahead that it needs
to create this new Java class for you, as shown in Figure 7-10.


http://developer.android.com/reference/android/os/Bundle.html
http://developer.android.com/reference/android/content/Context.html
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Figure 7-10. Using the Eclipse helper dialog Create class ‘EditGalaxy’ option to create your Intent object’s class

This will bring up the New Java Class dialog, which is shown in Figure 7-11. This dialog is initially
configured to create a Java subclass, by using the java.lang.Object superclass. In this case, since
you allowed Eclipse to invoke this dialog from your code, the name (EditGalaxy) is already provided
for you in the dialog, as is the project folder and package name, which Eclipse can also ascertain
from the project you are working on.
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Figure 7-11. Browse for Activity superclass, select, click the OK button and the Finish button to create the new class
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It is important to note that you can also create a new Java class; that is, you can access this New
Java Class dialog yourself without Eclipse doing it for you, by right-clicking on your project’s /src
folder, and selecting the New » Class menu sequence, just like you did in Chapter 5, shown in
Figures 5-4 and 5-5.

Since you were creating your Galaxy class in Chapter 5, you accepted the “default” java.lang.
Object superclass for the New Java Class dialog. However, since we are now creating a new
functional screen and user interface for our app, this time we want the Android class that we’re
creating to be an Android Activity subclass, so you will need to click the Browse button next to
the Superclass data field, which will open the Superclass Selection dialog, which is shown on the
right-hand side of Figure 7-11.

In the Choose a type field, type in “activ” which will bring up all of the Activity-related classes

in Android. Notice that as you type, the selection area of the dialog will be refined in real-time in
response to every keystroke which you add. If you type the activ sequence of characters in slowly,
you will see that the selection list will decrease in size with every keystroke!

Find the Activity - android.app package option; it should now be at the top of the dialog, and is
the only option which specifies the package that it is in (because it is so commonly utilized). Next,
select it, and click the OK button, or you can double-click on it, which will insert it as your new
superclass selection.

Once you click the OK button, the Superclass Selection dialog will vanish, and you will be back
inside of your New Java Class dialog, where you can now click the Finish button, since your class
name was already defined in your Intent object constructor method call, and Eclipse filled out your
Source folder and Package fields based upon the current project and package which you are
working on (and in).

Once you click on the Finish button, Eclipse will create the EditGalaxy.java class bootstrap Java
source code for you, as is shown in Figure 7-12. Now all you have to do is to add your onCreate()
method and start building out a new user interface design, to create your new functional Activity
screen design for your first menu option.

[+ Java - HelloUniverse/src/absolute/beginners/hellouniverse/EditGalaxy.java - ADT - 0 “
File Edit Refactor Source Mavigate Search Project Run Window Help
i B S N S O T T S T m T IS S [quick Access 2 | [@ien
2 Package Explorer 52 = = 1] EditGalaxyjava 5 =20 BEoutine 2 E R W w e W T 0O
4 12 HelloUniverse L package absolute.beginners.hellouniverse; f# absclutebeginners hellouniverse
# | src © EditGalaxy
4 {3 absclute.beginners.hellcuniverse import android.app.Activity;
|14] EditGalaxy.java &
1) Galaxyjava public class EditGalaxy extends RActivity {

4] MainActivity.java
38 gen [Generat 1
= Android 4.4.2
=4 Android Private Libraries
> assets v
B Console 2 D vl By
sbzolute beai Lo EditGalaxy.java - HelloUniverse/sre 66M of 206M i Android SDK Content Loader

Figure 7-12. The EditGalaxy.java class created via the New Java Class dialog and Superclass Selection dialog
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Before we start working on building out your EditGalaxy.java Activity subclass’s Java code, let’s
finish up with coding the Menultem switch and case statements we have been building first, so
that we finish up with what we are learning about in this part of the chapter: how to create a working
options menu inside of the MainActivity Activity subclass. The next step is adding a method call to
the .startActivity() method, passing over the Intent we just created.

Starting an Activity: Using the .startActivity() Method

As you can see in Figure 7-13, now that the EditGalaxy.java Activity subclass exists, the error
highlighting has vanished, and you are ready to call the .startActivity() method from your
MainActivity subclass. This is done “off of,” or using, your Activity subclass’s Context object,

which is named (using a Java this keyword “shortcut") this. Within the method you pass over the
editintent (explicit) Intent object which you created and configured in the previous line of Java code.
This Intent passing construct is done using the following line of Java code:

this.startActivity(editIntent);
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Figure 7-13. Calling the .startActivity() method off of the current Context object, and passing over the editintent Intent object

This will call the android.app.Activity package’s .startActivity() method, which is, as you can see, part
of the Android Activity class, off of the current Context (this) object, and passes over as a parameter
the editintent Intent object. This will start your new Activity subclass (EditGalaxy.java, which will
become EditGalaxy.class).

Figure 7-14 shows the completed onOptionsltemSelected() method structure, with the new
edit_galaxy case statement and the action_settings case statement that was created by the Eclipse
New Android Application Project series of dialogs. The default statement is triggered if none of the
case statements are called (utilized) and passes (returns) control of the Menultem Object back up to
the superclass using the super keyword and the method name and item Object using the statement
return super.onOptionsltemSelected(item); otherwise a return true; statement is used if any of the
case statements were evaluated and completed.
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Figure 7-14. Complete onOptionsltemSelected() method structure showing (boolean) return statements selected in Eclipse

The next step in the work process is to create the “internals” of the EditGalaxy.java class, which
when compiled becomes the EditGalaxy.class referenced inside of the Intent object. The EditGalaxy
class needs to include the onCreate() method, a setContentView() method call referencing a
RelativeLayout XML Ul definition, and later on, we will add in some event handling structures, to
allow the users to interface with the Ul. This will allow the application’s user to update the Galaxy
object characteristics (its data fields, or variables) by using a series of EditText widgets.

Coding the onCreate() Method: Using setContentView()

The easiest way to add in the four lines of code that need to be in every Activity subclass is to simply
copy them from your MainActivity.java class, as is shown in Figure 7-15 in the top half of the screen
shot, and then change the reference to activity_main.xml to be one for activity_edit.xml, which will
“throw” an error, initially.
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Figure 7-15. Copy onCreate() method from MainActivity, change Ul XML to activity_edit, New » Android XML File

It would be nice to be able to mouse-over this error and have Eclipse create the new XML file for
you, just like it did on the Java side of things, but unfortunately, this option has not been added to
the error pop-up yet, so we will need to create an XML Ul Layout definition file for ourselves. You
can also see the work process for this in Figure 7-15, which involves a right-click on the /res/layout
folder and the selection of the New » Android XML File menu sequence, which will bring up the
New Android XML File dialog, seen on the right-hand side of Figure 7-15.

Since you right-clicked on the /res/layout folder, the Layout XML resource type is already set for
you, as is the project name, so all you have to do is to name the file activity_edit, and select a
RelativeLayout container type in the main (central) area of the dialog. After you configure everything,
click the Finish button, and the file will be created for you, and will also be opened up for you inside
of the Eclipse central editing pane.

Creating an EditGalaxy Ul: Using a RelativeLayout

Since we learned about the LinearLayout class in the previous chapter, and since the
RelativeLayout class is the next most commonly used layout container class in Android application
Ul design, we’re going to use this class to design our Edit Galaxy Info screen in this section of the
chapter. | want to cover more unique and advanced Ul layout container classes in the next chapter
on Ul layout (container) design, so | am going to cover these two layout container classes in these
first two chapters that include Ul design topics in them. Ul design in Android simply cannot be
covered using one chapter; in fact, Apress has an entire book, called Pro Android Ul, by Wallace
Jackson (Apress, 2014) covering this topic alone! Thus, | will be covering some of the Ul-related
topics from this Pro Android Ul book title during Chapters 6 through 12, including the different layout
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classes and many of the popular widget classes, resolution density assets, the popular Android
Drawable classes, how to use alternate Ul layout folders, styles, themes, Ul graphics, Ul animation,
Ul audio, and so on.

Using Editable Text Fields: The EditText Widget

To be able to enter a text value in a user interface design, you will need to use an <EditText> Ul
widget. As you know, the work process to find this widget is to add a new line under the opening
<RelativeLayout> tag and use the left-facing chevron < character to bring up the Ul widget helper
dialog which is shown in Figure 7-16. Find and then select and double-click to insert the EditText
(class) child tag inside of your <RelativeLayout> parent tag. Add an ID naming the EditText object
edit_colony and a layout_margin value of 8DIP using this markup:

<EditText android:id="@+id/edit_colony" android:layout margin="8dip" />
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Figure 7-16. Use the left-facing chevron to bring up a child tag pop-up helper dialog and find, select, and double-click EditText

After we add the <Button> Ul widget next, we’ll add the other parameters which we’ll need in this Ul
element.

We are going to add the Button Ul element to this Ul design so that when your user enters their new
value into the EditText field, they can click an OK button when they are done making their entry, to
tell your Java program logic that it is OK to now take that value and to update the corresponding
Galaxy object data field (value) with that new numeric data value.
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Using Buttons in Ul Designs: The Button Widget

Add a new line underneath your <EditText> child tag, and use the left chevron < character to again
bring up the Ul widget helper dialog. Find the Button widget class, as is shown in Figure 7-17,
and select, and double-click on, the Button widget in order to insert it into your RelativeLayout Ul
definition XML mark-up.
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Figure 7-17. Use the left chevron to bring up a child tag pop-up helper dialog and find, select, and double-click Button

Add an android:id parameter named submit_colony so that the Java program logic can reference
the Button Ul element, using the android:id="@+id/submit _colony" parameter format, and then you
will be ready to add in your RelativeLayout positioning parameters, which will position the Button

Ul element relative to the position of the EditText Ul element. This “relative positioning” capability is
what sets the RelativeLayout class and Ul layout container type apart from all of the other Android Ul
layout container classes. Let’s cover this concept in the next section and take a closer look at some
of the most often used relative positioning parameters, using this Ul design, which happens to be
very well-suited for RelativeLayout positioning, as you will soon see.

Aligning Widgets Using RelativeLayout Parameters

After you add your android:id parameter in your <Button> child tag, type in the android:layout_
characters and a pop-up helper dialog containing all of the parameters which are compatible with
the <RelativeLayout> parent container type will appear, as can be seen in Figure 7-18. The first four,
above, below, toRightOf, and toLeftOf, are used to specify relative layout positioning, and the
next five listed in this dialog, alignBaseline, alignLeft, alignTop, alignRight, and alignBottom, are
used to specify relative layout alignment.
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Figure 7-18. Add the RelativeLayout parameter android:layout_toRightOf inside the <Button> child tag Ul widget

The next four parameters allow you to align your Ul widgets relative to the parent Ul layout
container, and the ones listed after those will allow you to center your Ul widgets, relative to their
parent Ul layout container. As you might well imagine, when all of these parameters are utilized
together in conjunction inside of each of your component Ul design widgets, you can achieve just
about any Ul layout design result that you can imagine.

What is really powerful about RelativeLayout is that when your user changes their Android hardware
device’s orientation from portrait (up and down, or vertical) to landscape (side to side, or
horizontal), your relative layout design can “morph” to conform to the new display screen shape!
Let’s start learning about some of these relative layout parameters!

Since we want our <Button> Ul widget to be located to the right of our <EditText> Ul widget, the
first Ul layout parameter that we will want to implement inside of the <Button> Ul element is the
android:layout_toRightOf parameter. To tell the parameter what other Ul element we want to lay it
out relative to, we use an ID parameter to give it that reference point. So, to position the Button Ul
widget that you named submit_colony to the right of the EditText Ul widget named edit_colony, you
would use the following XML tag and parameter configuration:

<Button android:id="@+id/submit_colony" android:layout_toRightOf="@+id/edit_colony"/>

This will make sure that the <Button> named submit_colony is positioned to the right of the
<EditText> named edit_colony. However, as you will soon see, it will not necessarily align these
two Ul elements attractively, nor will it position your Ul elements in the Y axis (above or below)
dimension, only within the X axis (side to side) dimension. This is why a number of RelativeLayout
positioning and alignment parameters must be utilized in conjunction with one another in order to
achieve a fine-tuned and professional Ul layout design result.
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Fortunately, these RelativeLayout Ul alignment and positioning parameters all evaluate quite

well in the Eclipse Graphical Layout Editor (GLE) tab, located at the bottom of the central

editing pane, and so we will use this to save time previewing the Ul design as we built it. Using a
Run As » Android Application menu sequence and launching the Nexus One AVD emulator every
time you want to preview a Ul design parameter will take about ten times longer (or more than ten
times longer if you have a slow system) than simply clicking back and forth between the XML editing
tab and the GLE tab!

Using the Eclipse Graphical Layout Editor (GLE)

As you can see in Figure 7-19, where | show the XML editing tab and the GLE tab output in the
same screen shot, | have copied the required layout_width and layout_height parameters into the
<EditText> and <Button> tags and set them to use a wrap_content system constant, and yet | still
have the warning regarding a hint parameter, which we’ll add in soon.
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If you mouse-over the wavy yellow warning highlighting, the warning message informs you that
Android wants you to provide a “hint” to your users using the android:hint parameter inside of your
<EditText> Ul widget, which we will learn about in the next section of this chapter.

As you can see in the bottom part of Figure 7-19, you can click on the Graphical Layout Editor tab
and see the EditText Ul widget, shown selected in light blue, and the android:layout_toRightOf
parameter, shown using a green arrow pointing to the right, as well as the Button Ul widget, shown
highlighted using a light yellow color.

Giving an EditText Field a Hint for Your Users

The EditText Ul widget class has a unique attribute or parameter called a “hint” which allows you
to suggest to your user what needs to be placed into this data entry field, rather than just having
a blank field next to the OK Button. This happens to be very handy for the Ul we are designing
here as this parameter will allow us to advise the user regarding what type of data we want them
to enter into each data field. For the first EditView, the hint would be “Enter Number of Colonies:”
The android:hint parameter references a <string> constant, so we will be creating hint <string>
constants very soon.

Add a new line after your android:layout_margin parameter and type in android:h to bring up the
helper dialog containing all of the parameters that start with an “h” and select and double-click to
insert the hint parameter, as shown in Figure 7-20. Once you do this, the warning highlighting will
disappear, and you can specify the hint <string> constant named hint_colony (which we will create
next) by using the following XML parameter mark-up:

android:hint="@string/hint_colony"
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Figure 7-20. Add suggested android:hint parameter to suggest <EditText> field contents and to remove warning
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Right-click on the strings.xml file in your /res/values folder, and add five <string> child tags in the
<resources> parent tag, one for your OK Buttons, named ok_button, and four for the EditText Ul
widget hint text, named hint_colony, hint_pop, hint_fleet, and hint_ships, with the logical hint text
values, as is shown in Figure 7-21.
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Figure 7-21. Create string constants in the strings.xml file for ok_button, hint_colony, hint_pop, hint_fleet, and hint_ships

Now your <EditText> child tag’s android:hint parameter will appear error-free and you can add an
android:text parameter to the <Button> child tag, using the following XML parameter mark-up, as is

shown in Figure 7-22

android:text="@string/ok_button"
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Figure 7-22. Reference hint_colony and ok_button string constants via android:hint and android:text parameters
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If you toggle over into Graphical Layout mode (view), shown in Figure 7-23, you will see a drastic
change in your Ul layout design, which has just become an order of magnitude more professional in its
appearance than it was before you added the hint and Button text label string constant value references.
This great-looking result was achieved by using only one RelativeLayout toRightOf reference, and if we
only had one EditText and Button Ul element in the design, this would be a relatively (no pun intended)
simple Ul design. However, we have another half-dozen Ul elements to incorporate into this Ul design,
not to mention some cool background image work that we will need to do to make this Ul design match
up with the “visual wow factor” within our MainActivity Ul screen design.
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Figure 7-23. Previewing the configured <EditText> and <Button> widgets using a Graphical Layout Editor (GLE)

Before we get into the fun part of “skinning” the Ul design using graphics assets, we need to
continue learning some more RelativeLayout positioning and alignment parameters, as well as
adding the EditGalaxy class to the AndroidManifest.xml file. You will need to do this at some point,
so that your app will not crash when you decide to preview it inside of the Nexus One AVD emulator,
by clicking on your “Edit Galaxy Info” Menultem option.

Aligning Several Ul Elements Using RelativeLayout Parameters

Now let’s ratchet up the RelativeLayout complexity by adding in EditText and Button Ul widgets
for the Galaxy object Population, Fleets, and Starships characteristics, and align all of these Ul
elements relative to one another, so that you can gain valuable experience with some of the other
RelativeLayout parameters, such as android:layout_below and android:layout_alignLeft, for
instance, which you are about to implement next.

To duplicate the first <EditText> and <Button> Ul construct, copy and paste the XML markup for these
Ul structures again underneath themselves, as is shown in Figure 7-24. Change the word “colony” to
“pop” and add a new line in the second <EditText> child tag after the android:hint parameter.
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Figure 7-24. Adding a Galaxy Population <EditText> and <Button> widget, and using RelativeLayout parameters

Add an android:layout_below and android:layout_alignLeft parameter, and have each of them
reference the edit_colony <EditText> Ul element using @+id/edit_colony. This is done using the
following XML markup:

android:layout_below="@+id/edit_colony" android:layout alignlLeft="@+id/edit_colony"

The first parameter will apply RelativeLayout positioning to the second <EditText> Ul element,
positioning it below the first <EditText> Ul element, using the android:layout_below parameter.
The second parameter will apply RelativeLayout alignment to the second <EditText> Ul
element, aligning it using the left side of each of the <EditText> Ul elements, using the
android:layout_alignLeft parameter.

Let’s click the Graphical Layout tab and preview what these parameters do for our Ul design. As you
can see in Figure 7-25, the EditText Ul elements line up perfectly, but the second Button Ul element
is not toRightOf the EditText Ul element as you specified. Or is it? In fact, the second Button Ul
element is to the right of EditText, according to the Y axis dimension; however, it is aligned with the
top of the screen next to the other Button! This is the default alignment, unless otherwise specified,
so we will have to add some RelativeLayout alignment parameters to the second <Button> Ul
element to correct this.
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Figure 7-25. Preview the layout_below and layout_alignLeft parameters for the <EditText> widget using the GLE

We will use the same two parameters in the second <Button> Ul element that we used in the second
<EditText> Ul element, since we wish to gain the exact same results. If you wish to utilize a speedy
programmer shortcut, cut and paste the two parameters you just added to the <EditText> Ul element
into the <Button> Ul element and change the edit_colony reference to instead refer to the submit_
colony ID by using the following markup:

android:layout_below="@+id/submit_colony"

android:layout_alignlLeft="@+id/submit_colony"

As is shown in Figure 7-26, you are positioning this second Button widget to the right of an
edit_pop EditText widget, below a submit_colony Button widget, and using the left edge of the a
submit_colony Button widget.

@

File Edit Refactor Source MNavigate
w0 AEIE-id
= m

% Package Explorer &2

(= drawable-hdpi -
= drawable-Idgi
= drawable-mdpi
&= drawable-xhdpi
= drawable-xodhdpi
4 [= layout
[ activity_mainaom|
= menu
o (= values
o dimens.xml
0 stringsaoml
A stylesxml
= values-swS00dp
= values-swT20dp-land
& values-v11
= values-v14 v

Java - HelloUniverse/res/flayout/activity_editxml - ADT

Search Project Run  Window Help

W QTR G ™y L O »| = Quick Access 2 | [§ Java
<l activity_editml 2 i« = A =]
it xmins:android="Attp://schemas.android.com/apk/res/android” P

atch_parent” android:l _height="match parent” >

colony” android:text="@string/ok_
tOf="g+id/edit_
| h="vrap content" android:layout _height=":
roid:id="g#+id/edit_pop" am
g+id/edi
layout_width="wrep_con
tid="@+id/submit pop"
at_toRightOf="@+id/ e

elony™

eft=rg+id/edit colony™

F_content" />
android:texc="g§string/ok_button”

£ _pop"

colony™ android:la: alignlefc="@8+id/submit colony™

="yrap content" />

7] Graphical Layout | ¥ activity_editoml

B console i3 M t wiltB~-r3-=0

290M of 365M [l : Android DK Content Loader

Figure 7-26. Using the layout_below and layout_alignLeft parameters to align the <Button> widgets to each other
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If you now use the Graphical Layout tab, as shown in Figure 7-27, you can see your Ul design is in
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Figure 7-27. Previewing the layout_below and layout_alignLeft parameters for your <Button> widgets in the GLE

Since we are going to want to preview this RelativeLayout Ul design and EditGalaxy Activity
subclass in the Nexus One AVD emulator at some point here, before our curiosity gets the best of
us, we need to take a quick break from Ul design and add the <activity> tag and parameters for our
new EditGalaxy class to the Android Manifest XML file. We will do this so that when this Activity is
“called” using the Intent object we created for the application, the app does not crash! If you wish
to see what that crash would look like were you not to add the Activity to the manifest, simply use
your trusty Run As » Android Application menu sequence now, and click on the Edit Galaxy Info
Menultem! Kah-Blamm! Let’s do something to avoid this crash scenario!

Adding EditGalaxy to Your App: Editing Your AndroidManifest

Let’s take a break and add the EditGalaxy class to your AndroidManifest.xml file, so that when we
want to test this Ul design in the Nexus One AVD emulator, the application won’t crash. Since we
use explicit Intent object Java code in order to launch the EditGalaxy Activity subclass, we will not
need to define any IntentFilter object structures, such as the MainActivity features, so all that we will
be required to add is the following XML markup:

<activity
android:name="absolute.beginners.hellouniverse.EditGalaxy"
android:label="@string/edit_galaxy" >

</activity>
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You can add this either before or after the MainActivity <activity> definition, as you can see in
Figure 7-28. Notice that we are using the Menultem label <string> to label the top of this Activity
subclass screen, so that users will know that it is the “Edit Galaxy Info” screen. If you want the
application name (brand) on the top of the screen, you would simply leave the app_name <string>
constant reference; that is entirely your call.
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Figure 7-28. Adding the <activity> child tag for the EditGalaxy class, and an Edit Galaxy Info <string> reference

You could also use the short-form tag style, since there are no child tags inside of the <activity>
parent tag, such as an <intent-filter> child tag, and thus, you could write this <activity> tag using the
following XML markup:

<activity android:name="absolute.beginners.hellouniverse.EditGalaxy"
android:label="@string/edit_galaxy" />

Now let’s get back to adding the bottom half of our EditGalaxy Ul design, which is not going to go
quite as smoothly as you think that it might, and so we will have an opportunity to learn even more
RelativeLayout alignment parameters which can be utilized to make your Ul design absolutely perfect!

Finishing Up the RelativelLayout Ul Design

Create your third set of <EditText> and <Button> Ul elements by copying and pasting your second
set of <EditText> and <Button> Ul elements and change edit_pop to edit_fleet for the <EditText> Ul
widget and submit_pop to submit_fleet for the <Button> Ul widget, as shown in Figure 7-29. Leave
your android:text reference for the <Button> set to ok_button and the android:layout_alignLeft
reference for the <EditText> set to @+id/edit_colony, so that all of the EditText Ul widgets will align
with the first EditText Ul widget.
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Figure 7-29. Adding the third <EditText> child tag and using RelativeLayout alignment to align it below edit_pop

It is important to note that you could also alternatively reference the layout_alignLeft parameter to
the EditText ID of the EditText Ul element above it (@+id/edit_pop), since that EditText Ul element
has already “inherited” the positioning from the edit_colony EditText Ul widget’s positioning. You can
apply the same principle to the layout_alignLeft parameter for the third Button Ul element; it could
either reference the @+id/submit_colony or the @+id/submit_pop as both of these references will
produce the same left-side Button alignment result.

Now click on the Graphical Layout Editor tab and preview the Ul design, which can be seen in
Figure 7-30. As you can see, the Ul design does not look professional, as the alignment of the
EditView Ul elements and the Button Ul elements is getting worse as we move from the top of the
design to the bottom.
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Figure 7-30. Using the Graphical Layout Editor tab to check on your <EditText> RelativeLayout alignment results

This means that we will need to add another alignment parameter to bring this Ul design back into
a perfectly aligned design. What we need is something that will align the bottom of the EditText Ul
widget with the bottom of the Button Ul widget, or better yet, align the text inside of the EditText
field Ul element with the text label on the Button Ul element.

As you can see in Figure 7-30, the Button Ul elements already align quite well, so we should
leverage that fact, by forcing the EditText Ul elements to align with the Button Ul elements in some
fashion, either by using the alignTop, alignBottom, or alignBaseline relative layout parameters, and
referencing the Button Ul elements.

Since the alignTop and alignBottom parameters are fairly straightforward, and since the baseline
alignment of the text in these user interface elements will provide a more professional visual result,
we will go ahead and learn about baseline alignment next, using the android:layout_alignBaseline
parameter.

The baseline of a font is the part of the font that sits on the line that most of the font characters sit
on. There are a couple of exceptions to this rule, such as the “y” in Galaxy shown in Figure 7-30,
which drops below the baseline, and some other characters, such as the “f” or the “j” and the “g” or
the “q,” which could also sometimes drop below the baseline, depending upon how they are drawn
for any given font type or style.

Next, let’s clean up the Ul